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การวิจัยคร้ังน้ีเปนการศึกษาความสัมพันธเชิงสาเหตุ โดยมีวัตถุประสงคดังน้ี 1) เพื่อศึกษาและเปรียบเทียบความสามารถทาง

คอมพิวเตอรของนักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานคร เม่ือจําแนกตามสังกัดและขนาดของโรงเรียน 2) เพื่อพัฒนาโมเดลเชิงสาเหตุและผล
ของการรับรูความสามารถดานคอมพิวเตอรของตนเองท่ีมีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานคร และ 
3) เพื่อตรวจสอบความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองท่ีมีตอความสามารถ
ทางคอมพิวเตอรท่ีพัฒนาขึ้นกับขอมูลเชิงประจักษ กลุมตัวอยางท่ีใชในการวิจัย คือ นักเรียนระดับชวงชั้นท่ี 4 ในกรุงเทพมหานคร จํานวน 
813 คน ตัวแปรท่ีใชการวิจัย ประกอบดวย ตัวแปรภายในแฝง 4 ตัวแปร ไดแก การรับรูความสามารถดานคอมพิวเตอรของตนเอง การ
ต้ังเปาหมาย ความผูกพันตอเปาหมายและความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานคร และตัวแปรภายนอก
แฝง 4 ตัวแปร คือ ระดับประสบการณเดิม บุคลิกภาพภายในของผูเรียน ความมุงม่ันในการทํางานและความวิตกกังวลในการใชคอมพิวเตอร 
โดยตัวแปรแฝง วัดจากตัวแปรสังเกตได รวมท้ังหมด 13 ตัวแปร เคร่ืองมือท่ีใชในการวิจัยคร้ังน้ีไดแก แบบสอบถามและแบบทดสอบ   
ซึ่งแบบสอบถามมีคาความเท่ียงสัมประสิทธิ์แอลฟาของครอนบาคของตัวแปรสังเกตไดต้ังแต 0.61-0.95 สําหรับแบบทดสอบมีคาความยากอยู
ระหวาง 0.25 กับ 1.00 และอํานาจจําแนกมีคาอยูระหวาง 0.00 กับ 0.88 มีคาความเท่ียงแบบ KR20 เทากับ 0.71 วิเคราะหขอมูลโดยใชการ
วิเคราะหคาสถิติพื้นฐาน การวิเคราะหสถิติทดสอบที (t-test) การวิเคราะหคาสัมประสิทธิ์สหสัมพันธแบบเพียรสัน และการวิเคราะห   
โมเดลลิสเรล 
 
 ผลการวิจัยท่ีสําคัญ สรุปไดดังน้ี 

1. นักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานคร มีความสามารถทางคอมพิวเตอร โดยมีคะแนนเฉลี่ยคิดเปนรอยละ 49.66 ของคะแนน
เต็ม โดยนักเรียนท่ีอยูในโรงเรียนสังกัดสํานักงานคณะกรรมการการศึกษาขั้นพื้นฐาน (สพฐ.) มีความสามารถทางคอมพิวเตอรสูงกวานักเรียน
ท่ีอยูในโรงเรียนสังกัดสํานักงานคณะกรรมการสงเสริมการศึกษาเอกชน (สช.) และยังพบวานักเรียนท่ีอยูในโรงเรียนขนาดใหญจะมี
ความสามารถทางคอมพิวเตอรสูงกวาโรงเรียนขนาดกลาง 

2. ตัวแปรท่ีมีอิทธิพลทางตรงตอการรับรูความสามารถดานคอมพิวเตอรของตนเองของนักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานคร 
ไดแก ตัวแปรระดับประสบการณเดิม ตัวแปรบุคลิกภาพภายในของผูเรียน ตัวแปรความมุงม่ันในการทํางานและตัวแปรความวิตกกังวลใน
การใชคอมพิวเตอร อยางไมมีนัยสําคัญทางสถิติท่ีระดับ .05 

3. ตัวแปรท่ีมีอิทธิพลทางตรงตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานครอยางมีนัยสําคัญทาง
สถิติท่ีระดับ .05 ไดแก ตัวแปรความผูกพันตอเปาหมาย และตัวแปรการต้ังเปาหมาย สวนตัวแปรท่ีมีอิทธิพลทางออมตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงชั้นท่ี 4 ในกรุงเทพมหานคร อยางมีนัยสําคัญทางสถิติท่ีระดับ .05 คือ ตัวแปรการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง 

4. โมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองท่ีมีตอความสามารถทางคอมพิวเตอร โดย
ภาพรวม มีความสอดคลองกับขอมูลเชิงประจักษ โดยใหคาไค-สแควร (Chi-square) เทากับ 9.146 ท่ีองศาอิสระ เทากับ 11 ท่ีระดับความ
นาจะเปน เทากับ 0.608 มีคา GFI เทากับ 0.998 คา AGFI เทากับ 0.986 และคา RMR เทากับ 0.020 ตัวแปรในโมเดลสามารถอธิบาย   
ความแปรปรวนของความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันท่ี 4 ในกรุงเทพมหานคร ไดรอยละ 24.20 
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 The objective of the research were 1) to study the level of upper secondary school students in Bangkok’s 
computer performance and to compare this in school under different authorities and of different school sizes.  
2) Development of a cause and effect model of computer self-efficacy on computer performance of upper secondary 
school students in Bangkok. And 3) to examine the goodness of fit of the model with empirical data. The research 
samples consisted of 813 upper secondary school students in Bangkok. Variables consisted of eight latent variables: 
previous experience, trainee personality, learning goal, computer anxiety, computer self-efficacy, goal setting, goal 
commitment and computer performance of upper secondary school students in Bangkok. These latent variables were 
measured by thirteen observed variables. The research data were collected by questionnaires and test. 
Questionnaires had Cronbach's alpha reliability coefficient of observe variable in the ranged of 0.61 – 0.95, test had 
level difficulty of the items was 0.67, discrimination power of the items was 0.34 and KR20 reliability coefficient of 0.72. 
Analyzed by employing descriptive statistics, t-test, Pearson’s product-moment correlation coefficient and LISREL 
analysis. 
 
The research finding were as follows: 

1. The upper secondary school students in Bangkok’s computer performance stood at 49.66 percent. And the 
students in the basic education commission have higher computer performance than students in the private education 
commission. And the students who studied in a large school are higher computer performance than students who 
studied in a medium size school. 

2. Previous experience, trainee personality, learning goal and computer anxiety variable had not the direct 
effect to computer self-efficacy of upper secondary school students in Bangkok, the level of significant being .05. 

3. Goal commitment and goal setting variable had the direct effect to computer performance of upper 
secondary school students in Bangkok. And computer self-efficacy variable had the indirect effect to computer 
performance of upper secondary school students in Bangkok. 

4. The causal model was valid and fitted with the empirical data. Indicated by the Chi-square goodness 
of fit test was 9.146, df = 11, p = 0.608, GFI = 0.998, AGFI = 0.986 and RMR = 0.020. The model accounted for 
24.20% of variance in the computer performance of upper secondary school students in Bangkok.  
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กิตติกรรมประกาศ 

วิทยานิพนธเลมนี้ สําเร็จลุลวงไปไดดวยดี โดยไดรับความกรุณาเปนอยางยิ่งจาก             
รองศาสตรจารย ดร.วรรณี แกมเกตุ อาจารยที่ปรึกษาวิทยานิพนธ ที่ใหคําปรึกษา ใหแนวคิด 
คําแนะนํา และแกไขขอบกพรองในการทําวิทยานิพนธ ต้ังแตเร่ิมตนจนกระทั่งสําเร็จเสร็จส้ิน ผูวิจัย
ขอกราบขอบพระคุณเปนอยางสูงมา ณ โอกาสนี้ 

ขอกราบขอบพระคุณรองศาสตราจารย ดร.อวยพร เรืองตระกูล และอาจารย ดร.บุญเรือง  
เนียมหอม คณะกรรมการสอบวิทยานิพนธ ขอกราบขอบพระคุณผูชวยศาสตราจารย ดร.ณัฎฐภรณ 
หลาวทอง ผูชวยศาสตราจารย ดร.พาสนา จุลรัตน อาจารย ดร.สกล วรเจริญศรี อาจารย ดร.ประกอบ 
กรณีกิจ  อาจารยชยการ  คีรีรัตน ผูเช่ียวชาญตรวจสอบเคร่ืองมือทุกทานเปนอยางสูง ที่ใหความรู 
ใหคําแนะนํา และขอเสนอแนะที่เปนประโยชนตอผูวิจัยเปนอยางยิ่ง  ขอขอบคุณปานอยและพี่ตาย
ที่ดูแลนิสิตในภาควิชาเปนอยางดี และอํานวยความสะดวกในทุกข้ันตอนของการทําวิทยานิพนธ  

ขอขอบพระคุณบัณฑิตวิทยาลัย ที่ไดกรุณามอบทุนอุดหนุนวิทยานิพนธจนทําใหผูวิจัย
สามารถทําวิทยานิพนธสําเร็จไดดวยดี 

ขอขอบคุณคณะผูบริหารโรงเรียนมาแตรเดอีวิทยาลัย เขตปทุมวัน กรุงเทพมหานคร อาจารย
ปานทิพย โสภาษิต ผูอํานวยการโรงเรียน อาจารยวีณา รักษาสกุล หัวหนาฝายวิชาการมัธยม ครู
รัตนา ครูจิติมา ครูสถาพร ครูวิศิษฐ ครูเพ็ญศิริ ครูธนารีย ครูจินต ครูธนาวรรณ ครูกรรณิการ ครูเมทิรา 
และครูในโรงเรียนมาแตรเดอีวิทยาลัยที่ไมไดกลาวถึงทุกคน คุณจุฑา คุณพีรยุทธ คุณทัศนีย คุณพนิดา 
คุณคูบุญ คุณยุทธพงษ คุณนิพัทธา คุณนริศรา คุณจารุวรรณ คุณสุรศักด์ิ คุณสุทธิพงศคุณกมล 
และพี่ๆ เพื่อนๆ และนองๆ ภาควิชาวิจัยและจิตวิทยาการศึกษาทั้งในและนอกเวลาราชการที่ไมได
กลาวถึงทุกคน ที่คอยเปนกําลังใจใหแกผูวิจัยมาโดยตลอด รวมทั้งใหความชวยเหลือ และให
คําแนะนําทุกคร้ังที่ผูวิจัยมีปญหาในการทําวิทยานิพนธ  

ทายที่สุดนี้ ผูวิจัยขอกราบขอบพระคุณพอสุพัฒน และคุณแมสุวิมล สุวัตถิพงศเปนอยาง
สูงที่ใหทุนเรียน รวม ทั้งใหความรัก ความหวงใย คอยเปนกําลังใจ และเปนทุกๆ อยาง รวมถึงญาติ
พี่นอง ที่คอยไตถาม ใหกําลังใจและความชวยเหลือผูวิจัยเกี่ยวกับการทําวิทยานิพนธมาโดยตลอด 
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บทที่  1 
 

บทนํา 
 
ความเปนมาและความสําคัญของปญหา 
 

การศึกษาเปนรากฐานท่ีสําคัญอยางยิ่งในการพัฒนาประเทศชาติใหเจริญกาวหนา
ทัดเทียมกับประเทศอ่ืนในโลก ทั้งนี้เพราะการศึกษาเปนการพัฒนาคนใหมีความรู ความคิด              
มีความสามารถมีทักษะในการทํางานและดําเนินชีวิตในสังคมอยางมีความสุข เมื่อคนในชาติไดรับ
การพัฒนาแลว ยอมสงผลใหเกิดการพัฒนาประเทศชาติในทุกๆดาน  ดังนั้นประเทศไทยจึงไดมี
การกําหนดหลักสูตรการศึกษาข้ันพื้นฐาน เพื่อใหเปนแนวทางสําหรับใชในกระบวนการศึกษา 

 
หลักสูตรการศึกษาข้ันพื้นฐาน พุทธศักราช 2544 ไดมีการกําหนดจุดมุงหมายเพื่อพัฒนา

คนไทยใหเปนมนุษยที่สมบูรณ เปนคนดี มีปญญา มีความสุข และมีความเปนไทยโดยมี
คุณลักษณะอันพึงประสงค เชน ใหคนไทยไดมีการพัฒนาทักษะกระบวนการ มีความคิดสรางสรรค
และเห็นคุณคาในตนเอง ทางดานมาตรฐานการเรียนรูในการพัฒนาผูเรียนของแตละโรงเรียนกต็อง
ปรับการจัดการศึกษาใหเหมาะสม โดยใหคํานึงถึงสภาพปญหา ความพรอม เอกลักษณ            
ภูมิปญญาทองถิ่นนั้นๆ ดังนั้นในขอบขายเนื้อหา กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลยี 
ชวงช้ันที่ 4 จึงไดมีการจัดใหสถานศึกษาแตละแหงสามารถปรับรูปแบบหลักสูตรใหเหมาะสมย่ิงข้ึน
ไดในบางกลุมสาระ เชน ศิลปะ การงานอาชีพและเทคโนโลยี ซึ่งยังจําเปนตองเรียนอยู อาจจัดเปน
รายวิชาหรือรวมกันในลักษณะบูรณาการ  โดยท่ีการศึกษาวิชาคอมพิวเตอรจะเปนสวนหนึ่งของ
กลุมสาระวิชาการงานอาชีพและเทคโนโลยี 

 
คอมพิวเตอรเปนเทคโนโลยีใหม มีความทันสมัยซ่ึงนับวันจะกาวเขามามีบทบาทเพิ่มข้ึน

อยางมากในวงการศึกษา ทั้งนี้เปนเพราะคอมพิวเตอรมีคุณสมบัติและลักษณะพิเศษที่สามารถจะ
เอ้ืออํานวยในการเรียนการสอนและการบริหารงานตางๆใหมีประสิทธิภาพมากยิ่งข้ึน  คอมพวิเตอร
จะชวยเพิ่มแรงจูงใจใหกับผูเรียน (กิดานันท มลิทอง, 2543) 

 
เนื่องจากในสังคมปจจุบันความกาวหนาของคอมพิวเตอรไดกอใหเกิดการเปล่ียนแปลง

อยางรวดเร็ว และมีบทบาทสําคัญในดานเศรษฐกิจ อุตสาหกรรม และการศึกษาเปนอยางมาก 



 2
 

สําหรับประเทศไทยไดนําคอมพิวเตอรและเทคโนโลยีสารสนเทศมาใชประโยชนในวงการการศึกษา
เพิ่มมากข้ึน ต้ังแตในระดับหลักสูตรการศึกษาข้ันพื้นฐานจนถึงทุกหนวยงาน จึงเปนเหตุใหผูเรียน
ตองมีทักษะในการใชคอมพิวเตอร ผูเรียนตองสามารถใชงานคอมพิวเตอรสําหรับทํางานไดตรงกับ
ความตองการตลอดจนสามารถพัฒนาตนเองไดเต็มตามศักยภาพของผูเรียน   

 
จากการศึกษาแนวคิดและทฤษฎีของแบนดูรา พบวาการรับรูความสามารถของตน           

(Self-Efficacy) เปนปจจัยหนึ่งที่จะทําใหบุคคลคาดการณความสามารถของตนเองได โดยที่การ
รับรูความสามารถของตนเอง หมายถึง การที่บุคคลตัดสินใจเกี่ยวกับความสามารถของตนเองที่จะ
จัดการและดําเนินการกระทําพฤติกรรมใหบรรลุเปาหมายที่กําหนดไว ซึ่งในสถานการณที่บางคร้ัง
อาจจะมีความคลุมเครือ ไมชัดเจน มีความแปลกใหม ที่ไมสามารถทํานายส่ิงที่เกิดข้ึนได                    
ซึ่งสภาพการณเหลานี้มักจะทําใหบุคคลเกิดความเครียดได (Bandura, 1986) การรับรู
ความสามารถของตนเปนโครงสรางทางจิตอยางหน่ึงที่เช่ือวามีบทบาทสําคัญตอการตรวจสอบ
ตนเอง โดยเฉพาะอยางยิ่งเมื่อมีแรงจูงใจในระดับที่เหมาะสม เพื่อใหสามารถทํางานที่ไมมี
ความคุนเคยได (Bandura, 1977, 1982) ในเร่ืองคอมพิวเตอรก็เชนกัน ถาบุคคลใดมีการรับรู
ความสามารถของตนดานคอมพิวเตอรในระดับสูง บุคคลก็มีแนวโนมที่จะเรียนรูดานคอมพิวเตอร
ไดดี กิสท สชาวเรอร และโรเซ็น (1989) และมารทอกชิโอ และดูลบอรน (1994)  ไดกลาววา บุคคล
จะเรียนรูอยางมีประสิทธิผลมากข้ึน เมื่อบุคคลนั้นมีการรับรูความสามารถดานคอมพิวเตอรของ
ตนเองเพิ่มข้ึน 

 
ดังนั้นการรับรูความสามารถดานคอมพิวเตอรของตนเองเปนส่ิงสําคัญที่จะทําใหผูเรียน

สามารถตัดสินตนเองไดวาตนเองมีความสามารถในการใชคอมพิวเตอรไดดีในระดับใด                        
ซึ่งในปจจุบันผูเรียนจะสามารถใชคอมพิวเตอรไดเปนและจะมีจํานวนมากข้ึนเร่ือยๆ แตผูเรียน
มักจะใชคอมพิวเตอรสําหรับการเลนอินเตอรเน็ต เลนเกมส สนทนา ดูหนัง ฟงเพลง ฯลฯ เพื่อความ
บันเทิงเปนสวนใหญ  ซึ่งถาหากมาคิดพิจารณาแลว ความสามารถทางดานคอมพิวเตอรสําหรับ
การใชงานทางการศึกษา  นักเรียนยังมีความสามารถทางคอมพิวเตอรที่อยูในระดับตํ่า   Marakas 
(1998)  จึงไดพัฒนาเหตุปจจัยและความสัมพันธตางๆที่ทําใหผูเรียนเกิดการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอร ซึ่งจากการศึกษางานวิจัยพบวา
มีตัวแปรที่มีความสัมพันธกัน ไดแก การต้ังเปาหมาย ความผูกพันตอเปาหมาย ความวิตกกังวลใน
การใชคอมพิวเตอร ความมุงม่ันในการทํางาน และบุคลิกภาพภายในของผูเรียน  
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 ผูเรียนในระดับมัธยมศึกษาตอนปลาย (ชวงชั้นที่ 4) เปนชวงชั้นที่มีความพรอมทางดาน
ทักษะคอมพิวเตอรเพราะไดใชคอมพิวเตอรเปนระยะเวลาหลายปนานกวานักเรียนในชวงช้ันอ่ืนๆ  
และนอกจากนี้ยังเปนชวงชั้นปสุดทายกอนที่ผูเรียนจะเขาศึกษาตอในระดับอุดมศึกษา ดังนั้น
ผูเรียนจึงมีการรับรูความสามารถดานคอมพิวเตอรของตนเองและความสามารถทางคอมพิวเตอร
ดีกวานักเรียนในชวงชั้นอื่นๆ เชนกัน ดวยเหตุผลและความสําคัญดังกลาวผูวิจัยจึงมีความสนใจ 
ที่จะพัฒนาโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ
ความสามารถทางคอมพิวเตอรของนักเรียนระดับช้ันมัธยมศึกษาตอนปลาย (ชวงชั้นที่ 4)  
 
คําถามวิจยั 
 

การวิจัยคร้ังนี้ ผูวิจัยสนใจศึกษาในประเด็นคําถามวิจัยที่สําคัญ 3 ประการ ดังนี้ 
1. ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานครอยูในระดับ

ใด และแตกตางกันหรือไม เมื่อจําแนกตามสังกัดและขนาดของโรงเรียน 
2. มีปจจัยใดบางที่มีอิทธิพลตอการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ

ความสามารถทางคอมพิวเตอร และรูปแบบความสัมพันธระหวางการรับรูความสามารถดาน
คอมพิวเตอรของตนเองกับความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่  4  ใน
กรุงเทพมหานครเปนอยางไร 

3. โมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานครท่ีพัฒนาข้ึนสอดคลอง
กับขอมูลเชิงประจักษหรือไม 
 
วัตถุประสงค 
 

 จากคําถามวิจยั 3 ประการ ผูวิจัยกาํหนดเปนวัตถุประสงคหลักสําคัญ 3 ประการ ดังนี ้
 1. เพื่อศึกษาและเปรียบเทียบความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4                  
ในกรุงเทพมหานคร จําแนกตามสังกัดและขนาดของโรงเรียน 
 2. เพื่อพัฒนาโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของ
ตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร 
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3. เพื่อตรวจสอบความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4                
ในกรุงเทพมหานครที่พัฒนาข้ึนกับขอมูลเชิงประจักษ 
 
ขอบเขตของการวิจัย 
 

 การวิจยัคร้ังนี ้ผูวิจัยกาํหนดขอบเขตของการวิจัย ดังนี ้
1. ประชากรที่ใชในการวิจัยในคร้ังนี้ คือ นักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร จํานวน  

161,763  คน โดยโรงเรียนที่ใชในการศึกษาคร้ังนี้ ประกอบดวย กลุมโรงเรียนที่มีขนาดใหญและ
ขนาดกลาง ในเขตกรุงเทพมหานคร  เพราะเปนโรงเรียนที่มีอุปกรณส่ือการเรียนการสอนทาง              
โสตทัศนศึกษา และเทคโนโลยีพรอม  

2. ตัวแปรที่ศึกษาในการวิจัยคร้ังนี้ ประกอบดวย ตัวแปรตามและตัวแปรตน ดังนี้  
 2.1 ตัวแปรตาม ไดแก ความสามารถทางคอมพิวเตอร ซึ่งเปนตัวแปรภายในแฝง
วัดไดจากตัวแปรสังเกตได 2 ตัว ไดแก คะแนนทดสอบโปรแกรมประมวลผลคําและคะแนนทดสอบ
โปรแกรมนําเสนอผลงาน 
 2.2 ตัวแปรตน ซึ่งเปนตัวแปรแฝง จํานวน 7 ตัวแปร ไดแก  
  2.2.1 ระดับประสบการณเดิม ซึ่งเปนตัวแปรภายนอกแฝง วัดไดจากตัว
แปรสังเกตได 2 ตัว ไดแก ระดับประสบการณในการใชโปรแกรมประมวลผลคําและการใช
โปรแกรมนําเสนอผลงาน 
  2.2.2 บุคลิกภาพภายในของผูเรียน ซึ่งเปนตัวแปรภายนอกแฝง วัดได
จากตัวแปรสังเกตได 2 ตัว ไดแก การเห็นคุณคาในตนเอง และความออนไหวทางอารมณ 
  2.2.3 ความมุงมั่นในการทํางาน ซึ่งเปนตัวแปรภายนอกแฝง วัดไดจาก
ตัวแปรสังเกตได คือ ระดับความมุงมั่นในการทํางาน  
  2.2.4 ความวิตกกังวลในการใชคอมพิวเตอร ซึ่งเปนตัวแปรภายนอกแฝง           
วัดไดจากตัวแปรสังเกตได คือ ระดับความวิตกกังวลในการใชคอมพิวเตอร 
  2.2.5   การรับรูความสามารถดานคอมพิวเตอรของตนเอง ซึ่งเปนตัวแปร
ภายในแฝง วัดไดจากตัวแปรสังเกตได 2 ตัว ไดแก การรับรูความสามารถในการใชโปรแกรม
ประมวลผลคําและการรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน 
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  2.2.6 การต้ังเปาหมาย ซึ่งเปนตัวแปรภายในแฝง วัดไดจากตัวแปร
สังเกตได คือ  ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมประมวลผลคําและโปรแกรม
นําเสนอผลงาน 
  2.7.7 ความผูกพันตอเปาหมาย ซึ่งเปนตัวแปรภายในแฝง วัดไดจาก         
ตัวแปรสังเกตได คือ ระดับความผูกพันตอเปาหมาย 
 
นิยามศัพทที่ใชในการวิจัย 
 

การรับรูความสามารถดานคอมพิวเตอรของตนเอง หมายถึง การที่ผูเรียนตัดสิน
ความสามารถของตนเองดานคอมพิวเตอรในการจัดการใหบรรลุเปาหมายที่กําหนดไว ซึ่งวัดได
จากตัวแปรสังเกตไดจํานวน 2 ตัวแปร ไดแก ตัวแปรการรับรูความสามารถในการใชโปรแกรม
ประมวลผลคําและตัวแปรการรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน  

การรับรูความสามารถในการใชโปรแกรมประมวลผลคํา หมายถึง การที่ผูเรียน
ตัดสินความสามารถของตนเองในการใชโปรแกรมประมวลผลคําใหบรรลุเปาหมายที่กําหนดไว ซึ่ง
วัดไดจากแบบสอบถามแบบมาตรประมาณคา (rating scale)  5 ระดับที่ผูวิจัยไดสรางข้ึนเอง  

การรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน หมายถึง การที่ผูเรียน
ตัดสินความสามารถของตนเองในการใชโปรแกรมนําเสนอผลงานใหบรรลุเปาหมายท่ีกําหนดไว 
ซึ่งวัดไดจากแบบสอบถามแบบมาตรประมาณคา (rating scale) 5 ระดับที่ผูวิจัยไดสรางข้ึนเอง 

ความสามารถทางคอมพิวเตอร หมายถึง คะแนนทดสอบที่ไดจากการใชโปรแกรม
คอมพิวเตอร ซึ่งวัดไดจากตัวแปรสังเกตได 2 ตัวแปร คือ คะแนนทดสอบโปรแกรมประมวลผลคํา
และคะแนนทดสอบโปรแกรมนําเสนอผลงาน โดยใชแบบทดสอบความสามารถทางคอมพิวเตอร
ในการทดสอบเปนแบบปรนัย 4 ตัวเลือก ที่ผูวิจัยไดสรางข้ึนเอง  

ระดับประสบการณเดิม หมายถึง ภูมิหลังในการใชโปรแกรมประมวลผลคําและโปรแกรม
นําเสนอผลงาน ซึ่งวัดไดจากตัวแปรสังเกตไดจํานวน 2  ตัวแปร ไดแก ตัวแปรระดับประสบการณใน
การใชโปรแกรมประมวลผลคําและตัวแปรระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน   

ระดับประสบการณในการใชโปรแกรมประมวลผลคํา หมายถึง ระดับจํานวนชวงป
ของประสบการณในการใชโปรแกรมประมวลผลคําและระดับจํานวนช่ัวโมงเฉล่ียตอวันในการใช
โปรแกรมประมวลผลคํา ซึ่งวัดเปนระดับความมากนอยของประสบการณจากแบบตรวจสอบ
รายการ (check list) ที่ผูวิจัยสรางข้ึน 
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ระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน หมายถึง ระดับจํานวนชวงป
ของประสบการณในการใชโปรแกรมนําเสนอผลงานและระดับจํานวนช่ัวโมงเฉล่ียตอวันในการใช
โปรแกรมนําเสนอผลงาน ซึ่งวัดเปนระดับความมากนอยของประสบการณจากแบบตรวจสอบ
รายการ (check list) ที่ผูวิจัยสรางข้ึน 

บุคลิกภาพภายในของผูเรียน หมายถึง การรับรูของผูเรียนในการประเมินตนเอง
เกี่ยวกับความสามารถในการกระทําสิ่งตางๆ อันไดแกความคิด ความรูสึกที่บุคคลมีตอตนเอง 
ประเมินตนเอง เกี่ยวกับความพอใจ ความมีคุณคา ความสําเร็จ ความสําคัญ ความสามารถ ความ
มั่นใจ และการนับถือตนเองทั้งเชิงบวกและเชิงลบ  ซึ่งวัดไดจากตัวแปรสังเกตไดจํานวน 2  ตัวแปร 
ไดแก คือ ตัวแปรการเห็นคุณคาในตนเอง และตัวแปรความออนไหวทางอารมณ   

การเห็นคุณคาในตนเอง หมายถึง ความคิด ความรูสึกของผูเรียนที่มีตอตนเอง ประเมิน
ตนเอง เกี่ยวกับความพอใจ ในคุณคา ความสําเร็จ ความสําคัญ ความสามารถ ความเชื่อมั่น และ
การยกยองตนเองซ่ึงวัดไดจากแบบสอบถามแบบมาตรประมาณคา (rating scale) 5 ระดับที่ผูวิจัย
ไดพัฒนามาจากแบบวัดของ Judge (2003)   

ความออนไหวทางอารมณ  หมายถึง ความรูสึกนึกคิดของผูเรียนที่มีตอตนเอง ในดาน
ความกังวลใจ ความรูสึกกดดัน ความไมมั่นใจในตนเอง และความรูสึกซึมเศราทอแทเกี่ยวกับการ
ทํางานใหประสบผลสําเร็จตามเปาหมายที่กําหนดไว ตลอดจนการใชชีวิตรวมกับผูอ่ืนในสังคมซ่ึง
วัดไดจากแบบสอบถามแบบมาตรประมาณคา (rating scale)  5 ระดับที่ผูวิจัยไดพัฒนามาจาก
แบบวัดของ Judge (2003)   

ความมุงม่ันในการทํางาน หมายถึง ลักษณะการแสดงออกของผูเรียนที่มีเปาหมาย          
ในการเรียนรูและมุงเนนในการทํางานใหบรรลุผลสําเร็จ ซึ่งวัดไดจากแบบสอบถามแบบมาตร
ประมาณคา (rating scale)  5 ระดับที่ผูวิจัยไดพัฒนามาจากแบบวัดของ Button (1996) 

ความวิตกกังวลในการใชคอมพิวเตอร หมายถึง สภาวะที่ผูเรียนรูสึกหวั่นไหวตอการ 
ใชคอมพิวเตอรอันสงผลใหผู เ รียนเกิดความรูสึกทางลบที่มีตอคอมพิวเตอร ซึ่งวัดไดจาก
แบบสอบถามแบบมาตรประมาณคา (rating scale)  5 ระดับที่ผูวิจัยไดพัฒนามาจากแบบวัดของ 
Heinssen (1987) 

การต้ังเปาหมาย หมายถึง หมายถึง การที่ผูเรียนคาดหวังและกําหนดรอยละของ
ผลสําเร็จในการใชโปรแกรมประมวลผลคํา(Microsoft Word) และโปรแกรมนําเสนอผลงาน 
(Microsoft PowerPoint) เปนเปาหมายตามทักษะของตนเอง ซึ่งวัดไดจากตัวแปรสังเกตไดจํานวน 
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2 ตัวแปร ไดแก ตัวแปรระดับเปาหมายของผลสําเร็จในการใชโปรแกรมประมวลผลคําและตัวแปร
ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน 

ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมประมวลผลคํา หมายถึง                    
การที่ ผู เ รียนคาดหวังและกําหนดรอยละของผลสําเร็จในการใชโปรแกรมประมวลผลคํา             
(Microsoft Word) ซึ่งวัดไดจากแบบตรวจสอบรายการ (check list)  ที่ผูวิจัยสรางข้ึน 

ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน หมายถึง                    
การที่ ผู เ รียนคาดหวังและกําหนดรอยละของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน 
(Microsoft PowerPoint) ซึ่งวัดไดจากแบบตรวจสอบรายการ (check list)  ที่ผูวิจัยสรางข้ึน 

ความผูกพันตอเปาหมาย หมายถึง การที่ผูเรียนมีความรูสึกรับผิดชอบตอเปาหมายซึ่ง
เนนผลสําเร็จของงานที่ผูเรียนกําหนดไวซึ่งวัดไดจากแบบสอบถามแบบมาตรประมาณคา (rating 
scale)  5 ระดับที่ผูวิจัยไดพัฒนามาจากแบบวัดของ Hollenback (1987) 
 
ประโยชนที่ไดรับจากงานวิจัย 
 

 1. ประโยชนในทางปฏิบัติ 
 ผลการวิจัยนี้จะทําใหทราบถึงปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอร
ของตนเองและความสามารถทางคอมพิวเตอร  ทั้งทางตรงและทางออม ผลการวิจัยจะทําใหผูสอน
ทราบถึงรูปแบบความสัมพันธระหวางการรับรูความสามารถดานคอมพิวเตอรของตนเองกับ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 วามีสาเหตุมาจากปจจัยใด  และยังไดทราบ
วามีปจจัยใดบางที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเองและความสามารถ
ทางคอมพิวเตอร  อันจะเปนประโยชนตอการนําไปสูการพัฒนาผูเรียนใหมีการพัฒนาระดับ
ความสามารถในการใชคอมพิวเตอรไดดียิ่งข้ึนตอไป 
 2. ประโยชนทางการวิชาการ 
 การศึกษาการรับรูความสามารถดานคอมพิวเตอรของตนเองและความสามารถทาง
คอมพิวเตอรนี้  ผูวิจัยไดใชกระบวนการวิจัยเพื่อนําไปสูการสรางโมเดลเชิงสาเหตุและผล                 
ซึ่งสามารถใชเปนตนแบบในการพัฒนาโมเดลเชิงสาเหตุและผลในบริบทของทางการศึกษาวิจัย
เร่ืองอ่ืนๆ ดวย 
 
 



บทที่ 2 
 

เอกสารและงานวิจัยที่เก่ียวของ 
  
 การวิจัยในคร้ังนี้ มีวัตถุประสงคหลักเพื่อพัฒนาโมเดลเชิงสาเหตุและผลของการรับรู
ความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียน             
ชวงชั้นที่ 4 ในเขตกรุงเทพมหานคร ซึ่งผูวิจัยไดแบงการนําเสนอเอกสารและงานวิจัยที่เกี่ยวของ
เปน 7 ตอน ดังนี้ ตอนแรก เปนการนําเสนอแนวคิด ทฤษฎีที่เกี่ยวกับการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง ตอนท่ีสอง เปนการนําเสนอแนวคิด ทฤษฎีที่เกี่ยวกับการต้ังเปาหมาย 
ตอนที่สาม เปนการนําเสนอปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง 
ตอนที่สี่ เปนการนําเสนอแนวคิดทฤษฎีที่เกี่ยวกับความสามารถทางคอมพิวเตอรและปจจัยที่
สงผลตอความสามารถทางคอมพิวเตอร ตอนท่ีหา เปนการนําเสนองานวิจัยที่เกี่ยวของโดย
แบงเปนงานวิจัยในประเทศและงานวิจัยตางประเทศ ตอนที่หก เปนการเสนอสาระเกี่ยวกับ
หลักการวิเคราะหโมเดลลิสเรล และตอนสุดทาย เปนการนําเสนอกรอบแนวคิดและสมมติฐาน
การวิจัย ซึ่งทั้ง 7 ตอนมีรายละเอียด ดังนี้ 

 

ตอนท่ี 1 แนวคิด ทฤษฎทีี่เกี่ยวกับการรับรูความสามารถดานคอมพิวเตอรของตนเอง 
ในตอนแรกนี้เปนการนําเสนอแนวคิดทฤษฎีที่เกี่ยวของกับการรับรูความสามารถดาน

คอมพิวเตอรของตนเองประกอบดวยสาระสําคัญ ไดแก ความหมายของการรับรูความสามารถ
ของตนเอง ทฤษฎีพื้นฐานเกี่ยวกับการรับรูความสามารถของตนเอง กระบวนการกระตุนการรับรู
ความสามารถของตนเอง กระบวนการทางปญญาที่เกี่ยวกับขอมูลของการรับรูความสามารถของ
ตนเอง แหลงของการรับรูความสามารถของตนเอง มิติของการรับรูความสามารถของตนเอง การ
วัดการรับรูความสามารถของตนเอง คุณลักษณะของบุคคลที่มีการรับรูความสามารถของตนเอง 
และการรับรูความสามารถของตนเองดานคอมพิวเตอร  

 

1.1 ความหมายของการรับรูความสามารถของตนเอง 
มิลเทียดู (Miltiadou,1999) กลาววา การรับรูความสามารถของตนเอง (Self- Efficacy) 

เปนการประเมินศักยภาพของตนเองตอกิจกรรมที่ตองปฏิบัติ หากผูเรียนมีการรับรูความสามารถ
ของตนเองสูงยอมมีแนวโนมวาผูเรียนจะสามารถปฏิบัติกิจกรรมนั้นไดประสบความสําเร็จ ปจจัยที่
สงผลตอการรับรูความสามารถของตนเอง คือการไดเห็นตัวแบบของผูเรียนในช้ันเรียน จะให
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ประสิทธิผลสูงกวาการเรียนรูจากผูสอน รวมทั้งการไดรับแรงจูงใจจากส่ิงแวดลอมการเรียน                    
จะสงผลตอความเชื่อมั่นในการเรียนและการแสดงพฤติกรรมตางๆ 

แบนดูรา (Bandura, 1986) กลาววา การรับรูความสามารถของตนเอง หมายถึง การที่
บุคคลตัดสินเกี่ยวกับความสามารถของตนเองวาสามารถกระทําบางอยางในเหตุการณหนึ่งได
หรือไม ซึ่งในเหตุการณนั้นบางครั้งอาจไมชัดเจน แปลกใหม ไมสามารถคาดการณส่ิงที่จะเกิดข้ึน
ได โดยปจจัยที่เกิดข้ึนจากเหตุการณเหลานั้นสงผลใหบุคคลเกิดความเครียดข้ึนได ปจจัยที่สงผล
ตอการรับรูความสามารถของตนเองไมไดมีเพียงทักษะที่บุคคลมีในขณะนั้นเทานั้น หากแตข้ึนอยู
กับการตัดสินของบุคคลวาสามารถทําส่ิงใดไดดวยทักษะที่มีอยู โดยการรับรูความสามารถของ
ตนเองนี้สามารถใชทํานายพฤติกรรมของบุคคลไดดวย 

ชังค (Schunk, 2000) กลาววา การรับรูความสามารถของตนเอง หมายถึง ความเชื่อมั่น
ของบุคคลเกี่ยวกับความสามารถที่จะเรียนรู หรือกระทําพฤติกรรมตามความสามารถที่มีอยูซึ่ง          
ไมเหมือนกับการที่เรารูวาจะทําอะไร เปนการประเมินทักษะและความสามารถของบุคคลตาม
ระดับความสามารถที่มีอยู 

พาจาเรสและมิลเลอร (Pajares and Miller,1994) กลาววา การรับรูความสามารถของ
ตนเองเปนการตัดสินความสามารถที่บุคคลมีตอตนเองในการแสดงพฤติกรรมที่เฉพาะเจาะจงใน
แตละสถานการณซึ่งการรับรูความสามารถของตนเองนี้จะเกี่ยวของกับความเช่ือมั่นในตนเองของ
บุคคลดวย 

จากการใหความหมายของคําวา การรับรูความสามารถของตนเอง ของนักวิชาการ 
สามารถสรุปไดวา การรับรูความสามารถของตนเอง เปนความเชื่อมั่นในการตัดสินความสามารถ
ของตนที่มีตอดานใดดานหนึ่งนอกจากนี้ยังสามารถทํานายพฤติกรรมของบุคคลนั้นไดอีกดวย 

 

1.2 ทฤษฎีพื้นฐานเกี่ยวกับการรับรูความสามารถของตนเอง 
แบนดูรา (Bandura, 1986) กลาววา การรับรูความสามารถของตนเองมีพื้นฐานมาจาก

ทฤษฎีการเรียนรูทางสังคม (Social cognitive theory) ซึ่งแนวคิดดานทฤษฎีการเรียนรูทางสังคม
เนนการเปล่ียนแปลงพฤติกรรมของบุคคลโดยใชองคประกอบดานบุคคลเปนสําคัญ วิธีการหนึ่งที่
สามารถสรางการเรียนรูคือการที่บุคคลรับรูความสามารถของตนเองอยางถูกตองจะนําไปสูการ
เปลี่ยนแปลงพฤติกรรมการเรียนรูได 

แบนดูรา (Bandura, 1977) กลาววา การรับรูความสามารถของตนเองมีผลตอการตัดสินใจ
ที่จะกระทําพฤติกรรม การที่บุคคลจะกระทําพฤติกรรมใดหรือไมนั้นข้ึนอยูกับปจจัย 2 ประการ คือ 
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1. ความคาดหวังในความสามารถของตน (Efficacy expectation) ซึ่งตอมาไดเปล่ียนเปนคํา
วา “การรับรูความสามารถของตนเอง” (Self-Efficacy) และใหคํานิยามวาเปนการรับรูความสามารถ
ของตนเองที่จะจัดการและดําเนินการกระทําพฤติกรรมใหบรรลุเปาหมายที่คาดหวังไว 

2. ความคาดหวังในผลที่จะเกิดข้ึน (Outcome expectation) หมายถึง ความคาดหวัง          
ที่บุคคลมีตอพฤติกรรมเฉพาะอยางที่จะปฏิบัติที่จะนําไปสูผลลัพธตามที่คาดหวังไว เปนการหวงัใน
ผลที่จะเกิดข้ึนที่เนื่องมาจากพฤติกรรมที่ไดกระทําไปแลว ดังแสดงในแผนภาพท่ี 2.1 ดังนี้ 

 
 
    
    

 
 

 
 
แผนภาพที่ 2.1   ความสัมพันธระหวางการรับรูความสามารถของตนเองและความคาดหวงัผล 

  ที่เกิดข้ึน  
ที่มา : Bandura, 1977 

 

จากแผนภาพขางตนแสดงใหเห็นวา การรับรูความสามารถของตนเอง และความคาดหวัง
เกี่ยวกับผลที่จะเกิดข้ึนนั้นมีความสัมพันธกันมาก โดยที่ความสัมพันธระหวางทั้งสองตัวแปรนี้              
มีผลตอการตัดสินใจที่จะกระทําพฤติกรรมของบุคคลนั้น ๆ ซึ่งจะเห็นไดจากตารางที่ 2.1 ดังตอไปนี้ 

 

ตารางที ่2.1  แสดงความสมัพันธระหวางการรับรูความสามารถของตนเอง และความคาดหวังผล 
         ที่จะเกิดข้ึน (Bandura, 1977) 

ความคาดหวังเกี่ยวกับผลลัพธที่เกิดขึ้น  
สูง ต่ํา 

สูง มีแนวโนมที่จะกระทําแนนอน มีแนวโนมที่จะไมกระทํา การรับรูความสามารถ
ของตนเอง ต่ํา มีแนวโนมที่จะไมกระทํา มีแนวโนมที่จะไมกระทําแนนอน 

 

จากตารางขางตนแสดงใหเห็นถึงความสัมพันธระหวางการรับรูความสามารถของตนเอง
กับความคาดหวงัเกี่ยวกับผลที่จะเกิดข้ึนสามารถสรุปไดดังนี ้

บุคคล พฤติกรรม ผลลัพธ 

การรับรูความ         
สามารถของตนเอง 

ความคาดหวงัผล      
ที่จะเกิดข้ึน 
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1. บุคคลที่มีการรับรูความสามารถของตนเองสูง มีความคาดหวงัเกีย่วกับผลลัพธที่เกิดข้ึน
สูงจะมีแนวโนมที่จะกระทาํกิจกรรม หรือพฤติกรรมนัน้แนนอน 

2. บุคคลที่มีการรับรูความสามารถของตนเองตํ่า มีความคาดหวงัเกีย่วกับผลลัพธที่เกิดข้ึน
สูงจะมีแนวโนมที่จะไมกระทาํกิจกรรม หรือพฤติกรรมนัน้ 

3. บุคคลที่มีการรับรูความสามารถของตนเองสูง มีความคาดหวงัเกีย่วกับผลลัพธที่เกดิข้ึน
ตํ่าจะมีแนวโนมที่จะไมกระทาํกิจกรรม หรือพฤติกรรมนัน้ 

4. บุคคลที่มีการรับรูความสามารถของตนเองตํ่า มีความคาดหวงัเกีย่วกับผลลัพธที่เกิดข้ึน
สูงจะมีแนวโนมที่จะกระทาํกิจกรรม หรือพฤติกรรมนัน้แนนอน 
 จากทฤษฎีพื้นฐานเกี่ยวกับการรับรูความสามารถของตนเองทําใหสรุปไดวาการรับรู
ความสามารถของตนเองมีผลตอการแสดงออกทางพฤติกรรม และเม่ือบุคคลนั้นมีความคาดหวัง
สูงก็ยอมจะทําใหผลลัพธนั้นเกิดข้ึนอยางแนนอน 

 

1.3 กระบวนการกระตุนการรับรูความสามารถของตนเอง 
แบนดูรา (Bandura, 1994) กลาววา การกระตุนการรับรูความสามารถของตนเองจะ

สงผลตอพฤติกรรมของบุคคล ซึ่งประกอบดวย 4 กระบวนการดังตอไปนี้ 
1.3.1 กระบวนการทางปญญา (Cognitive Processes) การรับรูความสามารถ

ของตนเองมีผลตอกระบวนการทางปญญาหลายรูปแบบ พฤติกรรมของบุคคลสวนมากมี
จุดมุงหมายที่ถูกกํากับโดยการต้ังเปาหมายไวลวงหนา การต้ังเปาหมายของบุคคลจะไดรับอิทธิพล
จากการประเมินความสามารถของตนเอง คนที่มีการรับรูความสามารถของตนเองสูงจะ
ต้ังเปาหมายที่ สูงและทาทาย  มีความมุงมั่นที่จะบรรลุเปาหมายมากกวาคนที่มีการรับรู
ความสามารถของตนเองตํ่าและรูปแบบพฤติกรรมสวนใหญมักริเร่ิมจากรูปแบบการคิด เปนการ
คิดสรางสภาพการณลวงหนาและยอนทบทวน บุคคลที่มีการรับรูความสามารถสูงจะสรางภาพ
แหงความสําเร็จ ส่ิงนี้จะชวยแนะแนวทางและสนับสนุนการกระทํา สวนบุคคลที่สงสัยใน
ความสามารถของตนเองจะสรางภาพความลมเหลวไวลวงหนา กระบวนการคิดจึงทําใหบุคคล
ทํานายเหตุการณและพัฒนาแนวทางที่จะควบคุมส่ิงที่จะมีผลตอการดํารงชีวิตของตนเองในสภาพ
การเรียนรูบุคคลมุงเนนไปที่ความรูของตนที่จะแสดงความคิดเห็น เพื่อรวบรวมปจจัยตางๆนําไปสู
การตรวจสอบ โดยบุคคลจะพิจารณาการประเมินตนเองอีกคร้ังจากผลการกระทําระยะส้ันและ
ระยะยาว จดจําปจจัยตางๆ ที่ถูกตรวจสอบและจําวาตนเองทํางานใหดีไดอยางไร 

การเผชิญกับสภาพการณที่มีความกดดัน อุปสรรคหรือความลมเหลว บุคคลที่มี
การรับรูความสามารถของตนเองตํ่าจะมีความคิดวิเคราะหที่เอาแนนอนอะไรไมได มีระดับความ
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พึงพอใจตนเองในระดับตํ่า และคุณภาพการทํา งานจะดอยลง ในทางตรงกันขามบุคคลที่มีการ
รับรูความสามารถสูง จะต้ังเปาหมายที่ทาทายและใชการคิดวิเคราะหที่ดีในการที่จะบรรลุผลสําเร็จ 

1.3.2 กระบวนการจูงใจ (Motivation Processes) การรับรูความสามารถของ
ตนเองมีบทบาทสําคัญในการจูงใจตนเอง การจูงใจของบุคคลสวนใหญอยูในรูปของกระบวนการ
คิด บุคคลจะมีการจูงใจตนเองและช้ีแนะการกระทําของตนเองโดยการคิดลวงหนา บุคคลจะสราง
ความเชื่อจากการคิดวาตนเองสามารถทําอะไรได และมีความคาดหวังถึงผลของการกระทํา บุคคล
จะต้ังเปาหมายและวางแผนการกระทําของตนเอง  โดยรูปแบบการจูงใจทางความคิดมีลักษณะ
แตกตางกัน 3 ลักษณะ คือ การระบุสาเหตุ การคาดหวังผลและเห็นคุณคา และการต้ังเปาหมาย 
ซึ่งการรับรูความสามารถของตนเองจะมีบทบาทตอการจูงใจ ทางความคิดทั้ง 3 ลักษณะ ดังนี้ 

1.3.2.1 การรับรูความสามารถของตนเองมีอิทธิพลตอการระบุสาเหตุ  
คนที่มีการรับรูความสามารถสูงจะอางสาเหตุของความลมเหลวของตนวาเกิดจากการขาดความ
พยายาม คนที่เช่ือวาตนเองไมมีความสามารถก็จะอางสาเหตุของความลมเหลวน้ันวาเกิดจาก
ตนเองไมมีความสามารถ การระบุอางสาเหตุนี้จะมีผลตอแรงจูงใจ การกระทํา และปฏิกิริยา
อารมณโดยผานการรับรูความสามารถของตนเอง 
   1.3.2.2 การคาดหวังผลและเห็นคุณคา แรงจูงใจจะถูกควบคุมโดยการ
คาดหวังผลจากการกระทํา แตบุคคลจะกระทําพฤติกรรมภายใตความเชื่อที่วาตนเองสามารถทํา
อะไรไดและความเชื่อในผลที่เกิดจากการกระทํา อิทธิพลของการคาดหวังผลและเห็นคุณคาจะเปน
แรงจูงใจใหบุคคลกระทําพฤติกรรมนั้น สวนหนึ่งข้ึนอยูกับการรับรูความสามารถของตนเอง 

1.3.2.3 การต้ังเปาหมาย บุคคลจะต้ังเปาหมายที่ทาทายและประเมินผล
ยอนกลับจากเปาหมายที่ต้ังไว การต้ังเปาหมายที่ทาทายจะทําใหแรงจูงใจเพิ่มและยังคงอยู
เปาหมายตางๆ จะมีอิทธิพลตอบุคคลโดยผานกระบวนการภายในตนเองมากกวาจะเปนการ
ควบคุมแรงจูงใจและพฤติกรรมโดยตรง แรงจูงใจนั้นจะมีพื้นฐานมาจากการต้ังเปาหมายที่
เกี่ยวของกับกระบวนการเปรียบเทียบทางปญญา โดยการทําใหเกิดความพึงพอใจในตนเองจาก
เปาหมายที่ต้ังไว พฤติกรรมของบุคคลจะพึงพอใจในตนเองในการบรรลุเปาหมายที่มีคุณคาและ
สงเสริมใหตนเองใชความพยายามมากข้ึน โดยการไมพอใจกับการกระทําที่ตํ่ากวามาตรฐาน 
แรงจูงใจจากเปาหมายหรือมาตรฐานสวนบุคคลจะไดรับผลมาจากอิทธิพลในตนเอง 3 ประเภท 
คือ การพึงพอใจและไมพึงพอใจตนเองจากการกระทําการรับรูถึงความสามารถของตนเองที่จะ
บรรลุเปาหมายที่ต้ังไวและการปรับปรุงการต้ังเปาหมายดวยกระบวนการทางปญญา 
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1.3.3 กระบวนการทางความรูสึกและอารมณ (Affective Processes) การรับรู
ความสามารถของตนเองจะมีผลตอความเครียดและความกดดันเมื่อบุคคลเผชิญกับสภาพการณ   
ที่ลําบากมีอุปสรรคและจะมีผลตอระดับแรงจูงใจ บุคคลที่เช่ือในความสามารถของตนเองจะ
สามารถควบคุมความเครียดที่จะทําใหเกิดความวิตกกังวลได แตคนที่เช่ือวาตนไมมีความสามารถ
จะมีความวิตกกังวลสูงและมองวาสภาพแวดลอมที่เขาอยูเต็มไปดวยอันตรายและมีความวิตก
กังวลกับส่ิงตางๆ ที่จะเกิดข้ึน ความวิตกกังวลไมเพียงไดรับอิทธิพลจากการรับรูความสามารถที่จะ
กระทําพฤติกรรมเทานั้น แตยังไดรับอิทธิพลจากการรับรูความสามารถดานการควบคุมความคิดที่
รบกวนได การรับรูความสามารถดานการควบคุมความคิดเปนปจจัยสําคัญที่จะควบคุมความคิด
อันกอใหเกิดความเครียดและความกดดัน ทั้งการรับรูความสามารถในการจัดการและการรับรู
ความสามารถในการควบคุมความคิดจึงทํางานรวมกันที่จะชวยลดความวิตกกังวลและพฤติกรรม
หลีกเล่ียงได 

1.3.4 กระบวนการเลือก (Selection Processes) การรับรูความสามารถของ
ตนเองจะมีผลตอการเลือกกระทําพฤติกรรมโดยบุคคลจะเลือกกระทําในสถานการณที่ตนเองเชื่อ
วาทําได และหลีกเลี่ยงสถานการณหรือกิจกรรมที่บุคคลเช่ือวาเกินความสามารถของตนเองท่ีจะ
ทําไดบุคคลที่มีการรับรูความสามารถของตนเองสูงจะเลือกงานที่มีลักษณะทาทาย สวนบุคคลที่มี
การรับรูความสามารถของตนเองตํ่าจะทอถอยหลีกเล่ียงงาน เปนการปดโอกาสที่จะพัฒนา
ศักยภาพของตนเอง 

สรุปไดวากระบวนการกระตุนการรับรูความสามารถของตนเองประกอบ            
ไปดวย  4 กระบวนการ คือ กระบวนการทางปญญา กระบวนการจูงใจ กระบวนการทางความรูสึก
และอารมณและกระบวนการเลือก 

 

1.4 กระบวนการทางปญญาที่เกี่ยวกับขอมูลของการรับรูความสามารถของตนเอง 
แบนดูรา (Bandura, 1986) กลาววา ขอมูลที่เปนแหลงการรับรูความสามารถของตนเอง

ไมไดเขาสูตัวบุคคลได ตองผานกระบวนการประเมินทางปญญา ซึ่งจะตองอาศัยปจจัยตางๆ เชน 
สภาพการณทางสังคม สถานการณ หรือระยะเวลา เปนตน ซึ่งการประเมินทางปญญาเกีย่วกบัการ
รับรูความสามารถของตนเองนี้จะตองรวมระหวางองคประกอบ 2 สวนที่แยกกันอยูเขาไวดวยกัน 
คือ องคประกอบที่เกี่ยวกับรูปแบบของขอมูลที่บุคคลใหความสนใจ และองคประกอบที่เกี่ยวกับ
การเชื่อมโยง เพื่อนํามาใชในการตัดสินความสามารถของตนเอง โดยมีขอมูลที่สงผลตอการรับรู
ความสามารถของตนเองดังนี้ 
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1.4.1 ขอมูลความสามารถที่ไดจากการกระทํา (Enactive Efficacy Information) 
การไดรับประสบการณตรงจากการกระทําจะทําใหการรับรูความสามารถของตนเองเปลี่ยนไป โดย
การเปล่ียนแปลงข้ึนอยูกับปจจัยตางๆ ไดแก 

1.4.1.1 ความพยายามและการตัดสินความสามารถ บุคคลที่มีการรับรู
ความสามารถของตนเองสูง จะมองวาความพยายามมีความสัมพันธทางลบกับความสามารถ นั่น
คือถาใชความพยายามเพียงเล็กนอยก็สามารถทํางานที่ยากหรือทาทายใหประสบความสําเร็จได 
แตถาตองใชความพยายามอยางมากจึงจะประสบความสําเร็จ แสดงวาบุคคลนั้นมีความสามารถ
นอยกวาในขณะเดียวกันถาไดใชความพยายามแลวแตยังไมประสบความสําเร็จ ก็จะประเมินวา
ตนเองมีการรับรูความสามารถของตนเองตํ่า 

1.4.1.2 รูปแบบของการอนุมานสาเหตุ  บุคคลที่ เ ช่ือวาตนเองมี
ความสามารถจะอนุมานสาเหตุของความสําเร็จหรือความลมเหลววาเกิดจากปจจัยภายใน ซึ่ง
ไดแก ความพยายามหรือความสามารถของตนเอง สวนบุคคลที่มองวาตนเองมีความสามารถตํ่า 
จะอนุมานสาเหตุของความสําเร็จหรือความลมเหลววาเกิดจากปจจัยภายนอก ดังนั้น หากจะเพิ่ม
การรับรูความสามารถของตนเองจะตองใชความพยายามหรือความสามารถที่มีอยูใหมากที่สุด 
โดยพยายามหลีกเล่ียงการชวยเหลือจากภายนอกใหนอยที่สุด 

1.4.1.3 ความต้ังใจและความจํา คนที่มีการรับรูความสามารถของตนเอง
สูงจะเลือกจําแตเฉพาะการกระทําหรือประสบการณที่ประสบความสําเร็จของตนเอง สวนคนที่รับรู
ความสามารถของตนเองตํ่าจะจําแตการกระทําหรือเหตุการณในทางลบ 

1.4.2 ขอมูลความสามารถที่ไดจากการเห็นตัวแบบที่ประสบความสําเร็จ 
(Vicarious Efficacy Information) ขอมูลนี้จะมีผลตอการรับรูความสามารถของตนเอง หากบุคคล
มีการนําตัวแบบนั้นมาเปรียบเทียบกับตนเอง ลักษณะสําคัญของตัวแบบที่ประสบความสําเร็จ     
มีดังนี้ 

1.4.2.1 ตองมีลักษณะคลายคลึงกับผูสังเกต ทั้งทางดานเพศ อายุ ระดับ 
การศึกษาทักษะหรือประสบการณในอดีต เปนตน 

1.4.2.2 ตองมีความหลากหลาย ซึ่งจะทําใหผูสังเกตเกิดความคิดวาคนที่
มีลักษณะตางกันก็สามารถประสบความสําเร็จไดเชนกัน 

1.4.3 ขอมูลความสามารถจากการพูดชักจูง (Persuasory Efficacy Information) 
การตัดสินเกี่ยวกับความสามารถของตนเองนั้น ไมไดข้ึนอยูกับตนเองเพียงอยางเดียว ยังข้ึนอยูกับ
บุคคลอ่ืนที่มีความสามารถในการประเมินอีกดวย บุคคลอ่ืนที่จะมีสวนชวยในการตัดสินเกี่ยวกับ
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ความสามารถของตนเองนั้นจะชวยโดยการใชคําพูดชักจูงเพื่อใหเกิดการรับรูเพิ่มข้ึน การใชคําพูด
ชักจูงจะไดผลหรือไมข้ึนอยูกับองคประกอบตอไปนี้ 

1.4.3.1 ความนาเช่ือถือของผูชักจูง ถาผูชักจูงมีความนาเช่ือถือและ             
มีความสําคัญตอผูถูกชักจูงมาก ก็มีแนวโนมที่จะชวยเพิ่มการรับรูความสามารถของตนเองไดมากข้ึน 

1.4.3.2 การใหขอมูลปอนกลับ  จะสงผลที่สม่ํ า เสมอตอการรับรู
ความสามารถของตนเองโดยการใหขอมูลปอนกลับในทางการใหกําลังใจ การลบลางความเชื่อ
ที่วาตนเองไมมีความสามารถ จะชวยใหบุคคลมีความพยายามซึ่งจะสงผลใหประสบความสําเร็จ
ได และชวยเพิ่มการรับรูความสามารถของตนเองได 

1.4.3.3 การเพิ่มความพยายาม การพูดชักจูงจะชวยใหผูที่ถูกชักจูงเพิ่ม
ความพยายามในการทํางานไดมากข้ึน 

1.4.4 ขอมูลความสามารถทางรางกาย (Physiological Efficacy Information) 
จะตองพิจารณาจากปจจัยตอไปนี้ 

1.4.4.1 ประสบการณเดิม บุคคลที่มีประสบการณวาการตอบสนอง          
ตอส่ิงเราของรางกายตนเองชวยใหการกระทําพฤติกรรมนั้นประสบความสําเร็จ จะมีการรับรู
ความสามารถของตนเองสูงกวาบุคคลที่คิดวาการตอบสนองของรางกายทําใหกระทําพฤติกรรม
นั้นลมเหลว 

1.4.4.2 ระดับของการตอบสนองตอส่ิงเรา ในการตัดสินใจเกี่ยวกับ
ความสามารถของตนเองอยูที่ระดับการตอบสนองตอส่ิงเรา กลาวคือ ถารางกายตอบสนองตอส่ิง
เราในระดับปานกลางจะชวยใหการปฏิบัติงานนั้นมีผลดี ถามีมากหรือนอยเกินไปจะเปนอุปสรรค
ตอการทํางานได 

1.4.4.3 การอนุมานสาเหตุในการตอบสนองตอส่ิงเรา เปนการอางสาเหตุ
ของการตอบสนองวาส่ิงเรานั้นทําใหตนเองเกิดการตอบสนองเพราะอะไร  คนที่มีระดับ
ความสามารถสูงไมวารางกายจะมีการตอบสนองตอส่ิงเราในรูปแบบใดก็จะไมมีผลตอระดับ
ความสามารถของตนเอง แตถาคิดวาการตอบสนองนั้นเปนเพราะตนเองขาดความสามารถก็จะมี
แนวโนมที่จะมีการรับรูความสามารถของตนเองลดลง 

1.4.4.4 ลักษณะทางอารมณ บุคคลที่มีลักษณะทางอารมณตางกัน มีผล
ตอการรับรูความสามารถของตนเองตางกัน 

1.4.5 การรวบรวมขอมูลเกี่ยวกับความสามารถ (Integration of Self-Efficacy 
Information) ในการตัดสินเกี่ยวกับความสามารถของตนเอง นอกจากมีขอมูลหลายๆ รูปแบบแลว       



 16
 

ยังตองมีการใหน้ําหนักกับขอมูลเหลานี้ดวย วิธีการกําหนดน้ําหนักใหกับขอมูลจะแตกตางกันไปตาม
ลักษณะของงานที่ทําหรือปจจัยอ่ืนๆ บางคร้ังอาจใชกระบวนการตัดสินธรรมดาเขามาชวยซ่ึง              
จะกอใหเกิดการใหน้ําหนักที่ผิดพลาดหรือมองขามความสําคัญของขอมูลบางตัวไป 

สรุปไดวากระบวนการทางปญญาที่เกี่ยวกับขอมูลของการรับรูความสามารถของ
ตนเอง มีขอมูลที่สงผลตอการรับรูความสามารถของตนเอง ไดแก ขอมูลความสามารถที่ไดจากการ
กระทําขอมูลความสามารถที่ไดจากการเห็นตัวแบบที่ประสบความสําเร็จ  ขอมูลความสามารถ
จากการพูดชักจูง  ขอมูลความสามารถทางรางกาย และการรวบรวมขอมูลเกี่ยวกับความสามารถ 

 

1.5 แหลงของการรับรูความสามารถของตนเอง 
แบนดูรา (Bandura, 1986) กลาววา การรับรูความสามารถของตนเองพัฒนามาจาก

ปจจัยพื้นฐาน 4 ประการ คือ 
1.5.1 ความสําเร็จจากการกระทํา (Enactive Attainment) ถือวาเปนส่ิง                   

ที่มีอิทธิพลมากที่สุด ที่มีผลตอการรับรูความสามารถของตนเอง เนื่องจากเปนประสบการณที่
เกิดข้ึนโดยตรงกับตนเอง เมื่อประสบความสําเร็จหลายคร้ังจะทําใหมีการรับรูความสามารถของ
ตนเองเพิ่มมากข้ึนและจะย่ิงพัฒนาการรับรูใหเขมแข็งข้ึนอีกถามีประสบการณของความสําเร็จ
บอยคร้ังยิ่งข้ึน ดังนั้นเมื่อเกิดเหตุการณที่เปนปญหาหรืออาจจะลมเหลวบางในบางคร้ัง ก็จะมี
ผลกระทบตอการรับรูความสามารถของตนเองนอยมากหรืออาจจะไมมีเลย เพราะบุคคลเหลานี้จะ
มองวาความลมเหลวนั้นมาจากปจจัยอ่ืนๆ ตรงกันขามกับบุคคลที่ทํางานแลวประสบแตความ
ลมเหลวอยูเสมอๆ ซึ่งจะประเมินความสามารถของตนเองตํ่า และมีแนวโนมที่จะแผขยายไปยัง
สถานการณอ่ืนๆ ที่มีลักษณะคลายกัน 

1.5.2 การไดเห็นประสบการณของผูอ่ืน หรือการสังเกตตัวแบบ (Vicarious 
Experience) ซึ่งเปนประสบการณที่ผูอ่ืนประสบความสําเร็จ เมื่อบุคคลไดเห็นตัวอยางพฤติกรรม
ของผูอ่ืนที่มีลักษณะคลายกับตนเองกระทําพฤติกรรมแลวไดรับผลสําเร็จ จะทําใหมีการรับรู
ความสามารถของตนเองเพิ่มข้ึน ซึ่งจะมองวาผูอ่ืนที่ความสามารถเทากันหรือใกลเคียงกับตนเอง
ทําได บุคคลก็สามารถทําไดเชนกัน ในขณะเดียวกัน ถาไดเห็นผูอ่ืนที่มีลักษณะคลายกับตนเอง
ประสบความลมเหลว ก็อาจจะสงผลใหขาดความมั่นใจหรือประเมินความสามารถของตนเอง
ตํ่าลง การรับรูความสามารถของตนเองก็จะเปลี่ยนไป 

1.5.3 การพูดชักจูง (Verbal Persuasion) การพูดชักจูงเปนวิธีที่ใชกันอยาง
แพรหลายท่ีจะทําใหบุคคลเกิดความเชื่อวาเขามีความสามารถที่จะกระทําพฤติกรรมนั้นไดสําเร็จ 
วิธีนี้จะไดผลมากถาพูดในเร่ืองที่เปนไปได  แตถาการพูดชักจูงไมสอดคลองกับความจริงแลวอาจ
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ทํารายผูฟงใหรูสึกลมเหลว ขาดความไววางใจในตัวผูชักจูง  ดังนั้นคนที่จะพูดชักจูงควรเปนคนที่ผู
ถูกชักจูงใหความเชื่อถือไววางใจและมีความสําคัญหรือมีอิทธิพลตอตัวเขาพูดชักจูงไปพรอมๆ กับ
การสรางความสามารถใหกับบุคคลนั้นรวมกัน 

1.5.4 ภาวะทางกายภาพ และอารมณ (Physiological and Affective State) 
บุคคลมักใชขอมูลทางกายภาพในการประเมินความสามารถของตน โดยเฉพาะบุคคลที่ถูกกระตุน
อารมณทางลบ หรือบุคคลที่อยูในสภาพถูกขมขู เกิดความกลัวความวิตกกังวล หรือต่ืนเตน เชน 
การประเมินอาการต่ืนเตนเมื่อตองเผชิญความเครียด หรือสถานการณซับซอนวาเปนสัญญาณ
แสดงวาตนไมมีความสามารถเกิดการรับรูความสามารถตนเองตํ่าทําใหพฤติกรรมไดไมดี 
นอกจากนี้หากมีประสบการณความลมเหลวในอดีตก็จะกระตุนอารมณในทางลบและทําใหการ
รับรูความสามารถของตนเองตํ่าไปดวย  แตถาบุคคลสามารถควบคุมและระงับการถูกกระตุนทาง
อารมณได ทําใหการรับรูความสามารถของตนเองดีข้ึน และสงผลใหแสดงออกถึงความสามารถดี
ข้ึนดวย 

ทั้งนี้แบนดูรา (Bandura, 1986) ไดกลาวอีกวาการรับรูความสามารถของตนเอง
อาจเกิดจากแหลงใดแหลงหนึ่งหรือหลายแหลงรวมกันในน้ําหนักที่แตกตางกัน แหลงที่กอใหเกิด
การรับรูความสามารถของตนเองและผลที่เกิดกับบุคคลสามารถแสดงเปนแผนภาพท่ี 2.2  ดังนี้ 

 
 

 
 
 
 
 
 

 
 
แผนภาพที่ 2.2  แหลงที่มาของความตระหนักถึงความสามารถของตนเองที่มีตอพฤติกรรม 
ที่มา : Bandura, 1986 
 

นอกจากนี้แลวแบนดูรายังไดกลาวตอวาบุคคลที่รับรูความสามารถของตนเองสูง 
จะมีพฤติกรรมที่แสดงถึงการกระทําที่ประสบความสําเร็จ เชน มีการตื่นตัว มีความสามารถจัดการ

ความสําเร็จจากการกระทํา 

การไดเห็นประสบการณของผูอื่น 

การพูดชักจูงจากผูอื่น 

สภาวะทางกายภาพ และอารมณ 

แหลงที่มา 

ความตระหนักถึง
ความสามารถ 
ของตนเอง

พฤติกรรม 

การเลอืกพฤติกรรมหรือ
หลีกเลีย่งไมทําพฤติกรรม

ความพยายามและ
ความยนืหยดัในการทํางาน

แบบแผนความคดิและ
การตอบสนองทางอารมณ
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สถานการณตางๆได มีการกําหนดเปาหมายที่ชัดเจน มีการวางแผนและเตรียมการฝกฝนตนเอง 
สามารถแกปญหาเชิงสรางสรรคไดเรียนรูจากประสบการณลมเหลว เกิดความเครียดตํ่าและสังเกต
ความสําเร็จจากผูอ่ืน  สวนบุคคลที่มีการรับรูความสามารถของตนเองตํ่า จะมีพฤติกรรมที่แสดง
การกระทําที่ลมเหลว เชน เฉยชา หลีกเล่ียง งานยาก ขาดแรงจูงใจ คาดการณถึงความลมเหลว 
ขาดความพยายาม ขาดความกระตือรือรน วิตกกังวล เกิดความเครียด คิดแตคําแกตัว โทษความ
พายแพลมเหลว 

สรุปไดวาแหลงที่มาของการรับรูความสามารถของตนเองมีเหตุปจจัยมาจาก             
4 แหลง คือ ความสําเร็จจากการกระทํา การไดเห็นประสบการณของผูอ่ืน การพูดชักจูงผูอ่ืนและ
สภาวะทางกายและอารมณของตนเอง 

 

1.6 มิติของการรับรูความสามารถของตนเอง  
แบนดูรา (Bandura, 1977) กลาววา ลักษณะของการรับรูเกี่ยวกับความสามารถของแต

ละคนนั้นอาจแตกตางกัน ข้ึนอยูกับมิติ 3 มิติ ดังนี้ 
1.6.1 มิติเกี่ยวกับขนาด (Magnitude) หมายถึง ปริมาณความยากงายของงาน         

ที่บุคคลเช่ือวาตนสามารถปฏิบัติได ซึ่งจะแตกตางกันไปในแตละบุคคลในการกระทําพฤติกรรม
หนึ่งๆ หรือแตกตางกันในบุคคลเดียวกันเม่ือตองทําพฤติกรรมที่มีความยากงายแตกตางกัน 

1.6.2 มิติเกี่ยวกับการแผขยาย (Generality) หมายถึง ระดับความคาดหวัง
เกี่ยวกับความสามารถของตนเองในการนําไปปฏิบัติในสถานการณนั้น ซึ่งประสบการณ           
การปฏิบัติงานบางอยางกอใหเกิดความสามารถในการนําไปปฏิบัติในสถานการณอ่ืนที่คลายคลึง
กัน แตในปริมาณที่แตกตางกัน 

1.6.3. มิติเกี่ยวกับความเขม (Strength) หมายถึง ความมั่นใจที่บุคคลคิดวาตน
สามารถทํางานไดที่ระดับความยากตางๆ 

สรุปไดวามิติของการรับรูความสามารถของตนเองน้ันข้ึนอยูกับมิติ 3 มิติ คือ           
มิติเกี่ยวกับขนาด การแผขยายและความเขม 

 

1.7 การวัดการรับรูความสามารถของตนเอง  
ลีและบ็อบโก (Lee & Bobko, 1994) ไดรวบรวมงานวิจัยเกี่ยวกับการวัดการรับรู

ความสามารถของตนเองตามแนวทฤษฎีของแบนดูรา(Bandura, 1977) ที่วาการรับรูความสามารถ
ของตนเองเก่ียวของกับสถานการณเฉพาะ และประกอบดวย 3 มิติ คือ มิติเกี่ยวกับขนาดความ
ยากของงาน มิติเกี่ยวกับการแผขยาย และมิติเกี่ยวกับความเขม ในการวัดการรับรูความสามารถ
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ของตนเองที่จะนําเสนอตอไปนี้ไมวาจะใชวิธีใดก็ตาม คะแนนที่ไดจะมีความสัมพันธกับพฤติกรรม
หรือการปฏิบัติงานของบุคคล ซึ่งบุคคลจะถูกประเมินเกี่ยวกับการปฏิบัติงานตางๆ โดยมีวิธีการวัด
การรับรูความสามารถของตนเองดังนี้ 
  1.7.1 การวัดความเขม (Self – Efficacy Strength) เปนวิธีที่นํามาใชวัดการรับรู
ความสามารถของตนเองมากที่สุด วิธีการวัดทําไดโดยการถามผูตอบถึงความมั่นใจวาเขาสามารถ
ปฏิบัติงานท่ีมีความยากของงานเพ่ิมข้ึนไดเพียงใด ขอคําถามมักมีลักษณะใหประเมินความมั่นใจ
จากไมมีความม่ันใจ (0) จนถึงมีความมั่นใจเต็มที่ (10) หรืออาจทําโดยใชมาตราสวนแบบอื่นๆ           
ก็ได เชน จาก 0% ถึง 100% 

1.7.2. การวัดขนาด (Self – Efficacy Magnitude) เปนวิธีที่นิยมนํามาใชวัดการ
รับรูความสามารถของตนเองรองลงมาจากการวัดความเขม วิธีการวัดจะทําโดยการถามผูตอบวา
เขาสามารถปฏิบัติงานที่กําหนดใหที่มีความยากข้ึนไดหรือไม ซึ่งคําถามมักจะมีลักษณะเปนมา
ตราสวนชนิด ใช/ไมใช (yes/no scale) คําตอบ “ใช” จะมีคะแนน 1 คะแนน คําตอบ “ไมใช”              
จะมีคะแนน 0 คะแนน ดังนั้นหากไดคะแนนสูงแสดงวามีการรับรูความสามารถของตนเองสูง 

1.7.3 การวัดแบบผสม คือ การวัดที่ใชวัดทั้งความเขมและขนาดของความยาก 
โดยใชขอคําถามเดียวแตมีคําตอบแยกกันเปน 2 ชอง ชองหนึ่งเปนแบบ ใช/ไมใช สวนอีกชองหนึ่ง
จะเปนมาตราสวนประเมินคาหรือใชประเมินเปนรอยละ การรวมคะแนนทําโดยการรวมคะแนน
ของความเขมเฉพาะขอที่ผูตอบตอบวา “ใช” 

1.7.4 เปนวิธีวัดความเขมและขนาดของความยากเหมือนกับวิธีที่ 3 แตมีขอ
แตกตางกัน คือ แปลงคะแนนดิบ (Raw Score) ใหเปนคะแนนฐาน (Z Score) 

1.7.5 การวัดความเขมโดยใชขอคําถามเพียงขอเดียวเกี่ยวกับงานที่กําหนดแลว
ใหผูตอบประเมินคาระดับความมั่นใจของตนเองตอการทํางานที่กําหนดนั้น 

เทเลอรและคณะ ไดกลาววาในการวัดการรับรูความสามารถของตนเอง บุคคลจะ
ถูกขอใหประเมินเกี่ยวกับการปฏิบัติงานดานตางๆ แตปญหาที่เกิดข้ึนคือ พบวาความสัมพันธ
ระหวางการรับรูความสามารถของตนเองกับผลการปฏิบัติงานมีคาความสัมพันธกันนอย                    
ซึ่งอาจจะมีสาเหตุ ดังนี้ 

1. การปฏิบัติงานเฉพาะอยางมีความเกี่ยวของกับการรับรูความสามารถ
ของตนเองนอย เชน งานที่เกี่ยวกับการเส่ียงโชคตางๆ 
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2. มิติของงานทําใหการวัดการรับรูความสามารถของตนเองของบคุคลได
ไม ดี  เชน  ระดับความยากของงานมีความแตกตางกันนอยเกินไปทําใหการวัดการรับรู
ความสามารถของตนเองไมแตกตางกัน 

 3. สถานการณบางอยางทําใหความแมนยําในการประเมินการรับรู
ความสามารถของตนเองลดลง เชน งานนั้นยังใหมสําหรับบุคคลนั้น 

โดยสรุปแลวการวัดความการรับรูความสามารถของตนเองสามารถวัดได
โดยวัดความเขม วัดขนาด วัดแบบผสม วัดโดยแปลงคะแนนดิบเปนคามาตรฐาน และวัดแบบเขม
โดยใชขอคําถามเพียงขอเดียว 

 

1.8 คุณลักษณะของบุคคลที่มีการรับรูความสามารถของตนเอง 
โยเดอรและพรอกเตอร (Yoder and Proctor, 1988); กรรณิการ จิตตบรรเทา (2539); 

อัจฉรา เนตรลอมวงศ (2531) กลาววา บุคคลที่มีการรับรูความสามารถของตนเองจะมีคุณลักษณะ
และแนวคิดดังนี้ 

1.8.1 ปฏิบัติหนาที่ในความรับผิดชอบไดครบถวนการกลารับผิดชอบเม่ือกระทําผิด 
1.8.2 แสดงพฤติกรรมดวยการกระทํา และคําพูดที่เหมาะสมในสถานการณตางๆ 

ทั้งในและนอกหองเรียน ในลักษณะตางๆ 
1.8.3 มีความเชื่อมั่นในการกระทําของตนเอง และม่ันใจวาจะประสบความสําเร็จ

ในส่ิงที่ไดกระทํา 
1.8.4 ยึดถือความเช่ือของตนเองอยางมั่นคง มีเหตุผล ไมคลอยตามผูอ่ืนโดย

ปราศจากการไตรตรอง 
1.8.5 มีความคลองตัวสูง มีความกระตือรือรนอยูเสมอ 
1.8.6 ทํางานรวมกับผูอ่ืนไดดี มีความสามารถในการปรับตัวเขากับส่ิงแวดลอม 
1.8.7 รับบทบาทผูนําโดยปราศจากการลังเล คาดหวังวาจะไดเปนผูนําในบาง

โอกาส 
1.8.8 ไมหลีกเล่ียงปญหา และมีความสามารถในการแกปญหาเฉพาะหนาไดดี 
1.8.9 กลาแสดงความสามารถและความคิดเห็นของตนเอง หรือกลาซักถามขอ

สงสัยตางๆ 
1.8.10 การพึ่งตนเองในการแกปญหาดวยความสามารถของตนเอง 
1.8.11 มีความคิดริเร่ิมสรางสรรค และเปนมิตรกับผูอ่ืนไดงาย 
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แบนดูรา (Bandura, 1997) กลาววา ผูเรียนที่มีระดับการรับรูความสามารถของ
ตนเองจะมีคุณลักษณะเฉพาะไดแก การมีสวนรวมในการเรียนอยางเต็มใจ ทํางานอยางเต็ม
ความสามารถมีความเพียรที่ตอเนื่อง มีการตอบสนองทางอารมณทางลบในระดับนอยเมื่อประสบ
กับเหตุการณที่ยากกวาความสามารถที่มีอยู 
  โดยสรุปแลวคุณลักษณะของบุคคลที่มีการรับรูความสามารถของตนเองมักจะ         
มีลักษณะ มีความรับผิดชอบ มีความเชื่อมั่นในตนเอง มีความกระตือรือรน ทํางานรวมกับผูอ่ืนไดดี 
กลาแสดงออก สามารถพึ่งพาตนเองได 

 

1.9 การรับรูความสามารถดานคอมพิวเตอรของตนเอง  
เบคเกอรและชมิทซ (Beckers and Schmidt , 2001) เสนอปจจัย 6 ขอที่สงผลตอการรับรู

ความสามารถของตนเองเก่ียวกับคอมพิวเตอร คือ ความรูเกี่ยวกับคอมพิวเตอร (Computer 
literacy), สภาวะรางกายที่สนองตอคอมพิวเตอร (physical arousal in response to 
computers), อารมณที่มีตอคอมพิวเตอร (affective feeling about them), ความเชื่อในประโยชน
ของคอมพิวเตอร (beliefs about beneficial effects of computers), และผลตอคุณคาความเปน
มนุษย (beliefs about their purported dehumanizing effects) 

คอมโปและฮิกกิ้นส (Compeau & Higgins,1995) พบวาการรับรูความสามารถตนเองใน
การใชคอมพิวเตอรมีผลตอความคาดหวังเกี่ยวกับผลสําเร็จในอนาคตจากการใชคอมพิวเตอร เชน
ในอาชีพการงานและการประสบผลสําเร็จของบุคคล 

นอกจากนี้ ฮิล,สมิทซและมานน (Hill, Smith and Mann, 1987) พบวาประสบการณและ
รูปแบบของประสบการณเปนปจจัยสําคัญที่มีผลตอการรับรูความสามารถตนเองในการใช
คอมพิวเตอรมากกวาระยะเวลาที่ใช 

รอส, โฮกาโบม เกรยและฮันเนย (Ross, Hogaboam-Gray and Hannay 2001) ทําการ
ทดสอบโดยใหนักเรียนยายหองเรียนโดยเปล่ียนครูผูสอนคอมพิวเตอรที่มีการรับรูความสามารถ
ตนเองตางกัน ปรากฎวานักเรียนเรียนดีข้ึนและมีการรับรูความสามารถตนเองสูงข้ึนเมื่อไดเรียนกับ
ครูที่มีความมั่นใจในทักษะการใชคอมพิวเตอรของตัวเอง 

โดยสรุปแลวการรับรูความสามารถของตนเองดานคอมพิวเตอร เกิดจากความรูที่ตนเองมี
เกี่ยวกับคอมพิวเตอรซึ่งอาจจะมาจากประสบการณเดิมหรือไดเห็นจากผูอื่น  สภาวะอารมณใน
ขณะนั้น  ความเชื่อในประโยชนของคอมพิวเตอรและที่มีตอมนุษย 
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ตอนท่ี 2 แนวคิด ทฤษฎีที่เกี่ยวกับการต้ังเปาหมาย 
ในตอนสองเปนแนวคิดทฤษฎีที่เกี่ยวของกับการต้ังเปาหมายประกอบดวยสาระสําคัญ 

ไดแก ทฤษฎีการต้ังเปาหมาย ความหมายของการต้ังเปาหมาย คุณสมบัติของเปาหมาย ผลของ
การกลไกการต้ังเปาหมาย อิทธิพลของการต้ังเปาหมาย  ประเภทของเปาหมาย ซึ่งไดแก เจตคติใน
การทํางาน ความมุงม่ันในการทํางาน เปาหมายเพื่อผลประโยชนในอนาคต เปาหมายเพื่อตองการ
รางวัลจากภายนอกเหนือไดรับการยกยองและเปาหมายเพื่อการไดยอมรับทางสังคม ความผูกพัน
ตอเปาหมาย ซึ่งประกอบไปดวย ความหมายของความผูกพันตอเปาหมาย การวัดความผูกพันตอ
เปาหมายและบริบทของความผูกพันตอเปาหมาย 
  

2.1 ทฤษฎีการต้ังเปาหมาย 
กระบวนการตั้งเปาหมายมีพื้นฐานมาจากทฤษฎีการเรียนรูทางปญญาสังคม (Social 

Cognitive Theory) ของแบนดูราที่เช่ือวาพฤติกรรมของบุคคลเกิดข้ึนและเปล่ียนแปลงเนื่องจาก
กําหนดซึ่งกันและกัน ขององคประกอบ 3 อยาง คือ องคประกอบทางปญญา และสวนบุคคล (P) 
องคประกอบทางพฤติกรรม (B) และองคประกอบทางสภาพแวดลอม (E)  นั้นคือ พฤติกรรมของ
บุคคลเกิดข้ึนและมีการเปลี่ยนแปลงเนื่องจากปจจัยทางสภาพแวดลอมและปจจัยสวนบุคคล              
ที่กําหนดซึ่งกันและกันกับปจจัยทางดานพฤติกรรมและสภาพแวดลอม (Bandura, 1986) อางถึง
ใน สมโภชน เอ่ียมสุภาษิต, 2536)  ซึ่งเมื่อพิจารณาแลวปจจัยจากสวนบุคคลจะมีเปาหมายเปน
ตัวกําหนดทิศทางของพฤติกรรม ถาบุคคลใดมีเปาหมายบุคคลนั้นก็จะเกิดแรงจูงใจที่จะทํา
พฤติกรรมนั้นมาก ข้ึนไปดวย  ซึ่ งทฤษฎีการเ รียน รูปญญาทางสังคมตามแนวคิดของ 
Bandura(1977) เชื่อวา แรงจูงใจมีรากฐานมาจากปจจัยสวนบุคคล 2 สวนไดแก  
  2.1.1 ความสามารถในการคาดหวังผลการกระทําในอนาคต ซึ่งจะเปนแรงจูงใจ
ในการกระทําพฤติกรรมตางๆ 
  2.1.2 กระบวนการตั้งเปาหมายและการประเมินตนเอง แรงจูงใจนี้เร่ิมเกิดจาก
การเปรียบเทียบระหวางผลงานที่บุคคลนั้นทําไดกับเปาหมายที่ ต้ังข้ึนมา ถาผลงานที่ทําไม
สอดคลองกับเปาหมายที่ต้ังข้ึน จะทําใหเกิดความรูสึกไมพอใจในตนเอง ซึ่งมีผลในการผลักดันให
บุคคลนั้นใชความพยายามมากข้ึน  แตถาบุคคลนั้นประสบความสําเร็จตามเปาหมายที่ตนต้ังไว 
จะเกิดความพึงพอใจในตนเองและทําใหบุคคลนั้นมีแนวโนมที่จะใชความพยายามตอไป 

เอดวิน เอ ล็อค และแกรี พีลาแธม ไดสรางทฤษฎีการต้ังเปาหมายเมื่อป 1990 ไว
วา มีความเหนือกวาทฤษฎีความคาดหวังในดานที่เนนเปาหมายของความคิดแตละคนเพื่อนําไปสู
การสรางพฤติกรรม โดยมีความเชื่อวาแตละคนจะมีแรงจูงใจที่มีความมุงมั่นและเฉพาะเจาะจงใน
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การไปสูเปาหมายตามที่ไดต้ังเอาไว  (Kanfer,1994, cited in Haslam, 2001) การนําเปาหมายมา
ใชในการจูงใจเปนแนวทางท่ีไดรับความนิยมมากที่สุด เพราะมีความสัมพันธกับความปรารถนา  
หรือความตองการของแตละบุคคล ไปสูความต้ังใจและกอใหเกิดพฤติกรรมที่ตอบสนองความ
ตองการ ดวยวิธีการที่ใหบุคคลเขามามีสวนรวมในการต้ังเปาหมาย ในขณะท่ีบางคนกลาวไววา
วิธีการนี้เปนวิธีการที่ผิวเผินเกินไปและคงอยูไดไมนาน (Kelly,1991, cited in Haslam, 2001) 
เปาหมายที่มีความแตกตาง บวกกับแรงจูงใจที่แตกตาง และความรูความสามารถที่ตนมี จะได
ผลลัพธเปนส่ิงที่สามารถชวยใหคนสรางงานที่เกิดจากความคิดของตนเอง (Task self Inventory) 

ทฤษฎีการตั้งเปาหมายของล็อค (Locke’s Goal Setting Theory) เปนทฤษฎี          
ที่มีการนํามาใชโดยมีงานวิจัยและทําการวิเคราะหเมตา จํานวนมากที่สรุปถึงผลลัพธเชิงบวกของ
การนําทฤษฎีการตั้งเปาหมายไปใชใหเกิดผลการปฏิบัติงานที่ดีข้ึน(ล็อคและลาแธม, 1990)                  
เปนเทคนิคการจูงใจแบบหนึ่งโดยมีเปาหมายของบุคคลเปนจุดเ ร่ิมตนรวมกับการรับรู
ความสามารถของตนเอง ทําใหเกิดพฤติกรรมที่สงผลตอการทํางาน โดยมีตัวแปรกํากับ คือ ความ
ผูกพันตอเปาหมาย การไดรับการตอบกลับ ความสามารถ ความยุงยากในงาน และสถานการณ
ตางๆที่เกี่ยวของ ดังแผนภาพที่ 2.3 

 
 

 
 
 
 

 
 
 
 
แผนภาพที่ 2.3 ความสัมพันธระหวางเปาหมาย การรับรูความสามารถในตนเองตัวแปรกํากับ 

และผลการปฏิบัติงาน   
ที่มา : Schermerthorn, Hunt & Osborn, 2006 
 

 สรุปไดวาการต้ังเปาหมาย การรับรูความสามารถ สามารถสงผลตอความพยายาม             
ความอดทน ทิศทาง กลยุทธงานหรือแผนการ ที่มีผลตอผลการปฏิบัติงานโดยมีตัวแปรกํากับ คือ 

เปาหมายท่ีมีความยาก 
เปาหมายท่ีมีความเฉพาะเจาะจง 

การรับรูความสามารถของตนเอง 
ในระดับสูง  ความคาดหวังสูง 

มีความเก่ียวของกับกลไกตางๆ 
- ความพยายาม 
- ความอดทน 
- ทิศทาง 
- กลยุทธในงานหรือแผนการ 

ตัวแปรกํากับ(Moderator) 
- ความผูกพันตอเปาหมาย 
- การตอบรับ 
- ความสามารถ 
- ความยุงยากของงาน 
- สถานการณท่ีเก่ียวของ 

ผลการปฏิบัติงาน
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ความผูกพันตอเปาหมาย การตอบรับ ความสามารถ ความยุงยากของงานและสถานการณที่
เกี่ยวของ 

 

2.2 ความหมายของการต้ังเปาหมาย 
แบนดูรา (Bandura, 1986) ไดกลาววา การตั้งเปาหมาย หมายถึง การกําหนดเปาหมาย 

หรือการกําหนดเกณฑในการแสดงพฤติกรรมใดพฤติกรรมหนึ่งที่ตองการเปล่ียนแปลงซ่ึงทําให
บุคคลทราบพฤติกรรมที่จะตองกระทําอยางชัดเจน และใชเปนเกณฑในการประเมินเปรียบเทียบ
พฤติกรรมที่กระทําจริงกับพฤติกรรมที่กําหนดไววา พฤติกรรมนั้นมีการเปลี่ยนแปลงในลักษณะ
เชนใด เพื่อใชเปนขอมูลปอนกลับในการแสดงปฏิกิริยาตอตนเองทั้งทางบวกและทางลบตอไป 
 คอกซ (ธนากร ศรีชาพันธ, 2539; อางอิงจาก Cox, 1994) กลาววา ผูไดรับการฝกเกี่ยวกับ
การต้ังเปาหมายในการแสดงทักษะ จะมีโอกาสประสบความสําเร็จมากกวาผูที่ไมไดรับการฝกการ
ต้ังเปาหมาย 

รูอิลารด (Rouillard, 1995) ใหความหมายของเปาหมายวาเปนผลสรุปที่เกิดจากความ
พยายามที่ชัดเจนของคุณ 
 ราชบัณฑิตยสถาน (2542) ใหความหมายของเปาหมายวา หมายถึง บุคคลหรือส่ิงที่ใช
เปนเปาแหงการโจมตี หรือเปนศูนยกลางแหงความใสใจหรือสังเกต หรือเปนความมุงหมายเจาะจง
ใหไดตามเจตนา 
 สรุปไดวาการต้ังเปาหมาย หมายถึง การกําหนดเปาหมายที่จะนําไปสูการแสดงพฤติกรรม
อยางใดอยางหนึ่ง ซึ่งจะทําใหบุคคลนั้นไดเปล่ียนแปลงพฤติกรรมที่ตองกระทําอยางชัดเจน ซึ่งผูที่
มีการตั้งเปาหมายจะมีโอกาสประสบความสําเร็จในเปาหมายนั้นมากกวาผูที่ไมไดมีการ
ต้ังเปาหมาย 

 

2.3 คุณสมบัติของเปาหมาย  
เปาหมาย (Goal) คือส่ิงที่คนพยายามที่จะบรรลุโดยผานพฤติกรรมและการกระทํา Goal 

Setting Theory) เนนไปที่การจูงใจบุคคลเพื่อใชในการปฏิบัติงาน และยังเนนอีกวา การปฏิบัติงาน
ที่ทําไปนั้นจะตองไดมาซึ่ง การบรรลุผลสําเร็จ ของงานอันเปนที่ยอมรับในระดับหนึ่ง 

คุณสมบัติของเปาหมายนั้น แบนดูรา (Bandura, 1986) กลาววา คุณสมบัติของเปาหมาย
เปนตัวกําหนดเงื่อนไขการกระทําพฤติกรรมที่เกี่ยวกับการใชความพยายาม และการจูงใจในการ
ทํางาน ซึ่งมีคุณสมบัติ ดังนี้ 
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2.3.1 เปาหมายที่มีลักษณะเฉพาะเจาะจง เปนเปาหมายที่กําหนดข้ึนอยาง
ชัดเจนวาพฤติกรรมใดที่บุคคลตองทํา และควรปฏิบัติอยางไร เปาหมายนี้จะทําใหเกิดแรงกระตุน
และชี้แนะในการทําพฤติกรรม ซึ่งสงผลตอความพอใจในตนเอง และการรับรูความสามารถของ
ตนเอง 
  2.3.2 เปาหมายที่มีลักษณะทาทาย ระดับของเปาหมายมีผลตอปฏิกิริยาของ          
ผูปฏิบัติเองและความพยายามที่ใช หากบุคคลทํางานที่ทาทายสําเร็จตามเปาหมายบุคคลนั้นก็          
จะเกิดความพอใจและความพยายามมากข้ึน ในการตั้งเปาหมายที่ทาทายนี้ควรเปนเปาหมายท่ี
ใกลเคียงกับความเปนจริงไมงายหรือยากจนเกินไป 
  2.3.3 เปาหมายระยะส้ัน  มีผลตอแรงจูงใจของบุคคลและความคาดหวังใน
ความสามารถของตนเอง เพราะเปาหมายนี้ควบคุมการกระทําพฤติกรรมไดใกลชิดกวา ทําให
บุคคลไดพบกับความสําเร็จรวดเร็วข้ึน และไดขอมูลจากการปฏิบัติชัดเจนกวาดวย 
  2.3.4 เปาหมายที่สอดคลองกับความเปนจริง ชี้ใหเห็นถึงความกาวหนาและ
ตัดสินประสิทธิภาพของงานท่ีบุคคลปฏิบัติ การตั้งเปาหมายที่สูงเกินไปหรือตํ่าเกินไป ไมกอใหเกิด
ประโยชนตอแรงจูงใจ 

คุณสมบัติของการต้ังเปาหมายนี้ แรนด (Rand, 1967) อางถึงใน สุธีรา นิมิตรนิวัฒน 
2537) ไดกลาวสนับสนุนวา กระบวนการต้ังเปาหมายที่ดีตองคํานึงถึงความเฉพาะเจาะจง ความ
ยากของงานและเปาหมาย  การต้ังเปาหมายที่ชัดเจนและทาทายจะชวยสงเสริมใหผูเรียนมี
ความสามารถทางการเรียนสูงข้ึน 

สรุปไดวาคุณสมบัติของเปาหมาย คือตัวกําหนดเงื่อนไขในการกระทําพฤติกรรม ซึ่งมี
คุณสมบัติไดแก เปาหมายที่มีลักษณะเฉพาะเจาะจง มีลักษณะทาทาย มีระยะส้ันและสอดคลอง
กับความเปนจริง 

 

2.4 ผลของกลไกการต้ังเปาหมาย  
การต้ังเปาหมายในการกระทําพฤติกรรมมีผลตอแรงจูงใจ การรับรูความสามารถของ

ตนเอง และมีผลตอความสนใจเพิ่มข้ึน (Bandura, 1986) ดังนี้ 
  2.4.1 ผลตอแรงจูงใจ การต้ังเปาหมายในการกระทําพฤติกรรม มักทําใหบุคคลมี
แรงจูงใจทจะกระทําพฤติกรรมเพิ่มข้ึน โดยมีแนวโนมที่จะใชความพยายามในการกระทําเพื่อให
บรรลุตามเปาหมายที่ต้ังไวมากข้ึน ตามกระบวนการของการต้ังเปาหมายที่มีการกําหนดเปาหมาย
ดวยตนเอง  การไดรับขอมูลปอนกลับ และการประเมินตนเอง ซึ่งการต้ังเปาหมายดวยตนเอง 
(self-set goal) เปนกระบวนการที่บุคคลสรางเกณฑข้ึนมา เพื่อประเมินการกระทําดวยตนเอง ทํา
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ใหไดเปาหมายที่มีความเหมาะสมกับระดับความสามารถ รวมทั้งบุคคลรูสึกวาเปนผูกําหนดและ
ตัดสินใจดวยตนเอง จึงสงผลตอการยอมรับเปาหมายและการใชความพยายามที่จะบรรลุ
เปาหมายที่ต้ังข้ึน ซึ่งจะยังทําใหเขาตองรับผิดชอบและปรับปรุงผลการทํางานของตนเองใหมี
ความกาวหนา ในทางตรงกันขาม เปาหมายที่บุคคลอ่ืนกําหนดให เปนการแทรกลักษณะของการ
ควบคุม หรือกําหนดใหบุคคลตองทําบางส่ิงบางอยาง   
  2.4.2 ผลตอการรับรูความสามารถของตนเอง การบรรลุเปาหมายทําใหบุคคล
รับรูวาตนนั้นมีความสามารถสูงข้ึนเพียงใด อันสงผลตอการใชความพยายามในการปฏิบัติงานนั้น 
  2.4.3 ผลตอความสนใจเพิ่มข้ึน ซึ่งสืบเนื่องมาจากบุคคลนั้นมีประสบการณที่
พอใจในการบรรลุตามเปาหมายที่ตนต้ังเอาไว การต้ังเปาหมายที่เปดโอกาสใหบุคคลไดแสดง
ความสามารถและความพยายามในการลดความไมสอดคลองระหวางการกระทํากับเปาหมาย             
จะมีผลตอความสนใจเพิ่มข้ึน 
 การตั้งเปาหมาย ไดถูกนํามาใชในองคการไมเพียงแตเพื่อผลักดันระดับของผลการ
ปฏิบัติงานที่พนักงานไดรับการจูงใจใหมอบใหกับงานและองคกร แตยังชวยทําใหแนใจวา ผลการ
ปฏิบัติงานสามารถนําไปสูเปาหมายในอนาคตขางหนา  ทฤษฎีการต้ังเปาหมายไดอธิบายถึงชนิด
ของเปาหมายที่มีประสิทธิผลที่สุดในการสรางแรงจูงใจและผลการปฏิบัติงาน เปาหมายชนิดไหน
นําไปสูแรงจูงใจและผลการปฏิบัติงานที่ดี ตามทฤษฎี มีปจจัยที่สําคัญ 2 อยาง คือ ความ
เฉพาะเจาะจง (specificity) และความยาก (difficulty) ซึ่งเมื่อใชรวมกันแลว จะนําไปสูระดับของ
แรงจูงใจและผลสําเร็จของงานท่ีสูงข้ึนความเฉพาะเจาะจงของเปาหมาย (Specific goal) จะไป
นําไปสูผลการปฏิบัติงานไดดีกวาเปาหมายที่คลุมเครือ  
 ความยากในการบรรลุเปาหมาย (Difficulty Goal) จะนําไปสูแรงจูงใจและผลการ
ปฏิบัติงานที่สูงกวาเปาหมายกลางๆ  คือเปาหมายที่ยากแตไมใชวาเปนไปไมไดสําหรับบุคคล
สวนมากที่จะทําได ในทางปฏิบัติบุคคลก็สามารถบรรลุเปาหมายงายๆไดอยูแลว ขอเสนอของ 
Goal-setting theory ก็คือ เปาหมายที่ระบุชัดเจนและยากจะนําไปสูแรงจูงใจและผลการ
ปฏิบัติงานที่สูงกวาเปาหมายที่งาย กลางๆ ไมชัดเจน หรือไมมีขอบเขตของเปาหมายเลย  และยังมี
งานวิจัยอีกมากมายที่สนับสนุนขอเสนอของทฤษฎีนี้ และยังพบดวยวาแรงจูงใจและผลการ
ปฏิบัติงานที่มาจากการตั้งเปาหมายนั้นแตกตางกันในแตละวัฒนธรรมดวย 
 ส่ิงสําคัญก็คือเมื่อผูบริหารหรือผูนําไดต้ังเปาหมายเอาไวแลว ผูที่อยูใตบังคับบัญชา
จะตองยอมรับในเปานั้นดวย และยังตองมีขอผูกมัดทางใจที่จะตองไปใหถึงเปาหมายนั้นใหได  ซึ่ง
บางคร้ังผูบริหารและบุคคลอาจะตองมีการตั้งเปาหมายรวมกัน (participate in goal setting) เพื่อ
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เพิ่มการยอมรับและความผูกพัน (Commitment) ในเปาหมายนั้นดวย  การมีความเชื่อในตัวบุคคล
วาเขาสามารถทําพฤติกรรมบางอยางใหเปนผลสําเร็จสูง (self-efficacy) ยังเปนส่ิงยืนยันไดวา
บุคคลนั้นจะมีแรงจูงใจที่จะทําเปาหมายที่ยาก ความเช่ือนี้นําไปสูการยอมรับ ความผูกพันตอ
เปาหมาย และแรงจูงใจที่จะบรรลุเปาหมาย และ goal setting จะไดผลที่สุดเมื่อบุคคลนั้นได
รับทราบผลสะทอนจากการทํางานของตนวาเขาทํางานเปนอยางไร ดังแผนภาพที่ 2.4 ไดแสดง
ความคาดหวัง  การต้ังเปาหมาย และผลการปฏิบัติงานวามีความสัมพันธกันทั้งสามปจจัย 

 
 
 
 
 
 
 

 
 
แผนภาพท่ี 2.4 ความสัมพันธระหวางการรับรูความสามารถตนเอง (Self-efficacy) การ

ต้ังเปาหมายดวยตนเอง (Self-set Goal) และผลการปฏิบัติงาน 
(Performance) 

ที่มา : Locke and Latham, 1990 
 

จากภาพสรุปไดวา ความคาดหวังและการรับรูความสามารถตนเองสงผลใหเกิดการ
ต้ังเปาหมายในบุคคลและผลการปฏิบัติ  การต้ังเปาหมายสวนบุคคลก็สงผลตอผลการปฏิบัติงาน
ดวยเชนกัน 

ซึ่งผลที่เกิดจากกลไกการต้ังเปาหมาย ไดแก ผลตอแรงจูงใจ ผลตอการรับรูความสามารถ
ของตนเองและผลตอความสนใจของตนเองที่เพิ่มข้ึน ซึ่งการต้ังเปาหมายไดถูกนํามาใชในทุก
องคการเพื่อเปนแรงผลักดันและแรงจูงใจใหกับคนในหนวยงานนั้นๆ 

 

2.5 อิทธิพลของการต้ังเปาหมาย   
การต้ังเปาหมายมีอิทธิพลตอพฤติกรรม และสงผลตอการทํางานของบุคคล ดังนี ้
 

0.39
ความคาดหวัง ((Expectancy) 

การรับรูความสามารถตนเอง (Self-efficacy)

การต้ังเปาหมายสวนบุคคล 
(Personal Goal, self – set)

0.39 
0.42

ผลการปฏิบัติงาน 
(Performance) 
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  2.5.1 อิทธิพลของการต้ังเปาหมายที่มีตอพฤติกรรม 
อิทธิผลของการต้ังเปาหมายที่มีผลตอพฤติกรรมนี้ล็อค (Lock, 1981) ไดอธิบาย

ใน 4 ลักษณะ คือ 
   2.5.1.1 การกําหนดทิศทาง การต้ังเปาหมายทําใหบุคคลสามารถกาํหนด
ทิศทางการกระทําไดสอดคลองกับเปาหมาย 
   2.5.1.2 ความพยายาม เปนส่ิงที่เกิดข้ึนไดพรอมๆกับการกําหนดทิศทาง
ตามสัดสวนที่บุคคลรับรูวาตนมีความตองการในเปาหมายเพียงใด นั้นคือ หากนักเรียนมีความ
ตองการบรรลุเปาหมายที่ทาทาย  เขาตองเพิ่มความพยายามและความต้ังใจมากกวา                      
การต้ังเปาหมายที่งายหรือไมมีเปาหมาย 
   2.5.1.3 ความคงทน เปนระดับของความเพียรพยายามท่ีเพิ่มมากข้ึน  
เมื่อเวลาผานไป ดังนั้น ความคงทน จึงเปนการนําเอากลไกทั้งสองดังที่กลาวแลวมารวมกัน 
   2.5.1.4 การพัฒนากลยุทธ กลไกทั้งสามอยาง อันไดแก ทิศทาง การใช
ความพยายาม และความคงทนเปนผลโดยตรงจากการต้ังเปาหมาย ในขณะที่การพัฒนากลยุทธ 
ห รือวางแผนเพื่ อ ให เป าหมายบรร ลุผล  เปนผลโดยทางอ อมจากการ ต้ั ง เป าหมาย  
กระบวนการพัฒนากลยุทธเปนสวนประกอบสําคัญในปญญาทําใหเกิดการพัฒนาทักษะ หรือการ
แกปญหาเชิงสรางสรรค เมื่อบุคคลไดต้ังเปาหมายแลว เขาก็จําเปนตองวางแผนและจัดระบบการ
ทํางาน 

2.5.2 อิทธิพลของเปาหมายที่มีผลตอการทํางานของบุคคล 
อิทธิพลของเปาหมายที่มีผลตอการทํางานของบุคคลนี้ล็อคและลาแธม(Lock  

and Latham, 1990) ไดกลาวถึง ดังนี้ 
   2.5.2.1 เปาหมายทําใหบุคคลตองใชความพยายามและเพิ่มความ
พยายามมากข้ึน 
   2.5.2.2 เปาหมายกระตุนใหบุคคลมีความคงทนในการทํางาน 
   2.5.2.3 เปาหมายทําใหบุคคลมุงความสนใจไปที่กิจกรรมที่เกี่ยวกับ
เปาหมาย 
   2.5.2.4 เปาหมายทําใหบุคคลนําความรูหรือทักษะที่มีอยูแลวมาใชเพื่อ
ความสําเร็จ 
   2.5.2.5 เปาหมายจูงใจใหบุคคลคนหายุทธวิธีในการทํางานที่เหมาะสม 
วางแผนและใชยุทธวิธีนั้น 
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   2.5.2.6 เปาหมายทําใหผลการทํางานมีคุณคายิ่งข้ึน 
   2.5.2.7 เปาหมายทําใหบุคคลทราบคุณภาพในการทํางาน 
   2.5.2.8 เปาหมายระดับสูงทําใหบุคคลรูสึกพึงพอใจในตนเอง 

สรุปไดวาอิทธิพลของการต้ังเปาหมายสามารถสงผลตอ พฤติกรรม ซึ่งไดแก การกําหนด
ทิศทาง ความพยายาม ความคงทนและการพัฒนากลยุทธจากกลไกทั้งสามอยาง และสงผลตอ
การทํางานของบุคคล 

 

2.6 ประเภทของเปาหมาย   
ประเภทของเปาหมาย เราสามารถแบงไดเปน เจตคติในการทํางาน ความมุงมั่นในการ

ทํางาน เปาหมายเพื่อผลประโยชนในอนาคต เปาหมายเพื่อตองการรางวัลจากภายนอกเหนอืไดรับ
การยกยองและเปาหมายเพื่อการไดยอมรับทางสังคม  

2.6.1. เจตคติในการทํางาน 
ในโรงเรียนทั่วไปเมื่อนักเรียนทํางานสงครู นักเรียนมักไดรับทราบผลการเรียนรู 

(feedback) จากครูเกี่ยวกับงานที่ทําตอหนาบุคคลอื่นเสมอ เชน ครูติดผลงานของนักเรียนบน
บอรด ครูคืนรายงานใหนักเรียนตอหนานักเรียนคนอ่ืน ซึ่งทําใหนักเรียนคนอ่ืนมองเห็นเกรดของกัน
และกันหรือไมครูก็มักตําหนิ หรือแนะนักเรียนโดยการพูดใหเพื่อนๆ คนอ่ืนไดยิน  ซึ่งการกระทํา
ดังกลาวของครู ทําใหนักเรียนรูสึกเสียหนา จากเหตุการณเหลานี้เลยทําใหนักเรียนรูสึกกังวลและ
ใหความสําคัญกับการถูกมองวาเปนคนเกง หรือคนไมมีความสามารถในสายตาตัวเองและผูอ่ืน 
(เชน ครูครอบครัว และกลุมเพื่อน) และพยายามหลีกเล่ียงจากการถูกมองวาเปนคนไมเกง หรือไม
มีความสามารถ นักเรียนที่ใหความสําคัญหรือเปนกังวลเกี่ยวกับการถูกมองจากบุคคลอ่ืน             
ในลักษณะเชนนี้ เปนนักเรียนที่มีเปาหมายชนิดที่เรียกวา “เจตคติในการทํางาน (Performance 
Goals Orientation)” ลักษณะบุคคลที่มีเปาหมายประเภทนี้ ไดแก  เชื่อวาความสามารถของ
บุคคลมีความคงที่ ไมสามารถเปล่ียนแปลงได ดังนั้นบุคคลที่เกงไมจําเปนตองขยัน สามารถ
ประเมินผลงานที่ตนเองทําโดยเปรียบเทียบกับบุคคลอ่ืน เพราะไมอยากใหตนเองดูไมดี เปนคน          
ที่เลือกทํางานที่เปดโอกาสใหตนเองไดแสดงใหผูอ่ืนเห็นวาตนเองมีความสามารถ และพยายาม
หลีกเล่ียงงานที่ทําใหตนเองดูแยหรือไมเกง รูสึกผอนคลายและภูมิใจที่ไดทํางานที่งายจนประสบ
ความสําเร็จ การเรียนรูเกิดจากแรงจูงใจภายนอก โดยคาดหมายรางวัลจากบุคคลอ่ืน และ
พยายามหลีกเล่ียงการถูกตําหนิ ใชวิธีการเรียนรูที่ชวยในการเรียนแบบทองจําเทานั้น ตองการ
ทราบผลการเรียนรูที่เปนส่ิงที่ดีเทานั้น ไมตองการทราบถึงขอบกพรองของตนเอง ถางานที่ทําไม
ประสบความสําเร็จก็จะยกเลิกงานนั้นงายๆ และพยายามหลีกเล่ียงงานท่ีตนเองเคยลมเหลวมา
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กอนในอดีต บุคคลนั้นจะคิดวาครูผูสอนคือผูพิพากษาที่ทําหนาที่เปนผูใหรางวัลหรือการใหลงโทษ 
และคิดวาความลมเหลวเปนตัวบงช้ีถึงความไมเกง ไมมีความสามารถ และเชื่อวาความลมเหลวน้ี
จะเกิดข้ึนในอนาคต 

แตวาการมีเจตคติในการทํางาน (Performance Goals Orientation) มันก็อาจะทําให
เกิดผลเสียมากมาย เชน ในกรณีที่นักเรียนเช่ือวาความสําเร็จของตนเกิดจากการเปรียบเทียบ
ความสามารถของตนกับนักเรียนคนอ่ืนๆ นักเรียนก็จะคิดวาครูนาจะมีอคติกับนักเรียนบางคน 
และไมมีความยุติธรรมในการใหคะแนน ซึ่งอยางไรก็ตาม ก็มีความสัมพันธระหวางการมีเจตคติใน
การทํางาน กับการรับรูความสามารถของตนเองในหลายลักษณะดังนี้ 

1. ถานักเรียนมีการรับรูความสามารถของตนเอง( have high self-efficacy) ในการ
กระทํากิจกรรมอยางใดอยางหน่ึงสูง และมีเจตคติในการทํางาน (Performance Goals 
Orientation)  นักเรียนเหลานี้มีแนวโนมจะมีความเชี่ยวชาญในการกระทํากิจกรรมนั้นๆ  (Mastery 
Oriented)  นั่นคือนักเรียนเหลานี้จะมีความพยายามอยางสม่ําเสมอในการกระทํากิจรรมนั้น 
เพื่อใหตนเองประสบความสําเร็จ มีความเชี่ยวชาญ มีทักษะ และเกงกวานักเรียนคนอ่ืนๆ ในชั้น 
 2. ถานักเรียนมีการรับรูความสามารถของตนเองในการกระทํากิจกรรมอยางใดอยางหนึ่ง
ตํ่า (have low self – efficacy) และเจตคติในการทํางาน (Performance Goals Orientation)  
นักเรียนเหลานี้ก็จะพยายามหาทางหลีกเล่ียงในการกระทํากิจกรรมนั้นๆ เพื่อไมใหตนเองดูแย
หรือไมมีความสามารถ ซึ่งเราเรียกนักเรียนพวกนี้วา “Failure Avoiding Orientation” 
 ซึ่งที่แยที่สุด คือ ถานักเรียนมีเจตคติในการทํางาน (Performance Goals Orientation) 
และคิดวาตนไมมีความสามารถในการกระทํากิจกรรมใดกิจกรรมหน่ึง  (Lack Ability) เราเรียก
นักเรียนเหลานี้วาเปน “นักเรียนที่ส้ินหวังในการเรียน (Learned – Helpless Orientation)” ซึ่ง
นักเรียนประเภทนี้มักไมคอยมีความพยายามในการเรียน มักยกเลิกการทํางานตางๆอยางงายดาย 
และมักคิดวาตนเองไมมีความสามารถถึงแมจะทุมเทความพยายามมากเทาไรก็ตาม และนักเรียน
เหลานี้มักรูสึกหดหู และมีอาการซึมเศรารวมดวย  ดังนั้นถาครูไดทําความเขาใจในเร่ือง “ความส้ิน
หวังในการเรียนรู” จึงมีประโยชนสําหรับครูผูสอนอยางยิ่ง เพราะถาครูเขาใจวา “ความส้ินหวังใน
การเรียนรู” เกิดข้ึนไดอยางไร และมีผลตอแรงจูงใจในการเรียนและผลการเรียนของนักเรียน
อยางไร ก็จะชวยใหครูสามารถชวยนักเรียนไดกอนที่จะเกิดความสิ้นหวังอันเกิดจากการเรียนรู 

สรุปวาเจตคติในการทํางาน คือ ความรูสึกของผูเรียนที่มีผลตอการกระทําตางๆ ที่จะ
เกิดข้ึนตอผลการทํางานใดๆ ไมวาจะเปนในอดีต หรืออนาคต หรือความกลัวตอการทํางานที่
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ผิดพลาด โดยที่เปาหมายในการสรางงานจะมีความสัมพันธตอความเชี่ยวชาญหรือการกระทําใน
กิจกรรมนั้นๆ ได 

2.6.2 ความมุงม่ันในการทํางาน 
ลักษณะของบุคคลที่มีความมุงมั่นในการทํางาน ไดแก บุคคลนั้นจะมีความเชื่อ

วาความพยายามและความฝกฝนทําใหบุคคลมีความสามารถและประสบความสําเร็จได          
เขาสามารถเลือกทํางานที่เปดโอกาสใหตนเองไดเกิดการเรียนรู และจะตองรูสึกผิดหวังและเบ่ือ
หนายถาตองทํางานที่งาย การเรียนรูที่เกิดข้ึนเกิดจากแรงจูงใจภายในของบุคคลนั้น  ตลอดจน
พยายามหาวิธีการเรียนรูตางๆ ที่ชวยทําใหการเรียนรูมีประสิทธิภาพมากข้ึนโดยทุมเทความ
พยายามอยางมากในการเรียนรู ถึงแมไมประสบความสําเร็จ ก็ไมยกเลิกที่จะทํางานช้ินนั้น  
สามารถประเมินผลงานที่ทําโดยเปรียบเทียบกับตนเองวามีความกาวหนาไปมากนอยอยางไร  
และเช่ือวาความพยายามและการฝกฝนทําใหบุคคลมีความสามารถและประสบความสําเร็จได  
จะรูสึกพอใจกับผลงานที่ตนเองตองทํา ถึงแมวางานที่ทําจะไมประสบความสําเร็จทั้งๆที่ได
พยายามอยางเต็มที่แลว  ตองการทราบผลการเรียนรู เพื่อเปนขอมูลในการปรับปรุงการเรียนรูใหดี
ข้ึน ผูเรียนจะคิดวาครูผูสอนคือแหลงขอมูลสามารถใหคําแนะนําตางๆได  และคิดวาความ
ผิดพลาดเปนเร่ืองปกติและมีประโยชนในกระบวนการเรียนรู และสามารถนําเอาความผิดพลาดไป
ปรับปรุงการเรียนใหดีข้ึน และความผิดพลาดเปนตัวบงชี้ใหบุคคลเพิ่มความพยายามในการ
ทํางานใหมากข้ึน 

นักเรียนที่มีความมุงมั่นในการทํางาน มีความต้ังใจที่จะเรียนรูเพื่อกอใหเกิดความ
เช่ียวชาญในการกระทํากิจกรรมใดกิจกรรมหนึ่งเปนที่นาสังเกตวานักเรียนที่มีเปาหมายเพื่อการ
เรียนรู (Learning Goals) ทุกคนมีความต้ังใจที่จะทํากิจกรรมตางๆ ใหประสบความสําเร็จถึงข้ันมี
ความเชี่ยวชาญ (Mastery Orientation) ถึงแมวานักเรียนเหลานี้บางคนจะมีความสามารถดอย
กวานักเรียนคนอ่ืนๆก็ตาม 

สรุปไดวาบุคคลที่มีความมุงมั่นในการทํางาน จะพยายามกระทํากิจกรรมตางๆที่
จะชวยใหบุคคลสามารถเรียนรูไดดีข้ึน เชน มีความกระตือรือรน ต้ังใจเรียน ยอมรับขอบกพรอง
ของตนเองได ไมทอถอยกับความลมเหลวที่เกิดข้ึน และคิดวาการพยายามและการฝกฝนเปน
หนทางไปสูความสําเร็จ  

2.6.3 เปาหมายเพื่อผลประโยชนในอนาคต  
นักเรียนที่มีเปาหมายประเภทนี้มองการเรียนรูเสมือนผลตอบแทนที่จะไดรับใน

ระยะยาว ยกตัวอยางเชน นักเรียนสวนใหญเชื่อวาการมีผลการเรียนที่ดีมีความสําคัญ เพราะทาํให
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นักเรียนมีความรูความสามารถ และมีทักษะท่ีจําเปนสําหรับการประสบความสําเร็จในอาชีพใน
อนาคต หรือมีความสําคัญและมีประโยชนในการใชสมัครเขาศึกษาตอในสถาบันตางๆ 
ผลการวิจัยพบวานักเรียนที่มีเปาหมายประเภทน้ีมีแนวโนมที่จะเอาใจใสในการศึกษาเลาเรียน
อยางสม่ําเสมอ และมักจะใชเทคนิคการเรียนรูที่เปนทั้งการเรียนรูที่มีความหมาย (Meaningful 
Learning) และการเรียนรูชนิดทองจํา  โดยทั่วไปนักเรียนพวกนี้มีแนวโนมที่จะแสดง “Mastery 
Orientation” ในการเรียนรูดวยเชนกัน  

2.6.4 เปาหมายเพื่อตองการรางวัลจากภายนอกเหนือไดรับการยกยอง 
นักเรียนที่มีเปาหมายประเภทนี้เอาใจใสในการเรียนเพื่อตองการไดรับการยกยอง

ทางสังคม หรือการไดรับเงิน และรางวัลตางๆจากบุคคลอ่ืน งานวิจัยเกี่ยวกับการปรับพฤติกรรม
แสดงใหเห็นวาการใชส่ิงลอภายนอก เชน เงิน ขนม รางวัล และคําชมเชย สามารถชวยใหนักเรียน
ที่ข้ีเกียจ ไมสนใจเรียน หันมาเอาใจใสในการเรียนเพิ่มข้ึนได ซึ่งถึงแมวานักเรียนที่มีเปาหมายเพื่อ
ตองการรางวัลจากภายนอกหรือไดรับการยกยอง (Extrinsic reward or Recognition Goals) จะ
เอาใจใสในการเรียนรู แตระดับของการเอาใจใสในการเรียนก็ไมสูงหรือมีการเรียนรูที่ลึกซ้ึง และมี
ความหมายมากเทากับนักเรียนที่มีเปาหมายเพื่อการเรียนรู (Learning Goals) และเปาหมายเพื่อ
ผลตอบแทนในระยะยาว (Internalized Future – Utility Goals) 

2.6.5 เปาหมายเพื่อการไดยอมรับทางสังคม  
นักเรียนสวนใหญ โดยเฉพาะนักเรียนระดับประถมศึกษาทําการบานเพื่อใหครู

พอใจ ตองการใหครูรัก ซึ่งส่ิงเหลานี้สามารถบังเกิดกับนักเรียนระดับมัธยมศึกษา และระดับ
วิทยาลัยไดเชนกัน เพราะนักเรียนทราบวาครูเปนผูควบคุมและใหเกรดนักเรียน นอกจากนี้นักเรียน
บางคนพยายามหลีกเล่ียงการเปนคนเกง หรือมีความสามารถ เพื่อทําใหเพื่อนพอใจหรือยอมรับ 
เพราะนักเรียนคิดวาการเปนคนไมเกงมักดูนาสนใจ และเทห็ในสายตาเพื่อน (It is “cool” to do 
well in school) กลาวอีกนัยหนึ่งก็คือ นักเรียนที่มีเปาหมายประเภทน้ีจะตัดสินใจกระทํากิจกรรมที่
เพื่อนๆ หรือสังคมที่อยูยอมรับเทานั้นโดยไมสนใจวากิจกรรมท่ีกระทํานั้นจะถูกตองหรือเหมาะสม
หรือไม เชน นักเรียนพยายามแตงตัวเซอๆเหมือนกับเพื่อนในกลุม เพื่อใหเพื่อนยอมรับ  เปนตน 

2.7 ความผูกพันตอเปาหมาย  
เราสามารถศึกษาความผูกพันตอเปาหมาย จากความหมายของความผูกพันตอเปาหมาย 

การวัดความผูกพันตอเปาหมายและบริบทของความผูกพันตอเปาหมาย 
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2.7.1 ความหมายของความผูกพันตอเปาหมาย  
เมเออรและบรุนสเตียน (Maier & Brunstein, 2001) พบวาเปาหมายสวนบุคคล 

(Personal Goal) เปนการแสดงถึงการกําหนดทิศทางในอนาคตของแตละคนในการมุงมั่นเพือ่ชีวติ
และการมองหาความสําเร็จในชีวิตที่หลากหลาย เสนอวาประกอบไปดวยมิติสามดาน ซึ่งไดแก 
ความผูกพันตอเปาหมาย ความสามารถไปสูเปาหมาย และความกาวหนาในการทําสําเร็จตาม
เปาหมาย เหตุผลที่สําคัญในการกําหนดการติดตามทําตามเปาหมายนั้น เพื่อนําไปสูการกาวสู
ความสําเร็จตามเปาหมายซ่ึงสามารถชวยสรางเสริมความรูสึกที่ดีของแตละบุคคล ในทางกลับกัน
ถามีสภาวะที่ออนแอในการไปสูเปาหมาย สงผลใหทําลายความรูสึกที่ดีของบุคคลในงาน ดังนั้น
บุคคลจึงพยายามเพื่อผลสําเร็จและหลีกเล่ียงความกดดันตางๆ ที่เกิดข้ึนจากการไมสามารถบรรลุ
เปาหมาย ดวยเหตุนี้จึงเปนส่ิงสําคัญมากที่บุคคลนั้นตองมีทั้งความรูสึกที่แข็งแกรงตอเปาหมาย
ตามที่ตนมีความผูกพันกับเปาหมายนั้น และสถานการณตางๆในชีวิตที่ชวยสนับสนุนตอส่ิงที่เปน
เปาหมาย ซึ่งหากส่ิงเหลานี้ไดรับการสงเสริมในข้ันตนของการทํางาน ยอมสงผลใหแตละคนไดพบ
กับเปาหมายตามที่ตนต้ังไวเพื่อไปสูจุดสูงสุดตามที่แตละคนตองการในการทํางาน 

ความผูกพันตอเปาหมาย (Goal Commitment) สามารถใชเปนเคร่ืองบงช้ีถึงการ
ยอมรับและความพยายามในการทําใหสําเร็จตามเปาหมายของแตละบุคคล จึงมีความสําคัญตอ
การกระทําและการตัดสินใจที่มีความเกี่ยวของกับผลระยะยาว และยังเปนแหลงของแรงจูงใจอัน
ทรงพลังที่จะตานทานตอส่ิงตางๆทําใหบุคคลมีความพยายามตอไปเพื่อใหถึงเปาหมาย (Meyer, 
Becker and Vandenberghe, 2004) ความผูกพันตอเปาหมายมีนัยสําคัญกับการรับรู
ความสามารถของตนเองเพื่อการต้ังเปาหมาย บางบุคคลมีเปาหมายที่ตนไดต้ังข้ึน หากแตมีความ
ผูกพันในการยอมรับเปาหมายตํ่า ก็ไมสามารถสรางผลลัพธตามที่ตนตองการได ทั้งนี้การสราง
ความผูกพันตอเปาหมายที่ดีและการทําไดสําเร็จตามเปาหมายยอมสรางความพึงพอใจใหกับ
บุคคลนั้น และสงผลตอความพึงพอใจในชีวิตและการทํางานตอไป 

ดังนั้นความผูกพันตอเปาหมาย (Goal Commitment) จึงหมายถึง ระดับที่บุคคล
ยอมรับในความปรารถนาของตนเองและแสวงหาวิธีการที่จะไปใหถึงเปาหมาย เปนการสราง
ความสําคัญตอการกระทําและการตัดสินใจที่มีความเกี่ยวของกับผลระยะยาวที่เกิดจากตนเอง 
อันสงผลตอการพยายามทําใหเปาหมายที่ต้ังไวเปนจริง 

2.7.2 การวัดความผูกพันตอเปาหมาย 
ความผูกพันตอเปาหมายและการยอมรับเปาหมายมีความคลายคลึงกันและ

มักจะใชแทนกันในงานวิจัยของล็อคและลาแธม (Locke & Latham, 1990) และไดขอสรุปของ
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ความแตกตางวาการยอมรับเปาหมาย (Goal Acceptance) เปนการเร่ิมตนขอตกลงตาม
เปาหมาย สวนความผูกพันตอเปาหมาย (Goal Commitment) เปนความตานทานตอการ
เปล่ียนแปลงตอเปาหมายจนถึงระยะสุดทาย โดยมีวิธีการวัดความผูกพันตอเปาหมาย ดังนี้ 
   2.7.2.1 อีเรสและไซดอน (Erez and Zidon, 1984) พบวาความผูกพัน
ตอเปาหมายเปนตัวแปรตอเนื่อง (continuous variable) โดยวิธีการวัดทําไดโดยการใชคําถาม
รูปแบบตางๆที่มีความเกี่ยวของกับเปาหมาย เชน “คุณผูกพันกับการยอมรับเปาหมายสูเพียงใด” , 
“ ส่ิงตางๆไมสามารถทําใหฉันเพิกเฉยตอเปาหมาย” , “ ฉันเต็มใจรวมมือเต็มที่เพื่อความสําเร็จใน
คร้ังนี้” 
   2.7.2.2 การวัดความผูกพันตอเปาหมายทางออมทําไดโดยการ
เปรียบเทียบระหวางการวัดระดับเปาหมายท่ีมอบให กับเปาหมายของตนเองท่ีตนเปนผูต้ังจากนั้น
จึงสรุปความพยายามในการไปสูเปาหมาย พบวาวิธีการวัดทางตรงมีคาความสัมพันธเทากับ .71 
และวิธีการวัดทางออมเทากับ .59 และพบวาความรูสึกผูกพันที่แสดงออกมาจะเกิดข้ึนไดตอเม่ือ
ระดับเปาหมายสวนบุคคลไดรับการควบคุมล็อคและโชว (Lock & Shaw, 1984) 
   2.7.2.3 การวัดความผูกพันตอเปาหมายโดยวิธีการวัดจากการประเมิน
ของผูคนรอบขางทั้งดานความสามารถและความเหมาะสมในการทํางาน วาพฤติกรรมหรือการ
กระทํานั้นสามารถใชเปนพื้นฐานในการพิสูจนความผูกพันตอเปาหมาย จากการที่ผูยอมรับ
เปาหมายนั้นตองใชความพยายามอยางมากที่จะทําใหสําเร็จมากกวาการปฏิเสธสลานิค
(Salanick, 1997) 
 สรุปไดวาการวัดความผูกพันตอเปาหมายมีวิธีการวัดไดโดยใชคําถามรูปแบบตางๆที่มี
ความเกี่ยวของกับเปาหมาย โดยการเปรียบเทียบระหวางการวัดระดับเปาหมายที่กําหนดให และ
ใชวิธีการวัดการประเมินจากบุคคลรอบขาง โดยเมื่อรวบรวมแนวคิดตางๆจากงานวิจัยพบวามี
ความสัมพันธกันอยางลึกซึ้งระหวางความผูกพันตอเปาหมายและผลการปฏิบัติงาน แต
ขณะเดียวกันยังมีปจจัยอ่ืนๆอีกที่เปนตัวกําหนดความผูกพันตอเปาหมาย 

2.7.3 บริบทของความผูกพันตอเปาหมาย 
  ปจจัยที่สงผลตอการยอมรับในความปรารถนาหรือความพยายามในการยอมรับ
ระดับเปาหมาย จากความพยายามของแตละคนที่เชื่อวาการทําตามเปาหมายเปนส่ิงสําคัญ ไดแก 
อํานาจ อิทธิพลจากกลุม สาธารณสภาพ ส่ิงจูงใจและรางวัล การบริหารตนเองหรือการไดรับ
รางวัลจากภายใน การลงโทษ และคุณคาที่มีของความเปนไปไดที่จะเกิดข้ึน 
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อํานาจ (Authority) ผลของการใชอํานาจเพื่อการสรางเปาหมายดวยตนเองดวย
การตั้งระดับของผลการทําส่ิงตางๆตามเปาหมายดวยตนเอง ตามที่ลิเคิรตไดศึกษาในป 1967
พบวาเปาหมายในการขายของเซลลแมนและเปาหมายในการขายของผูจัดการมีความสัมพันธใน
ทิศทางเดียวกันคอนขางสูง  โอลหแฮม (Oldham, 1975) ศึกษาพบวาอํานาจจากผูบังคับบัญชา  
มีนัยสําคัญกับแนวโนมของการทํางานหนักเพื่อใหเปนไปตามเปาหมายที่ไดรับ ความผูกพันตอ
เปาหมายสงผลสะทอนตอการยินยอมทําตามอํานาจอยางถูกตอง ความสัมพันธระหวางเปาหมาย
และอํานาจเปนส่ิงที่ถูกกลาวถึงมานานแลววาอํานาจนั้นตองมาจากบุคคลอันควรและบุคคลนั้น
ตองไดรับการยอมรับจากบุคคลอ่ืนๆดวย เพราะฉะนั้นบุคคลที่มีอํานาจจึงควรมีความเขาใจในการ
ส่ือสารและมอบหมายคําส่ัง มีความเชื่อมั่นในวัตถุประสงคขององคการและมีความสนใจบุคลากร
ของตน เพื่อใหผูปฏิบัติสามารถทําตามเปาหมายไดทั้งกายและใจ เม่ือเปนเชนนี้ผูบริหารที่ใหการ
สนับสนุนในการไปสูเปาหมายและพนักงานสามารถรับรูถึงการไดรับความชวยเหลือนี้ยอมสงผล
ตอการทํางานที่มีประสิทธิภาพ  ความเชื่อในอํานาจที่ตนมี ดวยวิธีการต้ังเปาหมายรวมกันระหวาง
ผูปฏิบัติงานและผูบริหาร โดยวิธีการพูดใหคําแนะนํารวมกับการแสดงใหเห็นถึงส่ิงที่ผูปฏิบัติงาน
สามารถไปใหถึงเปาหมายจากวิธีการตางๆ รวมถึงแรงกดดันจากผูบังคับบัญชา สงผลตอ
ความรูสึกในการมีความผูกพันกับเปาหมายของพนักงาน ล็อคและลาแธม(Locke & Latham, 
1990) มีความเชื่อวาการมอบหมายเปาหมายจะเกิดประสิทธิภาพเมื่อ 
  1. อํานาจที่นําไปสูการต้ังเปาหมายมีความถูกตอง 
  2. การต้ังเปาหมายตองใชรวมกับการใหรางวัลและการลงโทษ 
  3. การต้ังเปาหมายตองนําไปสูผลทางบวกกับการรับรูความสามารถของตนเอง 
  4. การต้ังเปาหมายตองนําไปสูความถูกตองตรงตามขอมูลมากที่สุด 

5. การต้ังเปาหมายตองสนับสนุนความรูสึกประสบความสําเร็จ 
6. การต้ังเปาหมายนําไปสูการพัฒนาตนเอง 
7. การต้ังเปาหมายตองนําไปสูการทาทายคนใหพัฒนาตนเอง 
8. รูปแบบของการใชอํานาจตองประกอบไปดวย ความสามารถในการมองเหน็ได

อยางเปนรูปธรรม ไดรับการสนับสนุน มีความเชื่อถือได จัดเตรียมส่ิงของส่ิงตางๆ เพื่อความพรอม
ในการไปสูเปาหมาย การใชอํานาจอยางเหมาะสม ไดรับความรูและเปนส่ิงที่ชื่นชอบ 

อิทธิพลจากกลุม (Peer group Influence) เปนส่ิงที่พบมากในวงการอุตสาหกรรม             
ความผูกพันกับผลการผลิตที่ไดมาตรฐานเปนผลมาจากความสามัคคี เหนียวแนนของกลุม 
เชนเดียวกับ การศึกษาของซีชอร (Seashore, 1954 cited in Locke & Latham, 1990)  พบวา
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ระดับความสัมพันธที่เหนียวแนนและความปรารถนาของกลุมนําไปสูผลผลิตที่มาก   การสังเกตดู
การทํางานจากตนแบบที่มีความยากมากกวาแบบงาย สงผลใหผูที่ต้ังความผูกพันตอเปาหมายนัน้
เกิดความรูสึกเช่ือมั่นในความสามารถของตนเองสูง (self efficacy) ข้ึนไดจากตัวแบบที่มีการ
ทํางานที่ดีและ แบนดูรา (Bandura, 1986) ไดเสนอวาการไดเห็นรูปแบบที่ดีนั้นเปนเทคนิคที่มี
อํานาจในการ จูงใจสูงการแขงขันภายในกลุมสามารถชวยสนับสนุนความผูกพันตอเปาหมายได
ทั้งทางตรงและทางออม โดยวิธีการบอกใหทราบวาขณะนี้เขากําลังไดรับการประเมินอยูรวมกับ
ใครในกลุมและตนเองนั้นอยูในระดับใดในตอนนี้ จากการศึกษาของโรเบิรตและฮอลล (Robert & 
Hall, 1987 cited in Locke & Latham, 1990) พบวาการแขงขันทําใหผลการปฏิบัติงานสูงข้ึน
มากกวาเมื่อไมไดรับการเปรียบเทียบและเปาหมายที่ ต้ังข้ึนจะอยูในระดับสูงและมีความ
เฉพาะเจาะจงกวาเชนกัน เพราะการสะทอนผลกลับทําใหบุคคลตองแขงขันเพื่อพัฒนาตนเองดวย 

สาธารณสภาพ (Publicness) การเปดเผยขอผูกพันของตนถึงเปาหมายของตนในที่
สาธารณะไดผลดีมากกวาการต้ังเปาหมายเฉพาะกับตนเอง เนื่องจากมีความเปนไปไดที่แตละคน
ไมตองการใหผูอ่ืนรับรูหากไมสามารถทําใหเสร็จไดตามเปาหมาย วาตนเองนั้นขาดความซ่ือสัตย
หรือไมมั่นคง และตองยอมรับความอับอายในภายหลัง เปาหมายจะยิ่งไดผลดีเมื่อต้ังในท่ี
สาธารณะและบุคคลนั้นต้ังเปาหมายของตนเองไวตลอดเวลา 

ส่ิงจูงใจและรางวัล (Incentive and rewards) จากทฤษฎีเกี่ยวกับการสรางแรงจูงใจทาง
จิตวิทยาตางๆลวนมีความเห็นตรงกันวาความผูกพันในการกระทําตางๆเปลี่ยนแปลงไดจากความ
ชื่นชอบส่ิงจูงใจหรือรางวัล จากการศึกษาของ (Campbell,1984, cited in Locke & Latham, 
1990) พบวาการกระตุนใหกลุมตัวอยางทํางานที่ไดรับมอบหมายพรอมกับเปาหมายท่ีมีความ
เฉพาะเจาะจงมีนัยสําคัญกับการใหรางวัลที่เปนตัวเงิน 

การบริหารตนเองหรือการไดรับรางวัลจากภายใน (self-Adminstered or Internal 
Reward) จากการศึกษาของอีวานเซวิชและแมคมาฮอน (Ivancevich & McMahon, 1982, cited 
in Locke & Latham, 1990) พบวาไมมีความสัมพันธระหวางความผูกพันตอเปาหมายและผลการ
ปฏิบัติงานในกลุมผูเขารวมงานวิจัยที่เปนวิศวกร อยางไรก็ตามใหตามการใหผลตอบสะทอนกลับ
จากการประเมินตนเองไดสงผลตอการเพิ่มความผูกพันตอองคการและผลการปฏิบัติงานรวมกับ
การสะทอนผลกลับจากผูบริหาร การใหเหตุผลนี้ยังไมกระจางนักแตเช่ือวาการที่ตนเองสามารถ
บอกไดถึงส่ิงที่ตนเองเปนผูควบคุมการกระทํายอมดีกวาการที่ผูอ่ืนเปนคนบอก เชนเดียวกับ
งานวิจัยของแมสเตอรและคณะ (Master et al. 1977,  cited in Locke & Latham, 1990) ที่พบวา
การที่ตนเองเปนผูใหรางวัลสงผลตอการสรางแรงจูงใจมากกวาการที่ไดรับรางวัลจากผูอ่ืน 
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การลงโทษ (Punishment) การสรางความผูกพันดวยวิธีการต้ังสถานการณวาหากทาํไมได
ตามเปาหมายจะถูกลงโทษน้ันตองเปนส่ิงที่ทําโดยสมัครใจเทานั้น ขณะเดียวกันผูบริหารจะตอง
คอยสนับสนุนในการใหบุคคลไดพยายามไปถึงจุดหมายและไมผลักดันใหพวกเขาไปสูความ
ลมเหลว การใชเหตุผลในการลงโทษสงผลอยางมีประสิทธิภาพหากรูวิธีการใชอยางถูกตองและ
ตองไดรับการยอมรับดวยเชนกัน 

คุณคาที่มีและความเปนไปไดที่จะเกิดข้ึน (General Valenceand Instrumentality) 
คุณคาของเปาหมายนั้นข้ึนอยูกับวาจะใชส่ิงใดในการจูงใจแตละคน และความเปนไปไดที่จะ
เกิดข้ึนมีนัยสําคัญกับความผูกพันในเปาหมายจากการศึกษาของยูลคและลาแธม (Yulk & 
Latham, 1978 ,cited in Locke & Latham, 1990) บุคคลที่ไดเลือกเปาหมายเองยอมมีความ
ผูกพันตอเปาหมายนั้นดวย  การไดรับเปาหมายกอนการต้ังเปาหมายดวยตนเองกอใหเกิดความ
ไมลงรอยกันในเปาหมาย ทางที่ดีคือเม่ือเปาหมายที่ทํามีความยาก ควรใหแตละบุคคลไดมีโอกาส
กําหนดเปาหมายดวยตนเองที่ตองการจริงๆ กอนที่จะมอบเปาหมายในงานใหกับพวกเขา 
เนื่องมาจากส่ิงที่แตละบุคคลไดรับคือความพึงพอใจจากภายใน เชนเดียวกับความผูกพันใน
องคการ หรือความพึงพอใจในงาน 

สรุปไดวาบริบทของความผูกพันตอเปาหมายจะมาจาก อํานาจ อิทธิพลจากกลุม                   
สาธารณสภาพ ส่ิงจูงใจและรางวัล การบริหารตนเองหรือการไดรับรางวัลจากภายใน การลงโทษ 
และคุณคาที่มีของความเปนไปไดที่จะเกิดข้ึน 
 

ตอนท่ี 3 ปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง   
ในตอนสามเปนปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง ไดแก  

ระดับประสบการณเดิม บุคลิกภาพภายในของผูเรียน ความมุงมั่นในการทํางานและความวิตก
กังวลในการใชคอมพิวเตอร  

 

3.1 ระดับประสบการณเดิม  
ประสบการณเดิมสามารถศึกษาไดจาก ความหมายของประสบการณ ประสบการณกับ

ทฤษฎีการสรางองคความรูดวยตนเองและประสบการณเดิมกับการเรียนรูแบบหย่ังรู 
ความหมายของประสบการณ (Experience) 
ไดมีนักจิตวิทยาหลายทานไดใหความหมายเกี่ยวกับการเรียนรูจากประสบการณไวดังนี้ 
ประสบการณ หมายถึง การที่มนุษยผานภาวะการรับรู ไดเห็น ไดฟงและไดปฏิบัติดวย

ตนเองมาแลวบอยคร้ังจน สะสมเปนประสบการณและความชํานาญ เชนศิลปนที่มีใจรักและช่ืนชม
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ความงามของธรรมชาติโดยเฉพาะดอกไมนานาพันธุ จึงมักจะเขาไปสัมผัสช่ืนชมกับความงามของ
ธรรมชาติ เหลานั้น และนิยมถายทอดความงามดวยการวาดภาพธรรมชาติเปนพิเศษศิลปนบาง
คนจึงมีความเจนจัดในการวาดภาพสีน้ํา หรือนักเรียนอาจวาดภาพจากประสบการณใน
ชีวิตประจําวัน เปนตน  

โรเจอร (Rogers, 1969) ไดใหความหมายวา การเรียนรูจากประสบการณ หมายถึงความ
สมดุลระหวางการเปลี่ยนแปลงและการเจริญกาวหนาของบุคคล โรเจอรมีความเช่ือวามนุษยทุก
คนมีธรรมชาติของการอยากเรียนรู บทบาทของครูตองอํานวยความสะดวกโดยการจัดบรรยากาศ
ใหเอ้ือตอการเรียนรู ตอบสนองวัตถุประสงคของผูเรียน ดําเนินการจัดหาทรัพยากรที่เหมาะสมให
ความสําคัญระหวางปญญาและอารมณ จัดใหมีการแลกเปล่ียนความรูและการคิดอยางมีอิสระ
ปราศจากอคติ 

ดิวอ้ี (Dewey, 1938) ไดใหความหมายของการเรียนรูจากประสบการณวาเปนวงจรของ
การลองกระทําเปนการเรียนรูที่เกิดจากการกระทําจริง ผูเรียนเปนผูสรางความรูใหมหรือผูเรียน
ปรับเปล่ียนตนเองในการปฏิบัติตามบทบาทใหม 

จัช (Juch, 1983) ไดใหความหมายของการเรียนรูจากประสบการณวาเปนวงจรการเรียนรู             
ซึ่งเปนตัวแทนของการเรียนรูที่เกิดจากประสบการณ ในระยะของวงจรแหงการเรียนรูจะมีการ
จัดการเรียนการสอนโดยผูสอน แตผู เ รียนเองก็สามารถจัดไดดวยตนเอง การเรียนรูจาก
ประสบการณเปนเร่ืองปกติของกระบวนการในชีวิตประจําวัน เปนการเรียนรูจากประสบการณเดิม
ไปยังประสบการณอ่ืนๆ บางคร้ังเหมือนกับวงจรการอบรม บางคร้ังก็ผิดพลาดถาถาไมเขาใจ
เกี่ยวกับ ผูเรียนและวิธีการเรียนรู 

กอลป (Kolb, 1984) ไดใหความหมายของการเรียนรูจากประสบการณวาเปนกระบวนการ
เรียนรูที่เปนลักษณะแบบองครวมและมีความหลากหลาย ซึ่งรูปแบบในการพัฒนาผูใหญจะ
ประกอบดวยประเด็นที่เกี่ยวของกับวิธีการเรียนรูของประชาชน การเจริญงอกงาม และการพัฒนา 
ทฤษฎีการเรียนรูจากประสบการณจะเนนบทบาทสําคัญของการปฏิบัติจริงในกระบวนการเรียนรู 

ปฟเฟอรและบัลเลล (Pfeiffer and Ballew, 1988) ไดใหความหมายวาการเรียนรูจาก
ประสบการณวาเปนการกําหนดวัตถุประสงคในการกระตุนผูเรียนใหมีความรูสึกที่ดีในการเรียนรู
เหมือนกับส่ิงที่เขาคิด พยายามทําใหผูเรียนเกิดพฤติกรรมและอารมณความรูสึกใหม เกิดความรู
ใหม การเรียนรูจากประสบการณ จะเกิดเมื่อบุคคลเก่ียวของผูกพันธในกิจกรรม การวิเคราะห
ทบทวนอยางมีวิจารณญาณเชิงนามธรรมที่เปนประโยชนใหเหตุผลในการทํางาน โดยอิง
สมมุติฐาน 
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อีวาน (Evans, 1994) ไดใหความหมายของการเรียนรูจากประสบการณวา หมายถึง 
ความรูและทักษะที่ไดรับ ประสบการณจากการทํางาน จาการปฏิบัติ และการศึกษาที่ไมเปน
ทางการ โดยจะผานจากการศึกษาทุกประเภท  หรือจากดานสายอาชีพ  การเรียนรูจาก
ประสบการณ เปนวิธีการเรียนรูจากหนังสือ จากการบรรยาย การทดลอง ทฤษฎีการเรียนรูจาก
ประสบการณจึงเปนชุดวิธีการเรียนรูวิธีหนึ่งจากหลายๆ ชุด 

ลัคแมน (Luckman, 1996) ไดใหความหมายของการเรียนรูจากประสบการณวา เปน
กระบวนการที่ผูเรียนไดสรางความรู ทักษะ และคุณคาจากประสบการณตรง 

เครก (Craig, 1997) ไดใหความหมายวา การเรียนรูจากประสบการณ หมายถึงความรู 
ทักษะ หรือความสามารถที่ไดรับจากการสังเกต การไดรับกระตุน หรือการมีสวนรวมในการปฏิบัติ
และดําเนินกิจกรรมการเรียนรู โดยเขาไปรวมดวยความสมัครใจ รวมปฏิบัติ วิเคราะหขอมูลอยางมี
วิจารณญาณ และนําไปประยุกตใช ดังนั้นการเรียนรูจากประสบการณ จึงหมายถึงการเรียนรู
เพื่อใหไดประโยชนดานความรูและการเปล่ียนแปลงพฤติกรรม ซึ่งเกิดไดทั้งในช้ันเรียน นอกช้ัน
เรียน สถานที่ทํางาน การเรียนรูจากประสบการณเปนการเขามีสวนรวมเพื่อทดสอบทฤษฎีเพื่อ
ตอบสนองผูเรียนใหสามารถตอบคําถามและแสวงหาคําตอบไดดวยตนเอง 

สรุปไดวา ประสบการณเดิม หมายถึง ส่ิงที่คนเราไดเคยรับรูทางประสาทสัมผัส เชน การ
เห็น การไดยิน  การกระทําของตนเอง การไดใชคอมพิวเตอรโดยจากการกระทําของตนเอง ที่
เกี่ยวของและไมเกี่ยวของกับส่ิงนั้นโดยตรง ดังนั้นประสบการณเดิมจึงเกิดจากการเรียนรูจากอดีต
ที่ผานมา โดยที่ประสบการณเดิมเราสามารถแบงออกเปน 2 จําพวกใหญๆ คือ ประสบการณเดิม
ของตนเอง และการไดเห็นประสบการณความสําเร็จจากผูอ่ืน 

ประสบการณกับทฤษฎีการสรางองคความรูดวยตนเอง 
Constructionism เปนทฤษฎีทางการศึกษาที่พัฒนาข้ึนโดย Professor Seymour Papert แหง 

M.I.T. (Massachusette Institute of Technology) ทฤษฎีคอนสตรัคช่ันนิสซึ่ม (Constructionism) 
หรือทฤษฎีการสรางองคความรูดวยตนเอง เปนทฤษฎีการเรียนรูที่เนนผูเรียนเปนผูสรางองคความรู
ดวยตนเอง  

 
 
ทฤษฎีคอนสตรัคช่ันนิสซ่ึม (Constructionism) หรือทฤษฎีการสรางองคความรูดวยตนเอง  

เปนทฤษฎีการเรียนรูที่เนนผูเรียนเปนผูสรางองคความรูดวยตนเองทฤษฎีคอนสตรัคช่ันนิสซึ่ม                
มีสาระสําคัญที่วา ความรูไมใชมาจากการสอนของครูหรือผูสอนเพียงอยางเดียว แตความรูจะ

ประสบการณใหม / ความรูใหม + ประสบการณเดิม / ความรูเดิม = องคความรูใหมบุคคล
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เกิดข้ึนและถูกสรางข้ึนโดยผูเรียนเอง การเรียนรูจะเกิดข้ึนไดดีก็ตอเมื่อผูเรียนไดลงมือกระทําดวย
ตนเอง (Learning by doing) มีพื้นฐานอยูบนกระบวนการการสราง 2 กระบวนการดวยกัน  

กระบวนการที่ 1 คือ ผูเรียนเรียนรูดวยการสรางความรูใหมข้ึนดวยตนเอง ความรูจะ
เกิดข้ึนจากการแปลความหมายของประสบการณที่ไดรับ หากเปนประสบการณตรงท่ีผูเรียนเปน
ผูกระทําดวยตนเองจะทําใหเกิดการเรียนรูอยางมีความหมาย  
 กระบวนการที่ 2 คือ กระบวนการการเรียนรูจะมีประสิทธิภาพมากที่สุด หากกระบวนการ
นั้นมีความหมายกับผูเรียนคนนั้น 

สรุปไดวา ประสบการณกับทฤษฎีการสรางองคความรูดวยตนเอง เปนทฤษฎีการสราง
องคความดวยตนเองดวยการที่ผู เรียนไดลงมือดวยกระทําดวยตนเอง โดยอยูบนฐานของ
กระบวนการ 2 กระบวนการ 

ประสบการณเดิมกับการเรียนรูแบบหย่ังรู 
โคเลอร (Wolfgang Kohler) ไดกลาวเกี่ยวกับการเรียนรูแบบหยั่งรู (Insight Learning) วา 

จะเปนการลักษณะของการรวมปญหาแลวจึงแยกเปนขอยอย ก็จะเกิดความคิดข้ึนมาทันที ที่
เรียกวาการหย่ังเห็น โดยการการหย่ังเห็นจะเกิดข้ึนรวดเร็วข้ึนอยูกับการมีแรงจูงใจ, มปีระสบการณ
เดิมและการมองเห็นความสัมพันธของส่ิงเรากับปญหาได 

 

3.2 บุคลิกภาพภายในของผูเรียน  
บุคลิกภาพภายในของผู เ รียนสามารถศึกษาไดจาก  ความหมายของบุคลิกภาพ 

ความสําคัญของบุคลิกภาพ และประเภทของบุคลิกภาพ 
ความหมายของบุคลิกภาพ 
คําวา “บุคลิกภาพ” (Personality) มาจากภาษาละตินวา “Persona” แปลวา หนากาก

ของตัวละคร (An Actor’s Mask) ในทางวิชาการไดใหความหมายของบุคลิกภาพไวอยางลึกซ้ึง
โดยครอบคลุมถึงลักษณะบุคลิกภาพภายใน ดังเชน นิยามจากพจนานุกรมศัพทสังคมวิทยา
อังกฤษ - ไทย พ.ศ. 2524 ใหไววา “บุคลิกภาพ เปนผลรวมของความคิด ทาที และนิสัยซ่ึงสรางสม
จากมูลฐานองคประกอบทางจิตและทางกายภาพของบุคคลอันถายทอดมาทางชีววิทยาสวนหนึ่ง 
และจากแบบอยางวัฒนธรรมที่ถายทอดมาทางสังคมอีกสวนหนึ่งรวมถึงการปรับเหตุจูงใจความ 
ปรารถนาและความมุงประสงคของตัวบุคคลนั้นให เขากับความตองการ  และวิ สัยแหง
สภาพแวดลอม ทั้งทางสังคมและที่ไมเกี่ยวกับสังคม…” ซึ่งความหมายของบุคลิกภาพนั้นมี
นักจิตวิทยาไดใหความหมายแตกตางกันไป ดังนี้ 
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ออลพอรต (Allport, 1937) ไดใหความหมายวา บุคลิกภาพเปนองคประกอบที่มีการ
เคล่ือนไหวภายในตัวบุคคล ซึ่งเปนระบบทั้งทางดานรางกายและจิตใจซ่ึงจะเปนตัวกําหนดแบบ
แผนเฉพาะตัวของเขาในการที่จะปรับตัวเขากับส่ิงแวดลอม 

กิลฟอรด (Guilford, 1959) ใหความหมายไววา บุคลิกภาพเปนแบบแผนของคุณลักษณะ
อันเฉพาะตัวของบุคคล 

ศรีธรรม ธนะภูมิ (2525) ใหความหมายของบุคลิกภาพวา เปนลักษณะนิสัยหรือ
พฤติกรรมของบุคคลหนึ่งที่แสดงออกซํ้าๆ เพื่อตอบสนองและปรับตอส่ิงแวดลอม 

จรรยา สุวรรณทัต และดวงกมล เวชบรรยงรัตน (2529: 219) ไดใหความหมายของ
บุคลิกภาพวา หมายถึง แบบแผนพฤติกรรมของบุคคลใดบุคคลหนึ่งที่เปนที่รับรูกันโดยทั่วไปวาเปน
ลักษณะสวนรวมของบุคคลนั้น ประกอบไปดวยพฤติกรรมที่แสดงออกและศักยภาพภายในของ
บุคคลซึ่งทําใหมีความแตกตางจากบุคคลทั่วไป 

ทินวัฒน มฤคพิทักษ (2535) ใหความหมายของบุคลิกภาพวา เปนเอกลักษณหรือ
พฤติกรรมเฉพาะตัวของบุคคลใดบุคคลหนึ่งซ่ึงทําใหบุคคลนั้นแตกตางจากบุคคลอ่ืน 

กันยา สุวรรณแสง (2539) ไดใหความหมายไววา บุคลิกภาพเปนแบบแผนของพฤติกรรม
ของบุคคลที่คนทั่วไปรับรู 

จากความหมายดังที่ไดกลาวมาแลวสรุปไดวา บุคลิกภาพเปนแบบแผนของพฤติกรรมของ
บุคคล อันเปนผลรวมของลักษณะภายนอกและลักษณะภายในของบุคคล ซึ่งทําใหบุคคลนั้นมี
ลักษณะเฉพาะตัวที่เปนเอกลักษณทําใหเขาตางจากบุคคลอ่ืนปจจัยที่เปนองคประกอบของ
บุคลิกภาพของบุคคล ไดแก ปจจัยภายนอกที่มองเห็นไดอยางชัดเจน เชน รูปราง หนาตา 
กิริยามารยาท การแตงตัว วิธีการพูด การนั่ง การยืน ฯลฯ สวนภายใน คือ สวนที่มองเห็นไดยากแต
อาจทราบโดยการอนุมาน เชน สติปญญา ความถนัด ลักษณะอารมณประจําตัว ความใฝฝน
ปรารถนาในชีวิต  คานิยม ความสนใจ  ฯลฯ ซึ่งบุคลิกภาพของมนุษยเปนส่ิงที่ ไมตายตัว 
เปล่ียนแปลงไปตามกาละ การเรียนรู และส่ิงแวดลอมทางสังคมและวัตถุธรรม  

ความสําคัญของบุคลิกภาพ 
บุคลิกภาพมีความสําคัญตอการดํารงชีวิตในสังคมเปนอยางมาก ดังจะพิจารณาไดจาก

ประเด็นตางๆ ดังตอไปนี้ 
1. ความมั่นใจ ผูที่มีบุคลิกภาพดีจะมีความมั่นใจในการแสดงออกมากข้ึน ทําใหกลา

แสดงออก เพราะผูอ่ืนที่พบเห็นจะใหความสนใจและความเช่ือมั่น ดังนั้นโอกาสของการที่จะ
ประสบความสําเร็จจึงมีมากข้ึน 
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2. การคาดหมายพฤติกรรม ถารูวาบุคคลนั้นมีบุคลิกภาพอยางไรจะทํานายไดวาใน
สถานการณใดจะแสดงพฤติกรรมอยางไร 

3. การยอมรับความแตกตางระหวางบุคคล สามารถบอกไดวาบุคคลหน่ึงแตกตางจากอีก
บุคคลหนึ่งไดโดยสังเกตดูพฤติกรรมที่เกิดข้ึนเปนประจําสม่ําเสมอแกบุคคลนั้นๆ 

4. การตระหนักในเอกลักษณของบุคคล บุคลิกภาพทําใหคนมีลักษณะเฉพาะตัวที่เปน
ของตนเอง เปนแบบอยางแกบุคคลอ่ืนๆ 

5. การปรับตัวใหเขากับคนอ่ืนๆ การที่รูบุคลิกภาพของบุคคลอ่ืนทําใหปรับตัวเขากับเขาได
งายข้ึน 

6. ความสําเร็จ คนที่บุคลิกภาพดี ไดเปรียบคนอ่ืนเสมอ เปนพื้นฐานแหงความศรัทธา
เชื่อถือแกผูพบเห็น ชวยใหธุระการงานสําเร็จงายข้ึน ไดรับความรวมมือ และการติดตอดวยดี ไดรับ
ความสะดวกในการปฏิบัติหนาที่การงาน 

7. การยอมรับของกลุม คนที่มีบุคลิกภาพดียอมเปนที่ยอมรับของคนทั่วไป ใครๆ ก็
เรียกรองตองการ ชอบที่จะใหรวมอยูในกลุมทําใหเกิดความมั่นคงทางจิตใจ 

สรุปไดวาความสําคัญของบุคลิกภาพสามารถพิจารณาไดจาก ความมั่นใจ การคาดหมาย
พฤติกรรม การยอมรับความแตกตางระหวางบุคคล การตระหนักในเอกลักษณของบุคคล การ
ปรับตัวใหเขากับคนอ่ืนๆ ความสําเร็จและการยอมรับของกลุม 

 

ประเภทของบุคลิกภาพ 
ศรีธรรม ธนะภูมิ (2535) ไดกลาวถึงบุคลิกภาพของบุคคลที่อยูในเกณฑปกติซึ่งมีลักษณะ

เดน (Personal Traits) ของอุปนิสัยแตกตางกันไป ซึ่งในคนๆ เดียวอาจมีบุคลิกภาพมากกวา              
1 แบบได ลักษณะของบุคลิกภาพนี้จะแสดงออกชัดเจนเมื่อบุคคลเขาสูวัยผูใหญโดยแบงออกเปน 
12 ประเภท คือ 

1. บุคลิกภาพม่ันคง (Stable Personality) ไดแก ผูมีวุฒิภาวะของพัฒนาการทางอารมณ
และบุคลิกภาพสุขุมเยือกเย็น มีความรับผิดชอบสูง มีเหตุผล มีวิจารณญานในการแกปญหา 

2. บุคลิกภาพพึ่งพาผูอ่ืน (Dependent Personality) ไดแก ผูที่มีบุคลิกภาพออนแอ
ชวยเหลือตัวเองไมได 

3. บุคลิกภาพชอบหลีกเล่ียง (Avoidance Personality) ไดแก ผูที่ไมมั่นใจในการเขาสังคม 
กลัวการถูกตําหนิ พยายามหลีกเล่ียงกิจกรรมทางสังคม กลัวการถูกวิจารณและกลัวการเส่ียงภัย
ตางๆ 
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4. บุคลิกภาพด้ือเงียบ (Passive - Aggressive Personality) ไดแก ผูที่ชอบตอตานอยาง
เงียบๆ การแสดงพฤติกรรมที่เหมาะสมในฐานะสมาชิกของครอบครัวหรือในสังคมไมรับผิดชอบ
งาน ชอบอางเหตุผลเพื่อหลีกเล่ียงความผิดพลาดที่เกิดข้ึน 

5. บุคลิกภาพยํ้าคิดย้ําทํา (Obsessive Compulsive Personality) ไดแก บุคคล เจา
ระเบียบ เครงครัด ไมคอยยืดหยุน เขมงวดตอกฎเกณฑ ชอบบงการใหผูใกลชิดกระทําอยางที่ตน
ตองการ ไมไววางใจผูอ่ืนวาจะทํางานไดดีเสมอตน 

6. บุคลิกภาพหลงตนเอง (Narcissistic Personality) ไดแก คนที่มีลักษณะชื่นชมตนเอง
มากกวา มีความสามารถและประสบความสําเร็จสูง ออนไหวตอคําวิจารณของผูอ่ืนและไมคอย
เห็นอกเห็นใจผูอ่ืน เปนคนชอบอิจฉาริษยา ไมยินดีในความสําเร็จของผูอ่ืน 

7. บุคลิกภาพเรียกรองความสนใจ (Histrionic Personality) เปนคนเจาอารมณตองการ
คนสรรเสริญ ตองการการยอมรับและคําปลอบใจจากผูอ่ืนเสมอ อารมณเปล่ียนแปลงอยางรวดเร็ว          
ใชความเดนทางเพศของตนเองดึงดูดความสนใจจากผูอ่ืน 

8. บุคลิกภาพแบบก้ํากึ่ง (Borderline Personality) ไดแก ผูที่มีปญหาเกี่ยวกับความเปน
ตัวของตัวเอง (Identity) มีปญหาในการสรางมนุษยสัมพันธ อารมณเปล่ียนแปลงงายมีลักษณะ
หุนหันไมยั้งคิด ทําตามใจตนเอง อารมณแปรปรวน มีปญหาในการสรางความสัมพันธกับผูอ่ืนไม
แนใจในบทบาทของตนเอง 

9.บุคลิกภาพหุนหันพลันแลนและกาวราว (Impressive and Aggressive Personality)  
ไดแก ผูที่ไมวางแผนลวงหนาในการกระทําส่ิงตางๆ อารมณรอน โกรธงาย ควบคุมตนเองไดนอย 
ชอบทําส่ิงตางๆ อยางรวดเร็วและกาวราว 

10. บุคลิกภาพตอตานสังคม (Antisocial Personality) ชอบกอเร่ืองขัดแยงกับผูอ่ืนไม
สนใจความรูสึกของผูอ่ืน ไมสนใจกฎระเบียบตางๆ ชอบฝาฝนขอตกลงของหมูคณะเอาแตใจ ขาด
ความรับผิดชอบ 

11. บุคลิกภาพอารมณแปรปรวน (Affective Personality) ไดแก ผูที่มีอารมณเปลี่ยนแปลง
งาย เด๋ียวเศราสลับครึกคร้ืน ชอบแสดงออกอยางเปดเผย มีปญหาในการสรางมนุษยสัมพันธ 

12. บุคลิกภาพระแวง (Paranoid Personality) เปนผูชอบสงสัย ไมไววางใจในผูอ่ืน             
มองโลกในแงราย ไมคอยใหอภัยผูอ่ืน หากมีขอขัดแยงจะตอบโตรุนแรงและอาฆาตพยาบาท           
มักระแวงคูครองและผูใกลชิดวาไมซื่อสัตยตอตน 

13. บุคลิกภาพแยกตัว (Schizoid Personality) ไมชอบสังคม เปนคนเฉยๆไมแสดง
อารมณไมชอบแสดงความรักความสนิทสนมกับผูอ่ืน ชอบแยกตัวทําส่ิงตางๆ ตามลําพัง 
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แอริค ฟรอมม (Erich Fromm) นักสังคมศาสตรชาวเยอรมันนีไดอธิบายความเห็นตอการ
พัฒนาบุคลิกภาพวา “ โครงสรางของสังคมใดๆ ยอมกลอมเกลาบุคลิกภาพของสมาชิกใหเขากนัได
กับคานิยมสวนรวมของสังคมนั้นๆ” 

อับราฮัม มาสโลว (Abraham Maslow) นักจิตวิทยาชาวอเมริกัน ไดเสนอแนวคิดเกี่ยวกับ
ทฤษฎีทางบุคลิกภาพในชวงศตวรรษที่ 19-20 อยู 3 แนวคิดที่สําคัญ คือ 

1. แนวคิดกลุมจิตวิเคราะห เช่ือวาจิตใตสํานึกและพลังจูงใจที่ไรเหตุผล เปนตัวกระตุนให
คนทําพฤติกรรมนานาประการ รวมทั้งเปนตัวกําหนดลักษณะบุคลิกภาพของบุคคล 

2. แนวคิดกลุมพฤติกรรม มีทัศนะวาบุคลิกภาพของมนุษยยืดหยุนอยูใตอิทธิพลของ
สิ่งแวดลอมทางชีวภาพและทางสังคม มนุษยจะมีบุคลิกภาพอยางไรจะประสบความสําเร็จหรือไม
ข้ึนอยูกับลักษณะรูปแบบของส่ิงแวดลอมรอบตัว และเช่ือวาพฤติกรรมและบุคลิกภาพใดๆ อยู
ภายใตกฎเกณฑการเรียนรู 

3. แนวคิดกลุมมานุษยนิยม เปนแนวคิดที่มองธรรมชาติของมนุษยในแงดีงามวามนุษยมี
ความปรารถนาจะสรางสรรคความดี ความเจริญแหงตน และบุคลิกภาพของตน รูคุณคาในตนเอง          
มีความตองการที่จะรูจักตนและความสามารถเฉพาะตน  เพื่อจะไดนําพลังและความรู
ความสามารถดังกลาวมาใชไดอยางเต็มที่ 

สรุปไดวาประเภทของบุคลิกภาพสามารถแบงออกไดเปน 13 ประเภท ไดแก บุคลิกภาพที่
มั่นคง พึ่งพาผูอ่ืน ชอบหลีกเล่ียง ด้ือเงียบ ย้ําคิดย้ําทํา หลงตนเอง เรียกรองความสนใจ แบบก้ํากึ่ง 
หุนหันพลันแลนและกาวราว ตอตานสังคม อารมณแปรปรวน ระแวงและบุคลิกภาพแยกตัว 

จากการศึกษางานวิจัยของ ริชารดดี จอหนสัน (Richard D. Johnson, 2005) ไดกลาวถึง
ลักษณะของ บุคลิกภาพภายในไววา บุคลิกภาพภายในมีสวนทําใหเกิดการแสดงพฤติกรรมตางๆ 
ออกมาได บุคลิกภาพภายใน หมายถึง การรับรูในการประเมินตนเองเกี่ยวกับความสามารถในการ
กระทําส่ิงตางๆ ทั้งเชิงบวกและเชิงลบ ซึ่งแบงออกเปน 2 ดาน ไดแก การเห็นคุณคาในตนเองและ
ความออนไหวทางอารมณ 

 3.2.1 การเห็นคุณคาในตนเอง 
แบนดูรา (Bandura, 1986) ไดกลาววา  ความเห็นคุณคาในตนเอง หมายถึง การ

ประเมินตนเองของบุคคลวาตนเองเปนอยางไร ถาบุคคลใดมีความรูสึกวาตนเองเปนบุคคลที่ไรคา
จะกลาวไดวาบุคคลนั้นเปนผูมีความเห็นคุณคาในตนเองตํ่า ในขณะที่บุคคลใดไดแสดงความ
ภาคภูมิใจในตนเอง จะกลาวไดวาบุคคลนั้นเปนผูมีความเห็นคุณคาในตนเองสูง 
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คารเพนนิโต (Carpenito, 1983) กลาววา ความเห็นคุณคาในตนเองเปน
บุคลิกภาพอยางหนึ่งของบุคคลที่จะมีการตัดสินความมีคุณคาในตนเอง จากผลการประเมนิตนเอง
ในเร่ืองความสามารถและการยอมรับของสังคม 

นาตยา วงศหลีกภัย (2532) สรุปวา ความเห็นคุณคาในตนเอง หมายถึง ทัศนคติ
ที่บุคคลมีตอตนเอง มีความเคารพยอมรับในตนเองวามีความสําคัญ และความสามารถในการ
กระทําส่ิงตาง ๆ ใหประสบกับความสําเร็จ 

สรุปไดวา ความเห็นคุณคาในตนเองเปนผลรวมของแนวทางที่บุคคลรับรู และ
พิจารณาตัดสินคาของตนตามความรูสึกของทัศนคคติที่มีตอตนเองในเชิงบวก ในเร่ืองการประสบ
ความสําเร็จ  การยอมรับตนเอง การพึ่งตนเอง ความมั่นใจ คิดวาตนเองมีคาในสังคม  

3.2.2 ความออนไหวทางอารมณ 
ความออนไหวทางอารมณ หมายถึง ความคิดความรูสึกของผูเรียนที่มีตอตนเอง

ในดาน ความหดหู  อาการซึมเศรา ความรูสึกกังวลใจ  อาจจะมีอาการความกดดันเกิดข้ึนเมื่อ
ตนเองไดทํางานที่ลมเหลว ไมสามารถควบคุมการทํางานของตนเองได  เกิดความสงสัยใน
ความสามารถของตนเอง ซึ่งอาจจะนําไปสูความทอแทและส้ินหวังได 

 

3.3 ความมุงมั่นในการทํางาน 
ตามพจนานุกรม (2524) ไดใหความหมายของคําวา มุง มีความหมายวา ต้ังใจไว 
มั่น มีความหมายวา แน, แนนอน, แนน, แนนและทนทาน ไมขยับเขย้ือนหรือเปล่ียนแปลง

ไดงาย, แนนหนาทนทาน  
เมื่อไดนําคําวา มุง และม่ัน มารวมจึงเกิดคําวา มุงมั่น มีความหมายวา ต้ังใจไว แนนอนไม

เปล่ียนแปลงไดงาย 
สวนภาษาอังกฤษนั้น ใน Webster’s dictionary (1965) ไดกลาวถึงคําที่ตรงกับความ

มุงมั่นในภาษาไทยไวคือ คําวา “Intention” แปลวา ต้ังใจ เจตนา (intention = a determination to 
act in a certain way = การตัดสินที่จะกระทําในทาง/วิธีที่กําหนดไวอยางแนนอน) 

เม่ือนําคําวา”มุงมั่น” มาใชกับ “การทํางาน” เปน “ความมุงมั่นในการทํางาน” จึงนาจะมี
ความหมาย ความต้ังใจ แนวแนที่จะทํางานใหบรรลุความสําเร็จ มีความรับผิดชอบ ตอขอกําหนด
ของงาน มีการติดตามงานที่ทํา และหาวิธีการใหมๆ มาใชปฏิบัติงานใหดีข้ึนเร่ือยๆ 

ลักษณะของบุคคลที่มีความมุงมั่นในการทํางาน ไดแก บุคคลนั้นจะมีความเชื่อวาความ
พยายามและความฝกฝนทําใหบุคคลมีความสามารถและประสบความสําเร็จได  เขาสามารถ
เลือกทํางานที่เปดโอกาสใหตนเองไดเกิดการเรียนรู และจะตองรูสึกผิดหวังและเบื่อหนายถาตอง
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ทํางานที่งาย การเรียนรูที่เกิดข้ึนเกิดจากแรงจูงใจภายในของบุคคลนั้น  ตลอดจนพยายามหา
วิธีการเรียนรูตางๆ ที่ชวยทําใหการเรียนรูมีประสิทธิภาพมากข้ึนโดยทุมเทความพยายามอยางมาก
ในการเรียนรู ถึงแมไมประสบความสําเร็จ ก็ไมยกเลิกที่จะทํางานช้ินนั้น  สามารถประเมินผลงานที่
ทําโดยเปรียบเทียบกับตนเองวามีความกาวหนาไปมากนอยอยางไร  และเช่ือวาความพยายาม
และการฝกฝนทําใหบุคคลมีความสามารถและประสบความสําเร็จได  จะรูสึกพอใจกับผลงานที่
ตนเองตองทํา ถึงแมวางานที่ทําจะไมประสบความสําเร็จทั้งๆที่ไดพยายามอยางเต็มที่แลว  
ตองการทราบผลการเรียนรู เพื่อเปนขอมูลในการปรับปรุงการเรียนรูใหดีข้ึน  ผูเรียนจะคิดวา
ครูผูสอนคือแหลงขอมูลสามารถใหคําแนะนําตางๆได  และคิดวาความผิดพลาดเปนเร่ืองปกติและ
มีประโยชนในกระบวนการเรียนรู และสามารถนําเอาความผิดพลาดไปปรับปรุงการเรียนใหดีข้ึน 
และความผิดพลาดเปนตัวบงชี้ใหบุคคลเพ่ิมความพยายามในการทํางานใหมากข้ึน 

สรุปไดวาบุคคลที่มีความมุงมั่นในการทํางาน (Learning Goal Orientation) จะพยายาม
กระทํากิจกรรมตางๆที่จะชวยใหบุคคลสามารถเรียนรูไดดีข้ึน เชน มีความกระตือรือรน ต้ังใจเรียน 
ยอมรับขอบกพรองของตนเองได ไมทอถอยกับความลมเหลวที่เกิดข้ึน และคิดวาการพยายามและ
การฝกฝนเปนหนทางไปสูความสําเร็จ  

 

3.4 ความวิตกกังวลในการใชคอมพิวเตอร  
ความวิตกกังวลในการใชคอมพิวเตอรสามารถศึกษาไดจาก ความหมายของความวิตก

กังวล ประเภทของความวิตกกังวล กลไกการเกิดความวิตกกังวล สาเหตุของความวิตกกังวล ผล
ของความวิตกกังวล การประเมินความวิตกกังวล ระดับของความวิตกกังวลและความวิตกกังวลใน
การใชคอมพิวเตอร 

 

ความหมายของความวิตกกังวล  
ความวิตกกังวล (Anxiety) มีรากศัพทมาจากภาษากรีกและละติน รากศัพทที่มาจาก

ภาษากรีกมีความหมายวา “การกดหรือการรัดใหแนน” และรากศัพทภาษาละตินมีความหมายวา 
”ความแคบหรือความตีบตัน” จากรากศัพททั้ง 2 ภาษา ความหมายของความวิตกกังวลจะมี
ความหมายสอดคลองไปในทางเดียวกัน ซึ่งจะหมายถึง ความไมสุขสบาย ความกดดัน นอกจากนี้
ความหมายของความวิตกกังวลยังมีความหมายครอบคลุมไปถึง ความรูสึกหงุดหงิด ไมสบายใจ
ตอสถานการณที่ไมแนนอน ความรูสึกหวั่นเกรงตอผลที่จะเกิดข้ึน ความรูสึกกระสับกระสาย 
ความรูสึกอึดอัดไมสบายใจ ความรูสึกต่ืนตระหนก ความรูสึกไมมั่นใจเกี่ยวกับอนาคตลาดเดอร 
และมารค (Ladder &  Mark, 1971) 
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นอกจากนี้แลวยังมี นักจิตวิทยากลุมตางๆ ที่ไดสนใจศึกษาเกี่ยวกับความวิตกกังวล ก็จะ
ใหความหมายของความวิตกกังวลแตกตางกันออกไป ตามความเช่ือพื้นฐานของแตละกลุม
แนวความคิด ดังนี้ 

แนวคิดกลุมจิตวิเคราะหฟรอยด(Freud, 1943) ใหความหมายของความวิตกกังวลใน
ลักษณะที่เปนแรงขับพื้นฐานและเกี่ยวกับจิตไรสํานึก (uncondcious) โดยใหความหมายของ
ความวิตกกังวลไววา  เปนประสบการณ ความหวาดหวั่น ความตึงเครียด โดยมีสาเหตุที่ไมชัดเจน
ซึ่งสาเหตุที่ไมชัดเจนนี้มักจะเกี่ยวกับจิตไรสํานึก 

แนวคิดกลุมมนุษยนิยมโรเจอร (Roger, 1951) ไดใหความหมายของความวิตกกังวลโดย
เนนที่ความไมสอดคลองระหวางตนที่เปนจริง (Real self) และตนที่คาดหวัง (Ideal self) ซึ่ง
สภาวะเกิดความไมสอดคลองดังกลาวนี้จะทําใหเกิดความไมสมดุลทางจิตใจ ซึ่งจะเปนพื้นฐาน
ของการเกิดความวิตกกังวล 

แนวคิดกลุมปญญานิยมเบค (Beck, 1972) ไดใหความหมายของความวิตกกังวลวาเปน
ผลจากสภาพความกดดัน ที่บุคคลรับรูและประเมินจากสถานการณ ดังนั้นตามแนวคิดกลุมนี้จะให
ความสําคัญกับความคิดมากกวาสภาพความกดดันที่เกิดจริง กลาวคือ เมื่อมีสถานการณเกิดข้ึน
บุคคลจะรับรูและประเมินสถานการณที่เกิดข้ึนวาเปนการคุกคามหรือไม  ถาประเมินสถานการณ
วาเปนการคุกคาม สถานการณนั้นจะกลายเปนสถานการณที่กดดัน และจะกระตุนเกิดความวิตก
กังวล แตถาบุคคลประเมินสถานการณวาไมเปนการคุกคาม  สถานการณนั้นก็จะไมเปนความ
กดดัน สถานการณนั้นจะไมเปนส่ิงเราที่ทําใหเกิดความวิตกกังวล 

จากแนวความคิดของนักจิตวิทยากลุมตางๆ นั้นจะมีความหมายสอดคลองกันในสวนที่
กลาวถึงพฤติกรรมที่แสดงออกถึงความวิตกกังวล เชน รูสึกหวาดหวั่น รูสึกตึงเครียด ไมสบายใจ 
ฯลฯ  แตจะอธิบายการเกิดความวิตกกังวลตางกันออกไป คือ กลุมจิตวิเคราะหจะใหความสําคัญ
กับแรงขับพื้นฐานและจิตไรสํานึก กลุมมนุษยนิยมเนนที่ความไมสอดคลองกันระหวางคนที่
คาดหวังกับคนที่เปนจริง  แนวคิดปญญานิยมเนนที่การรับรูและประเมินสถานการณวาจะเปน
สถานการณที่รูสึกคุกคามหรือไม 

ฮอทสแมน (Holtzman, 1976) ไดกลาววาความวิตกกังวลจะเกิดข้ึนเมื่อบุคคลรับรูเปนส่ิง
เรานั้นวาเปนส่ิงเราที่มาคุกคามตนเอง และการประเมินวาส่ิงเรานั้นเปนภาวะคุกคามหรือไม จะ
ไดรับอิทธิพลจากความวิตกกังวลที่เปนคุณลักษณะเฉพาะตัวดวย ถาหากบุคคลประเมินวาส่ิงเรา
นั้นคุกคามตอตนก็จะทําใหเกิดความวิตกกังวลโดยมีการแสดงออกดังนี้ 
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1. มีการกระตุนการทํางานของระบบประสาทสวนกลาง ทําใหเกิดการเปล่ียนแปลงทางสรีระ  
2. เกิดความวิตกกังวลตอสภาพการณ 
3. มีการใชกลไกการเผชิญความเครียด (Coping mechanism) เพื่อจํากัดสาเหตุของ

ความวิตกกังวล หรือเพื่อลดความวิตกกังวล 
การแสดงออกของความวิตกกังวล ทั้ง 3 ประการนี้ จะมีปฏิสัมพันธซึ่งกันและกันและจาก

การรับรูการเปลี่ยนแปลงทางสรีระ จะทําใหบุคคลประเมินความรูสึกวารูสึกวิตกกังวล จึงทําให
พยายามหาวิธีลดความวิตกกังวล โดยใหเปล่ียนสภาพแวดลอมที่ทําใหเกิดความวิตกกังวล
พยายามเรียนรูที่จะแสดงออกอยางเหมาะสม มีการประเมินส่ิงเราใหมและเรียนรูวิธีลดความวิตก
กังวลโดยตรง เพื่อลดการกระตุนระบบประสาทสวนกลางและการเปล่ียนแปลงทางสรีระ 

สรุปไดวา ความวิตกกังวล หมายถึง พฤติกรรมที่แสดงออกถึงความวิตกกังวล เชน รูสึก
หวาดหวั่น รูสึกตึงเครียด ไมสบายใจ ตอส่ิงใดสิ่งหนึ่ง 

ประเภทของความวิตกกงัวล 
 สปลเบอรเกอร (Spielberger, 1972) ไดแบงความวิตกกังวลออกเปน 2 ประเภท คือ 
 1. ความวิตกกังวลตอสภาพการณ (State anxiety) เปนความวิตกกังวลที่เกิดข้ึนจากการ
ตอบสนองเฉพาะอยาง โดยจะเกิดข้ึนทันทีทันใดเมื่อมีส่ิงเรามากระตุนใหเกิดความไมพอใจหรือทํา
ใหเกิดอันตราย มีผลทําใหเกิดพฤติกรรมตอบสนองตอส่ิงเรานั้น โดยท่ีในชวงเวลาที่ถูกกระตุนเรา
นั้น จะเปนภาวะที่ตึงเครียด หวาดหว่ัน กระวนกระวาย มีการตื่นตัวของระบบประสาทอัตโนมัติ ซึ่ง
ความรุนแรงที่แสดงออกตอสภาวะเชนนี้ จะแตกตางกันไปตามความแตกตางระหวางบุคคล 
 2. ความวิตกกังวลที่เปนลักษณะประจําตัว (Trait anxiety) เปนความวิตกกังวลที่มีอยูใน
ตัวบุคคลจนกลายเปนลักษณะประจําตัวและมีลักษณะคงที่ และความวิตกกังวลที่เปนลักษณะ
ประจําตัวนี้จะไมปรากฏออกมาเปนพฤติกรรม แตจะเปนตัวเสริมของความวิตกกังวลตอ
สถานการณ คือ เมื่อมีส่ิงเรามากระตุนใหเกิดความไมพอใจหรือทําใหเกิดอันตราย  บุคคลที่มี
ความวิตกกังวลที่เปนลักษณะประจําตัวสูง จะมีความไวในการรับรูส่ิงเราที่ทําใหไมพอใจหรือทําให
เกิดอันตรายไดเร็วกวาบุคคลท่ีมีความวิตกกังวลที่เปนลักษณะประจําตัวตํ่า นอกจากนี้ความวิตก
กังวลที่ เปนลักษณะประจําตัว  และมีผลตอความรุนแรงของการเกิดความวิตกกังวลตอ
สถานการณ 

สรุปไดวาความวิตกกังวลที่เปนลักษณะประจําตัวจะเปนลักษณะประจําตัวของบุคคลที่มี
แนวโนมที่จะเกิดความวิตกกังวล ซึ่งเปนลักษณะของบุคลิกภาพที่ฝงแนนของแตละบุคคล แต
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ความวิตกกังวลตอสภาพการณ จะมีลักษณะเกิดข้ึนเฉพาะสถานการณ คือจะเกิดข้ึนเมื่อไดเผชิญ
กับสถานการณที่ถูกคุกคาม และเกิดข้ึนช่ัวคราวเฉพาะสถานการณ 

นอกจากแนวความคิดในการแบงประเภทของความวิตกกังวลออกเปน ความวิตกกังวลตอ
สภาพการณและความวิตกกังวลที่เปนลักษณะประจําตัวแลว Sarason et al. (1960) ไดแบง
ประเภทของความวิตกกังวลออกเปน ความวิตกกังวลตอสถานการณทั่วไป (Genaral anxiety) ซึ่ง
เปนความวิตกกังวลที่เกิดข้ึนโดยไมมีสถานการณเปนตัวกระตุนเราอยางเฉพาะเจาะจง และความ
วิตกกังวลตอสถานการณเฉพาะ (Specific anxiety) ซึ่งเปนความวิตกกังวลที่เกิดจากการ                      
มีปฏิกิริยาตอบสนองตอสถานการณที่มาคุกคามเฉพาะอยาง เชน การสอบ การเรียน การพูดหนาช้ัน 

กลไกการเกิดความวิตกกังวล 
 เอนดเลอรและเอ็ดเวิด (Endler & Edwards, 1982) อธิบายวาเม่ือบุคคลและส่ิงแวดลอม
มีปฏิสัมพันธซึ่งกันและกัน  บุคคลจะประเมินสถานการณที่เกิดข้ึนวาเปนภาวะคุกคามหรือไม              
ซึ่งการประเมินนี้จะมีความแตกตางกันออกไปตามลักษณะความวิตกกังวลที่เปนลักษณะ
ประจําตัว (Trait anxiety)ของแตละบุคคลและความรุนแรงของสถานการณที่เกิดข้ึน เมื่อบุคคล
ประเมินวาสถานการณนั้นเปนภาวะคุกคาม จะมีผลทําใหเกิดความวิตกกังวลตอสภาพการณ 
(State anxiety) และมีปฏิกิริยาตอบสนองตอความวิตกกังวลตามแผนภาพที่ 2.5 
 
 
 
 
 
 
 
 
 
 
แผนภาพที่ 2.5 กลไกการเกิดความวิตกกังวล 
ที่มา : Endler และ Edwards, 1982 

สถานการณ 
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สรุปไดวากลไกการเกิดความวิตกกังวลจะเกิดจากสถานการณและความวิตกกังวลที่เปน
ลักษณะประจําตัวซ่ึงสงผลทําใหเกิดการรับรูสถานการณ อันจะมีผลใหเกิดความวิตกกังวลในเวลา
ตอมา 

สาเหตุของความวิตกกังวล 
เอปสไตน (Epstein, 1972) ไดสรุปสาเหตุของความวิตกกังวลวาเกิดจากสาเหตุ 3 ประการ 

คือ  
 1. สาเหตุจากการมีส่ิงเราทางกายภาพมากระตุนเราบุคคล จนเกิดขีดระดับความสามารถ
ของบุคคลที่จะทนได ดังนั้นการตอบสนองตอความวิตกกังวลที่มาจากสาเหตุนี้จะแสดงออกมาเปน
ความเจ็บปวด แลวมีผลทําใหเกิดความกลัวและวิตกกังวล นอกจากนี้แลวขีดระดับความสามารถ
ของบุคคลที่จะทนตอส่ิงเราที่มากระตุนนั้น จะมีความแตกตางระหวางบุคคล 

2. สาเหตุจากความไมสอดคลองกันของความคิด คือ ความไมสอดคลองกันระหวาง
ประสบการณของตนและความคาดหวัง นั้นหมายความวาเกิดความไมสอดคลองกันระหวางความ
จริงและความคาดหวัง ซึ่งจะเปนภาวะที่รูสึกถูกคุกคามและนําไปสูการเกิดอาการวิตกกังวล 

3. สาเหตุจากความไมสามารถตอบสนองตอส่ิงเราที่เกิดข้ึนได ซึ่งอาจเกิดจากการไมรูส่ิง
เราใดเปนตัวกระตุนใหเกิดความวิตกกังวล และเกิดจากการขัดแยงระหวางการที่จะตองเลือกการ
ตอบสนอง ซึ่งภาวะเชนนี้จะนําไปสูการใหการเกิดความวิตกกังวล 

สรุปไดวาสาเหตุของความวิตกกังวลเกิดจากสาเหตุ คือ มีส่ิงเรามากระตุนบุคคลจนเกิน
ขีดความสามารถที่จะทนได ความไมสอดคลองกันทางความคิด และความไมตอบสนองตอส่ิงเราที่
เกิดข้ึนได 

ผลของความวิตกกังวล  
โกลดเบอรเกอร (Goldberger, 1982) ไดกลาวถึงผลกระทบของความวิตกกังวล คือ 

ความวิตกกังวลจะทําใหเกิดผลกระทบตอบุคคลในดานสรีระ อารมณ ความคิด และพฤติกรรมซ่ึงมี
รายละเอียดดังนี้ 

1. ดานชีวเคมี  ในขณะที่เกิดความวิตกกังวล จะทําใหระบบประสาทอัตโนมัติถูกกระตุน
แลวมีผลตอการทํางานของสมองและตอมไรทอ คือในขณะที่เกิดความวิตกกังวลตอมอดรีนาล 
(Adrenal medulla) จะหล่ังสารอดรีนาลิน (Adrenaline) และทําใหระดับของฮอรโมนบางชนิดใน
เลือดเพิ่มสูงข้ึน เชน อิพิเนฟริน (Epinephrene) และคอรติโคสเตรียรอยด (Corticceteriods) 

2. ดานสรีระ การเปล่ียนแปลงทางดานสรีระนั้นสวนมากจะเกิดข้ึนกับระบบประสาท
อัตโนมัติ ระบบกลามเนื้อ และระบบขับถาย การเปล่ียนแปลงทางระบบประสาทอัตโนมัติมักจะ
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เปนผลสืบเนื่องมาจากการเปล่ียนแปลงทางดานเคมี เชน สารอดรีนาลินจะมีผลทําใหอัตราการ
ไหลเวียนของเลือดมีมากข้ึน รางกายขับน้ํายอยมากกวาปกติ สารอิพิเนฟริน จะมีผลทําใหหัว
ใจเตนเร็วและเตนแรง ใจส่ัน ขนลุก เหงื่อออกงาย เพิ่มอัตราการเผาผลาญอาหาร สารคอรติโคส เต
รียรอยด จะมีผลตอระบบประสาทสวนกลาง เชน ทําใหนอนไมหลับ กระวนกระวาย รางกายขาด
ภูมิตานทานโรค การเปล่ียนแปลงเก่ียวกับระบบกลามเนื้อไดแกการเกิดอาการเกร็งของกลามเนื้อ 
ทําใหรูสึกปวดเมื่อยตามรางกาย การเปล่ียนแปลงเกี่ยวกับระบบขับถาย ไดแก อาการคล่ืนไส 
อาเจียน ทองอืดทองเฟอ ทองผูกหรือทองเสีย ปสสาวะบอย 

3. ดานอารมณ ผลของความวิตกกังวลที่มีตออารมณนั้น จะทําใหเกิดอาการต่ืนเตน 
หวาดหวั่น หงุดหงิด ตกใจงาย โกรธงาย กระสับกระสาย ขาดสมาธิ เหนื่อยหนาย ทอแท โศกเศรา 
เสียใจ รองไหบอย เปนตน 

4. ดานความคิด ความจําและการรับรู ผลของความวิตกกังวลจะทําใหเกิดความผิดปกติ
เกี่ยวกับความคิดไดแก การเกิดความคิดในทางลบ ระบบความคิดถูกรบกวน สับสน หมกมุน ย้ํา
คิด การตัดสินใจชา ไมยืดหยุนในการแกปญหา ความสนใจลดลง ขาดสมาธิ ฯลฯ ความผิดปกติ
เกี่ยวกับความจําไดแก มีอาการหลงลืม ความสามารถเกี่ยวกับจําลดลง และมีความผิดปกติ
เกี่ยวกับการเรียนรู 

สรุปไดวาผลของความวิตกกังวลจะสงกระทบใหเกิดกับบุคคล 4 ดาน ไดแก ดานชีวเคมี 
ดานสรีระ ดานอารมณและดานความคิด 

 

การประเมินความวิตกกังวล  
 เบราทีน (Beratein, 1973) ไดเสนอวาการประเมินความวิตกกังวลนั้นกระทําได 3 วิธี คือ 

1. การประเมินจากการรายงานตนเอง คือ ใหบุคคลรายงานความรูสึกวิตกกังวลดวย
ตนเอง ซึ่งอาจกระทําโดยการสัมภาษณ การจินตนาการ และการตอบแบบสอบถาม โดยเฉพาะ
การใชแบบสอบถามนั้นมักจะนํามาใชบอย เนื่องจากเปนวิธีที่สะดวกและใชไดผลดี 
 2. การประเมินจากการเปล่ียนแปลงทางสรีระ คือ เปนการประเมินจากการเปล่ียนแปลง
ทางสรีระที่เปนผลมาจากการทํางานของระบบประสาทอัตโนมัติ ไดแก การวัดความดันโลหิต การ
วัดอัตราการหายใจ การวัดการเตนของหัวใจ การวัดอาการเกร็งของกลามเนื้อ การวัดความ
ตานทานไฟฟาที่ฝามือ ฯลฯ 

3. การประเมินจากการสังเกตพฤติกรรม โดยการสังเกตพฤติกรรมโดยตรงหรือโดย
ทางออม การสังเกตโดยตรงจะเปนการสังเกตอาการที่แสดงออกถึงความเครียดโดยตรง เชน การ
หายใจ มือส่ัน กัดริมฝปาก ถอนหายใจ สวนการสังเกตพฤติกรรมทางออม กระทําไดโดยการให
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แสดงบทบาทสมมติแลวสังเกตพฤติกรรมความวิตกกังวลหรืออาจจะใหบุคคลอยูในสถานการณที่
ทําใหเกิดความวิตกกังวล แลวสังเกตพฤติกรรมความวิตกกังวล 
 สรุปไดวาการประเมินความวิตกกังวลสามารถประเมินได คือ การประเมินจากการรายงาน
ตนเอง จากการเปล่ียนแปลงทางสรีระและจากการสังเกตพฤติกรรม 

ระดับของความวิตกกังวล 
จอหนสัน (Johnson, 1986) ไดแบงระดับความรุนแรงของความวิตกกังวลออกเปน 4 

ระดับ ดังนี้ 
1. ความวิตกกังวลระดับเล็กนอย (Mild anxiety)  เปนความวิตกกังวลในระดับที่กระตุนให

บุคคลเกิดความต่ืนตัว กระตุนประสาทรับสัมผัสทั้ง 5 ใหรับรูไดอยางมีประสิทธิภาพมากข้ึน ทําให
เรียนรูและแกปญหาไดดีข้ึน และทําใหเกิดความคิดสรางสรรค 

2. ความวิตกกังวลระดับปานกลาง (Moderate anxiety) เปนความวิตกกังวลในระดับที่ทํา
ใหบุคคลสนใจตอความวิตกกังวลที่ เกิดข้ึน มีผลทําใหการรับรูประสาทสัมผัสทั้ง 5 ลดลง 
ความสามารถเกี่ยวกับการเรียนรูลดลง รางกายมีปฏิกิริยาตอบสนองตอความวิตกกังวลในการ
สอบ เชน มีอาการเกร็งของกลามเนื้อ มีอาการปนปวนภายในทอง มีอาการหอบหายใจเขาออกแรง 
ปวดศีรษะ เปนตน 

3. ความวิตกกังวลระดับสูง (Serve anxiety) เปนความวิตกกังวลในระดับที่ทําใหการรับรู
ประสาทสัมผัสทั้ง 5 ลดลงอยางมาก จนอาจทําใหรับรูสภาพแวดลอมบิดเบือนไปจากความเปน
จริง รับรูรายละเอียดของเหตุการณที่เกิดข้ึนเพียงบางสวน ทําใหไมสามารถเช่ือมโยงรายละเอียด
ของเหตุการณทั้งหมดที่เกิดข้ึนได และบุคคลมีปฏิกิริยาตอบสนองตอความวิตกกังวลทั้งทาง
รางกาย อารมณ และพฤติกรรม 

4. ความวิตกกังวลระดับรุนแรงที่สุด (Panic anxiety) เปนความวิตกกังวลในระดับที่ทําให
บุคคลรับรูสภาพแวดลอมผิดไปจากความเปนจริงจนอาจมีอาการของประสาทหลอน บุคคล
สูญเสียการควบคุมตนเอง บุคลิกภาพและความคิดผิดปกติจนอาจมีอาการหลงผิด ความสามารถ
เกี่ยวกับการเรียนรูเสียไป รางกายมีการตอบสนองตอความวิตกกังวลอยางรุนแรง 

ความวิตกกังวลไมใชสภาวะอารมณที่มีผลในทางลบเพียงอยางเดียว ความวิตกกังวลใน
ระดับเล็กนอยและปานกลาง จะมีประโยชนเปนตัวกระตุนใหเกิดการต่ืนตัวใหเกิดการเรียนรู
แกปญหา ทํากิจกรรมตางๆใหดีข้ึน และเกิดความคิดสรางสรรค แตความวิตกกังวลในระดับสูงและ
รุนแรงที่ สุด จะมีผลในทางลบ  ทําให เกิดพยาธิสภาพทางจิตใจจนอาจทําใหเกิดโรคจิต                         
โรคประสาทได 
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 สรุปไดวาความวิตกกังวล ไดแบงออกเปน 4 ระดับ คือ ระดับเล็กนอย ปานกลาง สูงและ
รุนแรงที่สุด ซึ่งแตละระดับก็จะมีผลความรุนแรงที่แตกตางกันออกไป 

 

ความวิตกกังวลในการใชคอมพิวเตอร 
นักวิจัยไดใหความหมายของคําวา ความวิตกเกี่ยวกับคอมพิวเตอร (Computer Anxiety) 

คืออาการทางจิตวิทยาที่บุคคลมีปฏิกริยาทางลบตอการใชคอมพิวเตอร อาการที่แสดงออก เชน 
ครุนคิดตลอดเวลาถึงความอันตราย กลัววาตนเองจะตกเปนทาสของเทคโนโลยี ไมสามารถ
ควบคุมสถานการณไดดวยตนเอง กลัววาคอมพิวเตอรจะเขามาแทนที่มนุษย อับอาย ทอแท ต่ืน
กลัววาจะแสดงความไมรูของตนเองออกไป 

การศึกษาในดานความวิตกกังวลเมื่อใชคอมพิวเตอรแสดงใหเห็นปรากฎการณของความ
วิตกและไดต้ังช่ือผูที่มีอาการตาง ๆ ไวคือ ซีเอ (CA) ที่รูจักกันดีวาเปนชื่อเรียกผูที่กลัวคอมพิวเตอร
(Computerphobia) ผูที่กลัวเทคโนโลยี (Technophobia) ฯลฯ บุคคลที่มีอาการซีเอ มักถูกจัดอยู
ในกลุมที่มีอาการกลัวคอมพิวเตอร และเทคโนโลยี หรือบางคร้ังก็ถูกเรียกวาเปนผูไมมีการศึกษา
ดานคอมพิวเตอร (computer illiterate) ความกลัวเทคโนโลยีเกิดข้ึนไดในหลากหลายลักษณะและ
มีอาการแตกตางกันดังนี้ 

1. ผูใชที่อึดอัดขัดของ (The uncomfortable user) เปนกลุมที่จัดไดวามีความกังวลตํ่า 
และไมจําเปนตองมีการใหความชวยเหลือเปนพิเศษ หรือชวยเหลือเปนรายบุคคล กลุมนี้ขาดเพียง
การสนับสนุนทางเทคนิควิธี หรือขอมูล เพื่อที่จะขับไลความไมรู หรือเรียนรูถึงความเปนจริงของ
คอมพิวเตอรเทคโนโลยี 

2. พวกกลัวคอมพิวเตอรที่มีความวิตก (The anxious computerphobic) เปนกลุมที่แสดง
อาการอยางชัดเจนวาวิตกกังวล เชนเหงื่อออกตามมือ ส่ัน ปวดศรีษะ ฯลฯ 

3. พวกกลัวคอมพิวเตอรแตภายนอกสงบนิ่ง (The outwardly calm computerphobic)    
คนกลุมนี้มีอาการสงบถาสังเกตจากภายนอก แตภายในใจจะเต็มไปดวยความวาวุน และถอยคําที่
ตอตานคอมพิวเตอร เชน “ใคร ๆก็รูวิธีทํา (งานกับคอมพิวเตอร) ยกเวนฉัน” หรือ “ฉันกําลังจะกด
ปุมผิดแน ๆ แลวเจาเคร่ืองนี่จะพัง” โรเซน(Rosen, 1993) 

อยางไรก็ตามเมื่อกลาวถึงความวิตกกังวลในการใชคอมพิวเตอรอาจมีชื่อเรียกอ่ืน ๆ อีกแต
ทายที่สุด อาการตาง ๆ จะเกี่ยวของกับความกลัวเทคโนโลยีคอมพิวเตอรทั้งส้ิน และเปนปจจัยหนึ่ง     
ที่เปนอุปสรรคตอการสรางสังคมคอมพิวเตอร (Computerized society) 
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ดังนั้นความวิตกกังวลในการใชคอมพิวเตอร จึงเปนความรูสึกของสภาวะจิตใจของผูเรียน
ที่มีตอการใชคอมพิวเตอรที่ทําใหผูเรียนเกิดความคิดดานลบตอตนเอง ในเร่ืองของการเรียน และ
การใชงานทางดานคอมพิวเตอร 

 

ตอนท่ี 4 แนวคิดทฤษฎีเกี่ยวกับความสามารถทางคอมพิวเตอรและปจจัยที่สงผลตอ
ความสามารถทางคอมพิวเตอร 

ในตอนนี ้ผู ว ิจ ัยได รวบรวมแนวคิดและทฤษฎีที ่เกี ่ยวข องก ับความสามารถทาง
คอมพิวเตอรและปจจัยที่สงผลตอความสามารถทางคอมพิวเตอร ดังนี้ 

 

สาระและมาตรฐานการเรยีนรูของกลุมการงานอาชีพและเทคโนโลยี  
ผูวิจัยนําสาระและมาตรฐานการเรียนรู กลุมการงานอาชีพและเทคโนโลยีนี้มาเปน

สาระสําคัญในการศึกษาหาตัวแปรสําหรับใชวัดความสามารถทางคอมพิวเตอรของนักเรียนชวงชัน้
ที่ 4 โดยพิจารณาจากเน้ือหาที่มีความเหมาะสมกับระดับชวงช้ันของนักเรียนในรายวิชา
คอมพิวเตอร ตามที่สาระและมาตรฐานการเรียนรูไดกําหนดไว ดังนี้ 

ในบทนําของสาระและมาตรฐานการเรียนรู กลุมการงานอาชีพและเทคโนโลยีกลาวไววา 
การพัฒนาผูเรียนตามหลักสูตรการศึกษาข้ันพื้นฐาน จะมุงพัฒนาใหเปนคนที่สมบูรณและสมดุล
ทั้งดานจิตใจ รางกาย สติปญญา อารมณ และสังคม โดยมุงเนนการพัฒนาใหผูเรียนมีความรู 
ความสามารถ ทั้งดานวิชาการ วิชางาน และวิชาชีวิต เพื่อใหสามารถดํารงชีวิตอยูในสังคมไดอยาง
มีความสุข พึ่งตนเองได อยูรวมกับผูอ่ืนอยางสรางสรรค พัฒนาสังคมและส่ิงแวดลอม  โดยที่สาระ
การเรียนรูกลุมการงานอาชีพและเทคโนโลยี เปนกลุมสาระการเรียนรูที่มุงเนนพัฒนาใหผูเรียนมี
ทักษะในการทํางาน ทํางานเปน รักการทํางาน ทํางานรวมกับผูอ่ืนได มีความสามารถในการ
จัดการ การวางแผนออกแบบการทํางาน สามารถนําเอาความรูเทคโนโลยีและเทคโนโลยี
สารสนเทศมาใช และประยุกตใชในการทํางาน สราง พัฒนางาน ผลิตภัณฑตลอดจนวิธีการใหม
เพื่อพัฒนาคุณภาพของงานและการทํางาน 

กลุมการงานอาชีพและเทคโนโลยีมีวิสัยทัศนที่เนนใหผูเรียนไดฝกกระบวนการทํางานและ
จัดการอยางเปนระบบ พัฒนาความคิดสรางสรรค มีทักษะการออกแบบงานและสามารถทํางานได
อยางมีกลยุทธ โดยใชกระบวนการของเทคโนโลยีสารสนเทศ ตลอดจนนักเรียนสามารถนํา
เทคโนโลยีมาประยุกตใชในการทํางาน สราง พัฒนา ผลิตภัณฑ หรือคิดคนวิธีการใหมที่เนนการใช
ทรัพยากรธรรมชาติ ส่ิงแวดลอมและพลังงานอยางประหยัดและคุมคา ดังนั้นเพื่อใหบรรลุวิสัยทัศน
ดังกลาว กลุมการงานอาชีพและเทคโนโลยี จึงกําหนดการเรียนรูที่ยึดงานกระบวนการจัดการและ
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การแกปญหาเปนสําคัญบนพื้นฐานของการใชหลักการและทฤษฎีเปนหลักในการทํางานและการ
แกปญหา งานท่ีนํามาฝกฝนเพื่อบรรลุวิสัยทัศนของกลุมนั้น เปนงานเพ่ือการดําเนินชีวิตใน
ครอบครัวและสังคมและงานเพื่อการประกอบอาชีพ ซึ่งงานทั้ง 2 ประเภทนี้ เมื่อผูเรียนไดรับการ
ฝกฝนและปฏิบัติตามกระบวนการเรียนรูของกลุมการงานอาชีพและเทคโนโลยีแลว ผูเรียนจะไดรับ
การปลูกฝงและพัฒนาใหมีคุณภาพและคุณธรรม การเรียนรูจากการทํางานและการแกปญหาของ
กลุมการงานอาชีพและเทคโนโลยี จึงเปนการเรียนรูที่เกิดจากการบูรณาการความรู ทักษะ และ
ความดีที่หลอมรวมกันจนกอเกิดเปนคุณลักษณะของผูเรียน ทั้งดานคุณภาพและคุณธรรมตาม
มาตรฐานการเรียนรูที่กําหนด 

ในดานคุณภาพของผูเรียน กลุมการงานอาชีพและเทคโนโลยีมุงพัฒนาผูเรียนแบบองค
รวมเพื่อใหเปนคนดี มีความรู ความสามารถ โดยมีคุณลักษณะที่พึงประสงคดังนี้ มีความรูความ
เขาใจเกี่ยวกับการดํารงชีวิตและครอบครัว การอาชีพ การออกแบบ และเทคโนโลยี เทคโนโลยี
สารสนเทศ เทคโนโลยีเพื่อการทํางาน และอาชีพมีทักษะในการทํางาน การประกอบอาชีพ การ
จัดการ การแสวงหาความรูเลือกใชเทคโนโลยีและเทคโนโลยีสารสนเทศในการทํางาน สามารถ
ทํางานอยางมีกลยุทธ สรางและพัฒนาผลิตภัณฑหรือวิธีการใหมมีความรับผิดชอบ ซื่อสัตย ขยัน 
อดทน รักการทํางาน ประหยัด อดออม ตรงตอเวลา เอ้ือเฟอ เสียสละ และมีวินัยในการทํางาน เหน็
คุณคาความสําคัญของงานและอาชีพสุจริต ตระหนักถึงความสําคัญของสารสนเทศ การอนุรักษ
ทรัพยากรธรรมชาติ ส่ิงแวดลอม และพลังงาน 

โดยสาระการเรียนรูของเทคโนโลยีสารสนเทศ 12 ป มีรายละเอียดดังนี้ 
1. ขอมูลและสารสนเทศ 
แหลงขอมูล ความหมายและประโยชนของขอมูล การรวบรวมขอมูล ประเภทของขอมูล    

การจัดเก็บขอมูลในรูปแบบที่เหมาะสม การประมวลผลขอมูลเปนสารสนเทศ การเก็บและ
บํารุงรักษาขอมูล ซอฟตแวรชวยประมวลผลขอมูล 

2. เทคโนโลยีสารสนเทศ 
องคประกอบของการผลิตสารสนเทศ บทบาทและประโยชนของเทคโนโลยีสารสนเทศ 

สวนประกอบและอุปกรณของเครื่องคอมพิวเตอร หลักการทํางานของเครื่องคอมพิวเตอร 
ซอฟตแวร คอมพิวเตอรระบบมัลติมีเดีย 

3. การสื่อสารขอมูลและเครือขาย 
การสื่อสารขอมูล สวนประกอบของเครือขายคอมพิวเตอร เครือขายอินเทอรเน็ตการคนหา

และการสืบคนขอมูล 



 56
 

4. หลักการแกไขปญหาหรือสรางงาน 
หลักการคิดคํานวณพื้นฐานในการประมวลผลขอมูล หลักการเร่ิมตนในการแกไขปญหา 

ข้ันตอนในการพัฒนาโปรแกรม และภาษาโปรแกรม การใชซอฟตแวรสําเร็จ ตรรกะ ระบบเลขฐาน
และวงจรตรรกะ 

5. โครงสรางงาน 
การนําเสนอขอมูล การวางแผนงาน การสรางงานตามวัตถุประสงคของงาน การจัดทํา

คูมือ การบํารุงรักษาโปรแกรมและขอมูล 
6. หลักการพื้นฐานของคอมพิวเตอร 
กลไกการทํางาน รูปแบบการทํางาน ภาษาคอมพิวเตอรระดับตํ่า 
7. การจัดขอมูล 
การจัดขอมูลเบ้ืองตน โครงสรางขอมูล การจัดการฐานขอมูล 
 

ตัวชี้วัดและสาระการเรียนรูแกนกลาง กลุมสาระการเรียนรูการงานอาชีพและ
เทคโนโลยีตามหลักสูตรแกนกลางการศึกษาขั้นพื้นฐาน 

นอกจากนี้ผูวิจัยจึงไดนําคูมือตัวชี้วัดและสาระการเรียนรูแกนกลางของกลุมสาระการ
เรียนรูการงานอาชีพและเทคโนโลยีตามหลักสูตรการศึกษาข้ันพื้นฐาน พุทธศักราช 2551 มา
พิจารณาในการศึกษาหาตัวแปรสําหรับใชวัดความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ัน       
ที่ 4 ประกอบเพิ่มเติม คือ ในสาระที่ 3 เทคโนโลยีสารสนเทศและการส่ือสาร (มาตรฐาน ง 3.1) ได
เนนใหผูเรียนเขาใจ เห็นคุณคาและสามารถใชกระบวนการเทคโนโลยีสารสนเทศในการสืบคน
ขอมูล การเรียนรู การสื่อสาร การแกปญหา การทํางาน และอาชีพอยางมีประสิทธิภาพประสิทธผิล
อยางมีคุณธรรม โดยในดานคุณภาพของผูเรียน คือ ใหผูเรียนสามารถเขาใจความสัมพันธระหวาง
เทคโนโลยีกับศาสตรอ่ืนๆ วิเคราะหระบบเทคโนโลยี มีความคิดสรางสรรคในการแกปญหาหรือ
สนองความตองการ สรางและพัฒนาส่ิงของเคร่ืองใชหรือวิธีการตามกระบวนการเทคโนโลยีอยาง
ปลอดภัย โดยใชซอฟตแวรในการออกแบบหรือนําเสนอผลงานวิเคราะหและเลือกใชเทคโนโลยีที่
เหมาะสมกับชีวิตประจําวันอยางสรางสรรคตอชีวิต สังคม ส่ิงแวดลอมและมีการจัดการเทคโนโลยี
ดวยวิธีการของเทคโนโลยีสะอาด ใชคอมพิวเตอรในการประมวลผลขอมูลใหเปนสารสนเทศเพื่อ
การตัดสินใจใชเทคโนโลยีนําเสนอผลงาน 
  

จากการศึกษาสาระและมาตรฐานการเรียนรู กลุมการงานอาชีพและเทคโนโลยี และคูมือ
ตัวชี้วัดและสาระการเรียนรูแกนกลางของกลุมสาระการเรียนรูการงานอาชีพและเทคโนโลยี ไดมี



 57
 

เนื้อหาที่มุงเนนใหผูเรียนสามารถใชโปรแกรมสําเร็จรูปสําหรับประมวลผลคําและใชออกแบบ
นําเสนอผลงานไดเปนโปรแกรมพื้นฐาน ดังนั้นในงานวิจัยคร้ังนี้เพื่อใหนักเรียนสามารถเลือกใช
เทคโนโลยีซอฟตแวรที่มีความเหมาะสมในการทํางานและเปนพื้นฐานสําหรับการใชงานโปรแกรม
อ่ืนๆ ผูวิจัยจึงเลือกใชความสามารถในการใชโปรแกรมประมวลผลคําและโปรแกรมนําเสนอ
ผลงานเปนตัวบงช้ีที่ใชในการวัดความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4                
ในกรุงเทพมหานคร โดยที่ความสามารถทางคอมพิวเตอรของนักเรียน จะวัดจากคะแนนทดสอบ
โปรแกรมประมวลผลคํา (Microsoft Word) และคะแนนทดสอบโปรแกรมนําเสนอผลงาน 
(Microsoft PowerPoint) 

 

ความสามารถทางคอมพิวเตอร คะแนนทดสอบโปรแกรมประมวลผลคําและ
โปรแกรมนําเสนอผลงาน 

ความสามารถทางคอมพิวเตอร คือ ความสามารถในการใชคอมพิวเตอรที่ผูเรียนไดจาก
การเรียนในวิชาคอมพิวเตอรซึ่งอางอิงมาจากสาระและมาตรฐานการเรียนรู กลุมการงานอาชีพ
และเทคโนโลยีและคูมือตัวช้ีวัดและสาระการเรียนรูแกนกลางของกลุมสาระการเรียนรูการงาน
อาชีพและเทคโนโลยีตามแตละโรงเรียนที่จัดใหมีการเรียนการสอนในแตละชวงช้ัน ซึ่งวัดไดจาก
คะแนนทดสอบโปรแกรมประมวลผลคํา (Microsoft Word) และคะแนนทดสอบโปรแกรมนําเสนอ
ผลงาน (Microsoft PowerPoint) ซึ่งผูวิจัยจะขอกลาวถึงรายละเอียดของโปรแกรมประมวลผลคํา 
(Microsoft Word) และโปรแกรมนําเสนอผลงาน (Microsoft PowerPoint) ดังนี้ 

 

โปรแกรมประมวลผลคํา (Microsoft Word) 
โปรแกรมประมวลผลคํา (Microsoft Word) เปนโปรแกรมที่มีหนาที่หลักในการตกแตง 

จัดการ สรางงานเอกสารในรูปแบบตางๆ  โปรแกรมนี้เหมาะสมสําหรับการสรางสรรคผลงานใน
รูปแบบตางๆ ไมวาจะเปน หนังสือ คูมือ รายงาน จดหมาย บันทึกการประชุม เอกสารสัญญา ใบ
ปะหนาแฟกซ ปฏิทิน ประวัติสวนตัว ฯลฯ ซึ่งสามารถรองรับการทํางานในทุกๆดาน 

โดยรายละเอียดผลการเรียนรูที่คาดหวังในการใชโปรแกรมประมวลผลคํา ผูเรียนหรือ
ผูใชงานสามารถใชงานคําส่ัง เปดและปดโปรแกรม แถบเคร่ืองมือตางๆ การปดโปรแกรม สรางงาน
เอกสาร ทํางานกับไฟล บันทึกไฟล ปดเปดไฟล ทํางานกับขอความ  ตกแตงขอความใหสวยงาม  
จัดวางขอความบนหนาเอกสาร  ใสสัญลักษณและเลขลําดับ ขอความอิสระดวย Text Box , 
WordArt Shape ฯลฯ 
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แผนภาพที่ 2.6 ภาพแสดงการใชงานโปรแกรมประมวลผลคํา (Microsoft Word) 

 

ความสาํคัญของโปรแกรมประมวลผลคํา  
ปจจุบันสํานักงานทั้งภาครัฐและเอกชน ไดมีการนําโปรแกรมประมวลผลคํามาใชในการ

พิมพเอกสารและรายงานตางๆ แทนเครื่องพิมพดีดมากข้ึน ทั้งนี้เนื่องจากความกาวหนาทาง
เทคโนโลยีคอมพิวเตอร โดยเฉพาะอยางยิ่งการพัฒนา ความสามารถของตัวประมวลผลและ
ประสิทธิภาพการเก็บขอมูลของหนวยเก็บขอมูลสํารองตางๆ เชน ฮารดดิสก ดิสกเกตต ที่มี
ความจําสูงข้ึนรวมถึงการผลิตเคร่ืองพิมพ (Printer) ความเร็วสูง ประกอบกับราคาเคร่ือง
คอมพิวเตอรมีราคาถูกลงแตมีประสิทธิภาพสูงข้ึน ทําใหสํานักงานตางๆ หันมาใชคอมพิวเตอรเขา
มาชวยในการประมวลขอมูล ซึ่งสามารถจัดทําเอกสาร บทความ ตลอดจนรายงานไดอยางรวดเร็ว 
โดยสามารถจัดขอความและ เลือกแบบอักษร แกไข เพิ่มเติม ปรับปรุง แทรกขอความ รวมขอความ
หรือเอกสาร จัดขอบกระดาษและตรวจดูเอกสารกอนที่จะพิมพเอกสารจริงออกมา นอกจากนี้ยัง
สามารถบันทึกเอกสารตางๆ ตลอดจนเรียกใชงานแฟมขอมูลที่ไดเก็บบันทึกไว ข้ึนมาใชงานใน
ภายหลังได 

 

ประโยชนของโปรแกรมประมวลผลคํา 
1. ชวยใหการจัดเก็บและคนหาเอกสารมีความรวดเร็วมากข้ึน เพราะงานเอกสารตางๆ            

จะถูกจัดเก็บเปนแฟมขอมูลลงใน ส่ือบันทึกขอมูลตางๆ สาารถคนหาและเรียกใชงานดสะดวกและ
รวดเร็ว 

2. ชวยลดปริมาณกระดาษที่จัดเก็บทําใหประหยัดพื้นที่ในการเก็บเอกสารเพราะเอกสาร
จะถูกจัดเก็บอยูในส่ือบันทึกขอมูลตางๆ ที่มีขนาดเล็กแตมีความจุในการเก็บขอมูลไดเปนจํานวน
มาก 
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3. ชวยลดข้ันตอนในการจัดทําเอกสาร เชน ถาตองการสงจดหมายที่มีขอความเหมือนกัน
ไปใหผูรับจดหมายเปนจํานวนมากอาจทําไดโดยการจัดทําจดหมายเวียน ซึ่งมีข้ันตอนการทํา              
ที่สะดวกและรวดเร็ว ซึ่งถาหากใชเคร่ืองพิมพดีดก็อาจจะตองเสียเวลาในการจัดทํามาก 

4. ชวยประหยัดเวลาและคาใชจายในการจัดพิมพเอกสาร 
5. ชวยสรางเอกสารใหมีความสวยงาม ทั้งนี้เพราะผูใชสามารถนํารูปภาพ รูปวาด 

ภาพกราฟกตาง ๆ มาแทรกลงในเอกสารไดโดยตรง 
6. ชวยใหการทํางานกับเอกสารถูกตองและมีขอผิดพลาดลดนอยลง เพราะผูใชงาน

สามารถตรวจสอบความถูกตองของเอกสารไดโดยตรงบนหนาจอจนพอใจจึงจะสั่งพิมพเอกสาร
ออกทางเคร่ืองพิมพได หรือาจใชระบบการตรวจสอบคําผิดแบบอัตโนมัติ ในการตรวจสอบการ
สะกดคําหรือไวยากรณของภาษาได 

 

โปรแกรมนําเสนอผลงาน (Microsoft Powerpoint) 
โปรแกรมนําเสนอผลงาน (Microsoft Powerpoint) เปนโปรแกรมที่รูจักกันดีวาใชในการ

สรางสไลดสําหรับการนําเสนองาน(Presentation) ไมวาจะเปนการแสดงบนจอภาพ ฉายโปรเจ็ค
เตอรที่ตอกับเคร่ืองคอมพิวเตอร เปนโปรแกรมที่มีเคร่ืองมือคอยอํานวยความสะดวกแกผูใชทําให
งานเกิดความนาสนใจยิ่งข้ึนโดยการใสรูปภาพตาง เชน ภาพนิ่ง ภาพเคล่ือนไหว เสียง และวิดีโอ
คลิป ฯลฯ 

โดยรายละเอียดผลการเรียนรูที่คาดหวังในการใชโปรแกรมนําเสนอผลงาน ผูเรียนหรือ
ผูใชงานสามารถ วิธีเรียกใชและปดโปรแกรม แถบเคร่ืองมือตางๆ การปดโปรแกรม   สรางและ
จัดการสไลดกับสไลดได จัดการกับขอความโดยใชรูปแบบตางๆ การตกแตงแผนโดยใชแมแบบ 
แทรกและปรับแตงรูปภาพ รูปวาดหรืออักษรประดิษฐ ใสลูกเลนใหเนื้อหาทั้งในสไลดและขณะ
เปล่ียนสไลด หรือจะกําหนดการเคลื่อนไหวในการนําเสนอเองได   

 
แผนภาพที่ 2.7 ภาพแสดงการใชงานโปรแกรมนําเสนองาน (Microsoft PowerPoint) 
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ความสาํคัญของโปรแกรมนําเสนอผลงาน 
ในปจจุบันนี้การนําเสนอเขามามีบทบาทสําคัญในองคกรทางธุรกิจ ทางการเมือง                  

ทางการศึกษา หรือแมแตหนวยงานของรัฐทุกแหงก็ตองอาศัยวิธีการนําเสนอเพื่อส่ือสารขอมูล 
เสนอความเห็นเสนอขออนุมัติหรือเสนอขอสรุปผลการดําเนินงานตางๆ ผูมีหนาที่เกี่ยวกับการ
ประชาสัมพันธ การแนะนําเพื่อการเยี่ยมชม การฝกอบรม การประชุม หรือผูที่เปนหัวหนางานทุก
ระดับจะตองรูจักวิธีการนําเสนอ เพื่อนําไปใชใหเหมาะสมกับงานตางๆ และเพื่อผลสําเร็จของการ
พัฒนางานของตน หรือขององคกรและหนวยงานตางๆ กลาวโดยสรุปการนําเสนอมีความสําคัญ  
ตอการปฏิบัติงานทุกประเภท เพราะชวยในการตัดสินใจในการดําเนินงาน ใชในการพัฒนางาน 
ตลอดจนเผยแพรความกาวหนาของงานตอผูบังคับบัญชาและบุคคลผูที่สนใจ    

 

การรับรูความสามารถดานคอมพิวเตอรของตนเอง  
คอมโปและฮิกกินส (Compeau & Higgins, 1995) ไดพบวาการรับรูความสามารถตนเอง

ในการใชคอมพิวเตอร มีผลตอความคาดหวังเกี่ยวกับผลสําเร็จในอนาคตจากการใชคอมพิวเตอร 
เชน ในอาชีพการงานและการประสบผลสําเร็จของบุคคล  ซึ่งความคาดหวังเกี่ยวกับผลสําเร็จใน
การทํางานในอนาคตขางหนาสําหรับนักเรียนก็จะหมายถึงความสามารถทางคอมพิวเตอร 

รอส,โฮกาโบม เกรยและฮานเนย (Ross, Hogaboam-Gray and Hannay, 2001) ทําการ
ทดสอบโดยใหนักเรียนยายหองเรียนโดยเปล่ียนครูผูสอนคอมพิวเตอรที่มีการรับรูความสามารถ
ตนเองตางกัน ปรากฎวานักเรียนเรียนดีข้ึนและมีการรับรูความสามารถตนเองสูงข้ึนเมื่อไดเรียนกับ
ครูที่มีความมั่นใจในทักษะการใชคอมพิวเตอรของตัวเองจึงทําใหนักเรียนไดมีความสามารถทาง
คอมพิวเตอรสูงข้ึน 

ดังนั้นการรับรูความสามารถดานคอมพิวเตอรของตนเองจึงเปนปจจัยหนึ่งที่มีผลตอ
ความสามารถทางคอมพิวเตอร ซึ่งนอกจากนี้แลวการรับรูความสามารถดานคอมพิวเตอรของ
ตนเองยังจะเปนเหตุใหเกิดการต้ังเปาหมายและความผูกพันตอเปาหมายอีกดวย 

 

การต้ังเปาหมาย 
จากทฤษฎีการตั้งเปาหมายของล็อค ไดสรุปวาการต้ังเปาหมายของบุคคลสามารถ                

ทําใหเกิดพฤติกรรมที่สงผลตอการทํางาน ตามที่ไดกลาวไวแลวในตอนที่สอง อันจะทําใหผลการ
ปฏิบัติงานดีข้ึนตามไปดวย ซึ่งอาจจะกลาวในทางการวิจัยผูวิจัยจึงสรุปวาการต้ังเปาหมายในเร่ือง
คอมพิวเตอรจะสงผลตอความสามารถทางคอมพิวเตอร 
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ความผูกพันตอเปาหมาย  
ความผูกพันตอเปาหมาย คือ ความพยายามของคนท่ีจะบรรลุเปาหมายเมื่อบรรลุ

เปาหมายแลวจะเกิดความคงอยูของพฤติกรรม   ความผูกพันตอเปาหมายมักจะถูกนําไปศึกษา
รวมกับการต้ังเปาหมายในการทํางาน ในแงที่วา ความผูกพันตอเปาหมายเปนตัวสําคัญทีท่าํใหคน
บรรลุเปาหมายหรือเปนที่มาของเปาหมายไมวาจะเปนเปาหมายที่เรากําหนดเอง, เปาหมายที่มี
สวนรวมหรือเปาหมายที่ถูกกําหนดให  ความสัมพันธระหวางการต้ังเปาหมายในการทํางานกับ
ความผูกพันตอเปาหมายจะสงผลตอผลิตภาพการทํางาน 2 ลักษณะ คือ 

1. หากระดับของเปาหมายมีความคงที่ หรือทุกคนมีเปาหมายที่ทาทาย ความผูกพันตอ
เปาหมายจะเพิ่มผลิตภาพการทํางาน โดยไดมีงานวิจัยของ อีเรซและไซดอน (eraz and Zidon, 
1984) พบวา ในทุกระดับของความยากของเปาหมายจะเกิดผลทางบวกกับความผูกพันตอ
เปาหมายและผลิตภาพการทํางาน และขอเสนอนสนับสนุนจากงานวิจัยของไรท (Wright, 1989) 
ที่พบวาเปาหมายยากจะมีความผูกพันตอเปาหมายทางบวกับผลิตภาพการทํางาน 

2. ความผูกพันตอเปาหมายนาจะเปนส่ือกลางระหวางการตั้งเปาหมายในการทํางานกับ
ผลิตภาพการทํางานตามระดับความยากงายของเปาหมาย 

ดังนั้นระดับความยากงายของเปาหมายมีผลกระทบตอความผูกพันตอเปาหมาย 
เปาหมายยากที่คนสามารถบรรลุเปาหมายไดจะเกิดความผูกพันตอเปาหมายที่สูงสงผลตอการ
เพิ่มผลิตภาพการทํางานที่สูงข้ึน เชน งานวิจัยของไรท (Wright, 1989) ซึ่งศึกษาระดับความยาก
งายของเปาหมายในการทํางานกับความผูกพันตอเปาหมาย พบวาเปาหมายที่งายจะไมเกิดความ
ผูกพันตอเปาหมาย แชมเปญและแมคอาฟ (Champagne & Mc Afee, 1989) ไดเสนอวา
นอกจากความยากงายของเปาหมายแลว ความสามาถในการบรรลุเปาหมายก็เปนส่ิงทีสําคัญที่
จะตองสัมพันธกับผลิตภาพการทํางาน  ในแงของคุณภาพและปริมาณระยะยาว  การที่เราใชการ
ต้ังเปาหมายในการทํางานรวมกับการใหรางวัล มีผลตอความคาดหวังในผลสําเร็จ (Expectancy) 
และคุณคาของผลสําเร็จที่เราจะไดรับ (Valence) ส่ิงเหลานี้มีผลตอความผูกพันตอเปาหมาย 
(Goal Commitment) 

เมเออรและบรุนสเตียน (Maier & Brunstein, 2001) พบวาเปาหมายสวนบุคคล 
(Personal Goal) เปนการแสดงถึงการกําหนดทิศทางในอนาคตของแตละคนในการมุงมั่นเพือ่ชีวติ
และการมองหาความสําเร็จในชีวิตที่หลากหลายโดยมีการตัดสินใจไปตามแตละเปาหมายของ
บุคคล  ตามที่ ไดกลาวไวแลวในตอนที่สอง  ดังนั้นถาผู เ รียนมีความมุงมั่นและผูกพันกับ
ความสามารถทางคอมพิวเตอร มีความตองการจะใหไดความสามารถที่ดี ผูเรียนจึงตองมีความ
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ผูกพันตอเปาหมายทางดานคอมพิวเตอรนั้นดวย ซึ่งผูวิจัยจึงขอสรุปวาความผูกพันตอเปาหมาย
จะสงผลตอความสามารถทางคอมพิวเตอร  

 

ตอนท่ี 5 งานวิจัยที่เกี่ยวของ 
 5.1 งานวิจัยในประเทศ 

วรารัตน บุญณสะ (2550) ไดศึกษาความสัมพันธระหวางการตั้งเปาหมายสวนบุคคลใน
งานพยาบาลและความต้ังใจคงอยูของงานพยาบาลใหม และศึกษาความสัมพันธระหวางความ
ผูกพันตอเปาหมายในฐานะตัวแปรกํากับในความสัมพันธระหวางการตั้งเปาหมายสวนบุคคล และ
ความต้ังใจอยูในงาน และศึกษาผลของตัวแปรดานการตั้งเปาหมายสวนบุคคลและความผูกพันตอ
เปาหมายที่สัมพันธกับความต้ังในอยูในงาน  ผลพบวาการต้ังหมายสวนบุคคลของพยาบาลใหมมี
ความสัมพันธทางบวกกับความต้ังใจคงอยูโดยงานรวม และรายดานไดแก ความมีอิสระในการ
ทํางาน ความตองการรายได ฯลฯ  ความผูกพันตอเปาหมายไมเปนตัวแปรกํากับในความสัมพันธ
ระหวางการต้ังเปาหมายสวนบุคคลกับความตั้งใจคงอยูในงาน แตความผูกพันตอเปาหมายมี
ความสัมพันธทางบวกกับความตั้งใจอยูในงาน ซึ่งเมื่อไดวิเคราะหการถดถอยพหุคูณเขิงช้ันพบวา
ขอมูลสวนบุคคลสามารถอธิบายความแปรปรวนของความต้ังใจคงอยูในงานไดรอยละ 17 ซึ่งเม่ือ
เพิ่มตัวแปรการต้ังเปาหมายสวนบุคคลสามารถอธิบายความแปรปรวนของความต้ังใจคงอยูในงาน
ไดเพิ่มข้ึนรอยละ 23 คือความม่ันคงทางอาชีพ โอกาสในการสรางความกาวหนาในอาชีพ การ
ไดรับการยอมรับจากผูรวมงาน และการไดรับการยอมรับจากหัวหนางาน 

ชูชีพ ออนโคกสูง และอนุสรณ อรรถศิริ (2549) ไดศึกษาความสัมพันธระหวางพลัง
ความสามารถแหงตน เปาหมาย และความเปนไปไดที่จะกระทํากับแรงจูงใจในการเรียน โดยใช
กลุมตัวอยางเปนนิสิตชั้นปที่ 1 หลักสูตรการศึกษาบัณฑิต มหาวิทยาลัยศรีนครินทรวิโรฒ ป
การศึกษา 2548 จํานวน 369 คน ผลการวิจัยพบวานิสิตมีพลังความสามารถแหงตนคอนขางมาก 
จะมีเปาหมายในการเรียนคอนขางชัดเจน มีความเปนไปไดที่จะกระทํากิจกรรมการเรียนคอนขาง
สูง มีแรงจูงใจในการเรียนคอนขางสูงและมีคะแนนเฉลี่ยสะสมอยูในระดับสูง   นิสิตชาย – หญิง มี
เปาหมายในการเรียนและคะแนนเฉล่ียสะสมแตกตางกันอยางมีนัยสําคัญทางสถิติที่ระดับ .05 
และ .01 ตามลําดับ  นิสิตตางคณะกันมีเปาหมายในการเรียนและแรงจูงใจในการเรียนแตกตางกนั
อยางมีนัยสําคัญทางสถิติที่ระดับ .01 และ .05 ตามลําดับ  นิสิตที่มีคะแนนเฉลี่ยสะสมตางกันมี
แรงจูงใจในการเรียนแตกตางกันอยางมีนัยสําคัญทางสถิติที่ระดับ .01  พลังความสามารถแหงตน
มีความสัมพันธทางบวกกับเปาหมายในการเรียนและความเปนไปไดที่จะกระทํากิจกรรมการเรียน
อยางมีนัยสําคัญทางสถิติที่ระดับ .01 และมีความสัมพันธทางบวกกับแรงจูงใจในการเรียนอยางมี
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นัยสําคัญทางสถิติที่ระดับ .05 เปาหมายในการเรียนมีความสัมพันธทางบวกกับความเปนไปไดที่
จะกระทํากิจกรรมการเรียนและแรงจูงใจในการเรียนอยางมีนัยสําคัญทางสถิติที่ระดับ .01  และมี
ความเปนไปไดที่จะกระทํากิจกรรมการเรียนมีความสัมพันธทางบวกกับแรงจูงใจในการเรียนอยาง
มีนัยสําคัญที่ระดับ .01 

ทวีวัฒน วัฒนกุลเจริญ (2547)ไดพัฒนารูปแบบการวัดประเมินตามสภาพจริงจากการ
เรียนอิเล็กทรอนิกสที่ใชวิธีการเรียนตามสถานการณที่สงผลตอการรับรูความสามารถของตนเอง
ของผูเรียนในสถานศึกษา ผลการวิจัยพบวา รูปแบบการวัดประเมินตามสภาพจริงฯ ประกอบดวย 
องคประกอบของการวัดประเมินตามสภาพจริง และข้ันตอนการวัดประเมินตามสภาพจริง  และผล
จากการใชรูปแบบการวัดประเมินตามสภาพจริงฯ ที่พัฒนาข้ึน โดยทดลองใชรูปแบบการวัด
ประเมินตามสภาพจริง พบวา ผูเรียนมีระดับการรับรูความสามารถของตนเองสูงกวากอนการ
ทดลองใชรูปแบบอยางมีนัยสําคัญทางสถิติที่ระดับ .05 
 รจเรข รัตนาจารย (2547) ไดศึกษาผลของการฝกการกํากับตนเองในการเรียนการสอน
วิชาวิทยาศาสตรที่มีตอการรับรูความสามารถของตนเองและความสามารถทางการเรียนวิชา
วิทยาศาสตรของนักเรียนช้ันมัธยมศึกษาปที่ 3 ผลการวิจัยที่เกี่ยวของกับการรับรูความสามารถใน
ตนเอง พบวา ภายหลังการทดลอง นักเรียนกลุมทดลองมีคาเฉลี่ยคะแนนการรับรูความสามารถ
ของตนเองในวิชาวิทยาศาสตรสูงกวากอนทดลอง อยางมีนัยสําคัญทางสถิติที่ระดับ .05  ภายหลัง
การทดลอง นักเรียนกลุมทดลองมีคาเฉลี่ยคะแนนการรับรูความสามารถของตนเองในวิชา
วิทยาศาสตรสูงกวานักเรียนกลุมเปรียบเทียบที่ไมมีการฝกการกํากับตนเองในการเรียนการสอน
วิชาวิทยาศาสตรอยางมีนัยสําคัญทางสถิติที่ระดับ .05  และภายหลังการทดลอง คะแนนการรับรู
ความสามารถของตนเองในวิชาวิทยาศาสตรของนักเรียนกลุมทดลองมีความสัมพันธกับคะแนน
ความสามารถทางการเรียนวิชาวิทยาศาสตรอยางมีนัยสําคัญทางสถิติที่ระดับ .05 โดยมีคา
สัมประสิทธิ์สหสัมพันธเทากับ .61 ซึ่งสูงกวากอนทดลอง ภายหลังการทดลอง นักเรียนกลุมทดลอง
มีคาสัมประสิทธิ์สหสัมพันธระหวางการรับรูความสามารถของตนเองในวิชาวิทยาศาสตรกับ
ความสามารถทางการเรียนวิชาวิทยาศาสตรของนักเรียนกลุมทดลองสูงกวานักเรียนกลุม
เปรียบเทียบ 

เสรี ชัดแชม และคอยจิตร นครราช (2549) ไดศึกษาเกี่ยวกับการรับรูความสามารถดาน
คอมพิวเตอรของนิสิตนักศึกษาสามสาขาวิชา โดยมีวัตถุประสงคเพื่อเปรียบเทียบความตรงเชิง
โครงสรางของโมเดลการรับรูความสามารถดานคอมพิวเตอรของนิสิตนักศึกษาตามแนวคิดการรับรู
ความสามารถของตนดานคอมพิวเตอรของทอรกซาเดทคอฟเทอรรอส และฟลูโกฟท (Torkzadeh, 
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Koufteros, & Pflughoeft, 2003) โดยมีกลุมตัวอยางเปนนิสิตนักศึกษาช้ันปที่ 1 จากมหาวิทยาลัย
ของรัฐ ปการศึกษา 2547 และไดใชเคร่ืองมือการวิจัยเปนแบบสอบถามเร่ืองการรับรูความสามารถ
ของตนดานคอมพิวเตอรของนิสิตนักศึกษา ซึ่งผลการวิจัยปรากฏวา การรับรูความสามารถดาน
คอมพิวเตอรของนิสิตนักศึกษาทั้งสาขาวิชาวิทยาศาสตรและเทคโนโลยีสาขาวิชาวิทยาศาสตร
สุขภาพ และสาขาวิชามนุษยศาสตรและสังคมศาสตร ประกอบดวย 4 องคประกอบเหมือนกัน 
ไดแก ทักษะเบ้ืองตน ทักษะดานแฟมขอมูลและซอฟตแวร ทักษะข้ันสูง และ ทักษะดาน
อินเทอรเน็ต  ความตรงเชิงโครงสรางของโมเดลการรับรูความสามารถดานคอมพิวเตอรของนิสิต
นักศึกษาทั้ง 3 สาขาวิชา มีความสอดคลองกับขอมูลเชิงประจักษ คาไค-สแควรมีต้ังแต 26.33 ถึง 
53.99 คา p(s) เทากับ 1.00 ดัชนี AGFIมีคาต้ังแต .95 ถึง .96 ดัชนี CFIs เทากับ 1.00 คา SRMR 
มีต้ังแต .02 ถึง .03 และคา RMSEAs เทากับ .00 และโครงสรางองคประกอบของโมเดลการรับรู
ความสามารถดานคอมพิวเตอรของนิสิตนักศึกษาทุกสาขาวิชาไมแตกตางกัน แตคาน้ําหนัก
องคประกอบแตกตางกัน 

ดร.เดือนเพ็ญ ทองนวม (2545) ไดทํางานวิจัยและศึกษาการรับรูความสามารถแหงตน 
เปาหมายในการศึกษาและการเรียนรูโดยการกํากับตนเอง ผลการวิจัยพบวานักศึกษาทีม่รีะดับการ
รับรูความสามารถดวยตนเองสูง  มีเปาหมายมุงความรู (Mastery Goal) และมุงผลการเรียนสูง 
(Performance  Goal)  รายงานวาตนใชกลยุทธการเรียนโดยการกํากับตนเองมากกวานักศึกษาที่
มีระดับการรับรูความสามารถดวยตนเองตํ่าและมีเปาหมายมุงความรูและมุงผลการเรียน  
นอกจากนี้ผลการศึกษายังพบวานักศึกษาที่ไดเกรดเฉล่ียสูง รายงานวามีระดับการรับรู
ความสามารถดวยตนเองและเปาหมายมุงความรูสูง และการใชการเรียนโดยการกํากับตนเอง
มากกวานักเรียนที่ไดเกรดเฉล่ียตํ่า  และการวิเคราะหการถดถอยพหุคูณยังแสดงใหเห็นวาใน
บรรดาตัวแปรที่ศึกษาทั้ง 4 ตัว ซึ่งประกอบไปดวยการรับรูความสามารถดวยตนเอง เปาหมายมุง
ความรู เปาหมายมุงผลการเรียน และเกรดเฉล่ีย  โดยการรับรูความสามารถแหงตนเองเปนตัว
ทํานายการเรียนรูโดยการกํากับตนเองไดดีที่สุด ตามดวยเปาหมายมุงความรู ขอเสนอแนะสําหรับ
อาจารยผูสอนในการพัฒนาความเชื่อในความสามารถข้ึนในตัวของผูเรียน ไดแก การใสใจในการ
รับรูความสามารถของผูเรียน การเปนตัวแบบที่ดี และการสรางบรรยากาศแหงความรวมมือในช้ัน
เรียน 

อดิศักด์ิ พงษพูลผลศักด์ิ ไพบูลย เกียรติโกมล และปยะมาศ เจริญพันธุวงศ (2544) ได
ศึกษาปจจัยที่มีผลตอความสามารถทางการเรียนวิชาคอมพิวเตอรของนักเรียนระดับมัธยมศึกษา
ตอนปลายในโรงเรียนของรัฐ : กรณีศึกษาจังหวัดลพบุรี โดยมีกลุมตัวอยางจํานวน 495 คน  ใช
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วิธีการเก็บขอมูลดวยแบบสอบถามและแบบทดสอบ  ผลปรากฏวา ระยะเวลาในการเดินทางมา
ศึกษา อาชีพผูปกครอง ระดับการศึกษาของผูปกครอง อัตราสวนระหวางนักเรียนกับครู วุฒิ
การศึกษาของครู สถิติการขาดเรียน และวิธีการสอนของครูมีผลตอความสามารถทางการเรียนของ
นักเรียน  เจตคติที่มีตอการเรียนสงผลโดยตรงตอความสามารถทางการเรียนของนักเรียน  และมี
ผลทางออมผานการปรับตัวของนักเรียนกับเพื่อน ความสนใจในวิชาชีพ แรงจูงใจใฝสัมฤทธิ์ ความ
รับผิดชอบ และทักษะพื้นฐานทางคอมพิวเตอร การปรับตัวของนักเรียนกับเพื่อนสงผลโดยตรงตอ
ความสามารถทางการเรียน  ความสนใจในวิชาชีพสงผลโดยตรงตอความสามารถทางการเรียน
และมีผลทางออมผานทางแรงจูงใจใฝสัมฤทธิ์  แรงจูงใจใฝสัมฤทธิ์สงผลโดยตรงตอความสามารถ
ทางการเรียนและมีผลทางออมผานความรับผิดชอบและทักษะพื้นฐาน และทักษะพื้นฐานทาง
คอมพิวเตอรจะสงผลโดยตรงตอความสามารถทางการเรียน 

วรกานต เส่ียงอารมณ (2541) ไดทําการศึกษาเร่ืองอิทธิพลของความยากงายของ
เปาหมายและรางวัลที่มีตอผลิตภาพการทํางาน และความผูกพันใจในเปาหมาย โดยกลุมตัวอยาง
เปนพนักงานเย็บกระเปารายวันแบงกลุมตามเงื่อนไขการทดลอง ตามเปาหมายและเงินรางวัล 
พบวาพนักงานที่มีการต้ังเปาหมายและใหส่ิงจูงใจเปนตัวเงินมีผลิตภาพที่สูงข้ึน ความยากงายของ
เปาหมายไมมีผลตอความผูกพันใจในเปาหมาย แตการใหเงินรางวัลมีผลตอความผูกพันใจใน
เปาหมาย สวนพนักงานที่บรรลุเปาหมายจะเกิดความผูกพันใจตอเปาหมายตามผลการวิจัยของ
ล็อค และลาแธม (1990) 
 กรรณิการ จิตตบรรเทา (2539)  ไดศึกษาความสัมพันธระหวางการรับรูความสามารถของ
ตนเองกับความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ  ความสัมพันธระหวางความ
คาดหวังในผลการเรียนภาษาอังกฤษกับความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ 
และความสัมพันธระหวางการรับรูความสามารถของตนเองและความคาดหวังในผลการเรียน
ภาษาอังกฤษกับความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ โดยมีกลุมตัวอยางเปน
นักเรียนช้ันมัธยมศึกษาปที่ 5 ในกรุงเทพมหานคร ใชการวิเคราะหดวยการหาคาความสัมพันธ
แบบเพียรสันและสัมประสิทธิ์สหสัมพันธพหุคูณ โดยผลการวิจัย คือ การรับรูความสามารถของ
ตนเองมีความสัมพันธทางบวกกับความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ อยางมี
นัยสําคัญทางสถิติที่ระดับ 0.01 ความคาดหวังในผลการเรียนภาษาอังกฤษมีความสัมพันธ
ทางบวกกับความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ อยางมีนัยสําคัญทางสถิติที่
ระดับ 0.01 และการรับรูความสามารถของตนเอง และความคาดหวังในผลการเรียนภาษาอังกฤษ 
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มีความสัมพันธกันทางบวกกับความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ อยางมี
นัยสําคัญทางสถิติที่ระดับ 0.01 

สุธีรา นิมิตรนิวัฒน (2537) ไดศึกษาผลของฝกการต้ังเปาหมายที่มีตอความสนใจใน
กิจกรรมและความสามารถในวิชาคณิตศาสตรของนักเรียนชั้นมัธยมศึกษาปที่ 2  ซึ่งผลการวิจัย
พบวา กลุมนักเรียนที่ต้ังเปาหมายระยะส้ันมีคะแนนความสนใจในกิจกรรมสูงกวากลุมนักเรียนที่
ต้ังเปาหมายระยะยาวและกลุมควบคุมอยางมีนัยสําคัญทางสถิติที่ระดับ .01 กลุมนักเรียนที่
ต้ังเปาหมายระยะส้ันมีคะแนนความสามารถในวิชาคณิตศาสตรสูงกวากลุมนักเรียนที่ต้ังเปาหมาย
ระยะยาวและกลุมควบคุม อยางมีนัยสําคัญทางสถิติที่ระดับ .01 

อมรรัตน บุบผโชติ (2546) ไดศึกษาผลของการใชบันทึกการเรียนรูในการเรียนการสอน
วิชาวิทยาศาสตรที่มีตอการรับรูความสามารถของตนเองและความสามารถทางการเรียนวิชา
วิทยาศาสตรของนักเรียนช้ันมัธยมศึกษาปที่ 3 โรงเรียนสาธิต สังกัดมหาวิทยาลัยของรัฐใน
กรุงเทพมหานคร โดยผลการวิจัยที่เกี่ยวของกับการรับรูความสามารถของตนเองพบวา การรับรู
ความสามารถของตนเองมีความสัมพันธกับความสามารถทางการเรียนวิชาวิทยาศาสตร หลังการ
เรียนโดยใชบันทึกการเรียนรูในการเรียนการสอนวิชาวิทยาศาสตรอยางมีนัยสําคัญทางสถิติที่
ระดับ .01 โดยมีคาสัมประสิทธิ์สหสัมพันธเทากับ .62 นักเรียนที่เรียนโดยใชบันทึกการเรียนรูมี
คาเฉล่ียคะแนนการรับรูความสามารถของตนเองในวิชาวิทยาศาสตรสูงกวากอนทดลอง อยางมี
นัยสําคัญทางสถิติที่ระดับ .05   นักเรียน  ที่เรียนโดยใชบันทึกการเรียนรูมีคาเฉลี่ยคะแนนการรับรู
ความสามารถของตนเองในวิชาวิทยาศาสตรสูงกวานักเรียนที่เรียนโดยไมใชบันทึกการเรียนรู 
อยางมีนัยสําคัญทางสถิติที่ระดับ .05   

ขนิษฐา สุวรรณนิตย (2533) ไดศึกษาปจจัยที่มีอิทธิพลตอความคาดหวังเกี่ยวกับ
ความสามารถของตนทั้งทางตรงและทางออม โดยการศึกษากับปจจัยระดับการอนุมานสาเหตุผล
ของการทําแบบทดสอบท่ีมาจากความสามารถในการเรียน การพูดชักจูงจากผู อ่ืน การ
ต้ังเปาหมายในการเรียน การเห็นผูอ่ืนเปนตัวแบบ ความวิตกกังวล ประสบการณที่ไดจากการเรียน 
และทักษะในการเรียน โดยมีกลุมตัวอยางเปนนักเรียนช้ันประถมศึกษาปที่ 6 ในจังหวัดนครสวรรค 
ใชวิธีการวิเคราะหขอมูลโดยใชการวิเคราะหเสนทาง ซึ่งผลการวิจัยพบวา  ปจจัยที่มีอิทธิพล
ทางตรงเชิงนิมานตอความคาดหวังเกี่ยวกับความสามารถของตน คือ ทักษะในการเรียน 
(0.43259) และประสบการณที่ไดรับจากการเรียน (0.06083) ปจจัยที่มีอิทธิพลทางตรงเชิงนิเสธ 
คือ ความวิตกกังวล (-0.41445) การเห็นผูอ่ืนเปนตัวแบบ (-0.17814)  สวนปจจัยที่มีอิทธิพล
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ทางออม คือ การต้ังเปาหมายในการเรียน (0.05847) และความวิตกกังวล (-0.07231) ซึ่งความ
วิตกกังวลเปนปจจัยที่มีอิทธิพลทั้งทางตรงและทางออม  

สาขางานวิจัยของสถาบันการสงเสริมการสอนวิทยาศาสตรและเทคโนโลยี (2549) ได
ศึกษาผลของการใชคูมือครูและหนังสือเรียนเทคโนโลยีสารสนเทศ ชวงชั้นที่ 4  โดยผลการวิจัย
พบวายังมีครูที่ใชคูมือครูและหนังสือเรียนสาระการเรียนรูพื้นฐานและเพิ่มเติมเทคโนโลยีสารสนเทศ
ชวงชั้นที่ 4  เพียงรอยละ 67.0 และใชคูมือครูสาระการเรียนรูเพิ่มเติม การโปรแกรมเบ้ืองตน คิดเปน 
รอยละ 53.3 และสาเหตุที่ครูไมไดใชคูมือครูและหนังสือเรียนเทคโนโลยีสารสนเทศของ สสวท. คือ 
ครูไมทราบวามีคูมือครูและหนังสือเรียนจําหนาย ถึงแมวาทราบวามีคูมือครูและหนังสือเรียน
จําหนายแตหาซ้ือไมได และทราบวามีคูมือครูและหนังสือเรียนจําหนายแตไมไดซื้อมาใช  

 

5.2 งานวิจัยตางประเทศ 
จัดจและโบโน (Judge and Bono, 2001) ไดศึกษาความสัมพันธระหวางการประเมิน

ตนเอง (Core Self Evaluation) กับความพึงพอใจในงานและผลการปฏิบัติงาน โดยไดกลาววาการ
ประเมินตนเองเปนการรับรูและเปนความคิดเกี่ยวกับตนเองในแงตางๆ ทั้งในดานบวกและดานลบ
โดยจัดจและโบโนไดแบงการประเมินตนเอง (Core Self Evaluation) ออกเปน 4 ดาน ไดแก ความ
ภาคภูมิใจในตนเอง (Self Esteem) ศูนยการควบคุม (Locus of Control) การรับรูความสามารถ
ของตนเอง (Self Efficacy) ความมั่นคงทางอารมณ (Emotional Stability) 

แวนคูเวอร, ธอมพสัน และวิลเลียม (Vancouver, Thompson & Williams, 2001)                 
ไดทําการศึกษาถึงการเปล่ียนแปลงความสัมพันธระหวางการรับรูถึงความสามารถของตน (Self 
efficacy) , เปาหมายสวนบุคคล (Personal Goal), และผลการปฏิบัติงาน(Performance) พบวา
เมื่อนํามาใชรวมกับทฤษฎีของแบนดูราถึงความเชื่อของตนในการที่จะบรรลุเปาหมายได นํามาหา
คาสหสัมพันธเม่ือใชรวมกับ Control Theory สามารถทํานายไดวา การรับรูถึงความสามารถของ
ตนที่จะบรรลุ เปาหมายสงผลในทางลบตอผลการปฏิบั ติงานที่ผานมา  (Subsequence 
Performance) การทดลองนี้มีผูเขารวมการวิจัย 56 คน  โดยใชวิธีการ within person technique 
พบวาเปาหมายสวนบุคคลมีความสัมพันธในทางบวกเม่ือนํามาใชรวมกับการรับรูความสามารถ
ของตนที่จะบรรลุเปาหมาย  แตมีความสัมพันธในทางลบกับผลการปฏิบัติงานที่ผานมาในการวิจัย
สวนที่สองกับผูรวมการวิจัย 185 คน พบวาการเพิ่มระดับของเปาหมายสามารถทํานาย
ความสัมพันธทางบวกของผลการปฏิบัติงานแมวาการต้ังเปาหมายนั้นจะเปนเปาหมายที่ยาก 

เมเออรและบรุนเสตียน (Maier and brunstein, 2001) ไดทําการวิจัยในเร่ืองการวิเคราะห
ระยะยาว: บทบาทของการตั้งเปาหมายในการทํางานของพนักงานใหม กับความพึงพอใจในงาน 
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และคาวมผูกพันตอองคการ พบวามีตัวแปรสําคัญ 3 อยางในการต้ังเปาหมายในงาน (personal 
work Goals) ไดแก ความผูกพันตอเปาหมาย (Goal Commitment) ความสําเร็จตอเปาหมาย 
(Goal Attainability) และความกาวหนาในการไปสูเปาหมาย (Goal Process) เปนตัวแปรสงผล
ตอทัศนคติของพนักงานใหม (Satisfaction and Organization commitment) ในการวิจัยนี้ได
ศึกษาพนักงานใหมต้ังแตระยะ 1 เดือนแรกที่เขาทํางาน จนถึง 20 สัปดาหของการทํางานโดยแต
ละคนจะไดรับมอบหมายใหต้ังเปาหมายในการทํางานของตน เม่ือถึงสัปดาหที่ 8 พนักงานเหลานี้
จะไดรับการทดสอบความผูกพันตอเปาหมายอันเปนตัวแปรกํากับที่สงผลตอความแตกตางในการ
ดําเนินการตามเปาหมายของพนักงานแตละคน อันนําไปสูการเปล่ียนแปลงความพึงพอใจในงาน 
(Job Satisfaction) และความผูกพันตอองคการ (Organization Commitment) พบวา
ความกาวหนาของเปาหมายเปนตัวแปรสงผานที่สําคัญตอความผูกพันตอเปาหมาย และ
ความสําเร็จตอเปาหมายของพนักงานใหมในดานทัศนคติตองาน 

 

ตอนท่ี 6 หลกัการวิเคราะหโมเดลลิสเรล 
โมเดลลิสเรล (LISREL model) หรือโมเดลสมการโครงสราง (Structural Equation 

Model) หรือโมเดลโครงสรางความแปรปรวนรวม (Covariance Structural Model) เปนโมเดล    
ที่แสดงความสัมพันธเชิงสาเหตุระหวางตัวแปรที่สรางข้ึนโดยวิเคราะหเพื่อตรวจสอบความ
สอดคลองกลมกลืนระหวางโมเดลการวิจัยที่ผูวิจัย สรางข้ึนมาจากทฤษฎีหรือการวิจัยที่ผานมากับ
ขอมูลเชิงประจักษ หัวใจสําคัญของโมเดลลิสเรลอยูที่การเปรียบเทียบความแตกตางระหวาง
เมตริกซความแปรปรวน-ความแปรปรวนรวม (variance-covariance matrix) ที่ไดจากขอมูลเชิง
ประจักษกับเมทริกซที ่ไดจากการประมาณคาพารามิเตอรที่คํานวณจากโมเดลลิสเรลที ่เปน
สมมติฐานการวิจัย เพื่อตรวจสอบความสอดคลองระหวางโมเดลกับขอมูลเชิงประจักษ พรอมทั้ง
รายงานดัชนีความสอดคลองดวย  
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โมเดลใหญในโปรแกรมลิสเรลสามารถเขียนเปนสมการและแสดงตามแผนภาพท่ี 2.8  
ดังนี้ 

 

 
 

แผนภาพที ่2.8 โมเดลใหญในโปรแกรมลิสเรล 
 

ในที่นี้ NX  = จํานวนตัวแปรภายนอกสังเกตได 
 NY  = จํานวนตัวแปรภายในสังเกตได 
 NK  = จํานวนตัวแปรภายนอกแฝง  
 NE  = จํานวนตัวแปรภายในแฝง 

เวคเตอรของตัวแปรในโมเดลมีสัญลักษณอักษรกรีก และความหมายดังตอไปนี้ 
 X     =    Eks      =  เวคเตอรตัวแปรภายนอกสังเกตได X ขนาด (NX x 1) 
 Y     =    Wi =  เวคเตอรตัวแปรภายในสังเกตได Y ขนาด (NY x 1) 
 ξ    =    Xi =  เวคเตอรตัวแปรภายนอกแฝง K ขนาด (NK x 1) 

η    =    Eta =  เวคเตอรตัวแปรภายในแฝง E ขนาด (NE x 1) 
δ    =    Delta =  เวคเตอรความคลาดเคล่ือน d ในการวัดตัวแปร X ขนาด (NX x 1) 
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ε    =    Epsilon =  เวคเตอรความคลาดเคล่ือน e ในการวัดตัวแปร Y ขนาด (NY x 1) 
ζ   =    Zeta = เวคเตอรความคลาดเคล่ือน z ในการวัดตัวแปร E ขนาด (NE x 1) 

 เมทริกซพารามิเตอรอิทธิพลเชิงสาเหตุหรือสัมประสิทธิ์การถดถอย (causal effects or 
regression coefficients) รวม 4 เมทริกซ และเมทริกซพารามิเตอรความแปรปรวน-ความ
แปรปรวนรวม (variance-covariance) รวม 4 เมทริกซ มีสัญลักษณอักษรกรีก คําอาน ตัวยอ
ภาษาอังกฤษและความหมายมีดังนี้ 

ΔX = Lambda-X  = LX  
        = เมทริกซสัมประสิทธิ์การถดถอยของ X บน K ขนาด (NX x NK) 
ΔY = Lambda-Y  = LY  
        = เมทริกซสัมประสิทธิ์การถดถอยของ Y บน E ขนาด (NX x NE) 
Γ   = Gamma  = GA  
       = เมทริกซอิทธิพลเชิงสาเหตุจาก K ไป E ขนาด (NE x NK) 
β   = Beta  = BE  
       = เมทริกซอิทธิพลเชิงสาเหตุระหวาง E ขนาด (NE x NE)  
Φ  = Phi     =  PH  
       = เมทริกซความแปรปรวน-ความแปรปรวนรวมระหวางตัวแปรภายนอกแฝง K ขนาด  
           (NK x NK)  
ψ  = Psi     =  Ps 
       = เมทริกซความแปรปรวน-ความแปรปรวนรวมระหวางความคลาดเคล่ือน z ขนาด  
           (NE x NE)  
θδ  = Theta-Delta   = TD  
       = เมทริกซความแปรปรวน-ความแปรปรวนรวมระหวางความคลาดเคล่ือน d ขนาด  
           (NX x NX) 
θδ  = Theta-epsilon = TE  
       = เมทริกซความแปรปรวน-ความแปรปรวนรวมระหวางความคลาดเคล่ือน e ขนาด  
           (NY x NY) 

 ในโปรแกรมลิสเรลโมเดลใหญนั้นจะประกอบไปดวยโมเดลที่สําคัญสองโมเดล ไดแก  
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1.โมเดลการวัด (Measurement model or Confirmatory factor model)   
 โมเดลการวัด เปนโมเดลการวิเคราะหตัวประกอบซ่ึงแสดงความสัมพันธระหวางตัวแปรที่
สังเกตไดกับตัวแปรประกอบหรือตัวแปรแฝง โมเดลการวัดประกอบดวยชุดของตัวแปรสังเกตได 2 
ชุด คือ ตัวแปรอิสระที่สังเกตได x =(x1,x2 และ x3) และตัวแปรตามสังเกตได Y= (Y1,Y2 และ Y3) ซึ่ง
มีลักษณะ ดังสมการ 
   

εη
δξ

+Δ=
+Δ=

))((
))((

YY
xx  

โดยที ่        x    =    เวคเตอรของคาจากการวัดตัวแปรที่สังเกตได (ตัวบงชี้ของตัวแปรแฝงทีเ่ปนตัว 
       แปรอิสระ ξ ) 

    xΔ =   เมตริกซของสัมประสิทธิ์การถดถอยหรือน้าํหนักตัวประกอบซึ่งแสดง 
                               ความสัมพันธ ระหวาง x กับξ  
          δ  =    เวกเตอรแสดงความคลาดเคล่ือนในสมการ x 
        Y =    เวกเตอรของคาจากการวัดตัวแปรตามสังเกตได (ตัวบงชี้ของตัวแปรแฝงท่ี 
                              เปนตัวแปรอิสระ η ) 
                 YΔ  =   เมตริกซของสัมประสิทธ์ิการถดถอยหรือน้ําหนักตัวประกอบซึง่แสดง 
                               ความสัมพันธ ระหวาง Y กับ η  
                   ε  =   เวกเตอรความคลาดเคลื่อนในสมการ Y 

2.โมเดลสมการโครงการ (Structural equation model) 
 โมเดลสมการโครงสรางเปนโมเดลที่แสดงความสัมพันธระหวางตัวแปรภายในโมเดลการวจิยั 
ซึ่งมีลักษณะดังสมการ ดังนี้ 
   ξξηη +Γ+= B  
โดยที่          η   =  เวคเตอรของตัวแปรแฝงที่เปนตัวแปรตาม 
      ξ  =  เวคเตอรของตัวแปรแฝงที่เปนตัวแปรตาม 
       B    =  เมตริกซของสัมประสิทธิ์การถดถอย ซึง่แสดงอิทธพิลโดยตรงของ η   ทีม่ตีอ η   
                             อ่ืนๆ 
       Γ  =  เมตริกซของสัมประสิทธิก์ารถดถอย ซึง่แสดงอิทธพิลโดยตรงของ ξ  ที่มีตอ ξ   
                             อ่ืนๆ 
 จุดประสงคหลักของโมเดลลิสเรล คือ ตองการที่จะวัดคาตัวแปรโมเดลสมการโครงสราง 
แตวาไมสามารถที่จะวัดตัวแปรที่อยูในสมการโครงสรางไดโดยตรง ดังนั้นจึงตองมีโมเดลการวัด
เพื่อที่จะวัดคาตัวแปรที่อยูในโมเดลสมการโครงสราง และจากการที่โมเดลลิสเรลนี้มีโมเดลการวัด
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อยูในโมเดลใหญของลิสเรล ทําใหโมเดลลิสเรลสามารถทําการประมาณคาพารามิเตอรซึ่งสามารถ
ใชในการวิเคราะหการถดถอยได 
 โมเดลลิสเรล เปนผลของการสังเคราะหวิธีการวิเคราะหขอมูลที่สําคัญ 3 วิธี คือ การวิเคราะห
องคประกอบ (factor analysis) การวิเคราะหอิทธิพล (path analysis) และการประมาณคาพารามิเตอร
ซึ่งในการวิเคราะหการถดถอยโดยการวิเคราะหองคประกอบ และการประมาณคาพารามิเตอรใน
การวิเคราะหถดถอยนั้นเปนการวิเคราะหในโมเดลการวัด ซึ่งถือวาเปนจุดเดนที่สําคัญของลิสเรล 
โดยการวิเคราะหองคประกอบเปนการวิเคราะหองคประกอบของตัวแปรแฝงที่ไมสามารถสังเกตได
โดยวัดจากองคประกอบของตัวแปรแฝง ซึ่งเปนตัวแปรสังเกตไดสวนการประมาณคาพารามิเตอร
ในการวิเคราะหการถดถอยนั้นจะเปนคาสถิติที่ชวยทําใหเราทราบคาพารามิเตอรที่แทจริงได เพราะ 
คาตัวแปรที่วัดไดจะบอกคาความคลาดเคล่ือนของการวัดในแตละตัวแปรดวยและในการวิเคราะห 
อิทธิพลนั้นจะอยูในสวนของโมเดลโครงสรางซึ่งเปนโมเดลที่สําคัญในโมเดลลิสเรล โดยเปนการ
วิเคราะหหาความสัมพันธเชิงสาเหตุระหวางตัวแปรภายนอกแฝงและตัวแปรภายในแฝง 
 

ขอตกลงเบื้องตนของโมเดลลิสเรล  ประกอบดวย 
  1. ลักษณะความสัมพันธระหวางตัวแปรทั้งหมดในโมเดลเปนความสัมพันธแบบเสนตรง
เชิงบวกและเปนความสัมพันธเชิงสาเหตุ 
 2. ลักษณะการแจกแจงของตัวแปรทั้งตัวแปรภายในและภายนอกและความคลาดเคล่ือน 
ตองเปนการแจกแจงแบบปกติ ความคลาดเคล่ือนตางๆตองมีคาเฉลี่ยเปนศูนย 
 3. ลักษณะความเปนอิสระตอกันระหวางตัวแปรกับความคลาดเคล่ือนสามารถแยกออก
ไดเปนความคลาดเคล่ือนที่เปนอิสระตอกัน ความคลาดเคล่ือนและตัวแปรแฝงท่ีเปนอิสระตอกัน 
 4. สําหรับการวิเคราะหอนุกรมเวลา ที่มีการวัดขอมูลมากกวา 2 คร้ัง การวัดตัวแปรตอง
ไมไดรับอิทธิพลจากชวงเวลาเหล่ือม (time lay) ระหวางการวัด 
 จะเห็นไดวาขอตกลงของโมเดลลิสเรลนั้นมีการผอนคลายมากกวาขอตกลงของการวิเคราะห 
การถดถอยและการวิเคราะหเสนทางเปนอยางมาก ซึ่งจะทําใหขอมูลสอดคลองกับขอตกลงทาง
สถิติไดดียิ่งข้ึน 
 กระบวนการสรางโมเดลนั้นโดยทั่วไปนั้น ขั้นแรกเปนการสรางโมเดลที่ไดมาจากการ
ทบทวนเอกสารและงานวิจัยตางๆ ข้ันตอมาจึงเปนขั้นของการตรวจสอบโมเดลที่ไดจากการสราง
โมเดลในขั้นตอนแรกกับขอมูลจริง เพื่อที่จะไดดูวาโมเดลที่เราไดจากขั้นตอนแรกนั้นสอดคลอง
กับขอมูลในสภาพการณจริง โดยในข้ันตอนนี้ถาเราจะเลือกใชสถิติวิเคราะหโปรแกรมลิสเรลก็จะ
วิเคราะหข้ันตอนนี้ โดยในการวิเคราะหดวยโปรแกรมลิสเรลจะมีข้ันตอนทั้งหมด 6 ที่สําคัญ ไดแก 
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ข้ันตอนที่ 1 การกําหนดขอมูลจําเพาะของโมเดล (specification of the model) ใน
การวิเคราะหขอมูลโปรแกรมลิสเรลส่ิงที่สําคัญคือ การกําหนดคาเมทริกซทั้ง 8 เมทริกซให
สอดคลองกับโมเดลการวิจัย การกําหนดขอมูลจําเพาะได 3 รูปแบบ ดังนี้ 

1. พารามิเตอรกําหนด (Fixed Parameter: FI) หมายถึง พารามิเตอรในโมเดลการ
วิจัยที่ไมมีเสนแสดงอิทธิพลระหวางตัวแปร ซึ่งสามารถกําหนดคาความสัมพันธในเมทริกซดวย
สัญลักษณ “0” 

 2. พารามิเตอรบังคับ (Constrained Parameter: ST) หมายถึง พารามิเตอรใน
โมเดลการวิจัยที่มีเสนแสดงอิทธิพลระหวางตัวแปร และพารามิเตอรขนาดอิทธิพลนั้นเปนคาที่
จะตองมีการประมาณ แตมีเงื่อนไขกําหนดให พารามิเตอรบางตัวมีคาเฉพาะคงที่ ซึ่งถาบังคับให
เปน 1 ก็สามารถกําหนดคาความสัมพันธในเมทริกซดวยสัญลักษณ “1” 

3. พารามิเตอรอิสระ (Free Parameter: FI) หมายถึง พารามิเตอรในโมเดลการวิจัยที่
ที่ตองการประมาณคา และไมบังคับใหมีคาอยางใดอยางหนึ่งใชสัญลักษณ “*” 

การกําหนดลักษณะพารามิเตอรวาเปนพารามิเตอรกําหนด พารามิเตอรบังคับ และ
พารามิเตอรอิสระในเมทริกซทั้ง 8 มีความสําคัญตอการใชโปรแกรมลิสเรลมาก ในการเขียนคําส่ัง
นักวิจัยตองกําหนดขอมูลจําเพาะของพารามิเตอรที่เขียนในรูปเมทริกซทั้ง 8 ดวยวามีรูปแบบ 
(form) และสถานะ (mode) ของพารามิเตอรเปนแบบใด รูปแบบของเมทริกซที่ใชในโปรแกรมลิส 
เรล มี 8 รูปแบบ ตามเมทริกซทางคณิตศาสตรทั่วไป ดังนี้ 

1. เมทริกซศูนย (Zero Matrix = ZE) 
2. เมทริกซเอกลักษณ (Identity Matrix = ID) 
3. เมทริกซเอกลักษณ,ศูนย (Identity, Zero Matrix = IZ) 
4. เมทริกซศูนย, เอกลักษณ (Zero, Identity Matrix = ZI) 
5. เมทริกซแนวทแยง (Diagonal Matrix = DI) 
6. เมทริกซสมมาตร (Symmetric Matrix = SYI) 
7. เมทริกซใตแนวทแยง (Subdiagonal Matrix = SD) 
8. เมทริกซสมมาตรมาตรฐาน (Standardized Symmetric Matrix = ST) 
9. เมทริกซเต็มรูปแบบ (Full Matrix = FU) 
สถานะ (mode) ของเมทริกซที่ใชในโปรแกรมกําหนดตามสถานะของสมาชิกในเมท

ริกซเปน 2 สถานะ คือ พารามิเตอรกําหนด (Fixed Parameter = FI) และพารามิเตอรอิสระ (Free 
Parameter = FR)  
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ข้ันตอนที่ 2 การระบุความเปนไดคาเดียวของโมเดล (identifications of the model)
การระบุความเปนไปไดคาเดียวทําใหนักวิจัยทราบไดลวงหนาวา โมเดลนั้นจะประมาณ
คาพารามิเตอรไดหรือไม เงื่อนไขที่ทําใหระบุความเปนไปไดคาเดียวพอดีที่ตองพิจารณาอยู 3 
ประเภท (Bollen, 1989 : 103,332; Long, 1983 : 44 อางถึงใน นงลักษณ วิรัชชัย, 2542) คือ 
เงื่อนไขจําเปน (necessary condition) เงื่อนไขพอเพียง (sufficient condition) และเงื่อนไขจําเปน
และพอเพียง (necessary and sufficient conditions) 

ข้ันตอนที่ 3 การประมาณคาพารามิเตอรจากโมเดล (parameter estimation of the 
model) จุดมุงหมายของการประมาณคาพารามิเตอร คือ การหาคาพารามิเตอรที่จะทําใหเมทริกซ
ความแปรปรวน-ความแปรปรวนรวมที่คํานวณไดจากกลุมตัวอยาง (S) และเมทริกซความ
แปรปรวน-ความแปรปรวนรวมที่ถูกสรางข้ึนจากพารามิเตอรที่ประมาณคาไดจากโมเดลสมมติฐาน 
(Σ หรือ sigma) มีคาใกลเคียงกันมากที่สุด  ถาหากเมทริกซทั้งสองมีคาใกลเคียงกันกัน แสดงวา
โมเดลที่เปนสมมติฐานมีความกลมกลืนกับขอมูลเชิงประจักษ ในการกําหนดเงื่อนไขใหเมทริกซทั้ง
สองมีคาใกลเคียงกันใชวิธีการสรางฟงกชั่นความกลมกลืน (fit or fitting function) รูปแบบของ
ฟงกชั่นทุกฟงกชั่นที่สรางข้ึนตองมีคุณสมบัติรวม 4 ประการ คือ (1) ฟงกชั่นความกลมกลืนตอง
เปนสเกลลารหรือเปนตัวเลขจํานวน (2) ฟงกชั่นความกลมกลืนตองมีคามากกวาหรือเทากับศูนย 
(3) ฟงกชั่นความกลมกลืนมีคาเทากับศูนยเม่ือเมทริกซ S และ Σ มีคาเทากันเทานั้น (4) ฟงกชั่น
ความกลมกลืนเปนฟงกชั่นตอเนื่อง (continuous function) วิธีการประมาณคาพารามิเตอรใน
โปรแกรมลิสเรลมี 7 วิธี ในจํานวนนี้เปนการประมาณคาที่ใชความกลมกลืนมี 5 แบบ คือ 

1. วิธีกําลังสองนอยที่สุดไมถวงน้ําหนัก (Unweighted Least Square = ULS) 
2. วิธีกําลังสองนอยที่สุดวางนัยทั่วไป (Generalized Least Square = GLS) 
3. วิธีไลคลิฮูดสูงสุด (Maximum Likelihood = Mi) 
4. วิธีกําลังสองนอยที่สุดถวงน้ําหนักทั่วไป  
(Generally Weight Least Square  = WLS) 
5. วิธีกําลังสองนอยที่สุดถวงน้ําหนักแนวทแยง  
(Diagonal Weighted Least   Square = DWLS) 
ข้ันตอนที่ 4 การตรวจสอบความตรงของโมเดล (validation of the model) ข้ันตอนนี้

เปนการตรวจสอบความตรงของโมเดลที่เปนสมมติฐานการวิจัยหรือการประเมินผลความถูกตอง
ของโมเดลหรือการตรวจสอบความกลมกลืนระหวางขอมูลเชิงประจักษกับโมเดล คาสถิติที่ชวยใน
การตรวจสอบความตรงของโมเดลมี 5 วิธี  
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1. ความคลาดเคล่ือนมาตรฐานและสหสัมพันธของคาประมาณพารามิเตอร 
(standard errors and correlations of estimates) ถาสหสัมพันธระหวางคาประมาณมีคาสูงมาก
เปนสัญญาณแสดงวาโมเดลการวิจัยใกลจะไมเปนบวกแนนอน (non-positive definite) เปน
โมเดลที่ไมดีพอ 

2. สหสัมพันธพหุคูณและสัมประสิทธิ์การพยากรณ (multiple correlations and 
coefficients of determination) คาสถิติเหลานี้ควรมีคาสูงสุดไมเกินหนึ่งและคาที่สูงแสดงวา
โมเดลมีความตรง 

3. คาสถิติวัดระดับความกลมกลืน (goodness of fit measures) คาสถิติในกลุมนี้ใช
ตรวจสอบความตรงของโมเดลเปนภาพรวมทั้งโมเดล สําหรับโปรแกรมลิสเรลมี 7 ประเภท 
ดังตอไปนี้ 

 3.1 คาไคสแควร (chi-square statistics) ถาคาไคสแควรมีคาตํ่ามาก ยิ่งมีคาใกล
ศูนยมากเทาไรแสดงวาโมเดลลิสเรลมีความสอดคลองกับขอมูลเชิงประจักษ Saris และt 
Stronkhorst (1984 : 200 อางถึงใน นงลักษณ วิรัชชัย, 2542) เสนอวาคาไคแสควรควรมีคา
เทากับองศาอิสระสําหรับโมเดลที่มีความกลมกลืนกับขอมูลเชิงประจักษ 

 3.2 ดัชนีวัดระดับความกลมกลืน (Goodness of fit Index = GFI) ดัชนี GFI จะมี
คาอยูระหวาง 0 ถึง 1 เม่ือขนาดของกลุมตัวอยางมีคาสูงข้ึน ดัชนี GFI ที่เขาใกล 1 แสดงวาโมเดล
มีความกลมกลืนกับขอมูลเชิงประจักษ 

 3.3 ดัชนีวัดระดับความกลมกลืนที่ปรับแกแลว (Adjusted Goodness of fit 
Index = AGFI) มีคุณสมบัติเชนเดียวกับ GFI 

 3.4 ดัชนีรากของคาเฉล่ียกําลังสองของสวนที่เหลือ (Root Mean Squared 
Residual = RMR) คาของดัชนี RMR ยิ่งเขาใกลศูนยแสดงวาโมเดลมีความกลมกลืนกับขอมูลเชิง
ประจักษ 

4. การวิเคราะหเศษเหลือหรือความคลาดเคล่ือน (analysis of residuals) ในการใช
โปรแกรมลิสเรลนักวิจัยควรวิเคราะหเศษเหลือควบคูกันไปกับดัชนีตัวอ่ืน ๆ ผลจากการวิเคราะห
ขอมูลดวยโปรแกรมลิสเรลในสวนที่เกี่ยวของกับความคลาดเคล่ือนมีหลายแบบ แตละแบบให
ประโยชนในการตรวจสอบความกลมกลืนของโมเดลกับขอมูลเชิงประจักษดังนี้ 

 4.1 เมทริกซเศษเหลือหรือความคลาดเคลื่อนในการเทียบความกลมกลืน (fitted 
residuals matrix) ถาโมเดลมีความสอดคลองกลมกลืนกับขอมูล คาความคลาดเคล่ือนในรูป
คะแนนมาตรฐานไมควรมีคาเกิน 2 ถายังมีคาเกิน 2 ตองปรับโมเดล 
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 4.2 คิวพล็อต  (Q-plot)  เปนกราฟแสดงความสัมพันธ ระหวางคาความ
คลาดเคล่ือนกับ ควอนไทลปกติ (normal quantiles) ถาไดเสนกราฟมีความชันมากกวาเสนทแยง
มุมเปนเกณฑในการเปรียบเทียบแสดงวาโมเดลมีความสอดคลองกลมกลืนกับขอมูลเชิงประจักษ 

5. ดัชนีดัดแปรโมเดล (mode; modification indices) เปนคาสถิติเฉพาะสําหรับ
พารามิเตอรแตละตัวมีคาเทากับคาไค-สแควรที่จะลดลงเมื่อกําหนดใหพารามิเตอรตัวนั้นเปน
พารามิเตอรอิสระหรือมีการผอนคลายขอกําหนดเงื่อนไขบังคับของพารามิเตอรนั้น 

ข้ันตอนที่ 5 การปรับโมเดล (model adjustment) ในกรณีที่ผลการตรวจสอบความ
ตรงของโมเดลพบวาโมเดลไมสอดคลองกับขอมูลเชิงประจักษ ผูวิจัยตองทําการปรับโมเดลโดย
อาศัยดัชนีดัดแปรโมเดล เปนแนวทางในการปรับโมเดลจนกวาจะไดโมเดลที่สอดคลองกับขอมูล
เชิงประจักษ 

ข้ันตอนที่ 6 การแปลผลการวิเคราะหขอมูล เปนข้ันตอนสุดทายที่ผูวิจัยตองทํา
หลังจากที่ไดโมเดลที่สอดคลองกับขอมูลเชิงประจักษเรียบรอยแลว 

การดําเนินการทั้ง 6 ข้ันตอนนี้ตอเนื่องกัน  ดังแผนภาพท่ี 2.9 และเมื่อตรวจสอบ
ความสอดคลองระหวางขอมูลเชิงประจักษกับโมเดลลิสเรล ถาผลการวิเคราะหพบวาไมสอดคลอง
นักวิจัยอาจปรับโมเดลลิสเรลและดําเนินการวิเคราะหใหมอีกรอบหนึ่ง ถาพบวามีความสอดคลอง
ระหวางขอมูลเชิงประจักษและโมเดลลิสเรล จึงจะแปลความหมายผลการวิเคราะหขอมูลได 
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แผนภาพที่ 2.9 ข้ันตอนการวิเคราะหโมเดลลิสเรล 
ที่มา : นงลักษณ วิรัชชัย, 2542 

ลักษณะเดน ของการวิเคราะหโมเดลลิสเรลที่ทําใหผลการวิจัยมีความถูกตองและมีความ
นาเช่ือถือ แบงออกเปน 4 ประเด็น คือ (นงลักษณ  วิรัชชัย, 2542) 
 1. หลักการวิเคราะหโมเดลเปนหลักการที่ตรงตามวิธีวิทยาการวิจัย คือ นักวิจัยไดสราง
สมมติฐานในการวิจัยในรูปของความสัมพันธโครงสรางเชิงเสนระหวางตัวแปร โดยมีพื้นฐานมา
จากทฤษฎีและงานวิจัยที่เกี่ยวของแลวจึงนํามาวิเคราะหโมเดลลิสเรลโดยการตรวจสอบขอมูลเชิง
ประจักษกลมกลืนสอดคลองกับโมเดลลิสเรลที่พัฒนาข้ึน 
 2. โปรแกรมลิสเรล เปนวิธีการวิเคราะหขอมูลทางสถิติใชศึกษาความสัมพันธเชิงสาเหตุ
ไดทั้งการวิจัยที่เปนการวิจัยเชิงทดลองและไมใชการวิจัยเชิงทดลอง โดยผลการวิเคราะหขอมลูจะมี
ความถูกตองมากขึ้นจากการวิเคราะหแบบด้ังเดิม เนื่องจากในโมเดลมีการรวมตัวแปรแฝงและมี
การผอนคลายขอตกลงเบื้องตนหลายประการ ซึ่งทําใหขอมุลซ่ึงทําใหขอมูลสอดคลองกับขอตกลง

การระบุความเปนไปไดคาเดียว

การแปลความหมายโมเดล

การตรวจสอบความกลมกลืน

เมตริกซความแปรปรวน-ความแปรปรวนรวม

การกําหนดขอมูลจําเพาะ

โมเดลลิสเรล

การปรับโมเดล

ขอมูลเชิงประจักษ   การประมาณคาพารามิเตอร

ไมกลมกลืน

กลมกลืน
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ทางสถิติไดดีข้ึน เชน การที่โมเดลลิสเรลยอมใหตัวแปรมีความคลาดเคล่ือนในการวัดและความ
คลาดเคล่ือนอาจสัมพันธกันได แตถาเปนการวิเคราะหแบบสหสัมพันธพหุคูณซ่ึงเปนการวิเคราะห
แบบด้ังเดิมนั้น จะกําหนดวาตองไมมีความสัมพันธกันของความคลาดเคล่ือน และตัวแปรวัดได
โดยไมมีความคลาดเคล่ือน ดังนั้นหากผูวิจัยสรางเคร่ืองมือวัดตัวแปรอยางไมมีคุณภาพยอมทําให
ตัวแปรผลการวิจัยไมถูกตอง 
 3. เทคนิคการวิเคราะหขอมูลโมเดลลิสเรลนั้นจะครอบคลุมเทคนิคการวิเคราะหขอมูลทาง 
สถิติข้ันสูงเกือบทุกประเภทไมวาจะเปน การวิเคราะหความแปรปรวน การวิเคราะหหลายระดับ 
การวิเคราะหองคประกอบ การวิเคราะหอิทธิพล รวมทั้งการวิเคราะหโมเดลเกี่ยวกับการวัดแบบ
ตางๆ 
 4. การวิเคราะหโมเดลลิสเรล สามารถใชเปนเครื่องมือในการตรวจสอบทฤษฎีที่ผูวิจัย
ตองการศึกษา ทั้งในดานการตรวจสอบความตรงเชิงโครงสรางและการตรวจสอบความตรงของ
โมเดล โดยสามารถพิจารณาไดจากดัชนีที่โปรแกรมเสนอไวในผลการวิเคราะห เชน ไค-สแควร 
ดัชนีความสอดคลอง (GFI) ดัชนีความสอดคลองเชิงเปรียบเทียบ (CFI) และดัชนีรากกําลังสอง
เฉลี่ยของเศษที่เหลือ (RMR) ดัชนีเหลานี้จะบงบอกวาโมเดลที่ผูวิจัยพัฒนาขึ้นหรือโครงสรางที่
ตองการตรวจสอบนั้นมีความสอดคลองกับขอมูลเชิงประจักษหรือไม ถายังไมสอดคลองกับขอมูล
เชิงประจักษ ผูวิจัยยังสามารถปรับโมเดลโดยพิจารณาจากดัชนีปรับโมเดล (MI) และดัชนีการ
เปล่ียนแปลงที่คาดหวัง(EPC) 
 
ตอนท่ี 7 กรอบแนวคิดและสมมติฐานการวิจัย 

ริชารดดี จอหนสัน (Richard D. Johnson, 2005) ไดนําทฤษฎีการรับรูความสามารถของ
ตนเองกับทฤษฎีการตั้งเปาหมายมาสังเคราะหกันเพื่อศึกษาความสัมพันธระหวางตัวแปรหลัก              
2 ตัวแปร คือ การรับรูความสามารถดานคอมพิวเตอรของตนเองและความสามารถทาง
คอมพิวเตอร โดยเก็บนักศึกษาจํานวน 313 คน  ที่มีประสบการณการใชคอมพิวเตอร  และใน
งานวิจัยไดมีตัวแปรที่เกี่ยวของกัน 9 ตัวแปร ไดแก ระดับประสบการณเดิม บุคลิกภาพภายในของ
ผูเรียน ความมุงมั่นในการทํางาน ความวิตกกังวลในการใชคอมพิวเตอร การรับรูความสามารถ
ดานคอมพิวเตอรของตนเอง การต้ังเปาหมาย  ความผูกพันตอเปาหมาย เจตคติในการทํางาน 
และความสามารถทางคอมพิวเตอร   แตในงานวิจัยนี้ผูวิจัยไดตัดตัวแปรเจตคติในการทํางาน
ออกไป เพราะจากการศึกษาเอกสารและงานวิจัยที่เกี่ยวของทําใหทราบวาตัวแปรนี้ไมไดเปนผลมา
จากการเกิดการรับรูความสามารถดานคอมพิวเตอรของตนเอง ดังนั้นผูวิจัยจึงเลือกศึกษาตัวแปร
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ทั้งหมด 8 ตัว ไดแก ประสบการณเดิม บุคลิกภาพภายในของผูเรียน ความมุงมั่นในการทํางาน 
ความวิตกกังวลในการใชคอมพิวเตอร การรับรูความสามารถดานคอมพิวเตอรของตนเอง การ
ต้ังเปาหมาย  ความผูกพันตอเปาหมาย และความสามารถทางคอมพิวเตอร 

โดยจากการศึกษาเอกสารและงานวิจัยของริชารดดี จอหนสัน (Richard D. Johnson, 
2005) ที่เกี่ยวของกับตัวแปรที่สงผลตอการรับรูความสามารถดานคอมพิวเตอร ผูวิจัยจึงได
สังเคราะหตัวแปรโดยไดตัวแปรที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเองได 
4 ตัวแปร ไดแก ระดับประสบการณเดิม บุคลิกภาพภายในของผูเรียน ความมุงมั่นในการทํางาน
และความวิตกกังวลในการใชคอมพิวเตอร โดยมีรายละเอียด ดังตารางที่ 2.2 
 

ตารางที ่2.2 สรุปผลการสังเคราะหตัวแปรที่สงผลตอการรับรูความสามารถดานคอมพิวเตอร 
                    ของตนเอง 
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ตัวแปรทีส่งผลตอ 
การรับรูความสามารถ 

ดานคอมพิวเตอรของตนเอง 

1997 2000 2004 1989 2001 1992 2000
ระดับประสบการณเดิม / /      
บุคลิกภาพภายในของผูเรียน   /     
ความมุงมัน่ในการทํางาน    / /   
ความวิตกกงัวลในการใชคอมพิวเตอร      / / 
 นอกจากนี้แลวยังมีเอกสารและงานวิจยั ริชารดดี จอหนสัน (Richard D. Johnson, 
2005)ที่ไดกลาวถงึตัวแปรทีส่งผลตอความสามารถทางคอมพิวเตอร ซึ่งผูวิจยัไดสังเคราะหตัวแปร
โดยไดตัวแปรที่สงผลตอความสามารถทางคอมพวิเตอรได 3 ตัวแปร ไดแก การรับรูความสามารถ
ดานคอมพิวเตอรของตนเอง การตั้งเปาหมายและความผูกพันตอเปาหมาย โดยมีรายละเอียด ดังตาราง
ที่ 2.3 
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ตารางที ่2.3 สรุปผลการสังเคราะหตัวแปรที่สงผลตอความสามารถทางคอมพวิเตอร 
นักจิตวทิยา/นักวิจยั 
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ตัวแปรทีส่งผลตอ 
ความสามารถทางคอมพิวเตอร 

1984 1989 1995 2004 1986 1997 

การรับรูความสามารถดานคอมพวิเตอรของตนเอง / / /    
การต้ังเปาหมาย    / /  
ความผูกพนัตอเปาหมาย    / / / 
 

ดังนั้นจากการศึกษาแนวคิด ทฤษฎี เอกสารและงานวิจัยที่เกี่ยวของทั้งหมดทําใหผูวิจัย
สนใจที่จะศึกษาปจจัยจาก 2 ตัวแปร คือ การรับรูความสามารถดานคอมพิวเตอรของตนเองและ
ความสามารถทางคอมพิวเตอร โดยผูวิจัยขออธิบายเปน 3 สวนไดแก สวนที่ 1 ปจจัยที่ทําใหเกิด
การรับรูความสามารถดานคอมพิวเตอรของตนเอง สวนที่ 2 ผลของการรับรูความสามารถของ
ตนเองดานคอมพิวเตอร  และสวนที่ 3 ปจจัยที่มีผลทําใหเกิดความสามารถทางคอมพิวเตอร  

สวนที่ 1 ปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง ไดแก 
ประสบการณเดิม บุคลิกภาพภายในของผูเรียน ความมุงมั่นในการทํางาน และความวิตกกังวลใน
การใชคอมพิวเตอร   แบนดูรา (Bandura, 1997) ไดกลาววาประสบการณเดิม คือ การที่บุคคล
ไดรับขาวสารจากแหลงขอมูลตางๆซึ่งจะทําใหบุคคลนั้นไดรับรู เกิดการเรียนรูที่หลากหลาย เมื่อ
บุคคลใดไดรับประสบการณเดิมที่ประสบความสําเร็จมากอนก็จะเปนเหตุใหเกิดทักษะและมี
ความสามารถทางดานนั้นดวย ซึ่งสอดคลองกับ ซาราโนวา (Salanova, 2000) ที่กลาวเอาไววา
การไดใชคอมพิวเตอรหรือประสบการณการใชงานมากอนก็สามารถทํานายหรือประมาณคาการ
รับรูความสามารถดานคอมพิวเตอรของตนเองได  ดังนั้นประสบการณเดิมนาจะสงผลตอตอการ
รับรูความสามารถดานคอมพิวเตอรของตนเอง   ล็อคและลาแธม (Locke & Latham, 2004) ได
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กลาววาการรับรูความสามารถของตนเองเปนส่ือกลางความสัมพันธระหวางบุคลิกภาพภายในของ
บุคคลนั้น กระบวนการตั้งเปาหมาย และความสามารถทางคอมพิวเตอร ผูวิจัยจึงเห็นวา
บุคลิกภาพภายในของผูเรียน นาจะสงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง  
วูดและแบนดูรา (Wood and Bandura, 1989) ไดกลาวถึงความมุงมั่นในการทํางานวาเปนการ
กําหนดเปาหมายสําหรับการเรียนรูซึ่งจะสามารถประมาณคาการรับรูความสามารถของตนเองได 
เพราะวาการมีความมุงมั่นในการทํางาน จะเปนกระบวนการหนึ่งในการประมาณคาการรับรู
ความสามารถ เชน การศึกษาจากส่ิงรอบขาง การไดมาซึ่งทักษะ การพัฒนาตางๆ  และ แวนเดอวาล 
(Vandewalle, 2001) ไดศึกษาเกี่ยวกับความสัมพันธที่เกี่ยวกับความสนใจในการเขาศึกษาและ
แรงจูงใจ ซึ่งงานวิจัยเหลานี้ไดสอดคลองกับความสัมพันธระหวางการมีความมุงมั่นในการทํางาน 
และการรับรูความสามารถของตนเอง ฉะนั้นผูวิจัยจึงเห็นวาความมุงมั่นในการทํางานนาจะสงผลตอ
การรับรูความสามารถดานคอมพิวเตอรของตนเอง     ความวิตกกังวลในการใชคอมพิวเตอร คือ 
ความกลัว ความหวาดหวั่นความเกรงกลัวในการใชคอมพิวเตอร อันจะสงผลตอการสูญเสียในดาน
ตางๆ เชน การทํางาน การสื่อสารดานตางๆ กลัววาใชแลวจะกอใหเกิดขอผิดพลาดอะไรบางอยาง 
มาโตะชิคโค (Martocchio, 1992) และ จอหนสันและมาราสกา (Johnson and Marakas, 2000) 
ไดกลาววาความวิตกกังวลในการใชคอมพิวเตอรมีความสัมพันธตอการการรับรูความสามารถของ
ตนเองดานคอมพิวเตอร  ดังนั้นผูวิจัยจึงเห็นวาความวิตกกังวลในการใชคอมพิวเตอรนาจะสงผลทาง
ลบกับการรับรูความสามารถดานคอมพิวเตอรของตนเอง 

สวนที่ 2 ผลของการรับรูความสามารถดานคอมพิวเตอรของตนเอง ไดแก การต้ังเปาหมาย
ความผูกพันตอเปาหมาย ล็อคและลาแธม (Locke & Latham, 1990) ไดกลาววาความสําเร็จของ
เปาหมายสามารถทําใหบุคคลนั้นมีความสามารถเกิดข้ึน แตในทางตรงกันขามการรับรูความสามารถ
ของตนเองก็สามารถทําใหบุคคลนั้นมีความเชื่อในเปาหมาย ความผูกพันตอเปาหมายและเกิดการ
ต้ังเปาหมายดวยตนเอง  ดังนั้นผูวิจัยจึงเห็นวาการรับรูความสามารถดานคอมพิวเตอรของตนเอง
นาจะสงผลใหเกิดการต้ังเปาหมายและความผูกพันตอเปาหมาย  

สวนที่ 3 ปจจัยที่สงผลทําใหเกิดความสามารถทางคอมพิวเตอร   ไดแก  การรับรู
ความสามารถดานคอมพิวเตอรของตนเอง การต้ังเปาหมาย และความผูกพันตอเปาหมายล็อค 
(Lock , 1984) วูดและแบนดูรา (Wood and Bandura, 1989) คอมโบและฮิกกิ้น (Compeau and 
Higgins, 1995) ไดศึกษาการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีผลตอการเกิด
ความสามารถทางคอมพิวเตอร ซึ่งเปนผลที่นําไปสูความสําเร็จ    ในทางเดียวกัน ยีและอิม (Yi and 
Im, 2004) ก็ไดนําหลักการของ ล็อคและลาแธม(Locke & Latham, 1990) นี้ไปศึกษาตอในเร่ือง ผล
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ของการต้ังเปาหมาย ความผูกพันตอเปาหมายที่มีตอความสามารถทางคอมพิวเตอร  ดังนั้นผูวิจัยจึง
เห็นวา การรับรูความสามารถดานคอมพิวเตอรของตนเองการตั้งเปาหมาย และความผูกพันตอ
เปาหมายนาจะสงผลตอความสามารถทางคอมพิวเตอรเชนกัน 

จากที่กลาวมาทั้งหมดนี้ ผูวิจัยจึงขอนําเสนอกรอบแนวคิดโมเดลเชิงสาเหตุและผลของ
การรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถดานคอมพิวเตอรของ
นักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร โดยสรุปดังแผนภาพที่ 2.10 

 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ระดับประสบการณ 
ในการใชโปรแกรม
ประมวลผลคํา 

ระดับประสบการณใน
การใชโปรแกรม
นําเสนอผลงาน

การเห็นคุณคา 
ในตนเอง 

ความออนไหว 
ทางอารมณ 

ระดับความมุงมั่น
ในการทํางาน 

ระดับความวิตกกังวล 
ในการใชคอมพิวเตอร 

ระดับประสบการณเดิม 

บุคลิกภาพภายในของผูเรียน 

ความมุงมั่นในการทํางาน 

ความวิตกกังวล 
ในการใชคอมพิวเตอร 

การรับรูความสามารถ
ดานคอมพิวเตอรของตนเอง

การรับรูความสามารถ
ในการใชโปรแกรม
ประมวลผลคํา

การรับรูความสามารถ
ในการใชโปรแกรม
นําเสนอผลงาน

     การตั้งเปาหมาย 

ความผูกพันตอเปาหมาย

ระดับเปาหมายของ
ผลสําเร็จในการใช

โปรแกรมประมวลผลคํา

ระดับเปาหมายของ
ผลสําเร็จในการใช

โปรแกรมนําเสนอผลงาน

คะแนนทดสอบ 
โปรแกรมประมวลผลคํา 

คะแนนทดสอบ 
โปรแกรมนําเสนอผลงาน 

ความสามารถ
ทางคอมพิวเตอร

ระดับความผูกพันตอเปาหมาย

แผนภาพที่ 2.10 กรอบแนวคิดโมเดลความสัมพันธเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเอง
                        ที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร 83



บทที่ 3 
 

วิธีดําเนินการวิจัย 
 

การวิจัยในคร้ังนี้เปนการศึกษาความสัมพันธเชิงสาเหตุ (causal relationships) โดยมี
วัตถุประสงคหลักเพื่อพัฒนาและตรวจสอบความตรง (validation) ของโมเดลเชิงสาเหตุระหวาง
การรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของ
นักเรียนระดับชั้นมัธยมศึกษาตอนปลาย (ชวงช้ันที่ 4) ในเขตกรุงเทพมหานคร ดังมีรายละเอียด
และข้ันตอนการดําเนินการวิจัยดังตอไปนี้ 

 

ประชากรและกลุมตัวอยางที่ใชในการวิจัย 
 ประชากร 
 ประชากรที่ใชในการศึกษาคร้ังนี้  คือ นักเรียนระดับช้ันมัธยมศึกษาตอนปลาย (ชวงช้ันที่ 
4) ในกรุงเทพมหานคร จํานวน 161,763 คน ซึ่งผูวิจัยใชเปนกรอบประชากรในการกําหนดขนาด
ของกลุมตัวอยางในการวิจัยคร้ังนี้ 

กลุมตัวอยาง 
 กลุมตัวอยางที่ใชในการศึกษาคร้ังนี้ คือ นักเรียนระดับชั้นมัธยมศึกษาตอนปลาย (ชวงชัน้ที ่4)
ในกรุงเทพมหานคร ประจําภาคเรียนที่ 2 ปการศึกษา 2551 จํานวน 720 คน ซึ่งไดจากการกาํหนด
ขนาดของกลุมตัวอยางโดยใชแนวคิดของลินดแมน (Lindman, 1980 อางถึงในนงลักษณ วิรัชชัย , 
2542) เนื่องจากการวิจัยในคร้ังนี้เปนการวิเคราะหดวยโปรแกรมลิสเรล ซึ่งลินดแมน เสนอวาขนาด
กลุมตัวอยางตองมีอยางนอย 20 คน ตอ 1 พารามิเตอร โดยการวิจัยคร้ังนี้ไดกําหนดจํานวน
พารามิเตอรที่ตองประมาณคาในโมเดล จํานวน 36 พารามิเตอร จึงไดขนาดกลุมตัวอยาง จํานวน 
720 คน  
 การสุมตัวอยาง 

กลุมตัวอยางที่ใชในการศึกษาคร้ังนี้ คือ  นักเรียนระดับชั้นมัธยมศึกษาตอนปลาย                    
(ชวงช้ันที่ 4) ในเขตกรุงเทพมหานคร จํานวน 720 คน โดยผูวิจัยใชวิธีการสุมตัวอยางแบบหลาย
ข้ันตอน (Multi-State Sampling) โดยมีรายละเอียด ดังนี้ 

ข้ันที่ 1 แบงโรงเรียนตามสังกัด โดยผูวิจัยสนใจที่จะศึกษาในโรงเรียน 2 สังกัด คือ โรงเรียน
รัฐบาลสังกัดสํานักงานคณะกรรมการการศึกษาข้ันพื้นฐาน (สพฐ.) กระทรวงศึกษาธิการและ 
โรงเรียนเอกชนสังกัดสํานักบริหารงานคณะกรรมการสงเสริมการศึกษาเอกชน (สช.) สํานักงาน
ปลัดกระทรวง กระทรวงศึกษาธิการ ซึ่งเหตุผลที่ไมไดวิจัยโรงเรียนในสังกัดกรุงเทพมหานคร
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เนื่องจากโรงเรียนสังกัดกรุงเทพมหานครไมไดมีเปาหมายในการผลิตนักเรียนในระดับมัธยมศึกษา
ตอนปลายแลวแบงขนาดของโรงเรียนทั้ง 2 กลุม เปนโรงเรียนขนาดกลาง และโรงเรียนขนาดใหญ 
โดยใชเกณฑของกรมสามัญศึกษา  (กรมสามัญศึกษา 2542: 5)  ดังนี้ 

โรงเรียนขนาดกลาง จํานวนนักเรียน  500 – 1,499 คน 
โรงเรียนขนาดใหญ จํานวนนักเรียนต้ังแต  1,500 คน ข้ึนไป 

 โดยผูวิจัยสนใจที่จะศึกษาในโรงเรียนขนาดกลางและขนาดใหญเนื่องจาก โรงเรียนในกลุม
นี้จะมีการสนับสนุนอุปกรณส่ือการเรียนการสอนทางโสตทัศนศึกษาอีกทั้งโรงเรียนยังไดมีการจัด
เนื้อหาสาระการเรียนรู (โปรแกรมท่ีใชสอน) ไดสอดคลองกับการรับรูความสามารถดาน
คอมพิวเตอรของผูเรียนซ่ึงจะมีผลตอความสามารถทางคอมพิวเตอร    

ข้ันที่ 2 เลือกโรงเรียนที่จะศึกษาโดยการสุมตัวอยางแบบแบงชั้น (stratified random 
sampling) ตามขนาดโรงเรียน และสุมโรงเรียนในแตละขนาด โดยใชวิธีการสุมอยางงาย (simple 
random sampling) ไดจํานวนโรงเรียนที่เปนกลุมตัวอยาง สังกัดละ 10 โรงเรียน โดยแตละสังกัด             
มีโรงเรียนทั้งขนาดกลางและขนาดใหญ อยางละ 5 โรงเรียน 

ข้ันที่ 3 ทําการสุมนักเรียนที่กําลังศึกษาอยูในระดับช้ันมัธยมศึกษาตอนปลาย (ชวงชั้นที่ 4)
ซึ่งผูวิจัยกําหนดใหทางโรงเรียนเปนผูสุมนักเรียนเองโดยสุมนักเรียน โรงเรียนละ 40 คน เนื่องจาก
ผูวิจัยใชวิธีการเก็บรวบรวมขอมูลโดยวิธีการสงแบบสอบถามทางไปรษณีย ดังนั้นจึงปองกันอัตรา
การตอบกลับในระดับตํ่าดวยการเพิ่มจํานวนแบบสอบถามที่สงเปนโรงเรียนละ 50 ฉบับ ดังนั้น
จํานวนแบบสอบถามที่สงจึงมีจํานวนทั้งส้ิน 1,000 ฉบับ รายละเอียดแสดงดังตารางที่ 3.1  

 

ตารางที ่3.1 จํานวนประชากรและกลุมตัวอยางนกัเรียนที่ใชในการวจิัย จําแนกตามขนาดโรงเรียน 
 

จํานวน
ประชากร 

(คน) 
สังกัด ขนาด

โรงเรียน 
จํานวนโรงเรียน
กลุมตัวอยาง 

จํานวนนักเรยีน
กลุมตัวอยาง 

จํานวน
แบบสอบถามที่สง

ใหญ 5 200 250 สพฐ. 
กลาง 5 200 250 
ใหญ 5 200 250 

161,763 
สช. 

กลาง 5 200 250 
รวม 20 800 1,000 
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ตัวแปรที่ใชในการวิจัย 
ตัวแปรที่ศึกษาในการวิจัยคร้ังนี้ ประกอบดวยตัวแปรแฝง 8  ตัวแปร ไดแก ระดับ

ประสบการณเดิม  บุคลิกภาพภายในของผูเรียน  ความมุงมั่นในการทํางาน  ความวิตกกังวลใน
การใชคอมพิวเตอร  การรับรูความสามารถดานคอมพิวเตอรของตนเอง  การต้ังเปาหมาย  ความ
ผูกพันตอเปาหมาย และความสามารถทางคอมพิวเตอร  ซึ่งวัดไดจากตัวแปรสังเกตไดรวม 13 ตัว
แปร ดังมีรายละเอียดของตัวแปรแฝงแตละตัว ดังตอไปนี้ 

1. ตัวแปรภายในแฝง (endogenous latent) ไดแก การรับรูความสามารถดาน
คอมพิวเตอรของตนเอง การต้ังเปาหมาย ความผูกพันตอเปาหมายและความสามารถทาง
คอมพิวเตอร โดยมีรายละเอียดแตละตัวแปร ดังตอไปนี้ 

1.1 การรับรูความสามารถดานคอมพิวเตอรของตนเอง (COMSELF) หมายถึง 
การที่ผูเรียนตัดสินความสามารถของตนเองดานคอมพิวเตอรในการจัดการใหบรรลุเปาหมาย ที่
กําหนดไว ซึ่งวัดจากการรับรูความสามารถในการใชโปรแกรมประมวลผลคํา (Microsoft Word) 
และโปรแกรมนําเสนอผลงาน (Microsoft PowerPoint) โดยวัดดวยแบบสอบถามแบบมาตร
ประมาณคา (rating scale) 5 ระดับ ที่ผูวิจัยไดสรางข้ึนเอง จํานวน 33 ขอ  

1.2 การตั้งเปาหมาย (GOALLEVEL) หมายถึง การที่ผูเรียนคาดหวังและกําหนด
รอยละของผลสําเร็จในการใชโปรแกรมประมวลผลคํา (Microsoft Word) และโปรแกรมนําเสนอ
ผลงาน (Microsoft PowerPoint) เปนเปาหมายตามทักษะของตนเอง ซึ่งวัดไดจากแบบตรวจสอบ
รายการ (check list) ที่ผูวิจัยสรางข้ึน จํานวน 2 ขอ โดยผูวิจัยทําการลงรหัสคะแนนของตัวแปรการ
ตั้งเปาหมาย โดยกําหนดให 1 = รอยละ 0 – 20 2 = รอยละ 21 – 40 3 =  รอยละ 41 – 60             
4 = รอยละ 61 – 80 5 = รอยละ 81 – 100 

1.3 ความผูกพันตอเปาหมาย (GOALCOMM) หมายถึง การที่ผูเรียนมีความรูสึก
รับผิดชอบตอเปาหมายซึ่งเนนผลสําเร็จของงานที่ผูเรียนกําหนดไว ซึ่งวัดไดจากแบบสอบถามแบบ
มาตรประมาณคา (rating scale) 5 ระดับที่ผูวิจัยไดพัฒนามาจากแบบวัดของ Hollenback 
(1987) จํานวน 6 ขอ  

1.4 ความสามารถทางคอมพิวเตอร (COMPER) หมายถึง คะแนนที่ไดจากการ
ทดสอบผูเรียนเก่ียวกับการใชโปรแกรมคอมพิวเตอร ประกอบดวย คะแนนจากการทดสอบ
โปรแกรมประมวลผลคํา (Microsoft Word) และโปรแกรมนําเสนอผลงาน (Microsoft 
PowerPoint) ซึ่งวัดไดจากแบบทดสอบปรนัย 4 ตัวเลือกจํานวน 35 ขอ 
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2. ตัวแปรภายนอกแฝง (exogenous latent) ไดแก ระดับประสบการณเดิม บุคลิกภาพ
ภายในของผูเรียน ความมุงม่ันในการทํางานและความวิตกกังวลในการใชคอมพิวเตอร 

2.1 ระดับประสบการณเดิม (PREVEXP) หมายถึง ภูมิหลังในการใชโปรแกรม
ประมวลผลคําและโปรแกรมนําเสนอผลงาน ประกอบดวย จํานวนปของประสบการณในการใช
โปรแกรมและจํานวนชั่วโมงเฉล่ียตอวันในการใชโปรแกรม ซึ่งวัดเปนระดับความมากนอยของ
ประสบการณจากแบบตรวจสอบรายการ (check list) ที่ผูวิจัยสรางข้ึน จํานวน 4 ขอ โดย ผูวิจัยทํา
การลงรหัสคะแนนของตัวแปรระดับประสบการณเดิม ดังนี้ 

ประสบการณในการใชโปรแกรม  
 นอยกวา 1 ป ใหคะแนนเทากับ 1   
 1 – 2 ป ใหคะแนนเทากับ 2  
 3 – 4 ป  ใหคะแนนเทากับ 3 
 5 – 6 ป  ใหคะแนนเทากับ 4 
 มากกวา 6 ป ใหคะแนนเทากับ 5 

จํานวนช่ัวโมงในการใชโปรแกรมโดยเฉล่ียตอวัน 
 นอยกวา 1 ชัว่โมง / วัน ใหคะแนนเทากับ 1 
 1 – 2 ชั่วโมง / วนั ใหคะแนนเทากับ 2 
 3 – 4  ชัว่โมง / วนั ใหคะแนนเทากับ 3   
 5 – 6  ชัว่โมง / วนั ใหคะแนนเทากับ     4                          
 มากกวา 6  ชั่วโมง / วัน ใหคะแนนเทากับ  5                

2.2 บุคลิกภาพภายในของผูเรียน  (TRAINPER)   หมายถึง การรับรูของผูเรียนใน
การประเมินตนเองเกี่ยวกับความสามารถในการกระทําส่ิงตางๆทั้งเชิงบวกและเชิงลบ  ซึ่งวัดจาก
การเห็นคุณคาในตนเองและความออนไหวทางอารมณ  โดยวัดดวยแบบสอบถามแบบมาตร
ประมาณคา (rating scale) 5 ระดับที่ผูวิจัยไดพัฒนามาจากแบบวัดของ Judge (2003)  จํานวน 
16 ขอ  

2.3 ความมุงมั่นในการทํางาน (LEARNGOA)  หมายถึง  ลักษณะการแสดงออก
ของผูเรียนที่มีเปาหมายในการเรียนรูและมุงเนนในการทํางานใหบรรลุผลสําเร็จ ซึ่งวัดไดจาก
แบบสอบถามแบบมาตรประมาณคา  (rating scale)  5 ระดับที่ผูวิจัยไดพัฒนามาจากแบบวัดของ 
Button (1996) จํานวน 8 ขอ  
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2.4 ความวิตกกังวลในการใชคอมพิวเตอร (COMANXIE) หมายถึง สภาวะที่
ผูเรียนรูสึกหวั่นไหวตอการใชคอมพิวเตอรอันสงผลใหผูเรียนเกิดความรูสึกในทางลบที่มีตอ
คอมพิวเตอร    ซึ่งวัดไดจากแบบสอบถามแบบมาตรประมาณคา (rating scale) 5 ระดับที่ผูวิจัยได
พัฒนามาจากแบบวัดของ Heinssen (1987) จํานวน 4 ขอ  

 
 
 

เครื่องมือที่ใชในการวิจัย 
 การวิจัยในคร้ังนี้ ใชแบบสอบถามและแบบทดสอบเปนเคร่ืองมือในการเก็บรวบรวม
ขอมูล ประกอบดวย 4 ตอน ดังนี้ 

 ตอนที่ 1 ขอมูลทั่วไปของนักเรียน เปนขอคําถามเกี่ยวกับลักษณะทางประชากรของกลุม
ตัวอยาง เปนแบบเติมคําตอบในชองวางและแบบตรวจสอบรายการ (check list) จํานวน 12 ขอ 

 ตอนที่ 2 แบบสอบถามเกี่ยวกับปจจัยที่สงผลตอการรับรูความสามารถดาน
คอมพิวเตอร  ประกอบไปดวยขอคําถาม 3 ดาน คือ 1)ดานบุคลิกภาพภายในของผูเรียน ซึ่ง
ผูวิจัยพัฒนามาจากแบบวัดของ Judge (2003)  2) ดานความมุงมั่นในการทาํงาน ซึง่ผูวจิยัพฒันา
มาจากแบบวัดของ Button (1996)  และ 3) ดานความวิตกกังวลในการใชคอมพิวเตอร  ซึ่ง
ผูวิจัยพัฒนามาจากแบบวัดของ Heinssen (1987) โดยเปนแบบมาตรประมาณคา (rating scale)  
5 ระดับ  จํานวน 28 ขอ                    
 โดยมีความหมายของแตละระดับ ดังนี ้
  5 หมายถงึ   เห็นดวยอยางยิ่งกับขอความนั้น  
  4 หมายถงึ   เห็นดวยกับขอความนั้น     
  3 หมายถงึ   ไมแนใจกับขอความนั้น    
  2 หมายถงึ   ไมเห็นดวยกับขอความนัน้          
  1 หมายถงึ   ไมเห็นดวยอยางยิง่กับขอความนัน้ 
  ขอคําถามในสวนนี้  แยกเปน 2 กรณี ไดแก ขอคําถามเชิงบวก และขอคําถามเชิงลบซึ่ง
เกณฑการใหคะแนนแยกเปน 2 กรณี ดังตารางที่ 3.2 
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ตารางที ่3.2 เกณฑการใหคะแนนขอความเกีย่วกบับุคลิกภาพภายในของผูเรียน 
 

เกณฑการใหคะแนน ระดับความคิดเห็น 
คําถามเชิงบวก คําถามเชิงลบ 

เห็นดวยอยางยิ่งกับขอความนั้น  5 1 
เห็นดวยกับขอความนั้น  4 2 
ไมแนใจกับขอความนั้น  3 3 
ไมเห็นดวยกับขอความนัน้  2 4 
ไมเห็นดวยอยางยิง่กับขอความนัน้  1 5 

  

 
ตัวอยางเคร่ืองมือแบบวัดบุคลิกภาพภายในของผูเรียนมีดังนี้ 
 

ระดับความคิดเห็น 

ขอความ 

มา
กท
ี่สุด

 

มา
ก 

ปา
นก
ลา
ง 

นอ
ย 

นอ
ยท
ี่สุด

 

   1. ฉันเปนทีรั่กใครของผูอ่ืน      
   2. ฉันไมสามารถเปนทีพ่ึ่งของใครไดเลย      

  
ตอนที่ 3  แบบสอบถามปจจัยที่สงผลตอความสามารถทางคอมพิวเตอร  ประกอบไปดวย

ขอคําถาม 2 ดาน คือ 1) ดานการรับรูความสามารถดานคอมพิวเตอรของตนเอง  และ 2) ดาน
ความผูกพันตอเปาหมาย  โดยขอคําถามดานการรับรูความสามารถดานคอมพิวเตอรของตนเอง
แบงเปน 2 สวน คือ การรับรูความสามารถในการใชโปรแกรมประมวลผลคําและการรับรู
ความสามารถในการใชโปรแกรมนําเสนอผลงาน ซึ่งผูวิจัยไดสรางข้ึนมาเองโดยเปนแบบมาตร
ประเมินคา (rating scale)   5 ระดับ   สวนขอคําถามดานความผูกพันตอเปาหมาย สามารถวัด
จากขอคําถามซ่ึงผูวิจัยไดพัฒนาแบบวัดและอางอิงมาจาก  Hollenbeck (1989) เปนแบบมาตร
ประเมินคา (rating scale) 5 ระดับ จํานวน 39 ขอ โดยมีความหมายและเกณฑการใหคะแนน
เชนเดียวกับแบบวัดบุคลิกภาพภายในของผูเรียน 
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ตัวอยางแบบสอบถามเกี่ยวกับแบบวัดความผูกพันตอเปาหมาย 
  

ระดับความคิดเห็น 

 ขอความ 

มา
กท
ี่สุด

 

มา
ก 

ปา
นก
ลา
ง 

นอ
ย 

นอ
ยท
ี่สุด

 

  1.ฉันคิดวาเปาหมายนี้เปนเปาหมายทีดี่ 
     ในการเริ่มดําเนนิการ 

     

 

 ตอนที่ 4 แบบทดสอบความสามารถทางคอมพิวเตอร วัดจากคะแนนความสามารถทาง
คอมพิวเตอรในการใชโปรแกรมประมวลผลคํา (Microsoft Word) และโปรแกรมนําเสนอผลงาน 
(Microsoft Powerpoint) ที่ผูวิจัยสรางข้ึนเองและมีความสอดคลองกับหลักสูตรการศึกษาข้ัน
พื้นฐานในชวงชั้นที่ 3 - 4 พ.ศ. 2551 เปนแบบทดสอบปรนัยแบบ 4 ตัวเลือก จํานวน 35 ขอ 
 

ตัวอยางแบบทดสอบความสามารถทางคอมพิวเตอร 
 

 1.  การเรียกดูเอกสารกอนพมิพคร้ังละหลายๆหนา  ตองคลิกที่ปุมใด 
 1.  2.  
 3.  4.  

 

การสรางและการตรวจสอบคุณภาพของเครื่องมือ 
 เคร่ืองมือที่ใชในการเก็บรวบรวมขอมูล คือ แบบสอบถามและแบบทดสอบ โดยในข้ันแรก
ผูวิจัยขอเสนอข้ันตอนการสรางและตรวจสอบคุณภาพของแบบสอบถาม ดังนี้ 
 ข้ันตอนที่ 1 ศึกษาเอกสาร ตํารา งานวิจัย และทฤษฎีที่เกี่ยวของกับการรับรูความสามารถ 
ดานคอมพิวเตอรของตนเอง กําหนดนิยามของตัวแปรและโครงสรางของตัวแปรที่ตองการวัด  
 ข้ันตอนที่ 2  นํานิยามตัวแปรที่ผูวิจัยกําหนดข้ึนในข้ันตอนที่ 1 มาสรางตารางวิเคราะห
โครงสรางตัวแปรที่ตองการศึกษา 
 ข้ันตอนที่ 3 สรางขอคําถามตามโครงสรางของตัวแปร ดังตารางที่ 3.3  

ข้ันตอนที่ 4 นําแบบสอบถามที่สรางข้ึน ไปใหอาจารยที่ปรึกษาตรวจแกไขและให
คําแนะนําเพื่อปรับปรุงแบบสอบถามใหเหมาะสม แลวนําแบบสอบถามไปใหผูเชี่ยวชาญทางดาน
การวัดและประเมินผลทางการศึกษา ผูเช่ียวชาญทางดานจิตวิทยาและผูเช่ียวชาญทางดานการ
สอนคอมพิวเตอร จํานวน 5 ทาน ตรวจสอบคุณภาพของเคร่ืองมือในดานความตรงเชิงเนื้อหา 
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(content validity)  การใชภาษา และความถูกตองของภาษา แลวนํามาปรับปรุงแกไข โดยมี
เกณฑในการคัดเลือกผูเชี่ยวชาญในการตรวจสอบคุณภาพของเคร่ืองมือ ดังนี้ 
 1. นักวิชาการที่มีประสบการณสาขาการวัดและประเมินผลทางการศึกษาที่มี
ประสบการณทํางานมากกวา 5 ป จํานวน 1 ทาน 
 2. ครูที่มีความเช่ียวชาญทางดานจิตวิทยาและมีประสบการณทํางานมากกวา 10 ป 
จํานวน 2 ทาน  
 3. ครูที่มีความเช่ียวชาญทางดานการสอนคอมพวิเตอรและมีประสบการณทาํงาน
มากกวา 10 ป จาํนวน 2 ทาน  

โดยการตรวจสอบความตรงเชิงเนื้อหา ใชดัชนี IOC (index of consistency) โดยมี
เงื่อนไขใหผูเชี่ยวชาญตัดสินอยางเปนระบบ ซึ่งมีลักษณะการใหคะแนน คือ 

 1    เมื่อแนใจวา       รายการหรือขอคําถามนั้นสอดคลองกับคํานยิาม 
 0    เมื่อไมแนใจวา   รายการหรือขอคําถามนั้นสอดคลองกับคํานิยาม  
           -1    เมื่อแนใจวา       รายการหรือขอคําถามนั้นไมสอดคลองกับคํานิยาม 

 โดยผูวิจัยไดกําหนดเกณฑที่ใชในการตัดสินความตรงเชิงเนื้อหา คือ คาดัชนี IOC (index 
of consistency) ตองมากกวา 0.5 (IOC >0.5) จึงถือวาขอคําถามนั้นสอดคลองกับโครงสราง
และนิยามที่ตองการวัด (ศิริชัย กาญจนวาสี, 2544)  ผลการตรวจสอบพบวา ขอคําถามทั้งหมดมี
คาดัชนี IOC มากกวา 0.5 (IOC >0.5)  และมีการปรับภาษาเล็กนอย ผูวิจัยจึงปรับปรุง
แบบสอบถามใหสมบูรณตามขอเสนอแนะของผูเชี่ยวชาญ โดยผานความเห็นชอบจากอาจารยที่
ปรึกษา โดยรายละเอียดของผลการตรวจสอบคุณภาพและการปรับปรุงแบบสอบถาม ดังแสดง
ในภาคผนวก ง และ จ 
 

ตารางที่ 3.3 โครงสรางตัวแปรที่ตองการวดัและจํานวนขอในแบบสอบถาม 
 

ประเดน็หลัก จํานวนขอ ประเดน็ยอย จํานวนขอ ตอนที ่ ขอที่ 
ภูมิหลัง 6 สถานภาพทั่วไป 6 ตอนที่ 1 1 – 6 

ระดับประสบการณในการใช
โปรแกรมประมวลผลคํา 

2 ตอนที่ 1 7 – 8 
ระดับประสบการณ
เดิม 4 

ระดับประสบการณในการใช
โปรแกรมนําเสนอผลงาน 

2 ตอนที่ 1 10 – 11 

การเห็นคุณคาในตนเอง 8 ตอนที่ 2 1 – 8 บุคลิกภาพภาย          
ในของผูเรียน 

16 
ความออนไหวทางอารมณ 8 ตอนที่ 2 9 – 16 



 92

ตารางที่ 3.3 โครงสรางตัวแปรที่ตองการวดัและจํานวนขอในแบบสอบถาม (ตอ) 
 

ประเดน็หลัก จํานวนขอ ประเดน็ยอย จํานวนขอ ตอนที ่ ขอที่ 
ความมุงม่ันในการ
ทํางาน 8 

ระดับความมุงม่ันในการ
ทํางาน 

8 ตอนที่ 2  17 – 24 

ความวิตกกังวลใน
การใชคอมพิวเตอร 

4 
ระดับความวิตกกังวลในการ
ใชคอมพิวเตอร 

4 ตอนที่ 2 25 – 28 

การรับรูความสามารถในการ
ใชโปรแกรมประมวลผลคํา 

17 ตอนที่ 3 1 – 17  การรับรู
ความสามารถดาน
คอมพิวเตอรของ
ตนเอง 

33 
การรับรูความสามารถในการ
ใชโปรแกรมนําเสนอผลงาน 

16 ตอนที่ 3 18 – 33 

ความผูกพันตอ
เปาหมาย 
 
 

6 

ระดับความผูกพันตอ
เปาหมาย 

6 ตอนที่ 3 34 – 39 

ระดับเปาหมายของผลสําเร็จ
ในการใชโปรแกรม
ประมวลผลคํา 

1 ตอนที่ 1 9 การต้ังเปาหมาย 

2 
ระดับเปาหมายของผลสําเร็จ
ในการใชโปรแกรมนําเสนอ
ผลงาน 

1 ตอนที่ 1 12 

 

ข้ันตอนที่ 5 นําแบบสอบถามที่ปรับปรุงแลวไปทดลองใช (Try Out) กับนักเรียนจํานวน 
30 คน ที่ไมใชกลุมตัวอยาง แลวนํามาวิเคราะหหาคาความเที่ยงแบบความสอดคลองภายใน 
(internal consistency reliability) โดยวิธีหาสัมประสิทธิ์แอลฟาของครอนบาค (Cronbach’s 
Alpha coefficient) โดยมีรายละเอียดผลการตรวจสอบความเที่ยงของแบบสอบถาม ดังตารางที่ 3.4 
 ผลการวิเคราะหพบวา ขอคําถามในแตละดานมีคาความเท่ียงอยูระหวาง 0.6081 ถึง 
0.9507 และคาความเที่ยงทั้งฉบับ คือ 0.8999 แสดงวาแบบสอบถามที่ผูวิจัยสรางข้ึนมีคุณภาพ            
ในระดับคอนขางสูง สําหรับคาความเท่ียงของแบบวัดในแตละดานและทั้งฉบับ มีรายละเอียด          
ดังตารางที่ 3.4  
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ตารางที่ 3.4  คาความเที่ยงของแบบวัด จาํแนกตามตัวแปร 
 

ตัวแปร คาความเที่ยง 
ระดับประสบการณในการใชโปรแกรมประมวลผลคํา 0.6706 
ระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน 0.6855 
การเหน็คุณคาในตนเอง 0.7724 
ความออนไหวทางอารมณ 0.7198 
ความมุงมัน่ในการทํางาน 0.8119 
ความวิตกกงัวลในการใชคอมพิวเตอร 0.7703 
การรับรูความสามารถในการใชโปรแกรมประมวลผลคํา 0.9294 
การรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน 0.9507 
ความผูกพนัตอเปาหมาย 0.6081 

คาความเที่ยงทั้งฉบับ 0.8999 
 ลําดับตอมาผูวิจัยขอเสนอข้ันตอนการสรางและตรวจสอบคุณภาพของแบบทดสอบ ดังนี้ 
 ข้ันตอนที่ 1 ศึกษาหลักสูตรการศึกษาข้ันพื้นฐาน พุทธศักราช 2544 เอกสาร ตําราทีเ่กีย่วของ
กับสาระการเรียนรูในกลุมการงานอาชีพและเทคโนโลยีดานความสามารถทางคอมพิวเตอรของ
ตนเองของชวงช้ันที่ 4 ที่มีความมุงเนนปลูกฝงความรู ความสามารถและทักษะในวิทยาการและ
เทคโนโลยีเพื่อนําไปใชประโยชนทางการศึกษาอยางมีประสิทธิภาพ 
 ข้ันตอนท่ี 2 ศึกษาผลการเรียนรูที่คาดหวังจากหนังสือเรียนรายวิชาเทคโนโลยีสารสนเทศ
ระดับชวงชั้นที่ 4 ที่เกี่ยวของกับการใชโปรแกรมประมวลผลคําและโปรแกรมนําเสนอผลงาน 
 ข้ันตอนที่ 3 สรางแบบทดสอบความสามารถทางคอมพิวเตอรใหสอดคลองกับผลการ
เรียนรูที่คาดหวังเพื่อวัดความสามารถทางคอมพิวเตอรในการใชงานโปรแกรมประมวลผลคําและ
โปรแกรมนําเสนอผลงาน โดยผูวิจัยกําหนดโครงสรางเนื้อหาและผลการเรียนรูที่คาดหวังในการ
สรางขอสอบ ซึ่งประกอบไปดวย ขอสอบวัดความสามารถทางคอมพิวเตอรในการใชโปรแกรม
ประมวลผลคําและโปรแกรมนําเสนอผลงานเปนแบบทดสอบปรนัยชนิดเลือกตอบ 4 ตัวเลือก 
จํานวน 35 ขอ  ดังแสดงในตารางที่ 3.5  
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ตารางที่ 3.5 โครงสรางเนื้อหา ผลการเรียนรูที่คาดหวงั และจํานวนขอสอบวัดความสามารถ 
 ทางคอมพวิเตอร 
 

ความสามารถทาง
คอมพิวเตอร 

ผลการเรียนรูที่คาดหวัง ขอสอบขอที่

สามารถอธิบายหนาที่และสวนประกอบในแถบเครื่องมือใน
โปรแกรมประมวลผลคํา 

1 

สามารถสราง บันทึก เปด และแทรกขอความลงในเอกสารนั้นๆ 2 
สามารถต้ังคาหนากระดาษ ต้ังก้ันหนา ก้ันหลังขอความ 3 
สามารถกําหนดตําแหนงของแท็บและเลือกใชแท็บใหเหมาะสม
กับงาน 

4 

ความสามารถทาง 
คอมพิวเตอรในการใช 
โปรแกรมประมวลผลคํา 

สามารถเลือกขอความ ยายขอความ คัดลอกและลบขอความ 5 
 สามารถจัดรูปแบบขอความ รวมไปถึงการกําหนดหมายเลข

ลําดับ และเคร่ืองหมายหนาขอความ 
6 – 7 

 สามารถปรับเปล่ียนลักษณะของตัวอักษร เปล่ียนสีใหตัวอักษร
และใสสีพื้นหลังใหกับขอความ 

8 

 สามารถปรับระยะหางระหวางตัวอักษร บรรทัดและยอหนา 9 
 สามารถแทรกสัญลักษณพิเศษและอักขระพิเศษลงในเอกสาร 10 
 สามารถใสกรอบใหกับขอความ เอกสารและแบงคอลัมน 11 
 สามารถเรียกดูเอกสารกอนพิมพและส่ังพิมพเอกสารได 12 – 13 
 สามารถสรางตาราง แทรกแถว คอลัมน 14 – 15 
 สามารถสรางวัตถุรูปวาด ตัวอักษรศิลปและสามารถแทรก

รูปภาพ 
16 

 สามารถใสขอความในหัวกระดาษ ทายกระดาษและหมายเลข
หนา 

17 

สามารถอธิบายถึงความสามารถของโปรแกรมนําเสนอผลงาน 18 
สามารถสราง บันทึก เปดและปดงานนําเสนอผลงานได 19 

ความสามารถทาง 
คอมพิวเตอรในการใช 
โปรแกรมนําเสนอผลงาน สามารถบอกความแตกตางของมุมมองในการทํางานของ

โปรแกรม 
20 – 21 

 สามารถเปล่ียนลําดับสไลด ลบสไลด และเพิ่มสไลด 22 
 สามารถกําหนดขนาด ตัวหนา ตัวเอน ตัวขีดเสนใตและใสเงา

ใหกับขอความ 
23 – 24 

 สามารถใสตัวเลขและสัญลักษณแสดงลําดับหัวขอได 25 
 สามารถใชเคร่ืองมือวาดภาพและทํางานกับวัตถุตางๆ 26 
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ตารางที่ 3.5 โครงสรางเนื้อหา ผลการเรียนรูที่คาดหวงั และจํานวนขอสอบวัดความสามารถ 
                    ทางคอมพวิเตอร (ตอ) 
ความสามารถทาง
คอมพิวเตอร 

ผลการเรียนรูที่คาดหวัง ขอสอบขอที่

 สามารถบอกความแตกตางของภาพแบบเวคเตอร (Vector) กับ
ภาพแบบราสเตอร (Raster) 

27 

 สามารถปรับแตงภาพจากไฟลได 28 
 สามารถสรางกราฟและแผนผังลงในสไลด 29 
 สามารถตกแตงพื้นหลัง และสรางแมแบบ (Template) ได 30 – 31 
 สามารถกําหนดเอฟเฟคใหกับวัตถุตางๆตลอดจนเอฟเฟคพิเศษ 

(Transition) 
32 

 สามารถเพ่ิมเสียงประกอบทั้งภายในและภายนอกโปรแกรมเพ่ือ
ทําเอฟเฟคใหกับขอความ 

33 

 สามารถกําหนดรูปแบบการเชื่อมโยงสไลด 34 
 สามารถกําหนดคุณสมบัติของเอกสารกอนพิมพและใชคําส่ัง

พิมพไดอยางถูกวิธี 
35 

 

ข้ันตอนที่ 4 นําแบบทดสอบที่สรางข้ึน ไปใหอาจารยที่ปรึกษาตรวจแกไขและใหคําแนะนํา
แลวนําแบบทดสอบไปใหผูเช่ียวชาญทางดานการวัดและประเมินผลทางการศึกษา ผูเช่ียวชาญ
ทางดานจิตวิทยาและผูเชี่ยวชาญทางดานการสอนคอมพิวเตอร จํานวน 5 ทาน ตรวจสอบคุณภาพ
ของเคร่ืองมือในดานความตรงเชิงเนื้อหา (content validity)  การใชภาษา และความถูกตองของ
ภาษา แลวนํามาปรับปรุงแกไข โดยมีเกณฑในการคัดเลือกผูเชี่ยวชาญในการตรวจสอบคุณภาพ
ของเครื่องมือ ดังนี้ 
 1. นักวิชาการที่มีประสบการณสาขาการวัดและประเมินผลทางการศึกษาที่มีประสบการณ
ทํางานมากกวา 5 ป จํานวน 1 ทาน 
 2. ครูที่มีความเช่ียวชาญทางดานจิตวิทยาและมีประสบการณทํางานมากกวา 10 ป 
จํานวน 2 ทาน  
 3. ครูที่มีความเช่ียวชาญทางดานการสอนคอมพวิเตอรและมีประสบการณทาํงาน
มากกวา 10 ป จาํนวน 2 ทาน  

โดยการตรวจสอบความตรงเชิงเนื้อหา ใชดัชนีความสอดคลอง IOC (item objective 
congruence) โดยมีเงื่อนไขใหผูเชี่ยวชาญตัดสินอยางเปนระบบ ซึ่งมีลักษณะการใหคะแนน คือ 
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 1    เมื่อแนใจวา      รายการหรือขอคําถามนัน้วัดไดสอดคลองกับผลการเรียนรูที่
คาดหวงั 
 0    เมื่อไมแนใจวา  รายการหรือขอคําถามนั้นวัดไดสอดคลองกับผลการเรียนรูที่
คาดหวงั 
           -1    เมื่อแนใจวา  รายการหรือขอคําถามนัน้วดัไดไมสอดคลองกับผลการเรียนรูที่
คาดหวงั 

 โดยผูวิจัยไดกําหนดเกณฑที่ใชในการตัดสินความตรงเชิงเน้ือหา คือ คาดัชนีความ
สอดคลอง IOC (item objective congruence) ตองมากกวา 0.5 (IOC >0.5) จึงถือวาขอ
คําถามนั้นสอดคลองกับผลการเรียนรูที่คาดหวังที่ตองการวัด (ลวน สายยศ และอังคณา สายยศ 
2539)  ผลการตรวจสอบพบวา ขอคําถามทั้งหมดมีคาดัชนี IOC มากกวา 0.5 (IOC >0.5)  และ
มีการปรับภาษาเล็กนอย ผู ว ิจ ัยจึงปรับปรุงแบบทดสอบใหสมบูรณตามขอเสนอแนะของ
ผูเชี่ยวชาญ โดยผานความเห็นชอบจากอาจารยที่ปรึกษา โดยรายละเอียดของผลการตรวจสอบ
คุณภาพและการปรับปรุงแบบทดสอบ ดังแสดงในภาคผนวก ง และ จ 

ข้ันตอนที่ 5 นําแบบทดสอบท่ีไดจากการ (Tryout) กับนักเรียนจํานวน 30 คน ที่ไมใชกลุม
ตัวอยาง แลวนํามาวิเคราะหหาคาความยากและอํานาจจําแนก โดยใชโปรแกรม EVANA 401 
(ภคนันท ทองคํา, 2544) โดยใชเทคนิค  25 % (ประคอง  กรรณสูต, 2535)  โดยกําหนดเกณฑ
มาตรฐานในความยากงายมีคาระหวาง 0.20 – 0.80 คาอํานาจจําแนกมีคาต้ังแต 0.20 ข้ึนไป และคา
ความเที่ยงของแบบทดสอบทั้งฉบับกําหนดใหมีคาต้ังแต 0.60 ข้ึนไป โดยแบบทดสอบมคีาความเทีย่ง
เทากับ 0.7073 ดังที่ไดแสดงใน ภาคผนวก ง 
 ข้ันตอนที่ 6 นําผลการวิเคราะหคุณภาพของขอสอบ ไดแก ขอที่มีคาอํานาจจําแนกไมดี
และอํานาจจําแนกเปน 0 ดังตารางที่ 3.6 มาปรับปรุงขอคําถามโดยผูวิจัยไดไปขอคําแนะนําจาก
ผูเช่ียวชาญและปรับขอคําถามพรอมทั้งตัวเลือกตามขอเสนอแนะของผูเชี่ยวชาญอีกคร้ังหนี่ง
เพื่อใหเหมาะสมกอนที่จะนําไปเก็บขอมูล 
 

ผลการวิเคราะหคุณภาพของขอสอบดวยโปรแกรม EVANA 401 
 

จํานวนขอสอบที่วิเคราะห  (ขอ)            35  
จํานวนกระดาษคําตอบ (ชุด)                30  
คะแนนเฉลีย่                                       23.57  
สวนเบ่ียงเบนมาตรฐาน                       4.4248 
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คาความเที่ยง  KR-20                          .7073 
ความคลาดเคล่ือนมาตรฐาน                2.3937 

 
ตารางที่ 3.6 สรุปคุณภาพ คาความยากและอํานาจจาํแนกของขอสอบ 
 

คาอํานาจจาํแนก คาความยาก 
จําแนกดี จําแนกไมดี อํานาจจําแนกเปน 0 

ขอที่งายมาก 3 11 13 14 19 20 1 
ขอที่คอนขางงาย 9 15 22 23 26 31 - 
ขอที่ยากงายปานกลาง 7 10 12 21 25 28 29 17 27 33 
ขอที่คอนขางยาก 4 30 32 34 35 - 

2 5 6 8 16 18 24 

 

 
การเก็บรวบรวมขอมูล 
 

 ผูวิจัยดําเนินการเก็บรวบรวมขอมูลเกี่ยวกับสาเหตุและผลของการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที ่ม ีต อความสามารถทางคอมพิวเตอรของนักเรียนระดับชั้น
มัธยมศึกษา ตอนปลาย (ชวงช้ันที่ 4) ในกรุงเทพมหานคร โดยการใชแบบสอบถามและ
แบบทดสอบเพื่อเก็บขอมูลระหวางวันที่ 10 กุมภาพันธ ถึง 13 มีนาคม 2552 โดยมีรายละเอียดใน
การเก็บรวบรวมขอมูลดังตอไปนี้ 
 1. ผูวิจัยทําหนังสือขอความรวมมือในการทําวิจัยจากคณะครุศาสตร จุฬาลงกรณมหาวิทยาลัย 
ถึงผูบริหารของโรงเรียนแตละโรงเรียนในเขตกรุงเทพมหานครที่เลือกใชเปนกลุมตัวอยาง เพื่อขอ
อนุญาตในการเก็บรวบรวมขอมูลจากนักเรียนระดับช้ันมัธยมศึกษาตอนปลาย 
 2. ติดตอโรงเรียนที่เปนกลุมตัวอยาง เพื่อกําหนดวนัและเวลา ในการเก็บรวบรวมขอมูล 

3. นําแบบสอบถามและแบบทดสอบสงทางไปรษณีย จํานวน 1,000 ฉบับ โดยแนบซอง
เปลาติดแสตมปไปพรอมกับแบบสอบถามและแบบทดสอบ โดยขอความอนุเคราะหทางโรงเรียน
ใหสงแบบสอบถามและแบบทดสอบใหนักเรียนที่ไดรับการคัดเลือกซ่ึงทางผูวิจัยกําหนดใหทาง
โรงเรียนเปนผูสุมนักเรียนเองและรวบรวมแบบสอบถามและแบบทดสอบกลับคืนมายังผูวิจัย 

4. ผูวิจัยไดขอความรวมมือใหทางฝายวิชาการของโรงเรียนกําหนดครูเปนผูดําเนินการโดย
ทําหนาที่แจกแบบสอบถามและแบบทดสอบใหกับนักเรียนทําโดยใหมีการจัดการดําเนินการสอบ
ในหองที่มีสภาพแวดลอมที่เหมาะสม มีที่นั่งสามารถเขียนไดสะดวก  โดยการดําเนินการตอบ
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แบบสอบถามและแบบทดสอบแบงเปน 3 ระยะ คือ การเตรียมตัวกอนทําแบบสอบถามและ
แบบทดสอบ วิธีปฏิบัติขณะทําแบบสอบถามและแบบทดสอบ และเมื่อหมดเวลาทําแบบสอบถาม
และแบบทดสอบ ซึ่งมีข้ันตอนดังนี้ 

4.1 การเตรียมตัวกอนตอบแบบสอบถามและแบบทดสอบ 
  4.1.1 เตรียมแบบสอบถามและแบบทดสอบใหเรียบรอย มีผูดําเนินการ

สอบ 1 คน หรือมากกวา และจัดที่นั่งใหเพียงพอแกผูเขาสอบ 
  4.1.2 การเตรียมตัวสําหรับผูดําเนินการสอบ ผูดําเนินการสอบจะตอง

ศึกษาคําชี้แจงในการทําแบบสอบถามและแบบทดสอบลวงหนา เพื่อใหสามารถดําเนินการได
อยางถูกตอง 

 4.2 วิธีดําเนินการ 
  4.2.1 ผูดําเนินการแจกแบบสอบถามเกี่ยวกับการรับรูความสามารถดาน

คอมพิวเตอรใหแกผูตอบคนละ 1 ชุด  
  4.2.2 ผูดําเนินการสอบอธิบายคําช้ีแจงในการทําแบบสอบถาม 

   4.2.3 จากนั้นใหผูตอบลงมือทําแบบสอบถามโดยใชเวลา 15 นาที โดย
ผูดําเนินการสอบใหสัญญาณแกผูตอบไดลงมือทําพรอมกัน 

4.2.4 เม่ือหมดเวลาผูดําเนินการเก็บแบบสอบถามและแจกแบบทดสอบ
ความสามารถทางคอมพิวเตอรใหแกผูตอบคนละ 1 ชุด  

  4.2.5 ผูดําเนินการสอบอธิบายคําช้ีแจงในการทําแบบทดสอบ 
  4.2.6 จากนั้นใหผูตอบลงมือทําแบบทดสอบ โดยใชเวลา 30 นาที โดย

ผูดําเนินการสอบใหสัญญาณแกผูตอบไดลงมือทําพรอมกัน 
 4.3 วิธีปฏิบัติเมื่อหมดเวลา 
  4.3.1 ผู ดําเนินการสอบแจงเวลาที่ เหลือในการทําแบบทดสอบ 

เปน 3 ระยะ คือ 
   4.3.1.1 เมื่อเวลาในการสอบผานไป 15 นาที 
   4.3.1.2 เมื่อเหลือเวลาอีก 5 นาที จะหมดเวลาในการทํา 
   4.3.1.3 เมื่อหมดเวลาในการทํา 
  4.3.2 เม่ือหมดเวลาในการทําแบบทดสอบแลว ผูดําเนินการสอบให

ผูตอบวางดินสอหรือปากกาและหยุดทําแบบทดสอบทันที 
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  4.3.3 ในกรณีที่ผูตอบทําแบบทดสอบเสร็จกอนเวลาที่กําหนดใหผูตอบผู
นั้นออกไปนอกหองสอบกอน เพื่อไมใหรบกวนสมาธิในการทําแบบทดสอบของผูตอบคนอ่ืนๆ 
หลังจากนั้น เมื่อผูตอบทําแบบทดสอบเสร็จทั้งหองสอบแลว ผูดําเนินการสอบจึงเก็บแบบทดสอบ
ตามลําดับเลขที่ผูตอบ แลวรวบรวมแบบสอบถามและแบบทดสอบสงกลับคืนฝายวิชาการของ
โรงเรียน 

5. ผูวิจัยดําเนินการติดตามแบบสอบถามและแบบทดสอบโดยโทรศัพทติดตอกับโรงเรียน        
ที่เปนกลุมตัวอยาง โดยแบบสอบถามที่ไดรับกลับคืนมา มีจํานวนทั้งส้ิน 813 ฉบับ คิดเปนรอยละ 
81.30 จากจํานวนแบบสอบถามทั้งส้ิน 1,000 ฉบับ ดังนั้นผูวิจัยจึงไดจํานวนกลุมตัวอยางทั้งหมด 
813 คน รายละเอียด ดังตารางที่ 3.7 

ผลการตอบกลับแบบสอบถามจากกลุมตัวอยาง พบวา โรงเรียนในสังกัดสํานักงาน
คณะกรรมการสงเสริมการศึกษาเอกชน (สช.) ขนาดใหญ มีอัตราการตอบกลับสูงสุด จํานวน 213 
ฉบับ คิดเปนรอยละ 85.20 รองลงมาเปนโรงเรียนขนาดกลาง จํานวน 206 ฉบับ คิดเปนรอยละ 
82.40  โรงเรียนในสังกัดสํานักงานคณะกรรมการการศึกษาข้ันพื้นฐาน (สพฐ.) ขนาดกลาง จํานวน 
199 ฉบับ คิดเปนรอยละ 79.60 และขนาดใหญ จํานวน 195 คิดเปนรอยละ 78.00 ตามลําดับ 
 

ตารางที ่3.7 อัตราการตอบกลับแบบสอบถามคืนจากกลุมตัวอยาง 
 

สังกัด ขนาด
โรงเรียน จํานวนท่ีสง จํานวน 

ไดรับคืน อัตราการตอบกลับ 

ใหญ 250 213 85.20 สช. 
กลาง 250 206 82.40 
ใหญ 250 195 78.00 สพฐ. 
กลาง 250 199 79.60 

รวม 1,000 813 81.30 
 

การวิเคราะหขอมูล 
 

 การวิจยัคร้ังนี ้มีการวิเคราะหขอมูล ดังรายละเอียดตอไปนี ้
ตอนท่ี 1 การวิเคราะหขอมูลเบ้ืองตน โดยใชสถิติบรรยาย เพื่อบรรยายลักษณะของผูตอบ

แบบสอบถามและลักษณะตัวแปรที่ใชในการวิจัย โดยใชโปรแกรมสําเร็จรูป SPSS ดังนี้ 
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  1.1 วิเคราะหคาสถิติพืน้ฐานของกลุมตัวอยาง ดวยสถิติบรรยาย ไดแก คาความถี ่ 
รอยละ เพือ่บรรยายลักษณะของกลุมตัวอยาง 
  1.2 วิเคราะหคาสถิติพื้นฐาน ไดแก คามัชฌิมเลขคณิตหรือคาเฉล่ียเลขคณิต ( x )   
คาสวนเบ่ียงเบนมาตรฐาน (S.D.) คาความเบ (skewness) คาความโดง (kurtosis) และคา
สัมประสิทธิ์การกระจาย (coefficient of variation) ของตัวแปรสังเกตไดที่ใชในการพัฒนาโมเดลเพื่อ
ทราบลักษณะการแจกแจงของตัวแปร 

ตอนท่ี 2 การวิเคราะหความสามารถทางคอมพิวเตอรของนักเรียน ดวยการวิเคราะห
คาเฉลี่ยเลขคณิต ( x ) คาสวนเบี่ยงเบนมาตรฐาน (S.D.) และเปรียบเทียบความสามารถทาง
คอมพิวเตอรของนักเรียน โดยจําแนกตามสังกัดและขนาดของโรงเรียน ดวยสถิติทดสอบที (t-test)  
  ตอนท่ี 3 การวิเคราะหความสัมพันธระหวางตัวแปรสังเกตไดที่ใชในโมเดลเชิงสาเหตุและ
ผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอร
ของนักเรียนระดับช้ันมัธยมศึกษาตอนปลาย (ชวงชั้นที่ 4) ในกรุงเทพมหานคร โดยการวเิคราะหคา
สัมประสิทธิ์สหสัมพันธแบบเพียรสัน (Pearson’s product-moment correlation coefficient) โดย
ใชโปรแกรมสําเร็จรูป SPSS  
 ตอนที่ 4 การวิเคราะหตรวจสอบความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรู
ความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรที่ผูวิจัยสรางข้ึน
จากทฤษฎีและงานวิจัยที่เกี่ยวของกับขอมูลเชิงประจักษ พรอมทั้งคํานวณขนาดอทิธิพลทัง้ทางตรง
และทางออมของปจจัยที่สงผลตอความสามารถทางคอมพิวเตอรของนักเรียนระดับช้ันมัธยมศึกษา
ตอนปลาย (ชวงชั้นที่ 4) ในกรุงเทพมหานครดวยโปรแกรม LISREL Version 8.72 for WINDOWS 



บทที่ 4 
 

ผลการวิเคราะหขอมูล 
 
 การวิจัยในครั้งนี้ มีวัตถุประสงคเพื่อ 1) ศึกษาและเปรียบเทียบความสามารถทาง
คอมพิวเตอรนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร เมื่อจาํแนกตามสังกัดและขนาดของโรงเรียน 
2) พัฒนาโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร และ 3) เพื่อตรวจสอบ
ความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของ
ตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร                     
ที่พัฒนาข้ึนกับขอมูลเชิงประจักษ ดังนั้น ผูวิจัยจึงนําเสนอผลการวิเคราะหขอมูลเพื่อตอบ
วัตถุประสงคของการวิจัยดังกลาว โดยแบงออกเปน 4 ตอน โดยตอนที่ 1 และตอนที่ 2 เพื่อตอบ
วัตถุประสงคขอที่ 1 สวนตอนที่ 3 และตอนที่ 4 เพื่อตอบวัตถุประสงคขอที่ 2 และ ขอที่ 3 
 

ตอนท่ี 1 ผลการวิเคราะหคาสถิติพืน้ฐานของตัวแปรทีใ่ชในการวิจัย 
 ผลการวิเคราะหคาสถิติพื้นฐานของสถานภาพโดยทั่วไปของผูตอบแบบสอบถาม 
 ผลการวิเคราะหคามัชฌิมเลขคณิต ( x ) สวนเบี่ยงเบนมาตรฐาน ( S.D.)  ความเบ  
(Skewness) ความโดง (Kurtosis) และคาสัมประสิทธิ์การกระจาย (CV) ของตัวแปรสังเกตไดที่ใชใน 
การวิเคราะหโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร  
 ตอนท่ี 2 การวิเคราะหความแตกตางของระดับความสามารถทางคอมพิวเตอร จําแนก
ตามสังกัดและขนาดของโรงเรียน  
 2.1 การวิเคราะหระดับความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ใน
กรุงเทพมหานคร 
 2.2 การเปรียบเทียบระดับความสามารถทางคอมพิวเตอรจําแนกตามสังกัดและขนาดของ
โรงเรียน 

ตอนท่ี 3 ผลการวิเคราะหสหสัมพันธระหวางตัวแปรสังเกตได ที่ใชในการวิเคราะหโมเดล 
เชิงสาเหตุและผลของการรับรูความสามารถดานคอมพวิเตอรของตนเองที่มีตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในเขตกรุงเทพมหานคร  
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ตอนท่ี 4  ผลการวิเคราะหความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรู
ความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวง
ชั้นที่ 4 ในเขตกรุงเทพมหานคร โดยภาพรวมกับขอมูลเชิงประจักษ 
 

  เพื่อใหการนําเสนอผลการวิเคราะหขอมูลและการทําความเขาใจเกี่ยวกับผลการวิเคราะห
ขอมูลมีความสะดวกยิ่งข้ึน ผูวิจัยจึงกําหนดสัญลักษณและความหมายที่ใชแทนคาสถิติและตัวแปร
ตางๆ ในการนําเสนอ ดังนี้ 
 

 สัญลักษณที่ใชแทนคาสถิติ 
 x  หมายถึง  คามัชฌิมเลขคณิต หรือ คาเฉล่ีย (mean) 
 S.D. หมายถึง  สวนเบ่ียงเบนมาตรฐาน (standard  deviation) 
 max หมายถึง  คะแนนสูงสุด (maximum) 
 min หมายถึง  คะแนนตํ่าสุด (minimum) 
 sk หมายถึง  คาความเบ (skewness) 
 ku หมายถึง  คาความโดง (kurtosis) 

2χ   หมายถึง  ดัชนีตรวจสอบความกลมกลืนประเภทคาสถิติไค-สแควร 
df  หมายถึง  องศาอิสระ (degree of freedom) 
TE   หมายถึง  ขนาดอิทธิพลรวม (total effect) 
ID  หมายถึง  ขนาดอิทธิพลทางออม (indirect effect) 
DE  หมายถึง  ขนาดอิทธิพลทางตรง (direct effect) 

 R  หมายถึง   คาสัมประสิทธิ์สหสัมพันธพหุคูณ 
 R2  หมายถึง   สัมประสิทธิ์การทาํนาย (Coefficient of determination)  
 GFI  หมายถึง  ดัชนีวัดระดับความกลมกลืน (goodness of fit index) 
 AGFI หมายถึง  ดัชนีวัดระดับความกลมกลืนที่ปรับแกแลว (adjusted goodness of  
      fit index) 
 RMR  หมายถึง  ดัชนีรากของคาเฉล่ียกําลังสองของสวนเหลือ (root mean squared 
       residual) 
  p  หมายถึง   ระดับนัยสําคัญทางสถิติ 
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สัญลักษณที่ใชแทนตัวแปรแฝง 
 PREVEXP หมายถึง   ระดับประสบการณเดิม 
 TRAINPER หมายถึง   บุคลิกภาพภายในของผูเรียน 
 LEARNGOA หมายถึง   ความมุงมั่นในการทาํงาน 
 COMANXIE หมายถึง   ความวิตกกังวลในการใชคอมพิวเตอร 
 COMSELF หมายถึง   การรับรูความสามารถดานคอมพิวเตอรของตนเอง 
 GOALLEVEL หมายถึง   การต้ังเปาหมาย 
 GOALCOMM หมายถึง   ความผูกพันตอเปาหมาย 
 COMPER หมายถึง   ความสามารถทางคอมพิวเตอร 
 

สัญลักษณที่ใชแทนตัวแปรสังเกตได 
 WORDEXP หมายถึง   ระดับประสบการณในการใชโปรแกรมประมวลผลคํา 
 PPTEXP หมายถึง   ระดับประสบการณในการใชโปรแกรมนาํเสนอผลงาน 
 SELFEST หมายถึง   การเห็นคุณคาในตนเอง 
 NEUROTIC หมายถึง   ความออนไหวทางอารมณ 
 LEARNGOA หมายถึง   ความมุงมั่นในการทาํงาน 
 COMANXIE หมายถึง   ความวิตกกังวลในการใชคอมพิวเตอร 
 WORDSELF หมายถึง   การรับรูความสามารถในการใชโปรแกรมประมวลผลคํา 
 PPTSELF หมายถึง   การรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน 
 WORDGOAL หมายถึง   ระดับเปาหมายของผลสําเร็จในการใชโปรแกรม 
    ประมวลผลคํา 
 PPTGOAL หมายถึง   ระดับเปาหมายของผลสําเร็จในการใชโปรแกรม 
    นําเสนอผลงาน 
 GOALCOMM หมายถึง   ความผูกพันตอเปาหมาย 
 WORDPER      หมายถึง   คะแนนทดสอบโปรแกรมประมวลผลคํา 
 PPTPER หมายถึง   คะแนนทดสอบโปรแกรมนาํเสนอผลงาน 
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ตอนท่ี 1 ผลการวิเคราะหคาสถิติพื้นฐานของตัวแปรที่ใชในการวิจัย 
 

ผลการวิเคราะหขอมูลในตอนนี้ ประกอบดวย 2 สวน สวนแรก เปนผลการวิเคราะหคาสถิติ
พื้นฐานของกลุมตัวอยางที่ใชในการวิจัย โดยการนําเสนอคาสถิติแจกแจงความถี่ รอยละ และสวน 
ที่สอง เปนผลการวิเคราะหคาสถิติพื้นฐานของตัวแปรสังเกตไดที่ใชในการศึกษา  โมเดลเชิงสาเหตุ
และผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอร
ของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร ไดแก คาเฉล่ีย (mean) สวนเบี่ยงเบนมาตรฐาน (S.D.) 
คาคะแนนสูงสุด (maximum) คาคะแนนตํ่าสุด (minimum) คาความเบ (skewness) คาความโดง 
(kurtosis) คาสัมประสิทธิ์การกระจาย (CV) โดยมีวัตถุประสงคเพื่อศึกษาลักษณะการกระจายและ
การแจกแจงของตัวแปรสังเกตไดแตละตัวแปร 
 

1.1 ผลการวิเคราะหคาสถิติพื้นฐานของสถานภาพโดยทั่วไปของผูตอบแบบสอบถาม 
 

ผลการวิเคราะหคาสถิติพื้นฐานของสถานภาพโดยทั่วไปของนักเรียนผูตอบแบบสอบถามมี
รายละเอียด ดังตอไปนี้ 
 

ตารางที่ 4.1 จํานวนและรอยละของผูตอบแบบสอบถาม จําแนกตามสังกัด ขนาดของโรงเรียน 
        และตัวแปรตางๆ  (N = 813 คน) 

ตัวแปร จํานวน รอยละ 
1. สังกัด   
        สํานักงานคณะกรรมการการศึกษาข้ันพืน้ฐาน (สพฐ.) 394 48.46 
        สํานักงานคณะกรรมการสงเสริมการศึกษาเอกชน (สช.) 419 51.54 

รวม 813 100.00 
2. ขนาดโรงเรียน   
 ใหญ 408 50.18 
 กลาง 405 49.82 

รวม    813 100.00 
3. เพศ   
 ชาย 442 54.37 
 หญิง 371 45.63 

รวม 813 100.00 
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ตารางที่ 4.1 จํานวนและรอยละของผูตอบแบบสอบถาม จําแนกตามสังกัด ขนาดของโรงเรียน
        และตัวแปรตางๆ  (N = 813 คน) (ตอ) 

ตัวแปร จํานวน รอยละ 
4. อายุ (ป)   
 15 109 13.41 
 16 278 34.19 
 17 301 37.02 
 18 119 14.64 
 19 5 0.62 
 20 0 0.00 
 21 1 0.12 
 รวม 813 100.00 
5. ระดับช้ันเรียน   
 ม.4 284 34.93 
 ม.5 369 45.39 
 ม.6 160 19.68 

รวม 813 100.00 
6. แผนการเรียน   
 วิทย – คณิต  596 73.31 
 ศิลป – คํานวณ  88 10.82 
 ศิลป – ภาษา  129 15.87 
 อ่ืนๆ  0 0.00 

รวม 813 100.00 
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ตารางที่ 4.1 จํานวนและรอยละของผูตอบแบบสอบถาม จําแนกตามสังกัด ขนาดของโรงเรียน
        และตัวแปรตางๆ  (N = 813 คน) (ตอ) 

ตัวแปร จํานวน รอยละ 
7. ประสบการณในการใชคอมพิวเตอร   
 นอยกวา 1 ป 4 0.49 
 1 – 2 ป 39 4.80 
 3 – 4 ป 121 14.88 
 5 – 6 ป 172 21.16 
 มากกวา 6 ป 477 58.67 

รวม 813 100.00 
8. จํานวนช่ัวโมงทีน่ักเรียนใชคอมพิวเตอรใน 1 วัน   
 นอยกวา 1 ชั่วโมง / วนั 92 11.32 
 1 – 2 ชั่วโมง / วนั 325 39.98 
 3 – 4 ชั่วโมง / วนั 291 35.79 
 5 – 6 ชั่วโมง / วนั 54 6.64 
 มากกวา 6 ชัว่โมง / วนั 51 6.27 

รวม 813 100.00 
9. ประสบการณในการใชโปรแกรมประมวลผลคํา  
    ( Microsoft Word ) 

  

 นอยกวา 1 ป 40 4.92 
 1 – 2 ป 83 10.21 
 3 – 4 ป 196 24.11 
 5 – 6 ป 193 23.74 
 มากกวา 6 ป 301 37.02 

รวม 813 100.00 
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ตารางที่ 4.1 จํานวนและรอยละของผูตอบแบบสอบถาม จําแนกตามสังกัด ขนาดของโรงเรียน
        และตัวแปรตางๆ  (N = 813 คน) (ตอ) 

ตัวแปร จํานวน รอยละ 
10. จํานวนช่ัวโมงที่นกัเรียนใชโปรแกรมประมวลผลคํา  
     ( Microsoft Word )ใน 1 วนั 

  

 นอยกวา 1 ชั่วโมง / วนั 363 44.65 
 1 – 2 ชั่วโมง / วนั 358 44.03 
 3 – 4 ชั่วโมง / วนั 76 9.35 
 5 – 6 ชั่วโมง / วนั 6 0.74 
 มากกวา 6 ชัว่โมง / วนั 10 1.23 

รวม 813 100.00 
11. รอยละความคาดหวังถึงผลสําเร็จของผลงานจากการ 
      ใชโปรแกรมประมวลผลคํา (Microsoft Word)      

  

 รอยละ 0 – 20 32 3.94 
 รอยละ 21 – 40 71 8.73 
 รอยละ 41 – 60 146 17.96 
 รอยละ 61 – 80 293 36.04 
 รอยละ 81 – 100 271 33.33 

รวม 813 100.00 
12. ประสบการณในการใชโปรแกรมนาํเสนอผลงาน 
      (Microsoft PowerPoint ) 

  

 นอยกวา 1 ป           96 11.81 
 1 – 2 ป      214 26.32 
 3 – 4 ป 246 30.26 
 5 – 6 ป    139 17.10 
 มากกวา 6 ป 118 14.51 

รวม 813 100.00 
   
   



 

 

108

ตารางที่ 4.1 จํานวนและรอยละของผูตอบแบบสอบถาม จําแนกตามสังกัด ขนาดของโรงเรียน
        และตัวแปรตางๆ  (N = 813 คน) (ตอ) 

ตัวแปร จํานวน รอยละ 
13. จํานวนช่ัวโมงที่นกัเรียนใชโปรแกรมนาํเสนอผลงาน  
      (Microsoft PowerPoint) ใน 1 วัน           

  

 นอยกวา 1 ชั่วโมง / วนั 511 62.85 
 1 – 2 ชั่วโมง / วนั 227 27.92 
 3 – 4 ชั่วโมง / วนั 62 7.63 
 5 – 6 ชั่วโมง / วนั 8 0.98 
 มากกวา 6 ชัว่โมง / วนั 5 0.62 

รวม 813 100.00 
14. รอยละความคาดหวังถึงผลสําเร็จของผลงานจากการ 
      ใชโปรแกรมนําเสนอผลงาน (Microsoft PowerPoint)         

  

 รอยละ 0 – 20 38 4.67 
 รอยละ 21 – 40 88 10.82 
 รอยละ 41 – 60 164 20.17 
 รอยละ 61 – 80 322 39.61 
 รอยละ 81 – 100 201 24.72 

รวม 813 100.00 
    

จากตารางที่ 4.1  ผลการวิเคราะหคาสถิติพื้นฐานของผูตอบแบบสอบถามเม่ือจําแนกตาม
สังกัดของโรงเรียน พบวา นักเรียนผูตอบแบบสอบถามสวนใหญเปนนักเรียนในโรงเรียนสังกัด
สํานักงานคณะกรรมการสงเสริมการศึกษาเอกชน (สช.) คิดเปนรอยละ 51.54 รองลงมา คือ สังกัด
สํานักงานคณะ กรรมการศึกษาข้ันพื้นฐาน (สพฐ.) คิดเปนรอยละ 48.46 และเมื่อจําแนกตาม 
ขนาดของโรงเรียน พบวา นักเรียนผูตอบแบบสอบถามสวนใหญเปนนักเรียนในโรงเรียนขนาดใหญ 
คิดเปนรอยละ 50.18 รองลงมาคือ ขนาดกลาง คิดเปนรอยละ 49.82  คาสถิติพื้นฐาน พบวา 
ผูตอบแบบสอบถามสวนใหญเปนเพศชาย คิดเปนรอยละ 54.37 มีอายุ 17 ป 16 ป และ 18 ป คิด
เปนรอยละ 37.02  34.19 และ 14.64 ตามลําดับ และกําลังศึกษาอยูในระดับชั้นเรียน ม.5  ม.4 
และ  ม.6 คิดเปนรอยละ 45.39  34.93 และ 19.68 ตามลําดับ   และศึกษาแผนการเรียน วิทย – 
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คณิต ศิลป – ภาษาและศิลป – คํานวณ คิดเปนรอยละ 73.31 15.87 และ 10.82 ตามลําดับ  โดย
สวนใหญมีประสบการณในการใชคอมพิวเตอรมามากกวา 6 ป คิดเปนรอยละ 58.67  ใช
คอมพิวเตอรเปนระยะเวลา 1 – 2 ชั่วโมงตอวัน คิดเปนรอยละ 39.98 มีประสบการณในการใช
โปรแกรมประมวลผลคํา (Microsoft Word) มากกวา 6 ป คิดเปนรอยละ 37.02  ใชโปรแกรม
ประมวลผลคํา (Microsoft Word) เปนระยะเวลานอยกวา 1 ชั่วโมงตอวัน คิดเปน รอยละ 44.65  
ความคาดหวังถึงผลสําเร็จของผลงานจากการใชโปรแกรมประมวลผลคํา (Microsoft Word) รอย
ละ 61 – 80 คิดเปนรอยละ 36.04  และสวนใหญมีประสบการณในการใชโปรแกรมนําเสนอผลงาน 
(Microsoft PowerPoint) ระหวาง 3 – 4 ป คิดเปนรอยละ 30.26  ใชโปรแกรมนําเสนอผลงาน 
(Microsoft PowerPoint) เปนระยะเวลานอยกวา 1 ชั่วโมงตอวัน คิดเปนรอยละ 62.85  และความ
คาดหวังถึงผลสําเร็จของผลงานจากการใชโปรแกรมนําเสนอผลงาน (Microsoft PowerPoint) รอย
ละ 61 – 80 คิดเปนรอยละ 39.61  

 

1.2 ผลการวิเคราะหคาสถิติพื้นฐานของตัวแปรสังเกตได 
 

การวิเคราะหคาสถิติพื้นฐานของตัวแปรสังเกตได 13 ตัวแปร ที่ใชในการศึกษาโมเดลเชิง
สาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร โดยการวิจัยในคร้ังนี้  แบงเปนตัวแปร
ภายในแฝง จํานวน 4 ตัวแปร ไดแก ตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง 
(COMSELF) ตัวแปรการต้ังเปาหมาย   (GOALLEVEL)ตัวแปรความผูกพันตอเปาหมาย  
(GOALCOMM)  และตัวแปรความสามารถทางคอมพิวเตอร (COMPER) ของนักเรียนชวงช้ันที่ 4 
ในกรุงเทพมหานคร  ตัวแปรภายนอกแฝง จํานวน 4 ตัวแปร คือ ตัวแปรระดับประสบการณเดิม  
(PREVEXP)  ตัวแปรบุคลิกภาพภายในของผูเรียน (TRAINPER) ตัวแปรความมุงมั่นในการทํางาน
(LEARNGOA)และตัวแปรความวิตกกังวลในการใชคอมพิวเตอร (COMANXIE)  โดยตัวแปรแฝง
ทั้งหมด วัดไดจากตัวแปรสังเกตได ทั้งหมด 13 ตัวแปร ไดแก ระดับประสบการณในการใชโปรแกรม
ประมวลผลคํา (WORDEXP)   ระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน (PPTEXP)   
การเห็นคุณคาในตนเอง (SELFEST)  ความออนไหวทางอารมณ (NEUROTIC)  ความมุงมั่นในการ
ทํางาน (LEARNGOA)  ความวิตกกังวลในการใชคอมพิวเตอร (COMANXIE)  การรับรูความสามารถ
ในการใชโปรแกรมประมวลผลคํา (WORDSELF) การรับรูความสามารถในการใชโปรแกรมนําเสนอ
ผลงาน (PPTSELF)  ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมประมวลผลคํา (WORDGOAL)  
ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน (PPTGOAL)  ความผูกพันตอ
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เปาหมาย (GOALCOMM)  คะแนนทดสอบโปรแกรมประมวลผลคํา (WORDPER) และ คะแนน
ทดสอบโปรแกรมนําเสนอผลงาน (PPTPER)  โดยผลการวิเคราะหคาสถิติพื้นฐานของตัวแปรสังเกต
ได มีรายละเอียดดังตอไปนี้ 

ผลการวิเคราะหคาสถิติพื้นฐานของตัวแปรสังเกตไดในโมเดลเชิงสาเหตุและผลของการ
รับรูความสามารถดานคอมพิวเตอรของตนเองที่มีผลตอความสามารถทางคอมพิวเตอรของ
นักเรียนผูตอบแบบสอบถามทั้งหมด เมื่อพิจารณาคาเฉล่ีย ( x ) ของตัวแปรสังเกตได พบวา ตัวแปร
สังเกตไดสวนใหญมีคาเฉล่ียอยูในระดับปานกลางคอนขางสูง ( x = 2.84 – 3.95)  และตัวแปร 
คะแนนทดสอบโปรแกรมประมวลผลคํา (WORDPER) และ คะแนนทดสอบโปรแกรมนําเสนอผลงาน 
(PPTPER)  จะมีคาคะแนนทดสอบเฉลี่ยเทากับ 10.05 และ 7.33 จากคะแนนเต็ม 17 และ 18 
คะแนนตามลําดับ  

เมื่อพิจารณาสัมประสิทธิ์การกระจาย (CV) ของตัวแปรสังเกตได พบวา ตัวแปรคะแนน
ทดสอบโปรแกรมนําเสนอผลงาน (PPTPER)  มีการกระจายของขอมูลมากที่สุด (รอยละ 42.86)  
รองลงมา คือ ตัวแปรระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน (PPTGOAL)  
และ คะแนนทดสอบโปรแกรมประมวลผลคํา (WORDPER)  รอยละ 29.79 และ 28.97 ตามลําดับ 
สวนตัวแปรการเห็นคุณคาในตนเอง (SELFEST) มีการกระจายของขอมูลนอยที่สุด รอยละ 12.09
สวนตัวแปรที่เหลือมีการกระจายไมแตกตางกันมาก อยูระหวางรอยละ 13.30 – 28.36 แสดงวา
กลุมผูตอบแบบสอบถามทั้งหมดมีคะแนนทดสอบโปรแกรมนําเสนอผลงานแตกตางกันมากที่สุด 
รองลงมา ไดแก ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงานและคะแนนทดสอบ
โปรแกรมประมวลผลคํา  

เมื่อพิจารณาความเบ (SK) ของตัวแปรสังเกตได พบวา ตัวแปรสวนใหญมีการแจกแจงใน
ลักษณะเบซาย (คาความเบเปนลบ) แสดงวา ขอมูลของตัวแปรสูงกวาคาเฉลี่ย ยกเวนตัวแปร
ความผูกพันตอเปาหมาย (GOALCOMM) และตัวแปรคะแนนทดสอบโปรแกรมนําเสนอผลงาน 
(PPTPER)  ที่มีการแจกแจงในลักษณะเบขวา (คาความเบเปนบวก) แสดง วาขอมูลสวนใหญของ
ตัวแปรเหลานี้มีคะแนนตํ่ากวาคาเฉลี่ย 
 เมื่อพิจารณาความโดง (KU) ของตัวแปรสังเกตได พบวามีตัวแปร ความออนไหวทาง
อารมณ (NEUROTIC)  ความวิตกกังวลในการใชคอมพิวเตอร  (COMANXIE) ระดับเปาหมายของ
ผลสํา เ ร็จในการใช โปรแกรมนํ า เสนอผลงาน  (PPTGOAL)ความผูกพันตอ เป าหมาย 
(GOALCOMM)  คะแนนทดสอบโปรแกรมประมวลผลคํา (WORDPER) และคะแนนทดสอบ
โปรแกรมนําเสนอผลงาน (PPTPER)  มีการแจกแจงของขอมูลในลักษณะเตี้ยแบน หรือโคงนอย 
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(คาความโดงนอยกวา 0) และมีตัวแปรระดับประสบการณในการใชโปรแกรมประมวลผลคํา 
(WORDEXP) ระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน (PPTEXP) การเห็นคุณคา
ในตนเอง (SELFEST)  ความมุงมั่นในการทํางาน (LEARNGOA) การรับรูความสามารถในการ
ใชโปรแกรมประมวลผลคํา (WORDSELF)  การรับรูความสามารถในการใชโปรแกรมนําเสนอ
ผลงาน (PPTSELF) และระดับเปาหมายของผลสําเร็จในการใชโปรแกรมประมวลผลคํา 
(WORDGOAL)  มีการแจกแจงของขอมูลที่มียอดสูง หรือโคงมาก (คาความโดงมากกวา 0)         
ดังตารางที่ 4.2 
 

ตารางที ่4.2 คาสถิติพืน้ฐานของตัวแปรสังเกตไดที่ใชในการวิจยั (n=813) 
ตัวแปร x  SD CV MIN MAX SK KU 

WORDEXP 3.09 0.62 19.98 1.00 5.00 -0.40 0.22 
PPTEXP 2.84 0.61 21.41 1.00 5.00 -0.06 0.15 
SELFEST 3.84 0.46 12.09 1.50 5.00 -0.09 1.31 
NEUROTIC 3.05 0.73 24.05 1.00 5.00 -0.17 -0.10 
LEARNGOA 3.91 0.52 13.30 1.38 5.00 -0.12 0.44 
COMANXIE 3.95 1.06 26.76 1.00 5.00 -0.91 -0.15 
WORDSELF 3.87 0.60 15.49 1.24 5.00 -0.47 0.44 
PPTSELF 3.68 0.71 19.20 1.00 5.00 -0.44 0.49 
WORDGOAL 3.86 1.09 28.36 1.00 5.00 -0.85 0.04 
PPTGOAL 3.69 1.10 29.79 1.00 5.00 -0.70 -0.17 
GOALCOMM 3.43 0.48 13.88 2.17 5.00 0.55 -0.07 
WORDPER 10.05 2.91 28.97 1.00 17.00 -0.35 -0.17 
PPTPER 7.33 3.14 42.86 0.00 17.00 0.15 -0.40 
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ตอนท่ี 2  การวิเคราะหความแตกตางของระดับความสามารถทางคอมพิวเตอรของ
นักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร จําแนกตามสังกัดและขนาดของ
โรงเรียน  

 

 2.1 การวิเคราะหความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นท่ี 4                 
ในกรุงเทพมหานคร 

ผลการวิเคราะหความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร 
พบวาความสามารถทางคอมพิวเตอรของนักเรียนที่กําลังศึกษาอยูในโรงเรียนทั้งสังกัดสํานักงาน
คณะกรรมการการศึกษาข้ันพื้นฐาน (สพฐ.) และสังกัดสํานักงานคณะกรรมการการสงเสริม
การศึกษาเอกชน (สช.) ในกรุงเทพมหานคร มีคาระหวาง 16.814 – 17.975 ( x อยูระหวาง 16.814 
– 17.975) สวนเบ่ียงเบนมาตรฐาน มีคาระหวาง 5.323  - 5.352 ( SD อยูระหวาง 5.323 – 5.352) 
และความสามารถทางคอมพิวเตอรของนักเรียนที่กําลังศึกษาอยูในโรงเรียนทั้งโรงเรียนขนาดใหญ
และขนาดกลาง ในกรุงเทพมหานคร อยูในระดับปานกลาง ( x อยูระหวาง 16.939 – 17.817) สวน
เบ่ียงเบนมาตรฐาน  ( SD อยูระหวาง 5.313 – 5.389) ดังตารางที่ 4.3 

 

ตารางท่ี 4.3   คาเฉล่ียและสวนเบ่ียงเบนมาตรฐานแสดงความสามารถทางคอมพวิเตอรของ 
 นักเรียนชวงช้ันที ่4 ในกรุงเทพมหานคร จําแนกตามสังกัดและขนาดของโรงเรียน 
 (n=813) 
ตัวแปร N x  S.D. t p 
สังกัด     สพฐ. 394 17.975 5.323 3.099* 0.002 
              สช. 419 16.814 5.352   
ขนาด     ใหญ 408 17.817 5.389 2.341* 0.019 
             กลาง 405 16.939 5.313   
หมายเหตุ: * p < .05 
 

 2.2   ผลการเปรียบเทยีบความสามารถทางคอมพวิเตอรของนกัเรียนชวงชัน้ที่ 4                
ในกรุงเทพมหานคร เมื่อจําแนกตามสังกัดและขนาดของโรงเรียน  
 ผลการวิเคราะหความแตกตางของความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4                
ในกรุงเทพมหานคร  จําแนกตามสังกัดของโรงเรียน พบวาคะแนนเฉลี่ยของนักเรียนในโรงเรียน
สังกัดสํานักงานคณะกรรมการการศึกษาข้ันพื้นฐาน (สพฐ.) มีคะแนนความสามารถทาง
คอมพิวเตอรสูงกวาโรงเรียนในสังกัดสํานักงานคณะกรรมการสงเสริมการศึกษาเอกชน (สช.)อยาง
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มีนัยสําคัญทางสถิติที่ระดับ .05  และเมื่อจําแนกตามขนาดของโรงเรียน พบวาคะแนนเฉลี่ยของ
นักเร ียนในโรงเร ียนขนาดใหญมีคะแนนความสามารถทางคอมพิวเตอรส ูงกวาโรงเร ียน                
ขนาดกลาง อยางมีนัยสําคัญที่ระดับ .05 
 

ตอนที่ 3  ผลการวิเคราะหสหสัมพันธระหวางตัวแปรสังเกตไดที่ใชในการวิเคราะหโมเดลเชิง
สาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในเขตกรุงเทพมหานคร  

ผลการวิเคราะหสหสัมพันธระหวางตัวแปรสังเกตไดที่ใชในการวิเคราะหโมเดลเชิงสาเหตุ
และผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงชั้นที่ 4 มีรายละเอียดผลการวิเคราะหนําเสนอไว ดังตารางที่  4.4 
 ผลการวิเคราะหความสัมพันธระหวางตัวแปรสังเกตได เกี่ยวกับเหตุของการรับรู
ความสามารถทางคอมพิวเตอรที่มีตอความสามารถทางคอมพิวเตอรที่มีตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ของกลุมตัวอยางทั้งหมด พบวา คาสถิติ Bartlett’ test of 
Sphericity ซึ่งเปนคาสถิติทดสอบสมมติฐานวา เมทริกซสหสัมพันธเปนเมทริกซเอกลักษณ 
(identity  matrix) หรือไม มีคาสถิติเทากับ 4151.014 (p<.05) แสดงวาเมทริกซสหสัมพนัธระหวาง
ตัวแปรสังเกตไดทั้งหมดของกลุมตัวอยางแตกตางจากเมทริกซเอกลักษณอยางมีนัยสําคัญที่ระดับ 
.05 ซึ่งสอดคลองกับผลการวิเคราะห คาดัชนีไกเซอร – ไมเยอร - ออลคิน (Kaiser-Meyer-Olkin 
Measure of Sampling Adequacy) มีคาเทากับ  0.720  ซึ่งมีคาเขาใกล  1  แสดงวาตัวแปร
สังเกตไดของขอมูลชุดนี้มีความสัมพันธภายในตอกัน เหมาะสมที่จะนําไปใชในการวิเคราะหโมเดล
ลิสเรลตอไป  

จากตารางที่ 4.4 เมื่อพิจารณาเมทริกซสหสัมพันธระหวางตัวแปรสังเกตได ทั้ง 13 ตัว
แปรพบวา ความสัมพันธระหวางตัวแปรที่มีคาแตกตางจากศูนยอยางมีนัยสําคัญทางสถิติที่ระดับ 
.01 และระดับ .05 จํานวน 72  คู และ 3 คู ตามลําดับ และมีความสัมพันธกันอยางไมมีนัยสําคัญ 
จํานวน 16 คู  จากความสัมพันธระหวางตัวแปรรวม  91  คู 
 เมื่อพิจารณาความสัมพันธระหวางกลุมตัวแปรดานเดียวกัน  พบวา ความสัมพันธระหวาง
ตัวแปรสังเกตไดในกลุมตัวแปรระดับประสบการณเดิม จะมีความสัมพันธที่เปนทิศทางเดียวกันโดย       
มีตัวแปรที ่มีความสัมพันธกันมากที ่สุด คือ ตัวแปรระดับประสบการณในการใชโปรแกรม
ประมวลผลคํา (WORDEXP) กับตัวแปรระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน 
(PPTEXP) โดยมีขนาดความสัมพันธเทากับ 0.83 อยางมีนัยสําคัญทางสถิติที่ระดับ .01 แสดงวา 
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หากนักเรียนมีประสบการณในการใชโปรแกรมประมวลผลคําสูงข้ึนก็จะสงผลใหประสบการณใน
การใชโปรแกรมนําเสนอผลงานสูงข้ึนดวย ในขณะเดียวกันหากประสบการณในการใชโปรแกรม
นําเสนอผลงานสูงข้ึน ก็จะมีประสบการณในการใชโปรแกรมประมวลผลคําสูงข้ึนดวยเชนกัน    

เมื ่อพ ิจารณาความส ัมพ ันธ ระหว างต ัวแปรส ัง เกตได ของกลุ มต ัวแปรการร ับ รู
ความสามารถดานคอมพิวเตอรของตนเองพบวา มีความสัมพันธที่เปนทิศทางเดียวกัน โดยตัว
แปรที่มีความสัมพันธกันมากที่สุด คือ ตัวแปรการรับรูความสามารถในการใชโปรแกรมประมวลผล
คํา  (WORDSELF) กับตัวแปรการรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน 
(PPTSELF) โดยมีขนาดความสัมพันธเทากับ 0.75 อยางมีนัยสําคัญทางสถิติที่ระดับ .01 แสดงวา 
หากนักเรียนมีการรับรูความสามารถในการใชโปรแกรมประมวลผลคําสูงข้ึน ก็จะสงผลให การรับรู
ความสามารถในการใชโปรแกรมนําเสนอผลงานสูงข้ึนดวย  ในขณะเดียวกันหากการรับรู
ความสามารถในการใชโปรแกรมนําเสนอผลงานสูงข้ึน ก็จะมีการรับรูความสามารถในการใช 
โปรแกรมประมวลผลคําสูงข้ึนดวยเชนกนั
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ตารางที ่4.4 คาสัมประสิทธิ์สหสัมพันธระหวางตัวแปรสังเกตไดของกลุมตัวอยางทั้งหมด (n=813) 

 
              

              **p<.01,*p<.05 

ตัวแปร WORDEXP PPTEXP SELFEST NEUROTIC LEARNGOA COMANXIE WORDSELF PPTSELF WORDGOAL PPTGOAL GOALCOMM WORDPER PPTPER 
WORDEXP 1             
PPTEXP 0.830** 1            
SELFEST 0.126** 0.149* 1           
NEUROTIC 0.045 0.028 0.187** 1          
LEARNGOA 0.125** 0.134** 0.597** 0.082* 1         
COMANXIE 0.219** 0.173** 0.108** 0.462** 0.108** 1        
WORDSELF 0.288** 0.269** 0.454** 0.173** 0.427** 0.342** 1       
PPTSELF 0.290** 0.339** 0.396** 0.127** 0.347** 0.220** 0.752** 1      
WORDGOAL 0.339** 0.258** 0.227** 0.171** 0144** 0.232** 0.332** 0.287** 1     
PPTGOAL 0.294** 0.342** 0.266** 0.154** 0176** 0.228** 0.292** 0.349** 0.633** 1    
GOALCOMM 0.088* 0.032 0.239** 0.354** 0.250** 0.391** 0.266** 0.185** 0.206** 0.219** 1   
WORDPER 0.160** 0.122** 0.093** 0.244** 0.092** 0.370** 0.241** 0.131** 0.231** 0.239** 0.320** 1  
PPTPER 0.141** 0.101** 0.092** 0.188** 0.108** 0.304** 0.276** 0.195** 0.227** 0.240** 0.293** 0.572** 1 
MEAN 3.092 2.835 3.836 3.047 3.912 3.955 3.868 3.676 3.861 3.689 3.432 10.050 7.326 
SD 0.618 0.607 0.464 0.733 0.520 1.058 0.599 0.706 1.095 1.099 0.476 2.912 3.140 

Bartlett’s Test of Sphericity = 4151.014            df=78           P=.000 Kaiser-Meyer-Olkin Measure of Sampling Adequacy= 0.720 
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เมื่อพิจารณาความสัมพันธระหวางตัวแปรสังเกตไดของกลุมตัวแปรการต้ังเปาหมายพบวา 
ตัวแปรมีความสัมพันธไปในทิศทางเดียวกัน โดยตัวแปรที่มีความสัมพันธกันมาก คือตัวแปรระดับ
เปาหมายของผลสําเร็จในการใชโปรแกรม ประมวลผลคํา (WORDGOAL) กับระดับเปาหมายของ
ผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน (PPTGOAL) โดยมีขนาดความสัมพันธเทากับ 0.63 
อยางมีนัยสําคัญทางสถิติที่ระดับ .01 แสดงวาหากนักเรียนไดมีการต้ังเปาหมายของผลสําเร็จใน
การใชโปรแกรมประมวลผลคําสูงข้ึนก็จะทําใหระดับเปาหมายของผลสําเร็จในการใชโปรแกรม
นําเสนอผลงานสูงข้ึนดวย  ในขณะเดียวกันนักเรียนที่ไดมีการต้ังเปาหมายของผลสําเร็จในการใช
โปรแกรมนําเสนอผลงานสูงข้ึนก็จะทําใหการต้ังเปาหมายของผลสําเร็จในการใชโปรแกรม
ประมวลผลคําสูงข้ึนดวยเชนกัน   

เมื่อพิจารณาความสัมพันธระหวางตัวแปรสังเกตไดของกลุมตัวแปรความสามารถทาง
คอมพิวเตอร พบวา ตัวแปรมีความสัมพันธไปในทิศทางเดียวกัน โดยตัวแปรที่มีความสัมพันธกัน
มาก คือ คะแนนทดสอบโปรแกรมประมวลผลคํา (WORDPER) กับคะแนนทดสอบโปรแกรม
นําเสนอผลงาน (PPTPER) โดยมีขนาดความสัมพันธเทากับ 0.57 อยางมีนัยสําคัญทางสถิติ        
ที่ระดับ .01 แสดงวาหากนักเรียนไดมีคะแนนทดสอบโปรแกรมประมวลผลคําสูงข้ึนก็จะทําให
คะแนนทดสอบโปรแกรมนําเสนอผลงานสูงข้ึนดวย  ในขณะเดียวกันนักเรียนที่มีคะแนนทดสอบ
โปรแกรมนําเสนอผลงานสูงข้ึนก็จะทําใหคะแนนทดสอบโปรแกรมประมวลผลคําสูงข้ึนดวยเชนกัน   
 กลาวโดยสรุป ความสัมพันธระหวางตัวแปรสังเกตได 13 ตัวแปร รวม 91 คู ทั้งที่อยูใน        
ตัวแปรปจจัยเดียวกันและตัวแปรทุกปจจัยพบวา ตัวแปรสวนใหญมีความสัมพันธกันอยางมี
นัยสําคัญทางสถิติที่ระดับ .01 ในสวนของเมทริกซสหสัมพันธของตัวแปรสังเกตไดทุกคู พบวา 
แตกตางจากเมทริกซเอกลักษณอยางมีนัยสําคัญทางสถิติ ตัวแปรที่วัดไดมีความสัมพันธภายในตอ
กัน และคาความสัมพันธระหวางตัวแปรสังเกตไดที่เปนตัวแปรอิสระแตละคู สวนใหญมีคาไมเกิน 
0.8 แสดงวา ตัวแปรสังเกตไดสวนใหญแลวจะเปนตัวแปรอิสระของขอมูลชุดนี้ไมมีปญหาภาวะรวม
เสนตรงพหุ (Multicollinearity) (อุทุมพร จามรมาน, 2542) จึงเหมาะสมที่จะนําไปใชในการวิเคราะห
โมเดลลิสเรล (LISREL Model) ที่มีโมเดลการวัด (Measurement Model) ซึ่งอาศัยหลักการ
วิเคราะหองคประกอบที่ตัวแปรควรมีความสัมพันธภายในตอกัน แตไมควรมีขนาดความสัมพันธกัน
สูง ดังนั้น จะเห็นไดวาขอมูลชุดนี้มีความเหมาะสมที่จะนําไปใชในการตรวจสอบความสอดคลอง
ของโมเดลลิสเรลเต็มรูปกับขอมูลเชิงประจักษตอไป 
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ตอนท่ี 4 ผลการวิเคราะหความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ใน
กรุงเทพมหานครกับขอมูลเชิงประจักษ 

 

การวิเคราะหขอมูลในสวนนี้ เปนการวิเคราะหเพื่อตรวจสอบความสอดคลองของโมเดล
เชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร ตามสมมติฐานกับขอมูลเชิงประจักษ 
การวิจัยคร้ังนี้มี ตัวแปรภายนอกแฝง จํานวน 4 ตัวแปร ไดแก ตัวแปรระดับประสบการณเดิม 
(PREVEXP) ตัวแปรบุคลิกภาพภายในของผูเรียน (TRAINPER) ตัวแปรความมุงมั่นในการทํางาน
(LEARNGOA) และตัวแปรความวิตกกังวลในการใชคอมพิวเตอร (COMANXIE) ตัวแปรภายใน
แฝง 4 ตัวแปร ไดแก ตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง (COMSELF)            
ตัวแปรการตั้งเปาหมาย  (GOALLEVEL) ตัวแปรความผูกพันตอเปาหมาย (GOALCOMM) และ
ตัวแปรความสามารถทางคอมพิวเตอร (COMPER) ของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร 
โดยตัวแปรสังเกตไดที่ใชในการวิเคราะหขอมูลทั้งหมดมีจํานวน 13 ตัวแปร  

การทดสอบความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดาน
คอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ใน
กรุงเทพมหานครตามสมมติฐานกับขอมูลเชิงประจักษวิเคราะหโดยกําหนดใหความคลาดเคล่ือนใน 
การวัดไมสัมพันธกัน ผลการวิเคราะหขอมูลปรากฏวา โมเดลตามสมมติฐานไมสอดคลองกับขอมูล
เชิงประจักษโดยพิจารณาจากคาไค–สแควร ( 2χ ) มีคาเทากับ 1030.96 คาองศาอิสระเทากับ 55  
และคาความนาจะเปน (P) เทากับ.000  คาดัชนีวัดระดับความกลมกลืน(GFI)  เทากับ 0.837 และ
ดัชนีวัดระดับความกลมกลืนที่ปรับแกแลว (AGFI) มีคาเทากับ 0.730  คาดัชนีกําลังสองของสวน 
เหลือ (RMR) เทากับ 0.137 และคาเศษเหลือในรูปคะแนนมาตรฐานระหวางตัวแปรสูงสุด (Largest 
Standardized Residuals) เทากับ 21.440 
 จากผลการวิเคราะหดังกลาว ผูวิจัยทําการปรับโมเดลเชิงสาเหตุและผลของการรับรู
ความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวง
ชั้นที่ 4 ในกรุงเทพมหานคร โดยยอมใหความคลาดเคล่ือนมีความสัมพันธกันได ซึ่งการปรับโมเดล
ในข้ันตอนนี้ ผูวิจัยพิจารณาจากดัชนีดัดแปรโมเดล (Modification Indices) และผลจากการปรับ
โมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอ
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ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานครที่สอดคลองกับขอมูล
เชิงประจักษ โดยมีรายละเอียดดัง ตารางที่ 4.5 
 จากรายละเอียดผลการวิเคราะหขอมลูในตารางที ่ 4.5 เม่ือพิจารณาผลการวิเคราะหโมเดล
พบวา โมเดลมีความสอดคลองกับขอมูลเชิงประจักษ โดยพิจารณาจากคาสถิติที่ใชตรวจสอบความ
สอดคลองระหวางโมเดลกับขอมูลเชิงประจักษ ไดแก คาไค–สแควร ( 2χ )มีคาเทากับ 9.146 องศา 
อิสระเทากับ 11 ที่ระดับความนาจะเปน (P) เทากบั 0.608 ซึ่งแสดงวาผลการทดสอบคาไค–สแควร
( 2χ ) ไมแตกตางจากศูนยอยางมีนัยสําคัญทางสถิติ คือ ยอมรับสมมติฐานวาโมเดลทีพ่ัฒนาข้ึน
มามีความสอดคลองกับขอมูลเชิงประจกัษ ซึ่งสอดคลองกับผลการวเิคราะหคาดัชนีวัดระดับความ
กลมกลืน (GFI) เทากับ 0.998 ดัชนีวัดระดับความกลมกลืนที่ปรับแกแลว (AGFI) เทากับ 0.986  
ซึ่งมีคาเขาใกล 1 ดัชนีกําลังสองของสวนเหลือ (RMR ) เทากบั 0.0201  มีคาเขาใกลศูนย และ
กราฟคิวพล็อตของคาเศษเหลือในรูปคะแนนมาตรฐาน (Q-plot of Standardized  Residuals) มี
คาความชันมากกวาแนวทแยงซ่ึงเปนการแสดงวาโมเดลมีความสอดคลองกับขอมลูเชิงประจักษ 

 เมื่อพิจารณาคาความเที่ยงของตัวแปรภายนอกสังเกตได ทั้ง 6 ตัวแปรพบวา ตัวแปรที่มี 
คาความเที่ยงมากที่สุด คือ ตัวแปรระดับระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน 
(PPTEXP)  ตัวแปรความมุงมั่นในการทํางาน (LEARNGOA) และตัวแปรความวิตกกังวลในการใช
คอมพิวเตอร (COMANXIE)  ซึ่งทั้งหมดมีคาเทากับ 1.000 รองลงมา ไดแก ตัวแปรระดับ
ประสบการณในการใชโปรแกรมประมวลผลคํา (WORDEXP) ตัวแปรความออนไหวทางอารมณ 
(NEUROTIC)และตัวแปรการเห็นคุณคาในตนเอง (SELFEST) ซึ่งมีคาเทากับ 0.757  0.258 และ 
0.244 ตามลําดับ และเม่ือพิจารณาคาความเที่ยงของตัวแปรภายในสังเกตได 3 อันดับแรก พบวา 
ตัวแปรที่มีคาความเที่ยงมากที่สุด ไดแก ตัวแปรความผูกพันตอเปาหมาย (GOALCOMM) มีคา
เทากับ 1.000 รองลงมาไดแก ตัวแปรการรับรูความสามารถในการใชโปรแกรมประมวลผลคํา 
(WORDSELF) และตัวแปรคะแนนทดสอบโปรแกรมนําเสนอผลงาน (PPTPER) มีคาเทากับ 0.859 
และ 0.812 ตามลําดับ สําหรับคาสัมประสิทธิ์การพยากรณ (R2) ของสมการโครงสรางตัวแปร
ภายในแฝงของตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง ตัวแปรการตั้งเปาหมาย 
ตัวแปรความผูกพันตอเปาหมายและตัวแปรความสามารถทางคอมพิวเตอรพบวา มีคาเทากับ 
1.000 0.176 0.302 และ 0.242 ตามลําดับ แสดงวาตัวแปรในโมเดลสามารถอธิบายความ
แปรปรวนของการรับรูความสามารถดานคอมพิวเตอรของตนเอง การตั้งเปาหมาย ความผูกพันตอ
เปาหมาย และความสามารถทางคอมพิวเตอรไดรอยละ 100.00,17.60, 30.20 และ 24.20 ตามลําดับ 
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 เมื่อพิจารณา คาอิทธิพลทางตรงและอิทธิพลทางออมที่สงผลตอตัวแปรความสามารถ
ทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร (COMPER) พบวา ตัวแปรดังกลาว
ไดรับอิทธิพลทางตรงอยางมีนัยสําคัญทางสถิติที่ระดับ .01 จากตัวแปรความผูกพันตอเปาหมาย 
(GOALCOMM) และตัวแปรการต้ังเปาหมาย (GOALLEVEL) โดยมีขนาดอิทธิพลเทากับ 0.338 และ 
0.309 ตามลําดับ นอกจากนั้นตัวแปรความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ใน
กรุงเทพมหานคร (COMPER) ยังไดรับอิทธิพลทางออมจากตัวแปรการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง (COMSELF) โดยมีขนาดอิทธิพลเทากับ 0.201 ตามลําดับ โดยสงผานตัว
แปรปจจัยความผูกพันตอเปาหมาย (GOALCOMM) และตัวแปรการต้ังเปาหมาย (GOALLEVEL)    
ตัวแปรที่มีอิทธิพลรวมอยางมีนัยสําคัญทางสถิติที่ระดับ .01 ตอตัวแปรความสามารถทางคอมพิวเตอร
ของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร (COMPER) คือ ตัวแปรความผูกพันตอเปาหมาย 
(GOALCOMM) และตัวแปรการตั้งเปาหมาย (GOALLEVEL)โดยมีขนาดอิทธิพลทางบวกเทากับ 
0.338 และ 0.309 ตามลําดับ นอกจากนี้ยังมีตัวแปรที่มีอิทธิพลรวมอยางมีนัยสําคัญทางสถิติที่
ระดับ .05 ตอตัวแปรความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร 
(COMPER) คือ ตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง (COMSELF)โดยมีขนาด
อิทธิพลทางบวกเทากับ 0.174 แสดงวา ทั้งตัวแปรความผูกพันตอเปาหมาย  ตัวแปรการ
ต้ังเปาหมายและตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเองลวนมีอิทธิพลตอตัว
แปรความสามารถทางคอมพิวเตอรของนักเรียน โดยตัวแปรความผูกพันตอเปาหมายมีขนาด
อิทธิพลสูงกวาตัวแปรการต้ังเปาหมายและและตัวแปรการรับรูความสามารถดานคอมพิวเตอรของ
ตนเอง  ซึ่งเมื่อพิจารณาตัวแปรแลวจะพบวา การรับรูความสามารถในการใชโปรแกรมประมวลผล
คําและโปรแกรมนําเสนอผลงาน ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมประมวลผลคํา
และโปรแกรมนําเสนอผลงาน และความผูกพันตอเปาหมายจะสงผลทางบวกตอความสามารถทาง
คอมพิวเตอรของนักเรียน แสดงใหเห็นวา ถานักเรียนสามารถรับรูความสามารถในการใชโปรแกรม
ประมวลผลคําและโปรแกรมนําเสนอผลงานดวยตนเอง และมีการกําหนดเปาหมายของผลสําเร็จ
ในการใชโปรแกรมประมวลผลคําและโปรแกรมนําเสนอผลงานตลอดจนมีความรูสึกผูกพันตอ
เปาหมายแลวก็จะทําใหนักเรียนมีความสามารถทางคอมพิวเตอรสูงข้ึน 
  

เมื่อพิจารณาอิทธิพลทางตรงที่สงผลตอตัวแปรการรับรูความสามารถดานคอมพิวเตอร
ของตนเอง (COMSELF) พบวาตัวแปรบุคลิกภาพภายในของผูเรียน (TRAINPER) และ ตัวแปร
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ความมุงม่ันในการทํางาน (LEARNGOA) มีอิทธิพลทางตรงตอการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง (COMSELF) โดยมีขนาดอิทธิพลทางบวกเทากับ 0.877 และ 0.408 
ตามลําดับ นอกจากนี้ตัวแปรระดับประสบการณเดิม (PREVEXP) และตัวแปรความวิตกกังวลใน
การใชคอมพิวเตอร (COMANXIE) มีอิทธิพลทางตรงตอตัวแปรการรับรู ความสามารถดาน
คอมพิวเตอรของตนเอง (COMSELF) โดยมีขนาดอิทธิพลทางลบเทากับ -0.014 และ -0.516 
ตามลําดับ อยางไมมีนัยสําคัญทางสถิติที่ระดับ .05 
 

เมื่อพิจารณาเมทริกซสหสัมพันธระหวางตัวแปรแฝง พบวาคาสัมประสิทธิ์สหสัมพันธระหวาง
ตัวแปรแฝงมีคาอยูระหวาง -0.122 ถึง 0.901 โดยมีตัวแปรคูมีความสัมพันธในทิศทางตรงกันขาม 
(คาสหสัมพันธเปนลบ) ที่มีคาสหสัมพันธติดลบมากที่สุด ไดแก ตัวแปรระดับประสบการณเดิม 
(PREVEXP) กับตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง (COMSELF) โดยมีคา
สัมประสิทธิ์สหสัมพันธเทากับ -0.122 แสดงวาถาตัวแปรระดับประสบการณเดิม (PREVEXP) มีคา
สูงข้ึน ตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง (COMSELF) ก็จะมีคาลดลง และ
ตัวแปรที่มีความสัมพันธในทิศทางเดียวกัน (คาสหสัมพันธเปนบวก) มีคามากที่สุด ไดแก ตัวแปร
บุคลิกภาพภายในของผูเรียน (TRAINPER) กับตัวแปรความวิตกกังวลในการใชคอมพิวเตอร 
(COMANXIE)  โดยมีคาสัมประสิทธิ์สหสัมพันธเทากับ 0.901  แสดงวาถาตัวแปรบุคลิกภาพ
ภายในของผู เ รียน (TRAINPER) มีคาสูงข้ึนตัวแปรความวิตกกังวลในการใชคอมพิวเตอร 
(COMANXIE) ก ็จะม ีค าส ูง ขึ ้นด วยเช นก ัน  หร ือถ า ตัวแปรบุคลิกภาพภายในของผู เ รียน 
(TRAINPER) ตัวแปรความวิตกกังวลในการใชคอมพิวเตอร (COMANXIE) ก็จะมีคาลดลงดวย
เชนกัน โดยตัวแปรคูที่มีคาสหสัมพันธรองลงมา ไดแก  ตัวแปรการรับรู ความสามารถดาน
คอมพิวเตอรของตนเอง (COMSELF) และตัวแปรบุคลิกภาพภายในของผูเรียน (TRAINPER) 
โดยมีคาสัมประสิทธิ์สหสัมพันธเทากับ 0.891 

 
เมื่อเปรียบเทียบคาสหสัมพันธระหวางตัวแปรความสามารถทางคอมพิวเตอรของนักเรียน

ชวงชั้นที่ 4 ในกรุงเทพมหานคร (COMPER)กับตัวแปรแฝงทั้ง 7 ตัวแปร พบวา คาสัมประสิทธิ์
สหสัมพันธมีคาอยูระหวาง -0.021 – 0.434 โดยตัวแปรคูที่มีคาสัมประสิทธิ์สหสัมพันธมากที่สุด 
ไดแก ตัวแปรความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร 
(COMPER) กับตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง (COMSELF)  โดยมีคา
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สัมประสิทธิ์สหสัมพันธเทากับ 0.434 แสดงวา ถาตัวแปรการรับรูความสามารถดานคอมพิวเตอร
ของตนเอง (COMSELF) มีคาสูงข้ึนตัวแปรความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 
ในกรุงเทพมหานคร (COMPER) ก็จะมีคาสูงข้ึนดวยหรือถาตัวแปรการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง (COMSELF) มีคาลดลงก็จะทําใหตัวแปรความสามารถทางคอมพิวเตอร
ของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร (COMPER) มีคาลดลงดวย โดยตัวแปรคูที่มีคา
สัมประสิทธิ์สหสัมพันธรองลงมา ไดแก ตัวแปรความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ัน
ที่ 4 ในกรุงเทพมหานคร (COMPER) กับตัวแปรความผูกพันตอเปาหมาย(GOALCOMM)และตัว
แปรความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร (COMPER) กับ
ตัวแปรการตั้งเปาหมาย (GOALLEVEL) โดยมีคาสัมประสิทธิ์สหสัมพันธเทากับ 0.388 และ 0.377 
ตามลําดับ 

 
จากผลการพัฒนาโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของ

ตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร พบวา 
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 สามารถวัดดวยคะแนนทดสอบโปรแกรม
นําเสนอผลงานไดดีที่สุด สําหรับการตั้งเปาหมาย พบวา ระดับเปาหมายของผลสําเร็จในการใช
โปรแกรมนําเสนอผลงานจะสงผลตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4            
ในกรุงเทพมหานครมากที่สุด  นอกจากนี้แลวการรับรูความสามารถดานคอมพิวเตอรของตนเองยัง
สงผลทางออมไปยังความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร
โดยตองผานความผูกพันตอเปาหมายและการตั้งเปาหมาย กลาวคือ ถานักเรียนชวงช้ันที่ 4 ไดมี
การรับรูความสามารถดานคอมพิวเตอรของตนเองแลวขณะทํางานมีการตั้งเปาหมายและไดมี
ความผูกพันตอเปาหมายนั้นแลวก็จะสงผลใหนักเรียนมีความสามารถทางคอมพิวเตอรนั้นดวย 
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**p< .01, *p< .05                 

 
 

 
ตารางที่ 4.5  คาสถิติผลการวิเคราะหแยกคาสหสัมพันธระหวางตัวแปรแฝงและการวิเคราะหอิทธิพลของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดาน

คอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   
 

ตัวแปรผล COMSELF GOALLEVEL GOALCOMM COMPER 
ตัวแปรสาเหตุ TE IE DE TE IE DE TE IE DE TE IE DE 

-0.014 - -0.014 -0.004 -0.004 - -0.005 -0.005 - -0.002 -0.002 - PREVEXP 
(0.336) (0.336) (0.090) (0.090)  (0.117) (0.117) (0.059) (0.059)
0.877 - 0.877 0.654 0.654 - 0.849 0.849 - 0.424 0.424 - TRAINPER 

(0.541) (0.541) (0.473) (0.473)  (0.516) (0.516) (0.288) (0.288)
0.408 - 0.408 0.110* 0.110* - 0.142* 0.142* - 0.071 0.071 - LEARNGOA 

(0.240) (0.240) (0.057) (0.057)  (0.072) (0.072) (0.040) (0.040)
-0.516 - -0.516 -0.321 -0.321 - -0.417 -0.417 - -0.208 -0.208 - COMANXIE 
(0.354) (0.354) (0.508) (0.508)  (0.606) (0.606) (0.312) (0.312)

- - - 0.269** - 0.269** 0.349** - 0.349** 0.174* 0.201** - 0.027 COMSELF 
 (0.080) (0.080) (0.126) (0.126) (0.097) (0.051) (0.072)
- - - - - - - - - 0.309** - 0.309** GOALLEVEL 
  (0.060) (0.060)
- - - - - - - - - 0.338** - 0.338** GOALCOMM

    (0.071) (0.071)
คาสถิต ิ             
ไคว-สแควร = 9.146 p=0.608 df=11 GFI=0.998 AGFI=0.986 RMR=0.0201    
ตัวแปร WORDEXP PPTEXP SELFEST NEUROTIC LEARNGOA COMANXIE WORDSELF PPTSELF     
ความเที่ยง 0.757 1.000 0.244 0.258 1.000 1.000 0.859 0.812     
ตัวแปร WORDGOAL PPTGOAL GOALCOMM WORDPER PPTPER        
ความเที่ยง 0.605 0.654 1.000 0.599 0.540        
สมการโครงสรางตัวแปร COMSELF GOALLEVEL GOALCOMM COMPER        
R SQUARE 1.000 0.176 0.302 0.242        

122
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ตารางที่ 4.5  คาสถิติผลการวิเคราะหแยกคาสหสัมพันธระหวางตัวแปรแฝงและการวิเคราะหอิทธิพลของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดาน

คอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 (ตอ) 
 

 **p< .01, *p< .05                  
 
 
 
 
 

 
 
 
 
 

เมทริกซสหสัมพันธระหวางตัวแปรแฝง            
ตัวแปรแฝง PREVEXP TRAINPER LEARNGOA COMANXI COMSELF GOALLEVEL GOALCOMM COMPER     
PREVEXP 1            
TRAINPER 0.009 1           
LEARNGOA 0.119 0.156 1          
COMANXI 0.149 0.901 0.100 1         
COMSELF -0.122 0.891 0.667 0.295 1        
GOALLEVEL -0.033 0.382 0.179 0.279 0.670 1       
GOALCOMM -0.043 0.495 0.233 0.362 0.869 0.234 1      
COMPER -0.021 0.248 0.116 0.181 0.434 0.377 0.388 1     
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0.653 

 0 

0.970 

0.966 

-0.014

0.877

0.408

-0.516

ระดับประสบการณ 
ในการใชโปรแกรม
ประมวลผลคํา

ระดับประสบการณใน
การใชโปรแกรม
นําเสนอผลงาน

การเห็นคุณคา 
ในตนเอง 

ความออนไหว 
ทางอารมณ 

ระดับความมุงมั่น
ในการทํางาน 

ระดับความวิตกกังวล 
ในการใชคอมพิวเตอร 

0 

0 

ระดับประสบการณเดิม

บุคลิกภาพภายในของผูเรียน

ความมุงมั่นในการทํางาน

ความวิตกกังวล 
ในการใชคอมพิวเตอร

0.980 

1.000** 

0.494** 

0.508** 

1.000** 

1.000** 

การรับรูความสามารถ
ดานคอมพิวเตอรของตนเอง

การรับรูความสามารถ
ในการใชโปรแกรม
ประมวลผลคํา

การรับรูความสามารถ
ในการใชโปรแกรม
นําเสนอผลงาน

0.973** 0.901

0.584 0.796

0

     การตั้งเปาหมาย

ความผูกพันตอเปาหมาย

0.269**

-0.027

0.349**

0.984

0.953

ระดับเปาหมายของ
ผลสําเร็จในการใช

โปรแกรมประมวลผลคํา

ระดับเปาหมายของ
ผลสําเร็จในการใช

โปรแกรมนําเสนอผลงาน

คะแนนทดสอบ 
โปรแกรมประมวลผลคํา 

คะแนนทดสอบ 
โปรแกรมนําเสนอผลงาน 

0.756

0.801

0.842

0.512
ความสามารถ
ทางคอมพิวเตอร

0.338**

1.000

0.778

0.809**

0.309**

ระดับความผูกพันตอเปาหมาย

0.735**

0.774

0.970

0

แผนภาพที่ 4.1 ผลการพัฒนาโมเดลความสัมพันธเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียน 
                          ชวงชั้นที่ 4 ที่สอดคลองกับขอมูลเชิงประจักษ 124



บทที่ 5 
 

สรุปผลการวจิัย  อภิปรายผล  และขอเสนอแนะ 
 

การวิจัยครั้งนี้ เปนการศึกษาความสัมพันธเชิงสาเหตุและผลของการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในเขต
กรุงเทพมหานคร โดยมีวัตถุประสงค 3 ประการ ไดแก ประการแรก เพื่อศึกษาและเปรียบเทียบ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร เม่ือจําแนกตามสังกัด
และขนาดของโรงเรียน ประการที่สอง  เพื่อพัฒนาโมเดลเชิงสาเหตุและผลของการรับรู
ความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวง
ชั้นที่ 4 ในกรุงเทพมหานคร และประการสุดทาย เพื่อตรวจสอบความสอดคลองโมเดลเชิงสาเหตุ
และผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานครที่พัฒนาข้ึนกับขอมูลเชิงประจักษ 
 การดําเนินการวิจัยคร้ังนี้ ประชากรที่ศึกษา คือ นักเรียนระดับชั้นมัธยมศึกษาตอนปลาย 
(ชวงชั้นที่ 4) ในกรุงเทพมหานคร  2 สังกัด ไดแก โรงเรียนรัฐบาลสังกัดสํานักงานคณะกรรมการ
การศึกษาข้ันพื้นฐาน (สพฐ.) และโรงเรียนเอกชนสังกัดสํานักงานคณะกรรมการสงเสริมการศึกษา
เอกชน (สช.) รวมทั้งส้ิน จํานวน 161,763 คน โดยผูวิจัยไดดําเนินการเก็บรวบรวมขอมูลดวยการสง
แบบสอบถามทางไปรษณีย จํานวน 1,000 ฉบับ และไดรับแบบสอบถามกลับคืน จํานวน 813 
ฉบับ ซึ่งคิดเปนรอยละ 81.30 ของผูตอบแบบสอบถาม 

ตัวแปรที่ใชในการวิจยัคร้ังนี ้ประกอบดวย ตัวแปรแฝง (latent variables) จํานวน 8 ตัวแปร  
และตัวแปรสังเกตได (observed variables) จํานวน 13 ตัวแปร ซึ่งแบงเปนตัวแปรภายในแฝง 
จํานวน 4 ตัวแปร ไดแก ตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง วัดไดจาก            
ตัวแปรสังเกตได จํานวน 2 ตัวแปร ไดแก ตัวแปรการรับรูความสามารถในการใชโปรแกรม
ประมวลผลคํา และตัวแปรการรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน  ตัวแปรการ
ต้ังเปาหมาย  วัดไดจากตัวแปรสังเกตได จํานวน 2 ตัวแปร ไดแก ตัวแปรระดับเปาหมายของ
ผลสําเร็จในการใชโปรแกรมประมวลผลคํา และตัวแปรระดับเปาหมายของผลสําเร็จในการใช
โปรแกรมนําเสนอผลงาน ตัวแปรความผูกพันตอเปาหมาย วัดไดจากตัวแปรสังเกตได  คือ ตัวแปร
ความผูกพันตอเปาหมาย และตัวแปรความสามารถทางคอมพิวเตอร วัดจากตัวแปรสังเกตได 
จํานวน 2 ตัวแปร คือ ตัวแปรคะแนนทดสอบโปรแกรมประมวลผลคํา และตัวแปรคะแนนทดสอบ
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โปรแกรมนําเสนอผลงาน และตัวแปรภายนอกแฝง จํานวน 4 ตัวแปร ไดแก  ตัวแปรระดับ
ประสบการณเดิม วัดไดจากตัวแปรสังเกตได จํานวน 2 ตัวแปร ไดแก ตัวแปรระดับประสบการณใน
การใชโปรแกรมประมวลผลคําและตัวแปรระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน  ตัว
แปรบุคลิกภาพภายในของผูเรียน วัดไดจากตัวแปรสังเกตได  จํานวน 2 ตัวแปร ไดแก ตัวแปรการ
เห็นคุณคาในตนเองและตัวแปรความออนไหวทางอารมณ   ตัวแปรความมุงมั่นในการทํางาน วัดได
จากตัวแปรสังเกตได คือ ตัวแปรความมุงมั่นในการทํางานและตัวแปรความวิตกกังวลในการใช
คอมพิวเตอร วัดไดจากตัวแปรสังเกตได คือ ตัวแปรความวิตกกังวลในการใชคอมพิวเตอร   
 เคร่ืองมือที่ใชในการวิจัยคร้ังนี้ คือ แบบสอบถามซึ่งผูวิจัยสรางข้ึนเองจากการศึกษาเอกสาร 
และงานวิจัยที่เกี่ยวของ โดยแบงออกเปน 4 ตอน ไดแก ตอนที่ 1 แบบสอบถามขอมูลทั่วไปของ
นักเรียน เปนแบบเติมคําในชองวางและแบบตรวจสอบรายการ (check list) ตอนที่ 2 เปน
แบบสอบถามเกี่ยวกับปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอร  ประกอบไปดวย
ขอคําถาม 3 ดาน คือ  ดานบุคลิกภาพภายในของผูเรียน ดานความมุงมั่นในการทํางาน และดาน
ความวิตกกังวลในการใชคอมพิวเตอรโดยมีลักษณะเปนแบบมาตรประมาณคา  (rating scale)      
5 ระดับ  ตอนที่ 3 เปนแบบสอบถามปจจัยที่สงผลตอความสามารถทางคอมพิวเตอร ซึ่งประกอบ
ไปดวยขอคําถาม 2 ดานคือ ดานการรับรูความสามารถดานคอมพิวเตอรของตนเองและดานความ
ผูกพันตอเปาหมาย โดยมีลักษณะเปนแบบมาตรประมาณคา (rating scale) 5 ระดับ  และ 
ตอนที่ 4 เปนแบบทดสอบความสามารถทางคอมพิวเตอรที่ผูวิจัยสรางข้ึนเอง โดยมีลีกษณะเปน
แบบทดสอบปรนัยแบบ 4 ตัวเลือก จํานวน 35 ขอ 

การวิเคราะหขอมูล แบงออกเปน 4 สวน ไดแก สวนทีห่นึ่ง เปนการวเิคราะหขอมูลเบื้องตน 
โดยใชสถิติบรรยาย เพื่อใหทราบลักษณะของกลุมตัวอยางและลักษณะของตัวแปรที่ใชในการวิจัย  
โดยสถิติใชโปรแกรมสําเร็จรูป SPSS ไดแก คาความถี่ รอยละ คาเฉล่ียเลขคณิต ( x ) คาสวน
เบ่ียงเบนมาตรฐาน (S.D.) คาความเบ (skewness) คาความโดง (kurtosis) และคาสัมประสิทธิ์การ
กระจาย (coefficient of variation) สวนที่สอง เปนการวิเคราะหความแตกตางของระดับ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร โดยจําแนกตามสังกัด
และขนาดของโรงเรียน โดยใชการทดสอบความแตกตางของคาเฉลี่ยเลขคณิตคาที (t–test) สวนที่
สาม เปนการวิเคราะหความสัมพันธระหวางตัวแปรสังเกตไดที่ใชในการวิเคราะหโมเดลเชิงสาเหตุ 
โดยใชการวิเคราะหคาสัมประสิทธิ์สหสัมพันธแบบเพียรสัน (Pearson’s product-moment 
correlation coefficient)  และสวนสุดทาย เปนการตรวจสอบความสอดคลองของโมเดลเชิงสาเหตุ
และผลของการรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทาง
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คอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร ที่ผูวิจัยสรางข้ึนจากทฤษฎีและงานวิจัยที่
เกี่ยวของกับขอมูลเชิงประจักษ  พรอมทั้งคํานวณขนาดอิทธิพลทั้งทางตรงและทางออมของปจจัย
ที่สงผลตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร ดวย
โปรแกรม LISREL version 8.72 for WINDOWS 

จากกรอบแนวคิดในการวิจัย ผูวิจัยกําหนดสมมติฐานในการวิจัยคร้ังนี้ไว 3 ประการ ซึ่งมี
รายละเอียดอยูในบทที่ 2 ไดแก ประการแรก ปจจัยที่มีอิทธิพลเชิงสาเหตุโดยทางตรงตอการรับรู
ความสามารถดานคอมพิวเตอรของตนเอง ไดแก ระดับประสบการณเดิม บุคลิกภาพภายในของ
ผูเรียน ความมุงม่ันในการทํางาน และความวิตกกังวลในการใชคอมพิวเตอร   ประการทีส่อง ปจจัย
การรับรูความสามารถดานคอมพิวเตอรของตนเองที่มีอิทธิพลเชิงสาเหตุโดยทางตรงและทางออม
ตอความสามารถทางคอมพิวเตอร โดยผานการตั้งเปาหมายและความผูกพันตอเปาหมาย และ
ประการสุดทายโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอรของตนเอง                         
ที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร ที่ผูวิจัย
พัฒนาข้ึนจากทฤษฎีและงานวิจัยที่เกี่ยวของสอดคลองกับขอมูลเชิงประจักษ 
 
สรุปผลการวจิัย 
 

 สําหรับผลการวิจัย สรุปได ดังนี ้
 1. ผลการวิเคราะหคาสถิติพื้นฐานของกลุมตัวอยางพบวา ผูตอบแบบสอบถามสวนใหญ
เปนนักเรียนช้ันมัธยมศึกษาปที่ 5 ในโรงเรียนขนาดใหญ สังกัดสํานักงานคณะกรรมการสงเสริม
การศึกษาเอกชน (สช.) ผลการวิเคราะหคาสถิติพื้นฐานของตัวแปรสังเกตได เกี่ยวกับการรับรู
ความสามารถดานคอมพิวเตอรของตนเองและความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ัน
ที่ 4  ในกรุงเทพมหานคร จํานวน 13 ตัวแปร พบวา ตัวแปรสวนใหญมีคาเฉลี่ยอยูในระดับ            
ปานกลางคอนขางสูง  ( x = 2.84 – 3.95)  ยกเวน ตัวแปรคะแนนทดสอบโปรแกรมประมวลผลคํา 
(WORDPER) และ คะแนนทดสอบโปรแกรมนําเสนอผลงาน (PPTPER)  จะมีคาเฉล่ียเทากับ 10.05 
และ 7.33 จากคะแนนเต็ม 17 และ 18 คะแนนตามลําดับ  ซึ่งคิดเปนคะแนนโดยรวมมีคะแนน
เฉล่ียคิดเปนรอยละ 49.66 ของคะแนนเต็มทั้งหมด  โดยนักเรียนที่อยูในโรงเรียนสังกัดสํานักงาน
คณะกรรมการการศึกษาข้ันพื้นฐาน (สพฐ.) มีคะแนนเฉลี่ยความสามารถทางคอมพิวเตอรสูงกวา
โรงเรียนในสังกัดสํานักงานคณะกรรมการสงเสริมการศึกษาเอกชน (สช.) และนักเรียนที่อยูใน
โรงเรียนขนาดใหญมีคะแนนเฉลี่ยความสามารถทางคอมพิวเตอรสูงกวาโรงเรียนขนาดกลาง 
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ผลการวิเคราะหความสัมพันธระหวางตัวแปรสังเกตได พบวา สวนใหญมีความสัมพันธกัน
อยางมีนัยสําคัญที่ระดับ .01 โดยมีความสัมพันธที่เปนไปในทิศทางเดียวกัน และตัวแปรที่มี
ความสัมพันธกันมากที่สุดอยางมีนัยสําคัญ ไดแก  ตัวแปรระดับประสบการณในการใชโปรแกรม
ประมวลผลคํากับตัวแปรระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน  แสดงวา หาก
นักเรียนมีประสบการณในการใชโปรแกรมประมวลผลคําสูงข้ึนก็จะสงผลใหประสบการณในการใช
โปรแกรมนําเสนอผลงานสูงข้ึนดวย ในขณะเดียวกันหากนักเรียนมีประสบการณในการใช
โปรแกรมนําเสนอผลงานสูงข้ึนก็จะมีประสบการณในการใชโปรแกรมประมวลผลคําสูงข้ึนดวย
เชนกัน   นอกจากนั้นยังพบวา เมทริกซสหสัมพันธระหวางตัวแปรสังเกตไดมีความแตกตางจากเมท
ริกซเอกลักษณ (identity matrix) อยางมีนัยสําคัญที่ระดับ .01 เชนกัน นอกจากนั้นยังสอดคลอง
กับผลการวิเคราะหคาดัชนีไกเซอร – ไมเยอร - ออลคิน (Kaiser-Meyer-Olkin Measure of 
sampling adequacy) ซึ่งแสดงใหเห็นวาตัวแปรสังเกตไดของกลุมตัวอยางมีความสัมพันธภายใน
ตอกันและเหมาะสมท่ีจะนําไปใชในการพัฒนาโมเดลเชิงสาเหตุและผลของการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4                        
ในกรุงเทพมหานคร พรอมกับตรวจสอบความสอดคลองของโมเดลที่พัฒนาข้ึนกับขอมูลเชิง
ประจักษตอไป 

2. ผลการวิเคราะหความสอดคลองของโมเดลเชิงสาเหตุและผลของการรับรูความสามารถ
ดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4                        
ในกรุงเทพมหานครกับขอมูลเชิงประจักษ พบวา โมเดลมีความสอดคลองกับขอมูลเชิงประจักษ 
และเปนไปตามสมมติฐานทั้ง 3 ประการที่ผูวิจัยไดตั้งไว โดยใหคาดัชนีความสอดคลองระหวาง
โมเดลตามกรอบแนวคิดกับขอมูลเชิงประจักษ ในรูปของคาไค-สแควร เทากับ 9.146 องศาอิสระ
เทากับ 11 ที่ระดับความนาจะเปน (p) เทากับ 0.608 ซึ่งสอดคลองกับผลการวเิคราะห คาดัชนีวัด
ระดับความกลมกลืน (GFI)  เทากับ 0.998  ดัชนีวัดระดับความกลมกลืนที่ปรับแกแลว (AGFI) 
เทากับ 0.986 และดัชนีกําลังสองสวนเหลือ (RMR) เทากับ 0.020 โดยตัวแปรในโมเดลสามารถ
อธิบายความแปรปรวนโดยภาพรวมของการรับรูความสามารถดานคอมพิวเตอรของตนเอง การ
ต้ังเปาหมาย ความผูกพันตอเปาหมาย และความสามารถทางคอมพิวเตอรไดรอยละ 100.00 17.60 
30.20 และ 24.20 ตามลําดับ  

3. เมื่อพิจารณาอิทธิพลทางตรงและทางออม ที่สงผลตอตัวแปรความสามารถทาง
คอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร พบวาตัวแปรความสามารถทาง
คอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร ไดรับอิทธิพลทางตรงจากตัวแปรความ
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ผูกพันตอเปาหมายมากที่สุด อยางมีนัยสําคัญทางสถิติที่ระดับ.01 โดยมีขนาดอิทธิพลเทากับ 
0.338 รองลงมา คือ ตัวแปรการตั้งเปาหมาย โดยมีขนาดอิทธิพล เทากับ 0.309 นอกจากนี้ยังไดรับ
อิทธิพลทางออมจากตัวแปรการรับรูความสามารถทางดานคอมพิวเตอรของตนเอง โดยมีขนาด
อิทธิพลเทากับ 0.201 ตามลําดับ สําหรับปจจัยที่มีอิทธิพลรวมสูงสุดตอตัวแปรความสามารถทาง
คอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร อยางมีนัยสําคัญทางสถิติที่ระดับ .01 
ไดแก ตัวแปรดานความผูกพันตอเปาหมาย โดยมีขนาดอิทธิพลเทากับ 0.338 รองลงมา คือ             
ตัวแปรการต้ังเปาหมาย โดยมีขนาดอิทธิพล เทากับ 0.309 นอกจากนั้นยังพบวาตัวแปรการรับรู
ความสามารถดานคอมพิวเตอรของตนเอง ยังมีขนาดอิทธิพลรวมตอความสามารถทาง
คอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร อยางมีนัยสําคัญทางสถิติที่ระดับ .05
โดยมีขนาดอิทธิพล เทากับ 0.174 นอกจากนี้แลวยังมีตัวแปรที่มี อิทธิพลรวมตอตัวแปร
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานครอยางไมมีนัยสําคัญ
ทางสถิติ ไดแก บุคลิกภาพภายในของผูเรียน ความมุงมั่นในการทํางาน ระดับประสบการณเดิม
และความวิตกกังวลในการใชคอมพิวเตอร   

4. เม่ือพิจารณาอิทธิพลทางตรงที่สงผลตอตัวแปรการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง พบวาตัวแปรบุคลิกภาพภายในของผูเรียนและตัวแปรความมุงมั่นในการ
ทํางานมีอิทธิพลทางตรงตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง โดยมีขนาด
อิทธิพลทางบวกเทากับ 0.877 และ 0.408 ตามลําดับ นอกจากนี้ตัวแปรระดับประสบการณเดิม 
และตัวแปรความวิตกกังวลในการใชคอมพิวเตอรมี อิทธิพลทางตรงตอต ัวแปรการร ับ รู
ความสามารถดานคอมพิวเตอรของตนเอง โดยมีขนาดอิทธิพลทางลบเทากับ -0.014 และ -0.516 
ตามลําดับ อยางไมมีนัยสําคัญทางสถิติที่ระดับ .05 

จากผลการวิเคราะหดังกลาว สามารถสรุปไดวา ความสามารถทางคอมพิวเตอรของ
นักเรียนชวงชั ้นที ่ 4  สามารถวัดดวยคะแนนทดสอบโปรแกรมนําเสนอผลงานไดดีที ่สุด และ
สําหรับการตั้งเปาหมาย พบวา ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน
จะสงผลตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานครมากที่สุด  
นอกจากนี้แลวการรับรูความสามารถดานคอมพิวเตอรของตนเองยังสงผลทางออมไปยัง
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานครโดยตองผานความ
ผูกพันตอเปาหมายและการตั ้งเป าหมาย  กลาวคือ  ถานักเรียนชวงชั้นที่ 4 ไดมีการรับรู
ความสามารถดานคอมพิวเตอรของตนเองแลวขณะทํางานมีการต้ังเปาหมายและไดมีความผูกพัน
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ตอเปาหมายนั้นแลวก็จะสงผลใหนักเรียนมีความสามารถทางคอมพิวเตอรนั้นดวย ซึง่กคื็อจะทาํให
นักเรียนชวงชั้นที่ 4 มีระดับความสามารถทางคอมพิวเตอรที่สูงข้ึนนั่นเอง 
อภิปรายผลการวิจัย 
 

 จากสรุปผลการวิจัยที่นําเสนอไปขางตนแลวนั้น  จะเห็นไดวาโดยภาพรวมแลวมีความ
สอดคลองกับกรอบแนวคิดและสมมติฐานการวิจัย อยางไรก็ตาม ผลการวิจัยดังกลาว ยงัมปีระเด็น
ที่นาสนใจ ดังนี้  

1. ความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานครที่ศึกษา
พบวา นักเรียนสวนใหญมีความสามารถทางคอมพิวเตอรในระดับปานกลาง โดยมีคะแนนเฉลี่ย
คิดเปนรอยละ 49.66 ของคะแนนเต็ม  ซึ่งสอดคลองกับผลการทดสอบทางการศึกษาระดับชาติข้ัน
พื้นฐาน (O-NET) ชวงช้ันที่ 4 ปการศึกษา 2549 - 2550  (www.moc.moe.go.th/filedata/ONET_ANET.htm) 
ในวิชาการงานอาชีพและเทคโนโลยี พบวามีคะแนนเฉลี่ยคิดเปนรอยละ 49.53 ที่เปนเชนนี้          
อาจเนื่องมาจากครูผูสอนไมไดสอนตามคูมือครูและหนังสือเรียนวิชาการงานอาชีพและเทคโนโลยี 
ซึ่งจากงานวิจัยของสถาบันการสงเสริมการสอนวิทยาศาสตรและเทคโนโลยี (2549) พบวา ยังมีครู
ที่ไมไดใชคูมือครูและหนังสือเรียนสาระการเรียนรูพื้นฐานและเพิ่มเติมเทคโนโลยีสารสนเทศ                
ชวงชั้นที่ 4  อยูถึงรอยละ 33.0 ทั้งนี้ผูวิจัยสรางแบบทดสอบโดยอางอิงตามคูมือครูและหนังสือเรียน
วิชาการงานอาชีพและเทคโนโลยี  ชวงชั้นที่  4 จึงอาจเปนสาเหตุใหผลการศึกษาคร้ังนี้                      
พบวานักเรียนสวนใหญมีความสามารถทางคอมพิวเตอรอยูในระดับปานกลาง 
 จากผลการวิจัยที่พบวา นักเรียนที่อยูในโรงเรียนที่มีขนาดแตกตางกันจะมีความสามารถ
ทางคอมพิวเตอรแตกตางกัน โดยนักเรียนที ่อยู ในโรงเรียนขนาดใหญมีความสามารถทาง
คอมพิวเตอรมากกวานักเรียนที่อยูในโรงเรียนที่มีขนาดกลาง ทั้งนี้อาจเนื่องมาจากโรงเรียนขนาด
ใหญมีคุณภาพของการจัดการศึกษาดีกวาโรงเรียนที่มีขนาดเล็ก และมีความไดเปรียบในดาน
ความเพียงพอของครุภัณฑอุปกรณเทคโนโลยีสารสนเทศและอุปกรณการเรียนการสอน (กองวิจัย
การศึกษา, 2533) และสอดคลองกับงานวิจัยของมนัส ภาคภูมิ (2527) ที่ศึกษาพบวา ขนาดของ
โรงเรียนมีความสัมพันธตอคุณภาพการศึกษา โดยโรงเรียนขนาดใหญมีคุณภาพการศึกษาดีกวา
โรงเรียนขนาดกลาง ทั้งนี้จึงทําใหโรงเรียนขนาดใหญมีความพรอมในการจัดการเรียนการสอนใน
วิชาคอมพิวเตอรมากกวา มีอัตราสวนจํานวนเคร่ืองคอมพิวเตอรตอจํานวนนักเรียนและ                       
มีอัตราสวนจํานวนครูตอหองเรียนและนักเรียนในปริมาณที่สูง (สุวัฒนา สุวรรณเขตนิคม, 2528) 
ทําใหครูสามารถใกลชิดกับนักเรียนไดมากกวาโรงเรียนขนาดเล็กกวา ทําใหครูมีโอกาสไดมีเวลาให
คําปรึกษากับนักเรียนไดมากกวา  โรงเรียนสามารถจัดหาเคร่ืองคอมพิวเตอร อุปกรณเทคโนโลยี
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สารสนเทศและอุปกรณส่ือการเรียนการสอน ไดหลากหลายรูปแบบและมีปริมาณที่เพียงพอกับ
ความตองการของเด็กนักเรียน และนอกจากนั้นยังมีงบประมาณในการสนับสนุนกิจกรรมตางๆ             
ที่เกี่ยวของกับงานสารสนเทศตางๆของนักเรียนในโรงเรียนมากกวาโรงเรียนที่มีขนาดเล็กกวา 
ดังนั้นจึงทําใหนักเรียนที่เรียนในโรงเรียนขนาดใหญจึงมีความสามารถทางคอมพิวเตอรมากกวา
นักเรียนที่เรียนในโรงเรียนที่มีขนาดเล็กกวา 

นอกจากนี้นักเรียนที่อยูในโรงเรียนสังกัดสํานักงานคณะกรรมการการศึกษาข้ันพื้นฐาน 
(สพฐ.) จะมีคะแนนความสามารถทางคอมพิวเตอร ส ูงกว าโรงเร ียนในสังก ัดสํานักงาน
คณะกรรมการสงเสริมการศึกษาเอกชน (สช.) ซึ่งสอดคลองกับผลการทดสอบทางการศึกษา
ระดับชาติข้ันพื้นฐาน (O-NET)  ชวงชั้นที่ 4 ปการศึกษา 2550 ในวิชาการงานอาชีพและเทคโนโลยี 
โดยโรงเรียนในสังกัดสํานักงานคณะกรรมการการศึกษาข้ันพื้นฐาน (สพฐ.) จะมีคะแนนเฉลี่ยคิด
เปนรอยละ 49.65 ซึ่งมีคะแนนทดสอบ O-NET สูงกวาโรงเรียนในสังกัดสํานักงานคณะกรรมการ
สงเสริมการศึกษาเอกชน (สช.) โดยมีคะแนนเฉลี่ยคิดเปนรอยละ 47.90  
 

2. ความสัมพันธเชิงสาเหตุระหวางตัวแปรในโมเดลเชิงสาเหตุและผลของการรับรู
ความสามารถดานคอมพิวเตอรของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวง
ชั้นที่ 4 ในกรุงเทพมหานคร ซึ่งจากผลการวิเคราะหอิทธิพลทางตรงและทางออมที่สงผลตอ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร พบวาความสามารถ
ทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร ไดรับอิทธิพลทางตรงจากตัวแปรความ
ผูกพันตอเปาหมายมากที่สุด อยางมีนัยสําคัญ รองลงมา คือ ตัวแปรการตั้งเปาหมาย นอกจากนี้
ยังพบวาความสามารถทางคอมพิวเตอรยังไดรับอิทธิพลทางออมจากการรับรูความสามารถดาน
คอมพิวเตอรของตนเอง สําหรับตัวแปรที่มีอิทธิพลรวมสูงสุดตอตัวแปรความสามารถดาน
คอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร คือ ตัวแปรความผูกพันตอเปาหมาย  

การอภิปรายในประเด็นนี้ ผูวิจัยอภิปรายตามขนาดอิทธิพลของตัวแปรที่สงผลตอ
ความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในกรุงเทพมหานคร ดังนี้ 

 2.1 ความผูกพันตอเปาหมาย 
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร ไดรับอิทธิพล

รวมและอิทธิพลทางตรงที่เปนบวกอยางมีนัยสําคัญจากความผูกพันตอเปาหมายมากที่สุด ซึ่งวัด
ไดจากตัวแปรสังเกตได คือ ความผูกพันตอเปาหมาย  ซึ่งสอดคลองกับงานวิจัยของเมเออรและ 
บรุนเสตียน (2001) ที่ไดศึกษาเกี่ยวกับตัวแปรสําคัญ 3 อยาง คือ ความผูกพันตอเปาหมาย 
ความสําเร็จตอเปาหมายและความกาวหนาของเปาหมาย ซึ่งผลจากการศึกษาพบวา ตัวแปร
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ความผูกพันตอเปาหมายเปนตัวแปรกํากับที่สามารถสงผลตอความแตกตางในการผลสําเร็จของ
การทํางานของคนแตละคน และยังพบวาความกาวหนาของเปาหมายเปนตัวแปรสงผานที่สําคัญ
ตอความผูกพันตอเปาหมายอีกดวย  ซึ่งแสดงใหเห็นวาความผูกพันตอเปาหมายสงผลตอ
ความสามารถทางการทํางาน  กลาวคือถาคนใดมีความผูกพันตอเปาหมายนั้นๆแลว ก็จะสงผลให
คนนั้นมีประสิทธิภาพในการทํางานใดๆมากยิ่งข้ึน  และสัมพันธกับงานวิจัยของวรกานต  เส่ียง
อารมณ (2541) ที่ศึกษาเกี่ยวกับอิทธิพลความยากงายของเปาหมายและรางวัลมีตอผลงานและ
ความผูกพันตอเปาหมายพบวาคนท่ีทํางานจนบรรลุเปาหมายของตนเองแลวจะเกิดความผูกพัน
ตอเปาหมาย นั่นแสดงวาความผูกพันตอเปาหมายและความสามารถในการทํางานนั้นมี
ความสัมพันธกัน ดังนั้นถานักเรียนมีความผูกพันตอเปาหมายในการที่จะทํางานใหสําเร็จ มีความ
มั่นใจวาจะตองทํางานใหสําเร็จ โดยไมมีความกังวลใจและคิดวาเปาหมายที่นักเรียนไดกําหนดไว
เปนเปาหมายที่ดี ก็จะสามารถทําใหนักเรียนมีความสามารถทางคอมพิวเตอรมากยิ่งข้ึน 

 2.2 การต้ังเปาหมาย 
นอกจากนี้ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร                

ยังไดรับอิทธิพลรวมและอิทธิพลทางตรงที่ เปนบวกอยางมีนัยสําคัญจากการตั้งเปาหมาย                      
ดวยเชนกัน ซึ่งวัดจากตัวแปรสังเกตได ไดแก ระดับเปาหมายของผลสําเร็จในการใชโปรแกรม
ประมวลผลคําและระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงาน ซึ่งจากผลการ
วิเคราะหความสัมพันธระหวางตัวแปรสังเกตไดของตัวแปรการตั้งเปาหมาย ดังแผนภาพท่ี 4.1 
พบวา ระดับเปาหมายของผลสําเร็จในการใชโปรแกรมนําเสนอผลงานมีความสัมพันธกับการ
ต้ังเปาหมายมากที่สุดในทิศทางเดียวกัน  ซึ่งความสัมพันธระหวางการตั้งเปาหมายและ
ความสามารถทางคอมพิวเตอรไดสัมพันธกับงานวิจัยของภัทรียา มาลาทอง (2545) ที่พบวาการ
ต้ังเปาหมายทางการเรียนมีความสัมพันธทางบวกกับทัศนคติตอวิชาชีพพยาบาลอันจะสงผลใหมี
แนวทางในการกระทําพฤติกรรมตางๆอยางเหมาะสม ซึ่งสามารถกอใหเกิดแรงจูงใจภายในและ
นําไปสูความสําเร็จในการทํางาน และจากงานวิจัยของเพียรสัน (1997) ไดศึกษาเกี่ยวกับการ
ต้ังเปาหมายในคนงานพบวาในการทํางานของคนงานที่มีการต้ังเปาหมายจะมีผลงานปฏิบัติงานที่
ดีกวาคนที่ไมมีการต้ังเปาหมายในการทํางาน นอกจากนั้นยังสัมพันธกับงานของฮินส และเวอรลิน 
บี (1995) ที่ไดศึกษาเกี่ยวกับการเปรียบเทียบระดับของการตั้งเปาหมายในการทํางานกับผลการ
ปฏิบัติงาน พบวาในกลุมที่มีการต้ังเปาหมายจะมีผลการปฏิบัติงานที่ดีกวากลุมที่ไมมีการ
ต้ังเปาหมายในการทํางาน และสอดคลองกับคํากลาวของของ วอลช (1995) ที่กลาววาการ
ต้ังเปาหมายในการทํางานจะเปนส่ิงที่ดี หากไมมีจะเกิดผลเสียและไมไดผลตามเทาที่ควรจะเปน 
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ดังงานวิจัยของ ธนากร ศรีชาพันธ (2538) ที่ไดศึกษาผลของการตั้งเปาหมายที่มีตอความสามารถ
ในการเสิรฟเทนนิส พบวาความสามารถของกลุมคนที่ฝกการเสิรฟเทนนิสควบคูกับการ
ต้ังเปาหมายสูงกวาความสามารถของกลุมคนที่มีการเสริฟเทนนิสเพียงอยางเดียว  และจาก
งานวิจัยของพิสมัย สังขทอง (2539) ที่ไดศึกษาผลของการรวมมือในการอานโดยกลุมต้ังเปาหมาย
รวมกันที่มีตอการอานเขาใจความภาษาไทย พบวานักเรียนในกลุมที่เรียนดวยวิธีการรวมมือในการ
อานโดยกลุมต้ังเปาหมายรวมกัน จะมีคะแนนการอานเขาใจความภาษาไทยสูงกวานักเรียนกลุมที่
เรียนวิธีการสอนตามปกติของครู  ดังนั้นเพื่อชวยใหนักเรียนมีประสิทธิภาพในการทํางานมากข้ึน  
ครูสามารถทําไดโดยการสามารถสอนใหนักเรียนรูจักต้ังเปาหมายในการทํางานเพื่อใหผลงานที่
นักเรียนทําออกมามีประสิทธิภาพมากข้ึน  ในทํานองเดียวกันถาครูสอนวิชาคอมพิวเตอรไดสอนให
นักเรียนไดต้ังเปาหมายในการทํางานก็จะสงผลใหนักเรียนมีความสามารถทางคอมพิวเตอรมาก
ข้ึนได 

 2.3 การรับรูความสามารถดานคอมพิวเตอรของตนเอง 
นอกจากนั้นความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร      

ยังไดรับอิทธิพลรวมที่เปนบวกอยางมีนัยสําคัญจากการรับรูความสามารถดานคอมพิวเตอรของ
ตนเอง ซึ่งวัดไดจากตัวแปรสังเกตได ไดแก การรับรูความสามารถในการใชโปรแกรมประมวลผล
คําและการรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน ซึ่งจากผลการวิเคราะห
ความสัมพันธระหวางตัวแปรสังเกตไดของตัวแปรการการรับรูความสามารถดานคอมพิวเตอรของ
ตนเอง ดังแผนภาพท่ี 4.1 พบวา การรับรูความสามารถในการใชโปรแกรมประมวลผลคํา                         
มีความสัมพันธกับการรับรูความสามารถดานคอมพิวเตอรของตนเองมากที่สุดในทิศทางเดียวกัน 
ซึ่งความสัมพันธระหวางการรับรูความสามารถดานคอมพิวเตอรของตนเองและความสามารถทาง
คอมพิวเตอรไดสัมพันธกับงานวิจัยของกรรณิการ จิตตบรรเทา (2539) ที่ไดศึกษาเกี่ยวกับ
ความสัมพันธระหวางการรับรูความสามารถของตนเองกับความสามารถในการอานเพื่อความ
เขาใจภาษาอังกฤษพบวาการรับรูความสามารถของตนเองมีความสัมพันธทางบวกกับ
ความสามารถในการอานเพื่อความเขาใจภาษาอังกฤษ เชนเดียวกับงานวิจัยของอมรรัตน              
บุบผโชติ (2546) ที่ไดศึกษาผลของการใชบันทึกการเรียนรูในการเรียนการสอนวิชาวิทยาศาสตรที่
มีผลตอการรับรูความสามารถของตนเองและความสามารถทางการเรียนวิชาวิทยาศาสตร          
ผลพบวาการรับรูความสามารถของตนเองมีความสัมพันธกับความสามารถทางการเรียนวิชา
วิทยาศาสตร   และยังสัมพันธกับงานวิจัยของ ดร.เดือนเพ็ญ ทองนวม (2545) ที่ไดศึกษาการรับรู
ความสามารถของตนเอง เปาหมายในการศึกษาและการเรียนรูโดยการกํากับตนเอง ผลพบวา
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นักศึกษาที่มีระดับการรับรูความสามารถของตนเองสูงก็จะสงผลใหนักศึกษาไดเกรดเฉล่ียสูงและ
ยังใชการเรียนโดยการกํากับตนเอง ดังงานวิจัยของรจเรข รัตนาจารย (2547) ที่พบวาการรับรู
ความสามารถของตนเองในวิชาวิทยาศาสตรมีความสัมพันธกับความสามารถทางการเรียนวิชา
วิทยาศาสตร   และยังสัมพันธกับชูชีพ ออนโคกสูง และอนุสรณ อรรถศิริ (2549) เกี่ยวกับตัวแปร 
การรับรูความสามารถของตนเอง การต้ังเปาหมายในการเรียน และความเปนไปไดที่จะกระทํากับ
แรงจูงใจในการเรียน  พบวาการรับรูความสามารถของตนเองมีความสัมพันธทางบวกกับการ
ต้ังเปาหมายในการเรียน  ดังนั้นถานักเรียนสามารถตัดสินความสามารถดานคอมพิวเตอรของ
ตนเองในการจัดการตนเองเพื่อใหไดบรรลุตามเปาหมายท่ีประสงคไวไดมากข้ึนก็จะสงผลให
นักเรียนมีความสามารถทางคอมพิวเตอรมากข้ึน 

3. ตัวแปรที่สงผลตอการรับรูความสามารถดานคอมพิวเตอรของตนเอง ไดแก บุคลิกภาพ
ภายในของผูเรียน ความมุงมั่นในการทํางาน ระดับประสบการณเดิมและความวิตกกังวลในการใช
คอมพิวเตอร โดยคาอิทธิพลทางตรงของตัวแปรเหลานี้จะสงผลตอการรับรูความสามารถดาน
คอมพิวเตอรของตนเองอยางไมมีนัยสําคัญทางสถิติ ดังนั้นบุคลิกภาพภายในของผูเรียน ความมุงมั่น
ในการทํางาน ระดับประสบการณเดิมและความวิตกกังวลในการใชคอมพิวเตอรจึงไมมี
ความสัมพันธกับการรับรูความสามารถดานคอมพิวเตอรของตนเอง ซึ่งสอดคลองกับงานวิจัยของ
ทวี นําสกุลวงศ (2550) ที่ไดศึกษาเกี่ยวกับปจจัยคัดสรรที่สงผลตอการรับรูความสามารถของ
อาจารยมหาวิทยาลัยเทคโนโลยีราชมงคลอีสาน ผลพบวาตัวแปรประสบการณจากตัวแบบ และ
ความวิตกกังวลไมสงผลตอตัวแปรการรับรูความสามารถของอาจารย และยังมีงานวิจัยของศิริโฉม 
หนูมี (2548) ที่ไดศึกษาเกี่ยวกับความสัมพันธระหวางความฉลาดทางอารมณ ความมุงมั่นสู
ความสําเร็จกับผลสัมฤทธิ์ทางการเรียนวิชาภาษาอังกฤษของนักศึกษามหาวิทยาลัยรัตนบัณฑิต
วิทยาศาสตรและเทคโนโลยี ผลพบวาความมุงมั่นสูความสําเร็จไมมีความสัมพันธกับผลสัมฤทธิ์
ทางการเรียนวิชาภาษาอังกฤษ  นอกจากนี้ยังสัมพันธกับงานวิจัยของสกุณา แตแดงเพชร (2526) ที่
ไดศึกษาเกี่ยวกับความสัมพันธระหวางบุคลิกภาพ ความถนัดทางการเรียนและผลสัมฤทธิ์ทางการ
เรียนของนักเรียนชั้นมัธยมศึกษาปที่ 6 โรงเรียนสาธิตคณะศึกษาศาสตร ผลพบวาบุคลิกภาพไมมี
ความสัมพันธกับผลสัมฤทธ์ิทางการเรียน ทั้งนี้อาจเนื่องมาจากลักษณะขอคําถามที่ใชวัดตัวแปร
บุคลิกภาพภายในของผูเรียน ความมุงมั่นในการทํางานและความวิตกกังวลในการใชคอมพิวเตอร 
เปนขอคําถามที่ผูวิจัยไดพัฒนามาจากแบบวัดของนักวิจัยชาวตางประเทศ ซึ่งขอคําถามจะมี
ลักษณะที่เหมาะสมกับกลุมตัวอยางที่เปนนักศึกษาตางประเทศมากกวา สวนตัวแปรระดับ
ประสบการณเดิมจะมีลักษณะขอคําถามที่ไมเหมาะสม คือ ขอคําถามจํานวนชั่วโมงที่นักเรียนใช
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โปรแกรมประมวลผลคําและโปรแกรมนําเสนอผลงานใน 1 วัน ซึ่งตามปกติแลวนักเรียนจะใช
โปรแกรมประมวลผลคําและโปรแกรมนําเสนอผลงานก็ตอเมื่อตองทํางานกับโปรแกรมนั้นจริงๆ
หรือไดรับมอบหมายงานมาจากรายวิชา ที่กําลังศึกษาอยู ดังนั้นจึงสงผลใหนักเรียนสวนใหญมี
จํานวนช่ัวโมงในการใชโปรแกรมประมวลผลคําและนําเสนอผลงานที่นอย ดังนั้นในการศึกษาคร้ัง
ตอไป จึงควรที่จะปรับขอคําถามใหเหมาะสมกับบริบทของคนไทย 
 
ขอเสนอแนะในการวิจยั 
  

 การนําเสนอในสวนนี้ แบงการนําเสนอเปน 2 สวน คือ สวนแรก เปนการนําเสนอเกี่ยวกับ
ขอเสนอแนะในการนําผลการวิจัยไปใช และสวนที่สอง เปนการนําเสนอขอเสนอแนะในการทําวิจัย
คร้ังตอไป ซึ่งมีรายละเอียด ดังนี้ 
 

 ขอเสนอแนะในการนําผลการวิจัยไปใช 
 จากผลการวิเคราะหโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอร
ของตนเองที่มีตอความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ันที่ 4 ในเขตกรุงเทพมหานคร 
พบประเด็นตาง  ๆ  ที่นาสนใจ  ซึ่ง ผูวิจัยขอเสนอแนะการนําผลการวิจัยไปใชเพื่อพัฒนา
ความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในเขตกรุงเทพมหานคร ดังนี้ 
 1. จากขอคนพบของการวิจัยที่ชี้ใหเห็นวา ความสามารถทางคอมพิวเตอรของนักเรียนชวง
ชั้นที่ 4 ในเขตกรุงเทพมหานคร เปนผลมาจากปจจัยดานความผูกพันตอเปาหมายเปนสําคัญ 
เพราะฉะนั้น ครู ผูปกครอง และผูที่เกี่ยวของจึงควรพึงตระหนักไวเสมอวา การปลูกฝงและ
เสริมสรางความสามารถทางคอมพิวเตอรใหแกเด็กนั้นเปนหนาที่สําคัญอยางหนึ่งของทุกฝาย            
จึงควรพยายามทุกวิถีทางเพื่อใหเด็กเห็นคุณคาและประโยชนจากการใชคอมพิวเตอร สงเสริมให
เด็กรูจักใชเทคโนโลยีในทางที่ดี ทั้งนี้หากพอแมผูปกครอง หรือครูเปดโอกาสใหเด็กไดฝกใช
คอมพิวเตอรและการคนควาหาความรูผานคอมพิวเตอรบอย ๆ รวมทั้งใหการสนับสนุนการ
เสริมสรางทักษะทางคอมพิวเตอรแกเด็ก เชน จัดหาหนังสือคอมพิวเตอรเพิ่มเติม ระบบ
อินเตอรเน็ตที่เหมาะสมและตรงกับความสนใจของเด็ก จัดสถานที่และบรรยากาศใหเหมาะสมกับ
การใชคอมพิวเตอร และไมขัดขวางการใชคอมพิวเตอรและเทคโนโลยีของเด็ก รวมถึงรวมมือกับ
ทางโรงเรียนในการชวยกันสงเสริมการใชคอมพิวเตอรของเด็ก ก็จะสามารถทําใหเด็กมีความ
ผูกพันตอเปาหมายเพิ่มข้ึน ซึ่งเปนการสงเสริมใหเด็กมีความสามารถทางคอมพิวเตอรเพิ่มข้ึนไดอีก
ทาง 
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 2. จากการวิเคราะหโมเดลเชิงสาเหตุความสามารถทางคอมพิวเตอรของนักเรียนชวงช้ัน   
ที่ 4 ในเขตกรุงเทพมหานครยังไดรับอิทธิพลทางตรงจากตัวแปรการต้ังเปาหมาย ซึ่งผูวิจัยขอ
เสนอแนะในการนําผลวิจัยไปใชในสวนนี้ เพื่อพัฒนาความสามารถทางคอมพิวเตอรของนักเรียน
ชวงชั้นที่ 4 ในเขตกรุงเทพมหานคร โดยการที่ผูเรียนมีการต้ังเปาหมายหรือความคาดหวังในการ
เรียนรูไวนั้นจะสงผลใหเด็กมีแรงขับในการเรียนรู ทําใหมีความต้ังใจใฝรูในการเรียนวิชานั้น ๆ และ
เมื่อเด็กมีความมุงมั่นและต้ังใจแลวจะทําใหผลของการกระทํานั้นสําเร็จลุลวงไปไดดวยดี ดังนั้นใน
การจัดการเรียนการสอนคอมพิวเตอร ครูผูสอนจึงควรใหนักเรียนต้ังเปาหมายหรือความคาดหวังใน
การเรียนไวลวงหนาเพื่อใหนักเรียนมีแรงจูงใจในการเรียน และมีความต้ังใจในการเรียนในวิชา
คอมพิวเตอรเพื่อเปนการเพิ่มความสามารถทางคอมพิวเตอรของนักเรียนไดอีกทางหนึ่ง 

3. นอกจากนี้แลวยังมีตัวแปรการรับรูความสามารถดานคอมพิวเตอรของตนเอง ซึ่งแมจะ
ไมมีอิทธิพลโดยตรงตอความสามารถทางคอมพิวเตอรแตก็มีอิทธิพลทางออมตอความสามารถ
ทางคอมพิวเตอร กลาวคือ ถานักเรียนไดมีการรับรูความสามารถดานคอมพิวเตอรของตนเองแลว
และนักเรียนไดต้ังเปาหมายในการทํางานจนเกิดความผูกพันตอเปาหมายนั้นแลวก็จะสงผลให
นักเรียนมีความสามารถทางคอมพิวเตอรเพิ่มข้ึนได ดังนั้นถาครูผูสอนในวิชาคอมพิวเตอรสามารถ
สงเสริมใหนักเรียนเกิดการรับรูความดานคอมพิวเตอรของตนเอง โดยทางโรงเรียนจะตองจัดหา
อุปกรณทางคอมพิวเตอรที่เหมาะสมและเพียงพอกับจํานวนนักเรียนแลวก็จะเปนการเพิ่ม
ความสามารถทางคอมพิวเตอรของนักเรียนได 
 

 ขอเสนอแนะในการวิจยัคร้ังตอไป 
1. การวิจัยในครั้งนี้  ใชการวิจัยเชิงปริมาณเพื่อสํารวจหาปจจัยที่สงผลทั้งทางตรงและ

ทางออมตอความสามารถทางคอมพิวเตอรของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร                  
จึงควรทําการศึกษาหาปจจัยที่สงผลตอความสามารถทางคอมพิวเตอรในเชิงลึกโดยใชวิธีการ
วิจัยเชิงคุณภาพเพื่อตรวจสอบความสอดคลองและยืนยันผลการวิจัยซึ่งจะทําใหไดสารสนเทศ
เชิงลึกมากข้ึน 

2. ในการวัดความสามารถทางคอมพิวเตอรในการวิจัยคร้ังนี้วัดจากความสามารถในการ
ใชโปรแกรมประมวลผลคําและโปรแกรมนําเสนอผลงานเทานั้น ดังนั้นในการวิจัยคร้ังตอไปอาจทํา
การวัดความสามารถทางคอมพิวเตอรของนักเรียนโดยวัดจากตัวแปรสังเกตไดอ่ืนๆ ใหครอบคลุม
มากยิ่งข้ึน เชน ความสามารถในการใชอินเตอรเน็ต ความรูทางดานฮารดแวร ความรูทางดาน
เทคโนโลยีสารสนเทศและการส่ือสาร เปนตน 
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 3. จากการศึกษาพบวา ปจจัยดานบุคลิกภายในของผูเรียน ดานความมุงมั่นในการทํางาน 
ดานระดับประสบการณเดิม และดานความวิตกกังวลในการใชคอมพิวเตอรไมสงผลตอการรับรู
ความสามารถดานคอมพิวเตอรของตนเองและความสามารถทางคอมพิวเตอรของนักเรียน                
ซึ่งปจจัยดานตาง ๆ เหลานี้ เปนปจจัยที่เกี่ยวของกับพฤติกรรมของบุคคล ซึ่งมีความละเอียดและ
ซับซอน ดังนั้น จึงควรมีการศึกษาตัวแปรที่เกิดจากปจจัยภายนอกเพิ่มเติมไมวาจะเปนบุคคล        
ที่เกี่ยวของกับนักเรียน ตลอดจนสิ่งแวดลอมเพื่อใหโมเดลมีความสอดคลองกับขอมูลเชิงประจักษ
มากข้ึน 
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ภาคผนวก ก 

รายนามผูเชีย่วชาญในการตรวจสอบคุณภาพเคร่ืองมือ 
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ภาคผนวก ก 
รายนามผูเชีย่วชาญในการตรวจสอบคุณภาพเคร่ืองมือ 

 
1. ผูชวยศาสตราจารย ดร.ณัฎฐภรณ หลาวทอง อาจารยประจําภาควิชาวิจัยและจิตวทิยา
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2. ผูชวยศาสตราจารย  ดร.พาสนา จุลรัตน อาจารยประจําภาควิชาการแนะแนวและ

จิตวิทยาการศึกษา คณะศึกษาศาสตร  มหาวิทยาลัยศรีนครินทรวิโรฒฯ 
  3. อาจารย ดร.สกล วรเจริญศรี อาจารยประจําภาควิชาการแนะแนวและจิตวิทยา
การศึกษา คณะศึกษาศาสตร มหาวิทยาลัยศรีนครินทรวิโรฒฯ 

4. อาจารย ดร. ประกอบ กรณีกิจ อาจารยประจําภาควิชาหลักสูตร การสอนและ
เทคโนโลยีการศึกษา สาขาเทคโนโลยีการศึกษา คณะครุศาสตร จุฬาลงกรณมหาวิทยาลัย 

5. อาจารยชยการ  คีรีรัตน อาจารยประจํากลุมสาระการงานอาชีพและเทคโนโลยี  
โรงเรียนสาธิตจุฬาลงกรณมหาวิทยาลัย 
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ภาคผนวก ข 
หนังสือขอความรวมมือ 
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ภาคผนวก ค 

ตัวอยาง คูมอืการดําเนนิงานเก็บขอมูลสาํหรับคร ู
แบบสอบถามและแบบทดสอบ 

 

 

 

 

 

 

 

 

 

 



 150
 

คูมือการดําเนินการเก็บขอมูลแบบสอบถามและแบบทดสอบสาํหรับคร ู
 
จุดมุงหมาย 

แบบสอบถามและแบบทดสอบฉบับนี้สรางข้ึนเพื่อเปนเครื่องมือสําหรับศึกษาปจจัยที่มี
อิทธิพลตอการรับรูความสามารถดานคอมพิวเตอรของตนเองกับความสามารถทางคอมพิวเตอร
ของนักเรียนชวงชั้นที่ 4 ในกรุงเทพมหานคร  

 
ลักษณะของแบบสอบถามและแบบทดสอบ 

แบบสอบถามและแบบทดสอบชุดนี้ แบงออกเปน 4 ตอน ดังนี ้ตอนที่ 1 เปนขอมลูทั่วไป
ของนักเรียน ตอนที่ 2 เปนแบบสอบถามปจจัยที่สงผลตอการรับรูความสามารถดานคอมพิวเตอร
ของตนเอง ตอนที ่ 3 เปนแบบสอบถามปจจัยที่สงผลตอความสามารถทางคอมพิวเตอรและตอน            
ที่ 4 แบบทดสอบความสามารถทางคอมพิวเตอร โดยวธิีตอบใหนกัเรียนตอบโดยทาํเคร่ืองหมายลง
ไปในแบบสอบถามและแบบทดสอบ รวมใชเวลาในการทําแบบสอบถามและแบบทดสอบทัง้หมด 
45 นาท ี
 
วิธีดําเนินการเก็บขอมูล 

ในการดําเนนิการสอบควรดําเนนิการในหองที่มีสภาพแวดลอมที่เหมาะสม มทีี่นัง่สามารถ 
เขียนไดสะดวกโดยการดําเนินการตอบแบบสอบถามและแบบทดสอบแบงเปน 3 ระยะ คือ                 
การเตรียมตัวกอนทําแบบสอบถามและแบบทดสอบ วิธีปฏิบัติขณะทําแบบสอบถามและ
แบบทดสอบ และเม่ือหมดเวลาทําแบบสอบถามและแบบทดสอบ ซึ่งมีข้ันตอนดังนี้ 

1. การเตรียมตัวกอนตอบแบบสอบถามและแบบทดสอบ 
  1.1 เตรียมแบบสอบถามและแบบทดสอบใหเรียบรอย มีผูดําเนินการ

สอบ 1 คน หรือมากกวา และจัดที่นั่งใหเพียงพอแกผูเขาสอบ 
  1.2 การเตรียมตัวสําหรับผูดําเนินการสอบ ผูดําเนินการสอบจะตอง

ศึกษาคําชี้แจงในการทําแบบสอบถามและแบบทดสอบลวงหนา เพื่อใหสามารถดําเนินการได
อยางถูกตอง 

 2. วิธีดําเนินการ 
  2.1 ผูดําเนินการแจกแบบสอบถามเก่ียวกับเหตุและผลของการรับรู

ความสามารถดานคอมพิวเตอรใหแกผูตอบคนละ 1 ชุด 
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  2.2 ผูดําเนินการสอบอธิบายคําช้ีแจงในการทําแบบสอบถาม 
   2.3 จากนั้นใหผูสอบลงมือทําแบบสอบถามโดยใชเวลา 15 นาที โดย
ผูดําเนินการสอบใหสัญญาณแกผูสอบไดลงมือทําพรอมกัน 

2.4 เมื่อหมดเวลาผูดําเนินการเก็บแบบสอบถามและแจกแบบทดสอบ
ความสามารถทางคอมพิวเตอรใหแกผูสอบคนละ 1 ชุด  

  2.5 ผูดําเนินการสอบอธิบายคําช้ีแจงในการทําแบบทดสอบ 
  2.6 จากนั้นใหผูสอบลงมือทําแบบทดสอบ โดยใชเวลา 30 นาที โดย

ผูดําเนินการสอบใหสัญญาณแกผูสอบไดลงมือทําพรอมกัน 
 3. วิธีปฏิบัติเมื่อหมดเวลา 
  3 .1  ผู ดํ า เนินการสอบแจ ง เวลาที่ เห ลือในการทําแบบทดสอบ 

เปน 3 ระยะ คือ 
   3.1.1 เมื่อเวลาในการสอบผานไป 15 นาที 
   3.1.2 เมื่อเหลือเวลาอีก 5 นาที จะหมดเวลาในการทํา 
   3.1.3 เมื่อหมดเวลาในการทํา 
  3.2 เมื่อหมดเวลาในการทําแบบทดสอบแลว ผูดําเนินการสอบใหผูสอบ

วางดินสอหรือปากกาและหยุดทําแบบทดสอบทันที 
  3.3 ในกรณีที่ผูตอบทําแบบทดสอบเสร็จกอนเวลาที่กําหนดใหผูสอบผู

นั้นออกไปนอกหองสอบกอน เพื่อไมใหรบกวนสมาธิในการทําแบบทดสอบของผูสอบคนอ่ืนๆ 
หลังจากนั้น เมื่อผูสอบทําแบบทดสอบเสร็จทั้งหองสอบแลว ผูดําเนินการสอบจึงเก็บแบบทดสอบ
ตามลําดับเลขที่ผูสอบ แลวรวบรวมแบบสอบถามและแบบทดสอบสงกลับคืนฝายวิชาการของ
โรงเรียน 
 

 

 

 

 
 



 152
 

แบบสอบถามและแบบทดสอบเพื่อการวิจยั 
เรื่อง  

การพัฒนาโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพิวเตอร 
ของตนเองท่ีมีตอความสามารถทางคอมพิวเตอร 

 
""""""""""""""" 

 
 
 

        คําชี้แจง 
 1.แบบสอบถามและแบบทดสอบฉบับนี้มีวัตถุประสงคเพ่ือศึกษาปจจัยที่มีอิทธิพลตอการรับรู  
ความสามารถดานคอมพิวเตอรของตนเองกับความสามารถทางคอมพิวเตอรของนักเรียน 
ชวงช้ันที่ 4 ในกรุงเทพมหานคร  ขอใหนักเรียนตอบแบบสอบถามใหตรงกับความเปนจริงมากที่สุด   
 2.ขอมูลจากการตอบแบบสอบถามและแบบทดสอบของนักเรียนมีความสําคัญย่ิงตอความ
สมบูรณในการวิจัยจึงขอความกรุณาจากนักเรียนในการตอบคําถามใหครบทุกขอ 
 3.ขอมูลจากการตอบแบบสอบถามและแบบทดสอบของนักเรียนจะถือเปนความลับและไมมี
ผลกระทบใดๆ ตอนักเรียนท้ังส้ิน 
 4. แบบสอบถามและแบบทดสอบชุดนี้ใชเวลาในการทํา 45 นาที 
 5. แบบสอบถามและแบบทดสอบชุดน้ี แบงออกเปน 4 ตอน ดังนี้ 
   ตอนที่ 1 ขอมูลทั่วไปของนักเรียน 
   ตอนที่ 2 แบบสอบถามปจจัยที่สงผลตอการรับรูความสามารถ 
                ดานคอมพิวเตอรของตนเอง 
   ตอนที่ 3 แบบสอบถามปจจัยที่สงผลตอความสามารถทาง 
                คอมพิวเตอร  
   ตอนที่ 4 แบบทดสอบความสามารถทางคอมพิวเตอร 

 
               ขอขอบพระคุณที่ใหความรวมมือดวยดี 
            นายชุติวัฒน  สุวัตถิพงศ 
                            ผูวิจัย 

 
 

3  ขอมูลของทานมีประโยชนอยางยิง่สําหรับผูวิจยั  3 
ขอขอบคุณอยางสูงที่กรุณาตอบแบบสอบถาม 
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 ตอนที่ 1 ขอมูลทั่วไปของนักเรียน 
 คําช้ีแจง  โปรดทําเคร่ืองหมาย   ลงในชองวาง  หนาขอความที่ตรงกับความเปนจริงของนักเรียน   

                  และเติมขอความลงในชองวางตามความเปนจริง 
1. เพศ                               � 1) ชาย � 2) หญิง 
2. อายุ ………………………... ป                    
3. ศึกษาอยูในระดับชั้น                  
 

� 1) มัธยมศึกษาปที่ 4        
� 3) มัธยมศึกษาปที่ 6 

� 2) มัธยมศึกษาปที่ 5 

4. แผนการเรียน                              � 1) วิทย - คณติ                       
� 3) ศิลป – ภาษา         

� 2) ศิลป – คํานวณ 
� 4) อื่นๆระบ.ุ.............................. 

5. ประสบการณในการใชคอมพิวเตอร 
     � 1) นอยกวา 1 ป 
     � 4)  5 – 6 ป               

� 2)  1 – 2  ป 
� 5) มากกวา 6 ป                        

� 3) 3 – 4 ป 

6. โดยปกตินักเรียนใชคอมพิวเตอรบอยเพียงใด ( ระบุจํานวนชั่วโมงโดยเฉล่ียตอวัน ) 
     � 1) นอยกวา 1 ชั่วโมง / วัน 
     � 4) 5 – 6  ชั่วโมง / วัน   

� 2) 1 – 2 ชั่วโมง / วัน          
� 5) มากกวา 6  ชั่วโมง / วัน    

� 3) 3 – 4  ชั่วโมง / วัน  

7. นกัเรียนมีประสบการณในการใชโปรแกรมประมวลผลคํา ( Microsoft Word )  
     � 1) นอยกวา 1 ป 
     � 4)  5 – 6 ป               

� 2)  1 – 2  ป 
� 5) มากกวา 6 ป                        

� 3) 3 – 4 ป 

8. โดยปกตินักเรียนใชโปรแกรมประมวลผลคํา ( Microsoft Word )  คําบอยเพียงใด  
    ( ระบุจํานวนชัว่โมงโดยเฉล่ียตอวัน )  
     � 1) นอยกวา 1 ชั่วโมง / วัน 
     � 4) 5 – 6  ชั่วโมง / วัน   

� 2) 1 – 2 ชั่วโมง / วัน          
� 5) มากกวา 6  ชั่วโมง / วัน    

� 3) 3 – 4  ชั่วโมง / วัน  

9. นกัเรียนไดคาดหวังถึงผลสําเร็จของผลงานจากการใชโปรแกรมประมวลผลคํา ( Microsoft Word )   
    ไวรอยละเทาใด  
     � 1) รอยละ 0 - 20  
     � 4) รอยละ 61 – 80   

� 2) รอยละ 21 – 40 
� 5) รอยละ 81 – 100    

� 3) รอยละ 41 – 60 

10. นกัเรียนมีประสบการณในการใชโปรแกรมนําเสนอผลงาน ( Microsoft Powerpoint )  
     � 1) นอยกวา 1 ป 
     � 4)  5 – 6 ป               

� 2)  1 – 2  ป 
� 5) มากกวา 6 ป                        

� 3) 3 – 4 ป 

11. โดยปกตินักเรียนใชโปรแกรมนําเสนอผลงาน ( Microsoft Powerpoint ) บอยเพียงใด  
     ( ระบจุํานวนชั่วโมงโดยเฉลี่ยตอวัน )  
     � 1) นอยกวา 1 ชั่วโมง / วัน 
     � 4) 5 – 6  ชั่วโมง / วัน   

� 2) 1 – 2 ชั่วโมง / วัน          
� 5) มากกวา 6  ชั่วโมง / วัน    

� 3) 3 – 4  ชั่วโมง / วัน  
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12. นกัเรียนไดคาดหวังถึงผลสําเร็จของผลงานจากการโปรแกรมนําเสนอผลงาน ( Microsoft Powerpoint ) 
      ไวรอยละเทาใด 
     � 1) รอยละ 0 - 20  
     � 4) รอยละ 61 – 80   

� 2) รอยละ 21 – 40 
� 5) รอยละ 81 – 100    

� 3) รอยละ 41 – 60 

 
 ตอนที่ 2 แบบสอบถามปจจัยทีส่งผลตอการรับรูความสามารถดานคอมพิวเตอร 
            ของตนเอง 
 
คําชี้แจง   ใหนักเรียนพิจารณาขอความตอไปน้ี แลวทําเคร่ืองหมาย  ลงในชองวางท่ีตรงกับ 
 ความคิดเห็นของนักเรียนมากท่ีสุด  ดังตัวอยางตอไปน้ี 

      ตัวอยาง 
ระดับความคิดเห็น 

ขอที่ ขอคําถาม 

มา
กท
ี่สุด

 

มา
ก 

  ป
าน
กล
าง

 

นอ
ย 

นอ
ยท
ี่สุด

 

00 หากฉันไดพยายามทํางาน ฉันจะมีความสุข       
จากตัวอยาง นักเรียนทําเครื่องหมาย   ลงในชองระดับความคิดเห็น “มาก” หมายถึง ถานักเรียน 

ไดมีความพยายามทํางานอยางใดอยางหน่ึงจะทําใหตนเองมีความสุขมากกวามีความทุกขใจ 
ระดับความคิดเห็น 

ขอที่ ขอคําถาม 

มา
กท
ี่สุด

 

มา
ก 

ปา
นก
ลา
ง 

นอ
ย 

นอ
ยท
ี่สุด

 
 บุคลิกภาพภายในของผูเรียน  

1 ฉันพึงพอใจในความสําเร็จตามท่ีสมควรจะไดรับ      
2 เม่ือฉันพยายาม ฉันจะประสบความสําเร็จในการทํางาน      
3 ฉันทํางานไดอยางสมบูรณและประสบความสําเร็จอยางดี      
4 ฉันรูสึกภูมิใจกับการทํางานของตนเอง      
5 ฉันตัดสินใจเลือกทําส่ิงตางๆไดอยางม่ันใจ      
6 เม่ือเกิดปญหาขึ้น ฉันสามารถรับมือกับปญหาเหลานั้นได      
7 ฉันเปนที่รักใครของผูอื่น      
8 ฉันจะทําในส่ิงที่ถูกตองและเต็มความสามารถเสมอ      
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ระดับความคิดเห็น 

ขอที่                        ขอคําถาม 

มา
กท
ี่สุด

 

มา
ก 

ปา
นก
ลา
ง 

นอ
ย 

นอ
ยท
ี่สุด

 

9 ในการทํางานบางคร้ัง ฉันรูสึกมีความกดดันตอตนเอง      
10 บางคร้ังเมื่อฉันทํางานลมเหลว ฉันจะรูสึกวาตนเองไรคา      
11 บางคร้ังฉันรูสึกควบคุมการทํางานตางๆของฉันไมไดเลย      
12 ฉันมักจะสงสัยในความสามารถของตนเอง      
13 ฉันรูสึกกังวลท่ีฉันไมสามารถทํางานใหสําเร็จได      
14 บางคร้ังฉันรูสึกทอแทในชีวิต      
15 ฉันไมสามารถเปนที่พึ่งของใครไดเลย      
16 ปกติแลวไมคอยมีคนอื่นมาใสใจกับฉันมากนัก      

 ความมุงม่ันในการทํางาน  
17 โอกาสที่ในการจะไดทํางานที่ทาทายเปนส่ิงสําคัญสําหรับฉัน      
18 เม่ือลมเหลวในการทํางานชิ้นที่ยาก  ฉันวางแผนท่ีจะ 

พยายามใหมากข้ึนในการทํางานครั้งตอไป 
     

19 ฉันเลือกท่ีจะทํางานท่ีทําใหฉันไดเรียนรูส่ิงใหม ๆ      
20 โอกาสที่จะไดทําส่ิงใหม ๆ เปนส่ิงทาทายสําหรับฉัน      
21 ฉันพยายามอยางดีที่สุดเม่ือตองทํางานท่ีคอนขางยาก      
22 ฉันพยายามทุกคร้ังที่จะปรับปรุงการปฏิบัติงานท่ีผานมา 

ใหดีขึ้น 
     

23 โอกาสในการพัฒนาความสามารถเปนส่ิงสําคัญสําหรับฉัน      
24 เม่ือพบความยุงยากในการแกปญหา ฉันชอบลองหลาย ๆ  

ทางเพื่อหาวิธีที่ดีที่สุด 
     

 ความวิตกกังวลในการใชคอมพิวเตอร  
25 ฉันไมกลาใชคอมพิวเตอรเพราะกลัววาจะทําผิดพลาด  

แลวแกไขไมได 
     

26 ฉันรูสึกกลัวการใชคอมพิวเตอร      
27 ฉันหลีกเล่ียงการใชคอมพิวเตอรเพราะรูสึกไมคุนเคย      
28 ฉันรูสึกกลัวการใชคอมพิวเตอร แคคิดวาฉันอาจทําลายขอมูล

มากมายในเคร่ือง  เพียงแคกดปุมผิดคร้ังเดียว 
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ตอนที่ 3 แบบสอบถามปจจัยท่ีสงผลความสามารถทางคอมพิวเตอร  
 

คําชี้แจง    ใหนักเรียนพิจารณาขอความตอไปน้ี แลวทําเคร่ืองหมาย  ลงในชองวางท่ีตรงกับ 
 ความคิดเห็นของนักเรียนมากท่ีสุด  ดังตัวอยางตอไปน้ี 
ตัวอยาง 

ระดับความคิดเห็น 
ขอที่ ขอคําถาม 

มา
กท
ี่สุด

 

มา
ก 

  ป
าน
กล
าง

 

นอ
ย 

นอ
ยท
ี่สุด

 

00 หากฉันไดพยายามทํางาน ฉันจะมีความสุข       
 

จากตัวอยาง นักเรียนทําเคร่ืองหมาย   ลงในชองระดับความคิดเห็น “มาก” หมายถึง ถานักเรียน
ไดมีความพยายามทํางานอยางใดอยางหน่ึงจะทําใหตนเองมีความสุขมากกวามีความทุกขใจ 
 

ระดับความคิดเห็น 
ขอที่ ขอคําถาม 

มา
กท
ี่สุด

 

มา
ก 

  ป
าน
กล
าง

 

นอ
ย 

นอ
ยท
ี่สุด

 

การรับรูความสามารถดานคอมพิวเตอรของตนเอง 
 การรับรูความสามารถในการใชโปรแกรม 

ประมวล ผลคํา( Microsoft Word ) 
 

1 ฉันเชื่อวาฉันสามารถอธิบายหนาที่และสวนประกอบของ
โปรแกรมประมวลผลคําได 

     

2 ฉันเชื่อวาฉันสามารถอธิบายหนาที่และสวนประกอบของแถบ
เคร่ืองมือในโปรแกรมประมวลผลคําได 

     

3 ฉันเชื่อวาฉันสามารถสราง บันทึกและเปดเอกสารรวมถึง
แทรกขอความลงในเอกสารนั้นๆได 

     

4 ฉันเชื่อวาฉันสามารถต้ังคาหนากระดาษ ต้ังก้ันหนาและก้ัน
หลังขอความได 

     

5 ฉันเชื่อวาฉันสามารถกําหนดตําแหนงของแท็บและเลือกใช
แท็บใหเหมาะสมกับงานได 

     

6 ฉันเชื่อวาฉันสามารถเลือกขอความ ยายขอความ คัดลอก
และลบขอความได 

     

7 ฉันเชื่อวาฉันสามารถจัดรูปแบบขอความ รวมไปถึงการ
กําหนดหมายเลขลําดับ และเคร่ืองหมายหนาขอความได 
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ระดับความคิดเห็น 

ขอที่ ขอคําถาม 

มา
กท
ี่สุด

 

มา
ก 

ปา
นก
ลา
ง 

นอ
ย 

นอ
ยท
ี่สุด

 

8 ฉันเชื่อวาฉันสามารถปรับเปล่ียนลักษณะของตัวอักษร
เปล่ียนสีใหตัวอักษรและใสสีพื้นหลังใหกับขอความได 

     

9 ฉันเชื่อวาฉันสามารถปรับระยะหางระหวางตัวอักษร  
บรรทัดและยอหนาได 

     

10 ฉันเชื่อวาฉันสามารถแทรกสัญลักษณพิเศษและอักขระพิเศษ
ลงในเอกสารได  

     

11 ฉันเชื่อวาฉันสามารถใสกรอบใหกับขอความ เอกสารและ
แบงคอลัมนได 

     

12 ฉันเช่ือวาฉันสามารถเรียกดูเอกสารกอนพิมพและส่ังพิมพได      
13 ฉันเชื่อวาฉันสามารถสรางตาราง แทรกแถวและคอลัมน ได      
14 ฉันเชื่อวาฉันสามารถผสานเซลล และแยกเซลลตางๆ

ตลอดจนตกแตงตารางได 
     

15 ฉันเชื่อวาฉันสามารถสรางวัตถุรูปวาด  
ตัวอักษรศิลปและสามารถแทรกรูปภาพได 

     

16 ฉันเชื่อวาฉันสามารถใสขอความในหัวกระดาษ  
ทายกระดาษและหมายเลขหนาได 

     

17 ฉันเชื่อวาฉันสามารถสรางและบอกประโยชนของ 
จดหมายเวียนได 

     

 การรับรูความสามารถในการใชโปรแกรมนําเสนอ
ผลงาน( Microsoft Powerpoint ) 

 

18 ฉันเชื่อวาฉันสามารถอธิบายเก่ียวกับความสามารถของ
โปรแกรมนําเสนอผลงานได 

     

19 ฉันเชื่อวาฉันสามารถสราง บันทึก เปดและปดงานนําเสนอ
ผลงานได 

     

20 ฉันเชื่อวาฉันสามารถบอกความแตกตางของมุมมองในการ
ทํางานของโปรแกรมนําเสนอผลงานได 

     

21 ฉันเช่ือวาฉันสามารถเปล่ียนลําดับ ลบและเพิ่มสไลดไดถูกตอง      

22 
ฉันเชื่อวาฉันสามารถใสขอความ กําหนดขนาด ตัวหนา     
ตัวเอน ตัวขีดเสนใตและใสเงาใหกับขอความได 
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ระดับความคิดเห็น 

ขอที่ ขอคําถาม 

มา
กท
ี่สุด

 

มา
ก 

ปา
นก
ลา
ง 

นอ
ย 

นอ
ยท
ี่สุด

 

23 ฉันเชื่อวาฉันสามารถใสตัวเลขและสัญลักษณแสดงลําดับ
หัวขอได 

     

24 ฉันเชื่อวาฉันสามารถใชเคร่ืองมือวาดและทํางานกับวัตถุได      

25 ฉันเชื่อวาฉันสามารถบอกความแตกตางของภาพแบบ
เวคเตอร (Vector) กับภาพแบบราสเตอร (Raster) ได 

     

26 ฉันเชื่อวาฉันสามารถปรับแตงภาพจากภาพได      

27 ฉันเชื่อวาฉันสามารถสรางกราฟและแผนผังลงในสไลดได      

28 ฉันเชื่อวาฉันสามารถตกแตงพื้นหลัง และสรางแมแบบ 
(Template) ได 

     

29 ฉันเชื่อวาฉันสามารถกําหนดเอฟเฟคใหกับวัตถุตางๆ
ตลอดจน Transition ได 

     

30 ฉันเชื่อวาฉันสามารถเพิ่มเสียงประกอบทั้งภายในและ
ภายนอกโปรแกรมเพื่อทําเอฟเฟคใหกับขอความได 

     

31 ฉันเชื่อวาฉันสามารถกําหนดรูปแบบการเชื่อมโยงสไลดได      
32 ฉันเชื่อวาฉันสามารถกําหนดคุณสมบัติของเอกสารกอนพิมพ

และใชคําส่ังพิมพไดอยางถูกวิธี 
     

33 ฉันเชื่อวาฉันสามารถแสดงสไลดงานนําเสนอท่ีสรางเสร็จ 
แลวได 

     

ความผูกพันตอเปาหมาย 
34 ฉันรูสึกม่ันใจวาตองทํางานนี้ใหสําเร็จได      
35 หลังไดรับมอบหมายงาน ฉันไมสนใจวางานที่ฉันทําจะบรรลุ

เปาหมายหรือไม 
     

36 เปนไปไดวา เปาหมายที่ฉันต้ังอาจตองไดรับการทบทวน 
ขึ้นอยูกับวา งานดําเนินไดดีแคไหน 

     

37 ฉันไมกังวลมากนัก หากตองท้ิงเปาหมายที่ฉันต้ังไวไป        
38 เปนการยากสําหรับฉัน ในการที่จะต้ังใจดําเนินตาม

เปาหมายอยางจริงจัง 
     

39 ฉันคิดวาเปาหมายของการทํางานน้ีเปนเปาหมายที่ดี 
ในการเร่ิมดําเนินการ 
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 ตอนที่ 4 แบบทดสอบความสามารถทางคอมพิวเตอร 
 
      คําชี้แจง   ใหนักเรียนทําแบบทดสอบ โดยเลือกคําตอบขอท่ีถูกตองท่ีสุดเพียงคําตอบเดียว 
  แลวทําเคร่ืองหมาย 8 บนตัวเลือกน้ัน  ดังตัวอยางตอไปน้ี 
      ตัวอยาง 
 

      0. เมื่อตองการตัดขอความที่ไดเลือกเอาไว ตองคลกิที่ปุมใด 
 1.  2.  
 3.  4.  

 
จากตัวอยาง ถานักเรียนคิดวาตัวเลือกท่ี 1 ถูกตองก็ใหนักเรียนทําเครื่องหมาย 8 บนตัวเลือก  

ท่ี 1 ตามตัวอยาง  
 

     0. เมื่อตองการตัดขอความท่ีไดเลือกเอาไว ตองคลกิที่ปุมใด 
 1.  2.  
 3.  4.  
 

แบบทดสอบมี 2 สวน สวนท่ี 1 คือ แบบทดสอบความสามารถทางคอมพิวเตอรในการใช
โปรแกรมประมวลผลคํา และสวนท่ี 2 คือ แบบทดสอบความสามารถทางคอมพิวเตอรในการใชโปรแกรม
นําเสนอผลงาน 
 
สวนที่ 1 คือ แบบทดสอบความสามารถทางคอมพิวเตอรในการใชโปรแกรมประมวลผลคํา 
1.  
 
 
 จากภาพในแถบวงรีคือแถบที่แสดงขอมูลสวนใดของโปรแกรม 
 1. เมนูบาร (Menu Bar) 2. ทูลบาร  (Tool Bar) 
 3. ออพช่ันบาร (Option Bar) 4. คอมมานดบาร (Command Bar) 
2. เม่ือตองการเปดเอกสารเดิมและบันทึกเอกสารจะตองคลิกที่ปุมสัญลักษณใดตามลําดับ 
 1.    และ   2.   และ   

 3.    และ   4.    และ   

8 
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3. ถานักเรียนตองการกําหนดขนาดกระดาษในการทํางานเปนขนาด Legal นักเรียนตองทําอยางไร 
 1. Edit > Page Setup > Paper > Paper Margin = A4 
 2. Edit > Page Setup > Paper > Paper Size = Legal 
 3. File > Page Setup > Paper > Paper Margin = A4 
 4. File > Page Setup > Paper > Paper Size = Legal 
4. ขอใดกลาวผิดเก่ียวกับสัญลักษณในการกําหนดตําแหนงแท็บ 
  1.   ใชกําหนดใหขอความจัดชิดแท็บทางดานซาย 
  2.    ใชกําหนดใหจุดทศนิยม อยูในแนวเดียวกับตําแหนง  ในไมบรรทัดแนวนอน เหมาะกับการ

เรียงตัวเลขใหจุดทศนิยมตรงกัน 
  3.    ใชกําหนดเสนในแนวนอน ใหอยูในแนวเดียวกับตําแหนงไมบรรทัดในแนวต้ัง 
         4.   ใชกําหนดใหขอความจัดก่ึงกลางแท็บ 
5. เม่ือตองการคัดลอกขอความที่ไดเลือกเอาไว ตองคลิกท่ีปุมใด 
 1.  2.  
 3.  4.  
6. การจัดขอความทั้งยอหนาใหอยูก่ึงกลางหนากระดาษตองคลิกท่ีปุมใด หรือใชคําส่ังใดในการจัดยอหนา 
  1. คลิกท่ีปุม  หรือใชคําส่ัง Format > Paragraph > Alignment = Left 
  2. คลิกท่ีปุม  หรือใชคําส่ัง Format > Paragraph > Alignment = Centered 
  3. คลิกท่ีปุม  หรือใชคําส่ัง Format > Paragraph > Alignment = Right 
  4. คลิกท่ีปุม   หรือใชคําส่ัง Format > Paragraph > Alignment = Jusitified 
7. เม่ือตองการปรับแตงปุมเคร่ืองหมายหนาขอความใหเปนเคร่ืองหมายตางๆสามารถทําไดอยางไร 
  1. Format > Bullet and Numbering หรือคลิกที่ปุม  
  2. Insert > Bullet and Numbering หรือคลิกท่ีปุม  
  3. Format > Bullet and Numbering หรือคลิกที่ปุม   
         4. Insert > Bullet and Numbering หรือคลิกท่ีปุม  
8. เม่ือเลือกขอความ “คอมพิวเตอร” แลวคลิกปุม  และปุม  ขอความจะเปนอยางไร 
  1. คอมพิวเตอร 2. คอมพิวเตอร 
  3. คอมพิวเตอร 4. คอมพิวเตอร 
9. ขอใดกลาวถูกตองเกี่ยวกับการจัดยอหนา 
  ก. การปรับระยะหางระหวางบรรทัดตองเลือกเมนู Edit และเลือกคําส่ัง Ruler 
  ข. การปรับระยะหางระหวางยอหนาทําไดโดยการคลิกเมาสปุมขวาในยอหนาท่ีตองการ  
                     แลวเลือกคําส่ัง   Paragraph 
 1. ขอ ก  ถูกตอง 2. ขอ ข ถูกตอง 
 3. ขอ ก และ ข ถูกตอง 4. ไมมีขอใดถูกตอง 
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10. ขั้นตอนในการแทรกสัญลักษณพิเศษหรืออักขระพิเศษลงในเอกสารสามารถทําไดอยางไร 
  ก. จากกลองโตตอบ Symbol ในชอง Font ใหเลือกรายการของรูปแบบที่ตองการ 
  ข. คลิกปุม Insert  เพ่ือแทรกสัญลักษณที่จุดแทรกขอความในเอกสาร 
  ค. คลิกเลือกสัญลักษณที่ตองการแทรกเขาไปในเอกสาร 
  ง. คลิกเลือกเมนู Insert แลวเลือกคําส่ัง Symbol 
 1. ง – ก – ค – ข  2. ง – ข – ค – ก 
 3. ข – ก – ค –ง 4. ก – ง – ค – ข 
11. ถาตองการกําหนดรูปแบบของกรอบขอความใหเปนเสนประ จะตองกําหนดที่หัวขอใด ในแท็บ Borders  
 ของกลองโตตอบ Borders and Shading  
  1. Setting 2. Style 
  3. Color 4. Width 
12. การเรียกดูเอกสารกอนพิมพคร้ังละหลายๆหนา ตองคลิกท่ีปุมใด 
  1.  2.  
  3.  4.  
13. เม่ือตองการพิมพเอกสารหนา 14 ถึง หนา 20 โดยพิมพเฉพาะหนาคูตองปอนตัวเลขในชอง Pages อยางไร 
  1. 14 – 20 2. 14 – 16 , 18 – 20  
  3.  20 – 14  4. 14, 16 , 18 , 20  
14. ขอใดเปนวิธีการเลือกเซลลทั้งตาราง 
  1. คลิกตัวช้ีเมาสบนคอลัมนที่ตองการ แลวเลือกเมนู Table > Select Column 
  2. คลิกตัวช้ีเมาสบนแถวท่ีตองการ แลวเลือกเมนู Table > Select Row 
  3. คลิกตัวช้ีเมาสบนเซลลที่ตองการ แลวเลือกเมนู Table > Select Cell 
  4. คลิกตัวช้ีเมาสบนเซลลในตาราง แลวเลือกเมนู Table > Select Table 
15. กอนการคลิกเลือกเมนู  Table > Insert Columns เพ่ือแทรกคอลัมน จะตองทํากระบวนการใดกอน 
  1. คลิกเลือกเซลล 2. คลิกเลือกกลุมเซลล 
  3. คลิกเลือกคอลัมน 4. ถูกทุกขอ 
16. หากตองการสรางตัวอักษรศิลป (Word art) ลงในเอกสารจะตองคลิกทีปุมใด 
  1.  2.  
  3.  4.  
17. ปุมใดตอไปน้ี ใชสําหรับการสลับสวนหัวกระดาษ และทายกระดาษของเอกสาร 
  1.   2.   
  3.   4.   
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สวนที่ 2 คือ แบบทดสอบความสามารถทางคอมพิวเตอรในการใชโปรแกรมนําเสนอผลงาน 
18. ขอใดไมใชความสามารถของโปรแกรม PowerPoint 
 1. ทํางานงานคํานวณขอมูลทางบัญชีโดยเฉพาะ 2. แทรกแผนภูมิและภาพเคล่ือนไหวได 
 3. สามารถแทรกเสียงประกอบได 4. สามารถวาดรูปขณะนําเสนอผลงาน 
19. วิธีการปดงานนําเสนอที่ไดสรางไวอยางถูกตอง คือขอใด 
 1. เล่ือนเมาสไปคลิกท่ีปุม Minimize 2. ใชคําส่ัง File > Close 
 3. เล่ือนเมาสไปคลิกท่ีปุม  4. กดคีย < Ctrl + C >  
20. ลักษณะของการสรางงานนําเสนอ โดยเลือกใช Blank Presentation คือขอใด 
 1. แผนสไลดเปลา 2. แผนสไลดที่มีองคประกอบทางกราฟฟก 
 3. แผนสไลดที่มีการกําหนดหัวขอและโครงเนื้อหา 
 4. แผนสไลดที่มีกลองขอความและองคประกอบทางกราฟฟก 
21. หากนักเรียนตองการดูสไลดทั้งหมด และตองการเรียงลําดับการนําเสนอใหมควรคลิกท่ีปุม  
    หรือเรียกใชมุมมองในโปรแกรมใด 
 1. ปุม   หรือ มุมมอง Normal View 2. ปุม  หรือ มุมมอง Slide Show 
 3. ปุม   หรือ  มุมมอง Slide Sorter View 4. ปุม   หรือ  มุมมอง Slide Sorter View 
22. ถานักเรียนตองการเพิ่มสไลด จะตองคลิกท่ีปุมใดตามลําดับ 
 1. คลิกท่ีเมนู Insert -> New Slide   หรือ กดคีย Ctrl + M 
 2. คลิกท่ีเมนู Slide Show -> New Slide   หรือ กดคีย Ctrl + N 
 3. คลิกท่ีเมนู Insert ->  New Slide    หรือ กดคีย Ctrl + M 
 4. คลิกท่ีเมนู Slide Show -> เ New Slide    หรือ กดคีย Ctrl + N  
23. การเปล่ียนขนาดตัวอักษร  โดยการกดปุม   ผลลัพธจะเปนอยางไร 
 1. ตัวอักษรจะมีขนาดใหญกวาขนาดเดิม  
 2. ตัวอักษรจะมีขนาดเล็กลงกวาเดิม 
 3. ตัวอักษรจะมีตําแหนงตัวยกขึ้นจากตําแหนงเดิม 
 4. ตัวอักษรจะมีตําแหนงตัวหอยจากตําแหนงเดิม 
24. การกําหนดตัวอักษรหรือขอความใหเปนตัวหนาและใสเงาใหกับตัวอักษรและขอความตองใชเคร่ืองมือใด 
    ตามลําดับ 
 1. เคร่ืองมือ   และ   2. เคร่ืองมือ   และ   
 3. เคร่ืองมือ   และ   4. เคร่ืองมือ   และ   
25. ถาเราตองการเปล่ียนสัญลักษณหรือตัวเลขที่ใชเปนหัวขอสามารถเขาปรับไดที่เมนูใด 
 1. Tools > Bullet and Numbering 2. Insert > Bullet and Numbering 
 3. Format > Bullet and Numbering 4. Insert > Numbering and Bullet 
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26. หากเราตองการวาดรูปทรงกระบอก และรูปหัวลูกศรแบบตางๆดวย AutoShape จะตองใชคําส่ังใด 
      ตามลําดับ 
 1. AutoShape > Line , AutoShape > Connector 
 2. AutoShape > Callouts , AutoShape > Star and Banners 
 3. AutoShape > Basic shape , AutoShape > Block Arrows 
 4. AutoShape > Connector , AutoShape > Block Arrows 
 
27. ขอใดกลาวถูกตองเกี่ยวกับภาพแบบเวคเตอร (Vector) และภาพแบบราสเตอร (Raster) 
 ก. ภาพแบบเวคเตอร (Vector) เปนภาพที่เกิดจากการวาดเสนตรง เสนโคง รูปทรงเรขาคณิต  โดยภาพ
ชนิดนี้จะถูกจัดเก็บในลักษณะการประมวลผลเปนสูตรคณิตศาสตร ไดแก ไฟลฟอรแมต .wmf  
 ข. ภาพแบบราสเตอร (Raster) เปนภาพที่เกิดจากการเคร่ืองสแกนหรือภาพถายจากกลองดิจิตอลจน
ประกอบไปดวยจุดเล็กๆ ไดแก ไฟลฟอรแมต .bmp  .cgm  .gif  .png  .jpg 
 1. ขอ ก ถูกตอง 2. ขอ ข ถูกตอง 
 3. ขอ ก และ ข ถูกตอง 4. ไมมีขอใดถูก 
28. ปุมคําส่ังใดท่ีใชปรับแตงโหมดสีของภาพ 
 1.  2.  
 3.  4.   
29. ถาเราตองการสรางผังองคกร จะตองคลิกท่ีปุมคําส่ังใด และโดยปกติการสรางแผนผังขององคกร 
    จะเริ่มตนที่บุคลกรก่ีตําแหนง 
 1. ปุม   ,  เร่ิมตนที่ 1 ตําแหนง 2. ปุม  เร่ิมตนที่ 2 ตําแหนง 
 3. ปุม   ,  เร่ิมตนที่ 3 ตําแหนง 4. ปุม  เร่ิมตนที่ 4 ตําแหนง 
30. หากเราตองการใหพื้นหลังมีลักษณะเปนลาย “หินออน” ตองเลือกรูปแบบใด 

 1. Texture        2. Picture     

 3. Pattern        4. Gradient  
31. ประโยชนของการสราง Slide Master คือขอใด 
 1. ไดรูปแบบของสไลดที่มีความหลากหลาย 
 2. การแกไขขอมูลมนสไลดไมขึ้นอยูกับสไลดอื่น 
 3. ไดสไลดที่ตรงกับความตองการใชงานมากที่สุด 
 4. อํานวยความสะดวกตอการทําสไลดที่มีลักษณะเหมือนๆกัน 
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32. จงพิจารณาขอความตอไปนี้เก่ียวกับการใสเอฟเฟคและการใสทรานซิชัน (Transition) 
 ก. การกําหนดใหขอความวิ่งจากทางขวามาทางซายมือของจอภาพ คือ คําส่ัง Fly From Left 
 ข. การกําหนดเอฟเฟคสามารถกําหนดใหไดกับตัวหนังสือเทานั้นไมสามารถ กําหนดใหกับกราฟและ 
                  รูปภาพได 
 ค. การใสทรานซิชัน (Transition) เปนเทคนิคอยางหนึ่งที่ใชในการเปล่ียนสไลด 
 1. ขอ ก ถูกตองเพียงขอเดียว 2. ขอ ก และ ข ถูกตอง 
 3. ขอ ค ถูกตองเพียงขอเดียว 4. ขอ ก และ ค ถูกตอง 
33. ไฟลเสียงและไฟลวิดีโอนามสกุลใดท่ีนักเรียนสามารถที่เราสามารถแทรกลงในการนําเสนอผลงาน   
      Microsoft PowerPoint ไดตามลําดับ 
 1. ไฟลเสียง ไดแก .mid .wav .wma และ ไฟลวิดีโอ ไดแก  .mp4  .mov  
 2. ไฟลเสียง ไดแก .mp3 .ogg  .wma  และ ไฟลวิดีโอ ไดแก  .wmv   .mov 
 3. ไฟลเสียง ไดแก .mid .wav .wma และ ไฟลวิดีโอ ไดแก  . wmv    
 4. ไฟลเสียง ไดแก . mp3 .ogg  .wma  และ ไฟลวิดีโอ ไดแก  .mp4  . mov 
34. ถาเราตองการกําหนดการเช่ือมโยงสไลดเพื่อความสะดวกในการนําเสนองาน เราสามารถสรางปุม 
      ปฏิบัติการไดโดยขั้นตอนใด 
 1. ที่เมนูคลิกเลือก Slide Show > Setup Show… 
 2. ที่เมนูคลิกเลือก Slide Show > Action Buttons  
 3. ที่เมนูคลิกเลือก Slide Show > Setup Buttons 
 4. ที่เมนูคลิกเลือก Slide Show > Custom Buttons 
35. ในการส่ัง Print What จะมีคําส่ังทั้งหมด 4 ประเภท คือ  Slides,   Handouts , Notepages,  
      Outline View ดังนั้นคําส่ัง Print What หมายถึงอะไร 
 1. การกําหนดลําดับของสไลดที่ตองการจะพิมพออกทางเครื่องพิมพที่ต้ังตาไว 
 2. การกําหนดจํานวนชุดของเอกสารที่ตองการจะพิมพออกทางเครื่องพิมพที่ยังไมไดต้ังคา 
 3. การกําหนดมาตรฐานของการพิมพของเครื่องพิมพชนิดตางๆ ที่ยังไมไดต้ังคา 
 4. การเลือกส่ิงที่ตองการพิมพและกําหนดคุณสมบัติของเอกสารประกอบการบรรยาย 
 

☺  ขอขอบคุณที่กรุณาตอบแบบสอบถาม  ☺ 
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การปรับปรุงแบบสอบถามและแบบทดสอบ 
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การปรับปรุงแบบสอบถาม 
 

ขอ ขอความเดิม ขอความท่ีปรับปรุง 
ตอนท่ี 2  ขอมูลเกี่ยวกับปจจัยที่สงผลตอการรับรูความสามารถดานคอมพวิเตอรของตนเอง 
ดานบุคลิกภาพภายในของผูเรียน 
1 ฉันพงึพอใจในการประสบความสําเร็จ

ตามที่สมควรจรจะไดรับ 
ฉันพงึพอใจในความสาํเร็จตามที่สมควรจะ
ไดรับ 

4 ฉันรูสึกพงึพอใจและภูมิใจกับการทาํงาน
ของตนเอง  

ฉันรูสึกภูมิใจกับการทํางานของตนเอง 

13 ฉันไมรูสึกวาฉันสามารถทําใหเกิด
ความสําเร็จในการทํางานได 

ฉันรูสึกกงัวลทีท่ี่ฉันไมสามารถทํางานให
สําเร็จได 

14 บางคร้ังฉันรูสึกวา ส่ิงตาง ๆ ก็ดูนาทอแท
และส้ินหวัง 

บางคร้ังฉันรูสึกทอแทในชีวติ 

ดานความมุงม่ันในการทํางาน 
21 ฉันพยายามอยางดีที่สุดขณะตองทาํงานที่

คอนขางยาก 
ฉันพยายามอยางดีที่สุดเมื่อตองทํางานที่
คอนขางยาก 

22 ฉันพยายามอยางหนักที่จะปรับปรุงการ
ปฏิบัติงานที่ผานมา 

ฉันพยายามทกุคร้ังที่จะปรับปรุงการ
ปฏิบัติงานที่ผานมาใหดีข้ึน 

23 โอกาสที่จะพฒันาความสามารถเปนส่ิง
สําคัญสําหรับฉัน 

โอกาสในการพัฒนาความสามารถเปนส่ิง
สําคัญสําหรับฉัน 

24 เมื่อพบความยุงยากในการแกปญหา        
ฉันชอบลองหลายๆทางเพื่อหาวิธีที่ดีที่สุด

เมื่อพบความยุงยากในการแกปญหา       
ฉันชอบลองหลายๆแนวทางเพื่อหาวิธีที่ดี
ที่สุด 

ดานความวิตกกังวลในการใชคอมพิวเตอร 
28 ฉันรูสึกกลัวแคคิดวาฉันอาจทําลายขอมลู

มากมายในเคร่ืองเพียงแคกดปุมผิดคร้ัง
เดียว 
 
 

ฉันรูสึกกลัวเมือ่คิดวาฉันอาจทําลายขอมลู
มากมายในเคร่ืองเพียงแคกดปุมผิดคร้ัง
เดียว 
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ขอ ขอความเดิม ขอความท่ีปรับปรุง 
 ตอนท่ี 3  ขอมูลเกี่ยวกับปจจัยทีส่งผลตอความสามารถทางคอมพิวเตอร 
ดานการรับรูความสามารถดานคอมพิวเตอรของตนเอง 
2 ฉันเช่ือวาฉันสามารถอธิบายหนาที่และ

สวนประกอบในแถบเคร่ืองมอืในโปรแกรม
ประมวลผลคําได 

ฉันเช่ือวาฉันสามารถอธิบายหนาที่และ
สวนประกอบของแถบเคร่ืองมือในโปรแกรม
ประมวลผลคําได 

3 ฉันเช่ือวาฉันสามารถสราง บนัทกึ เปด
เอกสารและแทรกขอความลงในเอกสาร
นั้นๆได 

ฉันเช่ือวาฉันสามารถสราง บนัทกึและเปด
เอกสารรวมถงึแทรกขอความลงในเอกสาร
นั้นๆได 

13 ฉันเช่ือวาฉันสามารถสรางตาราง แทรก
แถว คอลัมน ได 

ฉันเช่ือวาฉันสามารถสรางตาราง แทรกแถว 
และคอลัมน ได 

18 ฉันเช่ือวาฉันสามารถอธิบายถึง
ความสามารถของโปรแกรมนําเสนอ
ผลงานได 

ฉันเช่ือวาฉันสามารถอธิบายเกี่ยวกับ
ความสามารถของโปรแกรมนาํเสนอผลงานได 

21 ฉันเช่ือวาฉันสามารถเปล่ียนลําดับสไลด 
ลบสไลด และเพิ่มสไลดไดถูกตอง 

ฉันเช่ือวาฉันสามารถเปล่ียนลําดับ ลบและ
เพิ่มสไลดไดถูกตอง 

ดานความผูกพันตอเปาหมาย 
34 ฉันรูสึกวาตองทํางานนี้ใหสําเร็จอยาง

จริงจัง 
ฉันรูสึกมัน่ใจวาตองทาํงานนีใ้หสําเร็จได 

35 ถาจะพูดกนัอยางจริงใจแลว  ฉันไมสนใจ
วางานนี้จะบรรลุเปาหมายหรือไม 

หลังไดรับมอบหมายงาน ฉันไมสนใจวางาน
ที่ฉันทําจะบรรลุเปาหมายหรือไม 

36 เปนไปไดวา เปาหมายนี้อาจตองไดรับการ
ทบทวน ข้ึนอยูกับวา งานดําเนนิไดดีแค
ไหน 

เปนไปไดวา เปาหมายที่ฉันต้ังอาจตองไดรับ
การทบทวน ข้ึนอยูกับวา งานดําเนินไดดีแค
ไหน 

37 ฉันไมกังวลมากนัก หากตองทิ้งเปาหมาย 
นี้ไป   

ฉันไมกังวลมากนัก หากตองทิ้งเปาหมายที่
ฉันต้ังไวไป   

39 ฉันคิดวาเปาหมายนี้เปนเปาหมายที่ดีใน
การเร่ิมดําเนินการ 
 

ฉันคิดวาเปาหมายของการทาํงานนี้เปน
เปาหมายที่ดีในการเริ่มดําเนนิการ 
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ขอ ขอความเดิม ขอความท่ีปรับปรุง 
ตอนท่ี 4  ขอมูลเกี่ยวกับแบบทดสอบความสามารถทางคอมพวิเตอร 
16 การพิมพขอความลงในตัวอักษรศิลป                   

( Word art ) ลงในเอกสารตองคลิกท่ีปุมใด 
 1.                2.  
 3.                4.  
 

หากตองการสรางตัวอักษรศิลป (Word art) ลงใน
เอกสารจะตองคลิกทีปุมใด 
 1.                2.  
 3.                4.  
 

19 วิธีการปดงานนําเสนอท่ีไดสรางไวอยางถูกตอง 
คือขอใด 
1. เล่ือนเมาสไปคลิกท่ีปุม  
2. ใชคําส่ัง File > Close 
3. เล่ือนเมาสไปคลิกท่ีปุม  
4. กดคีย < Ctrl + C > 

วิธีการปดงานนําเสนอท่ีไดสรางไวอยางถูกตอง 
คือขอใด 
1. เล่ือนเมาสไปคลิกท่ีปุม Minimize 
2. ใชคําส่ัง File > Close 
3. เล่ือนเมาสไปคลิกท่ีปุม  
4. กดคีย < Ctrl + C > 

22 ถานักเรียนตองการเพิ่มสไลด จะตองคลิกที่ปุมใด
ตามลําดับ 

1. คลิกที่เมนู Insert > เลือกคําส่ัง New Slide    
     หรือ กดคีย Ctrl + M 
2. คลิกที่เมนู Slide Show > เลือกคําส่ัง New Slide 

      หรือ กดคีย Ctrl + N 

3. คลิกที่เมนู Insert > เลือกคําส่ัง New Slide     
    หรือ กดคีย Ctrl + M 
4. คลิกที่เมนู Slide Show > เลือกคําส่ัง New Slide  

     หรือ กดคีย Ctrl + N 

ถานักเรียนตองการเพิ่มสไลด จะตองคลิกที่ปุมใด
ตามลําดับ 

1. คลิกที่เมนู Insert -> New Slide   หรือ  
   กดคีย Ctrl + M 

2. คลิกที่เมนู Slide Show -> New Slide   หรือ 
    กดคีย Ctrl + N 

3. คลิกที่เมนู Insert ->  New Slide    หรือ 
    กดคีย Ctrl + M 

4. คลิกที่เมนู Slide Show -> เ New Slide    
    หรือ กดคีย Ctrl + N 

30 หากเราตองการใหพื้นหลังมีลักษณะเปนลาย 
“หินออน” ตองเลือกรูปแบบใด 
     1. Texture   2. Picture 
     3. Pattern   4. Gradient 
 

หากเราตองการใหพื้นหลังมีลักษณะเปนลาย  
“หินออน” ตองเลือกรูปแบบใด 

1. Texture       2. Picture     

3. Pattern       4. Gradient  
 

 
 
 

นนนน 
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การประมาณคาความเท่ียงของแบบสอบถามแบบความสอดคลองภายใน 
จากการนาํไปทดลองใช 

 
คาความเที่ยงของแบบสอบถามทั้งฉบับ 
Reliability Coefficients 
N of Cases =     30.0                    N of Items = 71 
Alpha =    .8999 
 
¾ ระดับประสบการณในการใชโปรแกรมประมวลผลคํา 

 Reliability Coefficients 
 N of Cases =     30.0                    N of Items = 2 
 Alpha =    .6706 
 
¾ ระดับประสบการณในการใชโปรแกรมนําเสนอผลงาน 

 Reliability Coefficients 
 N of Cases =     30.0                    N of Items = 2 
 Alpha =    .6855 
 
¾ การเหน็คุณคาในตนเอง 

 Reliability Coefficients 
 N of Cases =     30.0                    N of Items = 8 
 Alpha =    .7724 
 
¾ ความออนไหวทางอารมณ 

 Reliability Coefficients 
 N of Cases =     30.0                    N of Items = 8 
 Alpha =    .7198 
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¾ ระดับความมุงมั่นในการทํางาน  
Reliability Coefficients 

 N of Cases =     60.0                    N of Items = 8 
 Alpha =    .8119 
 
¾ ระดับความวิตกกังวลในการใชคอมพิวเตอร 

 Reliability Coefficients 
 N of Cases =     30.0                    N of Items = 4 
 Alpha =    .7703 
 
¾ การรับรูความสามารถในการใชโปรแกรมประมวลผลคํา 
 Reliability Coefficients 

 N of Cases =     30.0                    N of Items = 17 
 Alpha =    .9294 
 
¾ การรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน 

 Reliability Coefficients 
 N of Cases =     30.0                    N of Items = 16 
 Alpha =    .9507 

 

¾ ระดับความผูกพนัตอเปาหมาย 
 Reliability Coefficients 

 N of Cases =     30.0                    N of Items = 6 
 Alpha =    .6081 
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ตารางแสดง คาความยาก คาความเที่ยง และคาอํานาจจําแนกของแบบทดสอบ 
ความสามารถทางคอมพวิเตอรในการใชโปรแกรมประมวลผลคําและโปรแกรม
นําเสนอผลงาน คํานวณโดยใชโปรแกรมวิเคราะหขอสอบ EVANA   

ขอที่ คาความยาก (p) คาอํานาจจาํแนก (r)
คาความเทีย่งของ

แบบทดสอบท้ังฉบับ 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 

0.81 
1.00 
0.81 
0.38 
0.88 
1.00 
0.50 
1.00 
0.69 
0.56 
0.88 
0.56 
0.88 
0.81 
0.63 
1.00 
0.69 
0.50 
0.81 
0.88 
0.56 
0.75 
0.63 
1.00 

0.13 
0.00 
0.38 
0.50 
0.00 
0.00 
0.50 
0.00 
0.38 
0.88 
0.25 
0.38 
0.25 
0.38 
0.25 
0.00 
0.13 
0.00 
0.38 
0.25 
0.63 
0.25 
0.50 
0.00 

0.71 
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ตารางแสดง คาความยาก คาความเที่ยง และคาอํานาจจําแนกของแบบทดสอบ 
ความสามารถทางคอมพวิเตอรในการใชโปรแกรมประมวลผลคําและโปรแกรม
นําเสนอผลงาน คํานวณโดยใชโปรแกรมวิเคราะหขอสอบ EVANA (ตอ) 

ขอที่ 
คาความยาก 

(p) 
คาอํานาจจาํแนก 

(r) 
คาความเทีย่งของ

แบบทดสอบท้ังฉบับ 
25 
26 
27 
28 
29 
30 
31 
32 
33 
34 
35 

0.50 
0.75 
0.69 
0.50 
0.44 
0.38 
0.69 
0.38 
0.44 
0.25 
0.38 

0.50 
0.50 
0.13 
0.50 
0.38 
0.50 
0.38 
0.75 
0.13 
0.25 
0.50 

 

คาเฉลี่ย 0.67 0.34  
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เฉลยแบบทดสอบความสามารถทางคอมพิวเตอร 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

โปรแกรมประมวลผลคํา โปรแกรมนาํเสนอผลงาน 
ขอที่ เฉลย ขอที่ เฉลย 

1 1 18 1 
2 2 19 2 
3 4 20 1 
4 3 21 3 
5 2 22 1 
6 2 23 1 
7 3 24 2 
8 4 25 3 
9 2 26 3 
10 1 27 3 
11 2 28 4 
12 3 29 2 
13 4 30 1 
14 4 31 4 
15 3 32 3 
16 1 33 3 
17 3 34 2 
    35 4 
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ภาคผนวก จ 

ผลการตรวจสอบคุณภาพของเครื่องมือ (IOC) 
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ตอนท่ี 1 ขอคําถามเกีย่วกับขอมูลทั่วไปของนักเรยีน 
 

 
 

ขอคําถาม ผลการพิจารณา 
1. เพศ � 1) ชาย � 2) หญิง เหมาะสม 
2. อายุ ………………………... ป                    เหมาะสม 
3. ศึกษาอยูในระดับชั้น � 1) มัธยมศึกษาปที่ 4 

� 3) มัธยมศึกษาปที่ 6 
� 2) มัธยมศึกษาปที่ 5 เหมาะสม 

4. แผนการเรียน � 1) วิทย – คณิต 
� 3) ศิลป – ภาษา 

� 2) ศิลป – คํานวณ 
� 4) อื่นๆ ระบุ........... เหมาะสม 

5. ประสบการณในการใชคอมพิวเตอร 
   � 1) นอยกวา 1 ป 
   � 4)  5 – 6 ป     

� 2)  1 – 2  ป  
� 5) มากกวา 6 ป 

� 3) 3 – 4 ป เหมาะสม 

6. โดยปกตินักเรียนใชคอมพิวเตอรบอยเพียงใด  
   ( ระบุจํานวนช่ัวโมงโดยเฉล่ียตอวัน )  
� 1) นอยกวา 1 ชั่วโมง / วัน  
� 4) 5 – 6  ชั่วโมง / วัน  

� 2) 1 – 2 ชั่วโมง / วัน          
� 5) มากกวา 6  ชั่วโมง / วัน

� 3) 3 – 4  ชั่วโมง / วัน  
เหมาะสม 

7. นักเรียนมีประสบการณในการใชโปรแกรมประมวลผลคํา ( Microsoft Word )  
   � 1) นอยกวา 1 ป 
   � 4)  5 – 6 ป     

� 2)  1 – 2  ป  
� 5) มากกวา 6 ป 

� 3) 3 – 4 ป เหมาะสม 

8. โดยปกตินักเรียนใชโปรแกรมประมวลผลคํา ( Microsoft Word )  
    บอยเพียงใด  ( ระบุจํานวนช่ัวโมงโดยเฉล่ียตอวัน )  
� 1) นอยกวา 1 ชั่วโมง / วัน  
� 4) 5 – 6  ชั่วโมง / วัน  

� 2) 1 – 2 ชั่วโมง / วัน          
� 5) มากกวา 6  ชั่วโมง / วัน

� 3) 3 – 4  ชั่วโมง / วัน  
เหมาะสม 

9. นักเรียนไดคาดหวังถึงผลสําเร็จของผลงานจากการใชโปรแกรมประมวลผลคํา  
   ( Microsoft Word ) ไวรอยละเทาใด 
   � 1) รอยละ 0 – 20 
   � 4) รอยละ 61 – 80 

� 2) รอยละ 21 – 40  
� 5)  รอยละ 81 – 100  

� 3) รอยละ 41 – 60  
เหมาะสม 

10. นักเรียนมีประสบการณในการใชโปรแกรมนําเสนอผลงาน  
     ( Microsoft Powerpoint )  
   � 1) นอยกวา 1 ป 
   � 4)  5 – 6 ป     

� 2)  1 – 2  ป  
� 5) มากกวา 6 ป 

� 3) 3 – 4 ป 
เหมาะสม 
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ตอนท่ี 2  ขอคําถามเกีย่วกับปจจัยท่ีสงผลตอการรับรูความสามารถดานคอมพิวเตอร 
            ของตนเอง 

 
 

ขอคําถาม ผลการพิจารณา 
11. โดยปกตินักเรียนใชโปรแกรมนําเสนอผลงาน ( Microsoft Powerpoint )  
      บอยเพียงใด   ( ระบุจํานวนช่ัวโมงโดยเฉล่ียตอวัน ) 
� 1) นอยกวา 1 ชั่วโมง / วัน  
� 4) 5 – 6  ชั่วโมง / วัน  

� 2) 1 – 2 ชั่วโมง / วัน          
� 5) มากกวา 6  ชั่วโมง / วัน

� 3) 3 – 4  ชั่วโมง / วัน  
เหมาะสม 

12. นักเรียนไดคาดหวังถึงผลสําเร็จของผลงานจากการโปรแกรมนําเสนอผลงาน  
      ( Microsoft Powerpoint )    ไวรอยละเทาใด 
   � 1) รอยละ 0 – 20 
   � 4) รอยละ 61 – 80 

� 2) รอยละ 21 – 40  
� 5)  รอยละ 81 – 100  

� 3) รอยละ 41 – 60  
เหมาะสม 

ขอที่ ขอคําถาม IOC 
การเห็นคุณคาในตนเอง 

1 ฉันพึงพอใจในความสําเร็จตามท่ีสมควรจะไดรับ 1 
2 เม่ือฉันพยายาม ฉันจะประสบความสําเร็จในการทํางาน 1 
3 ฉันทํางานไดอยางสมบูรณและประสบความสําเร็จอยางดี 1 
4 ฉันรูสึกภูมิใจกับการทํางานของตนเอง 1 
5 ฉันตัดสินใจเลือกทําส่ิงตางๆไดอยางม่ันใจ 1 
6 เม่ือเกิดปญหาขึ้น ฉันสามารถรับมือกับปญหาเหลานั้นได 1 
7 ฉันเปนที่รักใครของผูอื่น 1 
8 ฉันจะทําในส่ิงที่ถูกตองและเต็มความสามารถเสมอ 1 

ความออนไหวทางอารมณ 
9 ในการทํางานบางคร้ัง ฉันรูสึกมีความกดดันตอตนเอง 0.8 

10 บางคร้ังเมื่อฉันทํางานลมเหลว ฉันจะรูสึกวาตนเองไรคา 1 
11 บางคร้ังฉันรูสึกควบคุมการทํางานตางๆของฉันไมไดเลย 0.8 
12 ฉันมักจะสงสัยในความสามารถของตนเอง 0.8 
13 ฉันรูสึกกังวลท่ีฉันไมสามารถทํางานใหสําเร็จได 1 
14 บางคร้ังฉันรูสึกทอแทในชีวิต 1 
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ตอนท่ี 3  ขอคําถามเกีย่วกับปจจัยท่ีสงผลตอความสามารถทางคอมพิวเตอร 
             

 

ขอที่ ขอคําถาม IOC 
15 ฉันไมสามารถเปนที่พึ่งของใครไดเลย 1 
16 ปกติแลวไมคอยมีคนอื่นมาใสใจกับฉันมากนัก 1 

ความมุงม่ันในการทํางาน 
17 โอกาสที่ในการจะไดทํางานที่ทาทายเปนส่ิงสําคัญสําหรับฉัน 0.8 

18 
เม่ือลมเหลวในการทํางานชิ้นที่ยาก  ฉันวางแผนท่ีจะพยายามใหมากขึ้น 
ในการทํางานครั้งตอไป 1 

19 ฉันเลือกท่ีจะทํางานท่ีทําใหฉันไดเรียนรูส่ิงใหม ๆ 0.8 
20 โอกาสที่จะไดทําส่ิงใหม ๆ เปนส่ิงทาทายสําหรับฉัน 0.8 
21 ฉันพยายามอยางดีที่สุดเม่ือตองทํางานท่ีคอนขางยาก 1 
22 ฉันพยายามทุกคร้ังที่จะปรับปรุงการปฏิบัติงานท่ีผานมาใหดีขึ้น 1 
23 โอกาสในการพัฒนาความสามารถเปนส่ิงสําคัญสําหรับฉัน 0.8 
24 เม่ือพบความยุงยากในการแกปญหา ฉันชอบลองหลาย ๆ ทางเพือ่หาวิธีที่ดีที่สุด 1 

ความวิตกกังวลในการใชคอมพิวเตอร 
25 ฉันไมกลาใชคอมพิวเตอรเพราะกลัววาจะทําผิดพลาด แลวแกไขไมได 1 
26 ฉันรูสึกกลัวการใชคอมพิวเตอร 1 
27 ฉันหลีกเล่ียงการใชคอมพิวเตอรเพราะรูสึกไมคุนเคย 0.8 

28 
ฉันรูสึกกลัวการใชคอมพิวเตอร แคคิดวาฉันอาจทําลายขอมูลมากมาย 
ในเคร่ืองเพียงแคกดปุมผิดคร้ังเดียว 0.8 

ขอที่ ขอคําถาม IOC 
การรับรูความสามารถในการใชโปรแกรมประมวล ผลคํา( Microsoft Word ) 

1 
ฉันเชื่อวาฉันสามารถอธิบายหนาที่และสวนประกอบของ 
โปรแกรมประมวลผลคําได 1 

2 
ฉันเชื่อวาฉันสามารถอธิบายหนาที่และสวนประกอบของแถบเคร่ืองมือ 
ในโปรแกรมประมวลผลคําได 

1 

3 
ฉันเชื่อวาฉันสามารถสราง บันทึกและเปดเอกสารรวมถึงแทรกขอความลง 
ในเอกสารน้ันๆได 

1 

4 ฉันเชื่อวาฉันสามารถต้ังคาหนากระดาษ ต้ังก้ันหนาและก้ันหลังขอความได 1 
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ขอที่ ขอคําถาม IOC 

5 
ฉันเชื่อวาฉันสามารถกําหนดตําแหนงของแท็บและเลือกใชแท็บใหเหมาะสม
กับงานได 1 

6 ฉันเชื่อวาฉันสามารถเลือกขอความ ยายขอความ คัดลอกและลบขอความได 1 

7 
ฉันเชื่อวาฉันสามารถจัดรูปแบบขอความ รวมไปถึงการกําหนดหมายเลขลําดับ 
และเครื่องหมายหนาขอความได 1 

8 
ฉันเชื่อวาฉันสามารถปรับเปล่ียนลักษณะของตัวอักษรเปล่ียนสีใหตัวอักษร
และใสสีพื้นหลังใหกับขอความได 

1 

9 ฉันเชื่อวาฉันสามารถปรับระยะหางระหวางตัวอักษร บรรทัดและยอหนาได 1 
10 ฉันเชื่อวาฉันสามารถแทรกสัญลักษณพิเศษและอักขระพิเศษลงในเอกสารได  1 
11 ฉันเชื่อวาฉันสามารถใสกรอบใหกับขอความ เอกสารและแบงคอลัมนได 1 
12 ฉันเชื่อวาฉันสามารถเรียกดูเอกสารกอนพิมพและส่ังพิมพเอกสารได 1 
13 ฉันเชื่อวาฉันสามารถสรางตาราง แทรกแถวและคอลัมน ได 1 
14 ฉันเชื่อวาฉันสามารถผสานเซลล และแยกเซลลตางๆตลอดจนตกแตงตารางได 1 

15 
ฉันเชื่อวาฉันสามารถสรางวัตถุรูปวาด ตัวอักษรศิลปและสามารถ 
แทรกรูปภาพได 

1 

16 
ฉันเชื่อวาฉันสามารถใสขอความในหัวกระดาษ ทายกระดาษและหมายเลข 
หนาได 

1 

17 ฉันเชื่อวาฉันสามารถสรางและบอกประโยชนของจดหมายเวียนได 1 
การรับรูความสามารถในการใชโปรแกรมนําเสนอผลงาน( Microsoft Powerpoint ) 

18 
ฉันเชื่อวาฉันสามารถอธิบายเก่ียวกับความสามารถของโปรแกรมนําเสนอ
ผลงานได 1 

19 ฉันเชื่อวาฉันสามารถสราง บันทึก เปดและปดงานนําเสนอผลงานได 1 

20 
ฉันเชื่อวาฉันสามารถบอกความแตกตางของมุมมองในการทํางานของ
โปรแกรมนําเสนอผลงานได 1 

21 ฉันเชื่อวาฉันสามารถเปล่ียนลําดับ ลบและเพิ่มสไลดไดถูกตอง 1 

22 
ฉันเชื่อวาฉันสามารถใสขอความ กําหนดขนาด ตัวหนา ตัวเอน ตัวขีดเสนใต
และใสเงาใหกับขอความได 

1 

23 ฉันเชื่อวาฉันสามารถใสตัวเลขและสัญลักษณแสดงลําดับหัวขอได 1 
24 ฉันเชื่อวาฉันสามารถใชเคร่ืองมือวาดและทํางานกับวัตถุตางๆได 1 
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ขอที่ ขอคําถาม IOC 

25 
ฉันเชื่อวาฉันสามารถบอกความแตกตางของภาพแบบเวคเตอร (Vector)  
กับภาพแบบราสเตอร (Raster) ได 1 

26 ฉันเชื่อวาฉันสามารถปรับแตงภาพจากภาพได 0.8 
27 ฉันเชื่อวาฉันสามารถสรางกราฟและแผนผังลงในสไลดได 1 
28 ฉันเชื่อวาฉันสามารถตกแตงพื้นหลัง และสรางแมแบบ (Template) ได 1 
29 ฉันเชื่อวาฉันสามารถกําหนดเอฟเฟคใหกับวัตถุตางๆตลอดจน Transition ได 1 

30 
ฉันเชื่อวาฉันสามารถเพิ่มเสียงประกอบทั้งภายในและภายนอกโปรแกรมเพ่ือ
ทําเอฟเฟคใหกับขอความได 

1 

31 ฉันเชื่อวาฉันสามารถกําหนดรูปแบบการเชื่อมโยงสไลดได 1 

32 
ฉันเชื่อวาฉันสามารถกําหนดคุณสมบัติของเอกสารกอนพิมพและใชคําส่ังพิมพ
ไดอยางถูกวิธี 

1 

33 
ฉันเชื่อวาฉันสามารถแสดงสไลดงานนําเสนอท่ีสรางเสร็จ 
แลวได 

1 

ความผูกพันตอเปาหมาย 
34 ฉันรูสึกม่ันใจวาตองทํางานนี้ใหสําเร็จได 1 
35 หลังไดรับมอบหมายงาน ฉันไมสนใจวางานที่ฉันทําจะบรรลุเปาหมายหรือไม 1 

36 
เปนไปไดวา เปาหมายที่ฉันต้ังอาจตองไดรับการทบทวน ขึ้นอยูกับวา งาน
ดําเนินไดดีแคไหน 0.8 

37 ฉันไมกังวลมากนัก หากตองท้ิงเปาหมายที่ฉันต้ังไวไป   1 
38 เปนการยากสําหรับฉัน ในการที่จะต้ังใจดําเนินตามเปาหมายอยางจริงจัง 1 
39 ฉันคิดวาเปาหมายของการทํางานนี้เปนเปาหมายที่ดีในการเร่ิมดําเนินการ 0.8 
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ตอนท่ี 4  แบบทดสอบความสามารถทางคอมพวิเตอร 
             

 

ขอที่ ขอคําถาม IOC 
แบบทดสอบความสามารถทางคอมพวิเตอรในการใชโปรแกรมประมวลผลคํา  
( Microsoft Word ) 

1  
 
จากภาพในแถบวงรีคือแถบท่ีแสดงขอมูลสวนใดของโปรแกรม 
1. เมนูบาร (Menu Bar)            2. ทูลบาร  (Tool Bar) 
3. ออพชั่นบาร (Option Bar)     4. คอมมานดบาร (Command Bar) 

0.6 

2 เม่ือตองการเปดเอกสารเดิมและบนัทึกเอกสารจะตองคลิกท่ีปุมสัญลกัษณ 
ใดตามลําดับ 

1.    และ                      2.   และ   

3.    และ                       4.    และ   
 

1 

3 ถานักเรียนตองการกําหนดขนาดกระดาษในการทํางานเปน ขนาด Legal  นักเรียน
ตองทําอยางไร 
1. Edit > Page Setup > Paper > Paper Margin = A4 
2. Edit > Page Setup > Paper > Paper Size = Legal 
3. File > Page Setup > Paper > Paper Margin = A4 
4. File > Page Setup > Paper > Paper Size = Legal 

1 

4 ขอใดกลาวผิดเกี่ยวกับสัญลักษณในการกําหนดตําแหนงแท็บ 
1.   ใชกําหนดใหขอความจัดชิดแท็บทางดานซาย 
2.    ใชกําหนดใหจุดทศนิยม อยูในแนวเดียวกับตําแหนง  ในไมบรรทัด 
     แนวนอน เหมาะกับการเรียงตัวเลขใหจุดทศนิยมตรงกัน 
3.    ใชกําหนดเสนในแนวนอน ใหอยูในแนวเดียวกบัตําแหนงไมบรรทัด 
     ในแนวต้ัง 
4.   ใชกําหนดใหขอความจัดกึ่งกลางแท็บ 

1 

5 เม่ือตองการคัดลอกขอความท่ีไดเลือกเอาไว ตองคลิกท่ีปุมใด 
1.                       2.  
3.                             4.  

1 
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ขอที่ ขอคําถาม IOC 
6 การจัดขอความท้ังยอหนาใหอยูกึ่งกลางหนากระดาษตองคลิกท่ีปุมใด  

หรือใชคําสั่งใดในการจัดยอหนา 
1. คลิกท่ีปุม  หรือใชคําสั่ง Format > Paragraph > Alignment = Left 
2. คลิกท่ีปุม  หรือใชคําสั่ง Format > Paragraph > Alignment = Centered 
3. คลิกท่ีปุม  หรือใชคําสั่ง Format > Paragraph > Alignment = Right 
4. คลิกท่ีปุม   หรือใชคําสั่ง Format > Paragraph > Alignment = Jusitified 

1 

7 เม่ือตองการปรับแตงปุมเคร่ืองหมายหนาขอความใหเปนเคร่ืองหมายตางๆ 
สามารถทําไดอยางไร 
1. Format > Bullet and Numbering หรือคลิกท่ีปุม  
2. Insert > Bullet and Numbering หรือคลิกท่ีปุม  
3. Format > Bullet and Numbering หรือคลิกท่ีปุม   
4. Insert > Bullet and Numbering หรือคลิกท่ีปุม  

1 

8 เม่ือเลอืกขอความ “คอมพิวเตอร” แลวคลิกปุม  และปุม  ขอความ 
จะเปนอยางไร 
1. คอมพิวเตอร                 2. คอมพิวเตอร 
3. คอมพิวเตอร               4. คอมพิวเตอร 

1 

9 ขอใดกลาวถกูตองเกี่ยวกบัการจัดยอหนา 
ก. การปรับระยะหางระหวางบรรทัดตองเลือกเมนู Edit และเลอืกคําสัง่ Ruler 
ข. การปรับระยะหางระหวางยอหนาทําไดโดยการคลิกเมาสปุมขวา 
    ในยอหนาท่ีตองการแลวเลือกคําส่ัง   Paragraph 
1. ขอ ก  ถูกตอง                2. ขอ ข ถกูตอง 
3. ขอ ก และ ข ถกูตอง       4. ไมมีขอใดถูกตอง 

1 

10 ขั้นตอนในการแทรกสัญลักษณพิเศษหรืออกัขระพิเศษลงในเอกสารสามารถทําได
อยางไร 
ก. จากกลองโตตอบ Symbol ในชอง Font ใหเลือกรายการของรูปแบบ 
    ที่ตองการ 
ข. คลิกปุม Insert  เพ่ือแทรกสัญลกัษณที่จุดแทรกขอความในเอกสาร 
ค. คลิกเลือกสัญลักษณที่ตองการแทรกเขาไปในเอกสาร 
ง. คลกิเลือกเมนู Insert แลวเลือกคําสั่ง Symbol 
1. ง – ก – ค – ข                   2. ง – ข – ค – ก 
3. ข – ก – ค –ง                    4. ก – ง – ค – ข 

1 
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ขอที่ ขอคําถาม IOC 
11 ถาตองการกําหนดรูปแบบของกรอบขอความใหเปนเสนประ จะตองกาํหนด 

ที่หัวขอใด ในแทบ็ Borders ของกลองโตตอบ Borders and Shading  
1. Setting                   2. Style 
3. Color                   4. Width 

1 

12 การเรียกดูเอกสารกอนพิมพคร้ังละหลายๆหนา ตองคลิกที่ปุมใด 
1.                   2.  
3.                   4.  

1 

13 เม่ือตองการพิมพเอกสารหนา 14 ถึง หนา 20 โดยพิมพเฉพาะหนาคูตองปอนตัวเลข
ในชอง Pages อยางไร 
1. 14 – 20                  2. 14 – 16 , 18 – 20  
3.  20 – 14                   4. 14, 16 , 18 , 20  

1 

14 ขอใดเปนวิธกีารเลือกเซลลทั้งตาราง 
1. คลิกตัวชี้เมาสบนคอลัมนที่ตองการ แลวเลือกเมนู Table > Select Column 
2. คลิกตัวชี้เมาสบนแถวที่ตองการ แลวเลือกเมนู Table > Select Row 
3. คลิกตัวชี้เมาสบนเซลลที่ตองการ แลวเลือกเมนู Table > Select Cell 
4. คลิกตัวชี้เมาสบนเซลลในตาราง แลวเลือกเมนู Table > Select Table 

1 

15 กอนการคลิกเลือกเมนู  Table > Insert Columns เพ่ือแทรกคอลัมน  
จะตองทํากระบวนการใดกอน 
1. คลิกเลือกเซลล          2. คลิกเลือกกลุมเซลล 
3. คลิกเลือกคอลัมน      4. ถูกทุกขอ 

1 

16 หากตองการสรางตัวอักษรศิลป (Word art) ลงในเอกสารจะตองคลิกทีปุมใด 
1.                     2.  
3.                     4.  

1 

17 ปุมใดตอไปน้ี ใชสําหรับการสลับสวนหัวกระดาษ และทายกระดาษ 
ของเอกสาร 
1.                      2.   
3.                      4.   

1 
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ขอที่ ขอคําถาม IOC 
แบบทดสอบความสามารถทางคอมพวิเตอรในการใชโปรแกรมนําเสนอผลงาน 
( Microsoft Powerpoint ) 

18 ขอใดไมใชความสามารถของโปรแกรม PowerPoint 
1. ทํางานงานคํานวณขอมูลทางบญัชีโดยเฉพาะ  
2. แทรกแผนภูมิและภาพเคลื่อนไหวได 
3. สามารถแทรกเสียงประกอบได 
4. สามารถวาดรูปขณะนําเสนอผลงาน 

0.6 

19 วิธีการปดงานนําเสนอท่ีไดสรางไวอยางถูกตอง คือขอใด 
1. เลื่อนเมาสไปคลิกท่ีปุม Minimize    2. ใชคําสั่ง File > Close 
3. เลื่อนเมาสไปคลิกท่ีปุม             4. กดคีย < Ctrl + C > 

1 

20 ลักษณะของการสรางงานนําเสนอ โดยเลอืกใช Blank Presentation คือขอใด 
1. แผนสไลดเปลา 
2. แผนสไลดที่มีองคประกอบทางกราฟฟก 
3. แผนสไลดที่มีการกําหนดหัวขอและโครงเน้ือหา 
4. แผนสไลดที่มีกลองขอความและองคประกอบทางกราฟฟก 

0.8 

21 หากนักเรียนตองการดูสไลดทั้งหมด และตองการเรียงลําดับการนําเสนอใหมควร
คลิกท่ีปุมหรือเรียกใชมุมมองในโปรแกรมใด 
1. ปุม   หรือ มุมมอง Normal View  
2. ปุม  หรือ มุมมอง Slide Show 
3. ปุม   หรือ  มุมมอง Slide Sorter View  
4. ปุม   หรือ  มุมมอง Slide Sorter View 

1 

22 ถานักเรียนตองการเพ่ิมสไลด จะตองคลิกท่ีปุมใดตามลําดับ 
1. คลิกท่ีเมนู Insert -> New Slide   หรือ   กดคีย Ctrl + M 
2. คลิกท่ีเมนู Slide Show -> New Slide   หรือ   กดคีย Ctrl + N 
3. คลิกท่ีเมนู Insert ->  New Slide    หรือ    กดคีย Ctrl + M 
4. คลิกท่ีเมนู Slide Show -> เ New Slide    หรือ กดคีย Ctrl + N  

1 

23 การเปล่ียนขนาดตัวอักษร  โดยการกดปุม   ผลลัพธจะเปนอยางไร 
1. ตัวอกัษรจะมีขนาดใหญกวาขนาดเดิม 
2. ตัวอกัษรจะมีขนาดเล็กลงกวาเดิม 
3. ตัวอกัษรจะมีตําแหนงตัวยกขึน้จากตําแหนงเดิม 
4. ตัวอกัษรจะมีตําแหนงตัวหอยจากตําแหนงเดิม 

1 
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ขอที่ ขอคําถาม IOC 
24 การกําหนดตัวอักษรหรือขอความใหเปนตัวหนาและใสเงาใหกับตัวอักษรและขอความ

ตองใชเคร่ืองมือใดตามลําดับ 
1. เคร่ืองมือ   และ           2. เคร่ืองมือ   และ   
3. เคร่ืองมือ   และ           4. เคร่ืองมือ   และ   

1 

25 ถาเราตองการเปลี่ยนสัญลกัษณหรือตัวเลขท่ีใชเปนหัวขอสามารถ 
เขาปรับไดที่เมนูใด 
1. Tools > Bullet and Numbering  
2. Insert > Bullet and Numbering 
3. Format > Bullet and Numbering  
4. Insert > Numbering and Bullet 

1 

26 หากเราตองการวาดรูปทรงกระบอก และรูปหัวลกูศรแบบตางๆดวย AutoShape 
จะตองใชคําสั่งใดตามลําดับ 
1. AutoShape > Line , AutoShape > Connector 
2. AutoShape > Callouts , AutoShape > Star and Banners 
3. AutoShape > Basic shape , AutoShape > Block Arrows 
4. AutoShape > Connector , AutoShape > Block Arrows 

1 

27 ขอใดกลาวถกูตองเกี่ยวกบัภาพแบบเวคเตอร (Vector) และภาพแบบราสเตอร 
(Raster) 
 ก. ภาพแบบเวคเตอร (Vector) เปนภาพท่ีเกิดจากการวาดเสนตรง เสนโคง 
รูปทรงเรขาคณิต  โดยภาพชนิดน้ีจะถูกจัดเกบ็ในลักษณะ 
การประมวลผลเปนสูตรคณิตศาสตร ไดแก ไฟลฟอรแมต .wmf  
 ข. ภาพแบบราสเตอร (Raster) เปนภาพท่ีเกิดจากการเคร่ืองสแกนหรือ
ภาพถายจากกลองดิจิตอลจนประกอบไปดวยจุดเลก็ๆ ไดแก ไฟลฟอรแมต .bmp  
.cgm  .gif  .png  .jpg 
1. ขอ ก ถูกตอง                     2. ขอ ข ถูกตอง 
3. ขอ ก และ ข ถกูตอง           4. ไมมีขอใดถูก 

1 

28 ปุมคําสั่งใดที่ใชปรับแตงโหมดสีของภาพ 
1.                                2.  
3.                                4.   

1 

29 ถาเราตองการสรางผังองคกร จะตองคลิกท่ีปุมคําสั่งใด และโดยปกติการสราง
แผนผังขององคกรจะเร่ิมตนท่ีบุคลากรกี่ตําแหนง 
1. ปุม   ,  เร่ิมตนท่ี 1 ตําแหนง           2. ปุม  เร่ิมตนท่ี 2 ตําแหนง 
3. ปุม   ,  เร่ิมตนท่ี 3 ตําแหนง           4. ปุม  เร่ิมตนท่ี 4 ตําแหนง 

1 
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ขอที่ ขอคําถาม IOC 
30 หากเราตองการใหพ้ืนหลังมีลักษณะเปนลาย “หินออน” ตองเลือกรูปแบบใด 

1. Texture                        2. Picture     

3. Pattern                        4. Gradient  

1 

31 ประโยชนของการสราง Slide Master คือขอใด 
1. ไดรูปแบบของสไลดที่มีความหลากหลาย 
2. การแกไขขอมูลมนสไลดไมขึ้นอยูกับสไลดอื่น 
3. ไดสไลดที่ตรงกับความตองการใชงานมากท่ีสุด 
4. อํานวยความสะดวกตอการทําสไลดที่มีลักษณะเหมือนๆกัน 

0.8 

32 จงพิจารณาขอความตอไปน้ีเกี่ยวกบัการใสเอฟเฟคและการใสทรานซิชัน 
(Transition) 
ก. การกําหนดใหขอความว่ิงจากทางขวามาทางซายมือของจอภาพ คือ  
    คําสั่ง Fly From Left 
ข. การกําหนดเอฟเฟคสามารถกําหนดใหไดกับตัวหนังสือเทาน้ันไมสามารถ  
    กําหนดใหกับกราฟและ รูปภาพได 
ค. การใสทรานซชิัน (Transition) เปนเทคนิคอยางหนึ่งท่ีใชในการเปล่ียนสไลด 
1. ขอ ก ถูกตองเพียงขอเดียว          2. ขอ ก และ ข ถูกตอง 
3. ขอ ค ถกูตองเพียงขอเดียว          4. ขอ ก และ ค ถูกตอง 

1 

33 ไฟลเสียงและไฟลวิดีโอนามสกุลใดท่ีนักเรียนสามารถท่ีเราสามารถแทรกลงในการ
นําเสนอผลงาน  Microsoft PowerPoint ไดตามลําดับ 
1. ไฟลเสยีง ไดแก .mid .wav .wma และ ไฟลวิดีโอ ไดแก  .mp4  .mov  
2. ไฟลเสยีง ไดแก .mp3 .ogg  .wma  และ ไฟลวิดีโอ ไดแก  .wmv   .mov 
3. ไฟลเสยีง ไดแก .mid .wav .wma และ ไฟลวิดีโอ ไดแก  . wmv    
4. ไฟลเสยีง ไดแก . mp3 .ogg  .wma  และ ไฟลวิดีโอ ไดแก  .mp4  . mov 

1 

34 ถาเราตองการกําหนดการเชื่อมโยงสไลดเพ่ือความสะดวกในการนําเสนองาน เรา
สามารถสรางปุมปฏิบัติการไดโดยขั้นตอนใด 
1. ที่เมนูคลิกเลือก Slide Show > Setup Show… 
2. ที่เมนูคลิกเลือก Slide Show > Action Buttons  
3. ที่เมนูคลิกเลือก Slide Show > Setup Buttons 
4. ที่เมนูคลิกเลือก Slide Show > Custom Buttons 
 

1 
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ขอที่ ขอคําถาม IOC 
35 ในการสั่ง Print What จะมีคําสั่งท้ังหมด 4 ประเภท คือ  Slides,   Handouts , 

Notepages,  Outline View ดังน้ันคําสั่ง Print What หมายถึงอะไร 
1. การกําหนดลําดับของสไลดที่ตองการจะพิมพออกทางเคร่ืองพิมพที่ต้ังตาไว 
2. การกําหนดจํานวนชุดของเอกสารที่ตองการจะพิมพออกทางเคร่ืองพิมพ 
    ทีย่ังไมไดต้ังคา 
3. การกําหนดมาตรฐานของการพิมพของเครื่องพิมพชนิดตางๆ  
    ทีย่ังไมไดต้ังคา 
4. การเลือกสิ่งท่ีตองการพิมพและกําหนดคุณสมบัติของเอกสารประกอบ 
    การบรรยาย 

1 
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ภาคผนวก ฉ 

ผลการวิเคราะหโมเดลเชิงสาเหตุและผลของการรับรูความสามารถดานคอมพวิเตอร 
ของตนเองที่มตีอความสามารถทางคอมพิวเตอร ดวยโปรแกรมลิสเรล 8.72 

 

 

 

 

 

 

 

 

 
 
 



 188
 

     DATE:  4/30/2009 
TIME: 22:13 

 
 
                                L I S R E L  8.72 
 
                                       BY 
 
                         Karl G. J”reskog & Dag S”rbom 
 
 
 
                    This program is published exclusively by 
                    Scientific Software International, Inc. 
                       7383 N. Lincoln Avenue, Suite 100 
                        Lincolnwood, IL 60712, U.S.A.  
            Phone: (800)247-6113, (847)675-0720, Fax: (847)675-2140 
        Copyright by Scientific Software International, Inc., 1981-2005  
          Use of this program is subject to the terms specified in the 
                        Universal Copyright Convention. 
                          Website: www.ssicentral.com 
 
 
 The following lines were read from file   
 C:\Users\chang\Desktop\comself_sem\sem59.LPJ: 
 
 TI 
 !DA NI=106 NO=813 MA=CM 
 SY='C:\Users\chang\Desktop\comself_sem\sem39.DSF' 
 SE 
 1 2 3 4 5 6 7 8 9 10 11 12 13 / 
 MO NX=6 NY=7 NK=4 NE=4 BE=FU GA=FI PS=SY TE=SY TD=SY 
 LE 
 comself goallevel goalcomm comper 
 LK 
 prevexp trainper learngoa comanxi 
 FI PS(1,1) TE(7,7) TD(2,2) TD(5,5) TD(6,6) TD(4,2) TD(6,5) TD(6,2) TD(5,2) 
 FI TD(6,4) TD(5,4) 
 FR LY(1,1) LY(4,2) LY(6,4) LX(2,1) LX(3,2) LX(4,2) LX(5,3) LX(6,4) BE(2,1) 
 FR BE(3,1) BE(4,1) BE(4,2) BE(4,3) GA(1,1) GA(1,2) GA(1,3) GA(1,4) TH(1,1) 
 FR TH(1,2) TH(1,3) TH(1,4) TH(2,1) TH(2,2) TH(2,3) TH(2,4) TH(4,1) TH(4,2) 
 FR TH(4,7) TH(6,2) TH(6,5) TH(6,6) TH(6,7) TE(2,1) TE(3,2) TE(4,1) TE(4,2) 
 FR TE(5,1) TE(5,2) TE(6,1) TE(7,1) TE(7,2) TD(2,1) TD(3,2) TD(4,1) TD(5,3) 
 FR TD(6,1) TD(2,1) TD(4,1) TH(6,1) TH(3,4) TH(3,3) TD(3,6) TH(3,2) TH(5,2) 
 FR TH(4,5) TH(4,6) TD(1,5) TD(3,1) TH(5,4) TD(4,3) TH(1,5) TH(2,5) TH(1,6) 
 FR TH(2,6) 
 VA 0.401 LY(2,1) 
 VA 0.838 LY(3,2) 
 VA 2.273 LY(5,4) 
 VA 0.476 LY(7,3) 
 PD 
 OU SL=0 PC RS EF FS SS SC PT ND=3 IT=5000 MI AD=OFF 
 
 TI                                                                              
 
                           Number of Input Variables106 
                           Number of Y - Variables    7 
                           Number of X - Variables    6 
                           Number of ETA - Variables  4 
                           Number of KSI - Variables  4 
                           Number of Observations   813 
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TI 
         Covariance Matrix  
       

     wordself    pptself   wordgoal   pptgoal    wordper    pptper    
     --------   --------   --------   --------   --------   -------- 

wordself     0.359 
pptself      0.318      0.498 
wordgoal     0.218      0.222      1.199 
pptgoal       0.192      0.271      0.761      1.207 
wordper       0.420      0.269      0.736      0.766      8.479 
pptper       0.519      0.432      0.781      0.829      5.227      9.858 
goalcomm      0.076      0.062      0.108      0.115      0.445      0.438 
wordexp       0.107      0.127      0.229      0.199      0.289      0.274 
pptexp       0.098      0.145      0.171      0.228      0.216      0.193 
selfest       0.126      0.129      0.115      0.136      0.125      0.133 
neurotic      0.076      0.066      0.137      0.124      0.520      0.434 
learngoa      0.133      0.127      0.082      0.100      0.139      0.177 
comanxie      0.217      0.164      0.268      0.265      1.139      1.009 
 
         Covariance Matrix        
 
            goalcomm    wordexp    pptexp    selfest    neurotic    learngoa    
            --------   --------   --------   --------   --------   -------- 
goalcomm      0.227 
wordexp       0.026      0.382 
pptexp        0.009      0.311      0.368 
selfest       0.053      0.036      0.042      0.215 
neurotic      0.123      0.020      0.013      0.063      0.537 
learngoa      0.062      0.040      0.042      0.144      0.032      0.270 
comanxie      0.197      0.143      0.111      0.053      0.358      0.059 
 
         Covariance Matrix        
 
            comanxie    
            -------- 
 comanxie      1.120 
 
          BEHAVIOR UNDER STEEPEST DESCENT ITERATIONS 
 
 
 
           ITER  TRY    ABSCISSA          SLOPE             FUNCTION 
 
              1    0    0.00000000D+00   -0.24485365D+06    0.13433282D+03 
                   1    0.10000000D+01    0.12974628D+38    0.70616940D+36 
                   2    0.18871729D-31   -0.24485365D+06    0.13433282D+03 
                   3    0.37743457D-31   -0.24485365D+06    0.13433282D+03 
                   4    0.56615186D-31   -0.24485365D+06    0.13433282D+03 
                   5    0.75486915D-31   -0.24485365D+06    0.13433282D+03 
                   6    0.94358644D-31   -0.24485365D+06    0.13433282D+03 
                   7    0.11323037D-30   -0.24485365D+06    0.13433282D+03 
                   8    0.13210210D-30   -0.24485365D+06    0.13433282D+03 
                   9    0.15097383D-30   -0.24485365D+06    0.13433282D+03 
                  10    0.16984556D-30   -0.24485365D+06    0.13433282D+03 
                  11    0.18871729D-30   -0.24485365D+06    0.13433282D+03 
                  12    0.20758902D-30   -0.24485365D+06    0.13433282D+03 
                  13    0.22646074D-30   -0.24485365D+06    0.13433282D+03 
                  14    0.24533247D-30   -0.24485365D+06    0.13433282D+03 
                  15    0.26420420D-30   -0.24485365D+06    0.13433282D+03 
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                  16    0.28307593D-30   -0.24485365D+06    0.13433282D+03 
                  17    0.30194766D-30   -0.24485365D+06    0.13433282D+03 
                  18    0.32081939D-30   -0.24485365D+06    0.13433282D+03 
                  19    0.33969112D-30   -0.24485365D+06    0.13433282D+03 
                  20    0.35856285D-30   -0.24485365D+06    0.13433282D+03 
 
              2    0    0.00000000D+00   -0.24485365D+06    0.13433282D+03 
                   1    0.10000000D+01    0.12974628D+38    0.70616940D+36 
                   2    0.18871729D-31   -0.24485365D+06    0.13433282D+03 
                   3    0.37743457D-31   -0.24485365D+06    0.13433282D+03 
                   4    0.56615186D-31   -0.24485365D+06    0.13433282D+03 
                   5    0.75486915D-31   -0.24485365D+06    0.13433282D+03 
                   6    0.94358644D-31   -0.24485365D+06    0.13433282D+03 
                   7    0.11323037D-30   -0.24485365D+06    0.13433282D+03 
                   8    0.13210210D-30   -0.24485365D+06    0.13433282D+03 
                   9    0.15097383D-30   -0.24485365D+06    0.13433282D+03 
                  10    0.16984556D-30   -0.24485365D+06    0.13433282D+03 
                  11    0.18871729D-30   -0.24485365D+06    0.13433282D+03 
                  12    0.20758902D-30   -0.24485365D+06    0.13433282D+03 
                  13    0.22646074D-30   -0.24485365D+06    0.13433282D+03 
                  14    0.24533247D-30   -0.24485365D+06    0.13433282D+03 
                  15    0.26420420D-30   -0.24485365D+06    0.13433282D+03 
                  16    0.28307593D-30   -0.24485365D+06    0.13433282D+03 
                  17    0.30194766D-30   -0.24485365D+06    0.13433282D+03 
                  18    0.32081939D-30   -0.24485365D+06    0.13433282D+03 
                  19    0.33969112D-30   -0.24485365D+06    0.13433282D+03 
                  20    0.35856285D-30   -0.24485365D+06    0.13433282D+03 
 
 
 TI                                                                              
 
 Parameter Specifications 
 
         LAMBDA-Y     
 
             comself    goallevel   goalcomm     comper 
              --------   --------   --------   -------- 
 wordself        1          0          0          0 
 pptself         0          0          0          0 
 wordgoal        0          0          0          0 
 pptgoal         0          2          0          0 
 wordper         0          0          0          0 
 pptper          0          0          0          3 
 goalcomm        0          0          0          0 
 
         LAMBDA-X     
 
              prevexp     trainper   learngoa    comanxi 
              --------   --------   --------   -------- 
wordexp          0          0          0          0 
pptexp           4          0          0          0 
selfest          0          5          0          0 
neurotic         0          6          0          0 
learngoa         0          0          7          0 
comanxie         0          0          0          8 
 
         BETA         
 
              comself    goallevel   goalcomm     comper 
            --------   --------   --------   -------- 
comself          0          0          0          0 
goallevel        9          0          0          0 
goalcomm         10         0          0          0 
comper           11         12         13         0 
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         GAMMA        
 
              prevexp     trainper   learngoa    comanxi 
            --------   --------   --------   -------- 
 comself         14         15         16         17 
 goallevel        0          0          0          0 
 goalcomm         0          0          0          0 
 comper           0          0          0          0 
 
         PHI          
 
              prevexp     trainper   learngoa    comanxi 
            --------   --------   --------   -------- 
 prevexp          0 
 trainper        18          0 
 learngoa        19         20          0 
 comanxi         21         22         23          0 
 
         PSI          
 
            comself    goallevel   goalcomm     comper 
            --------   --------   --------   -------- 
                0         24         25         26 
 
         THETA-EPS    
 
        wordself     pptself   wordgoal   pptgoal    wordper    pptper 
            --------    --------   --------   --------   --------   -------- 
wordself        27 
pptself         28         29 
wordgoal         0         30         31 
pptgoal         32         33          0         34 
wordper         35         36          0          0         37 
pptper          38          0          0          0          0         39 
goalcomm        40         41          0          0          0          0 
 
         THETA-EPS    
 
             goalcomm 
            -------- 
  goalcomm          0 
 
         THETA-DELTA-EPS  
 
            wordself       pptself   wordgoal   pptgoal    wordper    pptper 
            --------   --------   --------   --------   --------   -------- 
  wordexp        42         43         44         45         46         47 
  pptexp         49         50         51         52         53         54 
  selfest         0         56         57         58          0          0 
  neurotic       62         63          0          0         64         65 
  learngoa        0         70          0         71          0          0 
 comanxie        74         75          0          0         76         77 
 
         THETA-DELTA-EPS  
 
             goalcomm 
            -------- 
  wordexp         0 
  pptexp          0 
  selfest         0 
  neurotic       66 
  learngoa        0 
 comanxie        78 
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         THETA-DELTA  
 
             wordexp    pptexp    selfest    neurotic    learngoa   comanxie 
            --------   --------   --------   --------   --------   -------- 
  wordexp        48 
  pptexp         55          0 
  selfest        59         60         61 
  neurotic       67          0         68         69 
  learngoa       72          0         73          0          0 
  comanxie       79          0         80          0          0          0 
 
 
 TI                                                                              
 
 Number of Iterations =312 
 
 LISREL Estimates (Maximum Likelihood)                            
 
         LAMBDA-Y     
 
              comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 wordself      0.378       - -        - -        - -  
              (0.126) 
               3.007 
  
 pptself       0.401       - -        - -        - -  
  
 wordgoal       - -       0.838       - -        - -  
  
 pptgoal        - -        0.875       - -        - -  
                         (0.087) 
                          10.011 
  
 wordper        - -        - -        - -       2.273 
  
 pptper         - -        - -        - -       2.330 
                                               (0.214) 
                                                10.879 
  
 goalcomm       - -        - -       0.476       - -  
  
 
         LAMBDA-X     
 
             prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
  wordexp      - -        - -        - -        - -  
  
  pptexp      0.609       - -        - -        - -  
             (0.015) 
              40.389 
  
  selfest      - -       0.229       - -        - -  
                        (0.051) 
                         4.481 
  
  neurotic     - -       0.372       - -        - -  
                        (0.047) 
                         7.965 
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  learngoa     - -        - -       0.518       - -  
                                   (0.013) 
                                   40.326 
  
 comanxie      - -        - -        - -       1.052 
                                              (0.026) 
                                               40.505 
  
 
         BETA         
 
             comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 comself       - -        - -        - -        - -  
  
 goallevel    0.269       - -        - -        - -  
             (0.080) 
              3.364 
  
 goalcomm     0.349       - -        - -        - -  
             (0.126) 
              2.772 
  
 comper      -0.027      0.309      0.338       - -  
             (0.072)    (0.060)    (0.071) 
             -0.372      5.120      4.754 
  
 
         GAMMA        
 
              prevexp     trainper   learngoa    comanxi    
             --------   --------   --------   -------- 
 comself      -0.014      0.877      0.408     -0.516 
              (0.336)    (0.541)    (0.240)    (0.354) 
              -0.041      1.341      1.703     -0.634 
  
 goallevel      - -        - -        - -        - -  
  
 goalcomm       - -        - -        - -        - -  
  
 comper         - -        - -        - -        - -  
 
 
         Covariance Matrix of ETA and KSI         
 
            comself    goallevel   goalcomm   comper     prevexp   trainper    
            --------   --------   --------   --------   --------   -------- 
comself      1.000 
goallevel    0.670      1.000 
goalcomm     0.869      0.234      1.000 
comper       0.434      0.377      0.388      1.000 
prevexp     -0.122     -0.033     -0.043     -0.021      1.000 
trainper     0.891      0.382      0.495      0.248      0.009      1.000 
learngoa     0.667      0.179      0.233      0.116      0.119      0.156 
comanxi      0.295      0.279      0.362      0.181      0.149      0.901 
 
         Covariance Matrix of ETA and KSI         
 
            learngoa    comanxi    
            --------   -------- 
 learngoa      1.000 
 comanxi       0.100      1.000 
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         PHI          
 
            prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
prevexp      1.000 
  
trainper      0.009      1.000 
             (0.065) 
              0.132 
  
learngoa      0.119      0.156      1.000 
             (0.034)    (0.068) 
              3.544      2.279 
  
comanxi       0.149      0.901      0.100      1.000 
             (0.033)    (0.101)    (0.034) 
              4.587      8.942      2.941 
  
 
         PSI          
         Note: This matrix is diagonal. 
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
                - -       0.842      0.699      0.739 
                        (0.119)    (0.089)    (0.090) 
                          7.097      7.879      8.175 
  
 
 
         Squared Multiple Correlations for Structural Equations   
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
               1.000      0.176      0.302      0.242 
 
         Squared Multiple Correlations for Reduced Form           
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
               1.000      0.176      0.302      0.242 
 
         Reduced Form                 
 
             prevexp     trainper   learngoa    comanxi    
             --------   --------   --------   -------- 
  comself    -0.014      2.434      0.408     -1.195 
             (0.336)    (1.815)    (0.240)    (1.884) 
              -0.041      1.341      1.703     -0.634 
  
  goallevel  -0.004      0.654      0.110     -0.321 
             (0.090)    (0.473)    (0.057)    (0.508) 
              -0.041      1.382      1.927     -0.633 
  
 goalcomm     -0.005      0.849      0.142     -0.417 
             (0.117)    (0.516)    (0.072)    (0.606) 
              -0.040      1.647      1.983     -0.688 
  
   comper     -0.002      0.424      0.071     -0.208 
             (0.059)    (0.288)    (0.040)    (0.312) 
              -0.040      1.472      1.766     -0.668 
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         THETA-EPS    
 
             wordself   pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
wordself     -0.001 
             (0.077) 
             -0.013 
  
pptself     -0.064      0.093 
            (0.106)    (0.230) 
            -0.605      0.402 
  
wordgoal       - -      -0.009      0.470 
                        (0.075)    (0.072) 
                         -0.118      6.560 
  
pptgoal     -0.036      0.029       - -       0.414 
            (0.023)    (0.083)               (0.077) 
            -1.579      0.353                 5.382 
  
wordper      0.037     -0.137       - -        - -       3.375 
            (0.117)    (0.062)                          (0.461) 
             0.319     -2.219                            7.316 
  
pptper      0.114       - -        - -        - -        - -       4.504 
           (0.121)                                                (0.504) 
            0.942                                                  8.938 
  
goalcomm   -0.087     -0.111       - -        - -        - -        - -  
           (0.035)    (0.046) 
           -2.460     -2.412 
  
         THETA-EPS    
 
             goalcomm    
             -------- 
  goalcomm       - -  
  
 
         Squared Multiple Correlations for Y - Variables          
 
            wordself       pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
               0.859      0.812      0.605      0.654      0.599      0.540 
 
         Squared Multiple Correlations for Y - Variables          
 
             goalcomm    
             -------- 
               1.000 
          
 

THETA-DELTA-EPS  
 
           wordself     pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
wordexp      0.099      0.121      0.220      0.189      0.247      0.219 
            (0.013)    (0.016)    (0.024)    (0.024)    (0.060)    (0.065) 
             7.683      7.772      9.078      7.878      4.125      3.395 
  
   
pptexp      0.120      0.171      0.181      0.239      0.214      0.176 
           (0.018)    (0.023)    (0.025)    (0.026)    (0.061)    (0.065) 
            6.788      7.414      7.220      9.310      3.538      2.710 
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selfest       - -      -0.005      0.038      0.056       - -        - -  
                       (0.043)    (0.015)    (0.020) 
                       -0.104      2.527      2.773 
 
neurotic     -0.128     -0.150       - -        - -     0.299      0.217 
            (0.058)    (0.070)                         (0.099)    (0.104) 
            -2.198     -2.134                           3.007      2.085 
  
learngoa       - -      -0.014       - -       0.013       - -        - -  
                        (0.046)               (0.018) 
                        -0.311                 0.718 
  
comanxie     -0.203     -0.281       - -        - -       0.674      0.539 
             (0.108)    (0.134)                          (0.179)    (0.186) 
             -1.885     -2.097                           3.770      2.900 
  
 
         THETA-DELTA-EPS  
 
             goalcomm    
            -------- 
  wordexp      - -  
  
  pptexp       - -  
  
  selfest      - -  
  
  neurotic    0.036 
             (0.029) 
              1.229 
  
  learngoa       - -  
  
 comanxie      0.007 
             (0.053) 
               0.125 
  
 
         THETA-DELTA  
 
             wordexp    pptexp    selfest    neurotic    learngoa   comanxie    
            --------   --------   --------   --------   --------   -------- 
  wordexp     0.382 
             (0.019) 
              20.175 
  
  pptexp     0.313       - -  
             (0.017) 
              18.251 
  
  selfest      0.030      0.035      0.162 
             (0.010)    (0.012)    (0.023) 
               3.044      2.856      6.981 
  
  neurotic    0.005       - -      -0.021      0.398 
             (0.015)               (0.018)    (0.036) 
               0.370               -1.132     11.117 
  
  learngoa    0.034       - -       0.124       - -        - -  
             (0.011)               (0.012) 
               3.135                10.576 
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 comanxie     0.122       - -      -0.165       - -        - -        - -  
             (0.022)               (0.067) 
              5.647                -2.460 
  
 
         Squared Multiple Correlations for X - Variables          
 
             wordexp    pptexp    selfest    neurotic    learngoa   comanxie    
            --------   --------   --------   --------   --------   -------- 
              0.757      1.000      0.244      0.258      1.000      1.000 
 
 
                           Goodness of Fit Statistics 
 
                             Degrees of Freedom = 11 
               Minimum Fit Function Chi-Square = 9.146 (P = 0.608) 
       Normal Theory Weighted Least Squares Chi-Square = 9.065 (P = 0.616) 
                  Estimated Non-centrality Parameter (NCP) = 0.0 
              90 Percent Confidence Interval for NCP = (0.0 ; 8.866) 
  
                       Minimum Fit Function Value = 0.0113 
                 Population Discrepancy Function Value (F0) = 0.0 
              90 Percent Confidence Interval for F0 = (0.0 ; 0.0109) 
              Root Mean Square Error of Approximation (RMSEA) = 0.0 
            90 Percent Confidence Interval for RMSEA = (0.0 ; 0.0315) 
               P-Value for Test of Close Fit (RMSEA < 0.05) = 0.999 
  
                  Expected Cross-Validation Index (ECVI) = 0.211 
            90 Percent Confidence Interval for ECVI = (0.211 ; 0.222) 
                         ECVI for Saturated Model = 0.224 
                       ECVI for Independence Model = 6.778 
  
     Chi-Square for Independence Model with 78 Degrees of Freedom = 5477.822 
                           Independence AIC = 5503.822 
                               Model AIC = 169.065 
                             Saturated AIC = 182.000 
                           Independence CAIC = 5577.932 
                               Model CAIC = 625.123 
                             Saturated CAIC = 700.767 
  
                          Normed Fit Index (NFI) = 0.998 
                       Non-Normed Fit Index (NNFI) = 1.002 
                    Parsimony Normed Fit Index (PNFI) = 0.141 
                       Comparative Fit Index (CFI) = 1.000 
                       Incremental Fit Index (IFI) = 1.000 
                         Relative Fit Index (RFI) = 0.988 
  
                            Critical N (CN) = 2196.118 
  
  
                     Root Mean Square Residual (RMR) = 0.0201 
                            Standardized RMR = 0.0184 
                       Goodness of Fit Index (GFI) = 0.998 
                  Adjusted Goodness of Fit Index (AGFI) = 0.986 
                  Parsimony Goodness of Fit Index (PGFI) = 0.121 
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 TI                                                                              
 
         Fitted Covariance Matrix 
 
         wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordself    0.355 
 pptself     0.314      0.493 
 wordgoal    0.212      0.216      1.187 
 pptgoal     0.186      0.264      0.750      1.197 
 wordper     0.410      0.258      0.718      0.750      8.413 
 pptper      0.496      0.406      0.736      0.769      5.164      9.798 
 goalcomm    0.070      0.055      0.093      0.097      0.419      0.430 
 wordexp     0.099      0.121      0.220      0.189      0.247      0.219 
 pptexp      0.092      0.141      0.164      0.221      0.185      0.146 
 selfest     0.123      0.126      0.112      0.132      0.129      0.132 
 neurotic    0.072      0.062      0.119      0.124      0.508      0.432 
 learngoa    0.131      0.124      0.078      0.094      0.137      0.140 
 comanxie    0.209      0.157      0.246      0.257      1.107      0.982 
 
         Fitted Covariance Matrix 
 
            goalcomm    wordexp    pptexp    selfest    neurotic    learngoa    
            --------   --------   --------   --------   --------   -------- 
  goalcomm    0.227 
  wordexp       - -      0.382 
  pptexp     -0.012      0.313      0.371 
  selfest     0.054      0.030      0.036      0.214 
  neurotic    0.124      0.005      0.002      0.064      0.537 
  learngoa    0.057      0.034      0.038      0.143      0.030      0.269 
 comanxie     0.188      0.122      0.096      0.052      0.353      0.054 
 
         Fitted Covariance Matrix 
 
            comanxie    
            -------- 
 comanxie      1.106 
 
         Fitted Residuals 
 

      wordself       pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordself     0.004 
 pptself      0.004      0.005 
 wordgoal     0.005      0.005      0.011 
 pptgoal      0.006      0.006      0.011      0.010 
 wordper      0.010      0.010      0.018      0.015      0.066 
 pptper       0.022      0.026      0.044      0.060      0.063      0.060 
 goalcomm     0.006      0.008      0.015      0.017      0.025      0.008 
 wordexp      0.007      0.006      0.010      0.010      0.041      0.054 
 pptexp       0.006      0.004      0.007      0.007      0.031      0.047 
 selfest      0.003      0.004      0.004      0.003     -0.003      0.001 
 neurotic     0.004      0.004      0.018     -0.001      0.011      0.001 
 learngoa     0.002      0.003      0.004      0.006      0.002      0.037 
 comanxie     0.008      0.007      0.022      0.008      0.032      0.027 
 
         Fitted Residuals 
 
            goalcomm    wordexp    pptexp    selfest    neurotic    learngoa    
            --------   --------   --------   --------   --------   -------- 
  goalcomm     0.000 
  wordexp      0.026      0.000 
  pptexp       0.022     -0.002     -0.003 
  selfest     -0.001      0.006      0.006      0.001 
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  neurotic     0.000      0.015      0.011     -0.001      0.000 
  learngoa     0.004      0.006      0.005      0.001      0.002      0.001 
  comanxie     0.009      0.021      0.016      0.001      0.005      0.005 
 
         Fitted Residuals 
 
            comanxie    
            -------- 
 comanxie      0.014 
 
 Summary Statistics for Fitted Residuals 
 
 Smallest Fitted Residual =   -0.003 
   Median Fitted Residual =    0.006 
  Largest Fitted Residual =    0.066 
 
  
 
Stemleaf Plot 
 
 - 0|3321110000  
   0|111111222333444444444555555666666666777788889  
   1|00000111145556788  
   2|12225667  
   3|127  
   4|147  
   5|4  
   6|0036 
 
         Standardized Residuals   
 
      wordself   pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordself     2.421 
 pptself      2.465      2.423 
 wordgoal     0.747      0.778      2.237 
 pptgoal      1.338      1.358      2.303      2.233 
 wordper      0.728      0.689      0.355      0.348      2.443 
 pptper       1.380      1.498      0.757      1.135      2.443      2.443 
 goalcomm     2.171      2.275      1.109      1.508      1.796      0.502 
 wordexp      2.093      2.008      1.681      1.819      1.971      2.437 
 pptexp       2.203      2.107      1.346      1.448      1.736      2.375 
 selfest      1.817      1.876      1.285      1.264     -0.126      0.048 
 neurotic     2.319      1.664      1.405     -0.058      1.075      0.124 
 learngoa     0.871      1.096      1.298      1.929      0.074      0.988 
 comanxie     2.070      1.777      1.435      0.674      2.588      2.187 
 
         Standardized Residuals   
 
            goalcomm    wordexp    pptexp    selfest    neurotic    learngoa    
            --------   --------   --------   --------   --------   -------- 
 goalcomm       - -  
 wordexp      2.499     -0.447 
 pptexp       2.528     -1.864     -2.282 
 selfest     -0.303      2.517      2.524      2.337 
 neurotic    -0.256      2.600      2.221     -0.428     -0.277 
 learngoa     0.868      2.089      1.909      2.428      0.708      2.467 
 comanxie     2.506      2.460      2.229      0.331      1.966      1.166 
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         Standardized Residuals   
 
            comanxie    
            -------- 
 comanxie      2.558 
 
 Summary Statistics for Standardized Residuals 
 
 Smallest Standardized Residual =   -2.282 
   Median Standardized Residual =    1.681 
  Largest Standardized Residual =    2.600 
 
 Stemleaf Plot 
 
 - 2|3  
 - 1|9  
 - 1|  
 - 0|  
 - 0|443331100  
   0|11334  
   0|5777778899  
   1|0111123333344444  
   1|557778888999  
   2|00011112222222333344444444  
   2|55555555666 
 Largest Positive Standardized Residuals 
 Residual for  neurotic and  wordexp   2.600 
 Residual for comanxie and  wordper   2.588 
 
 
 TI                                                                              
 
                         Qplot of Standardized Residuals 
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   -3.5                                                                      
3.5 
                             Standardized Residuals 
 
 TI                                                                              
 
 Modification Indices and Expected Change 
 
         Modification Indices for LAMBDA-Y        
 
            comself     goallevel   goalcomm     comper    
            --------    --------   --------   -------- 
 wordself      - -        0.148       - -       0.148 
 pptself       - -        - -        - -        - -  
 wordgoal      0.040       - -       0.151      0.172 
 pptgoal       0.040       - -       0.420      0.345 
 wordper       0.059      0.381      0.343       - -  
 pptper        0.059      0.381      0.343       - -  
 goalcomm       - -       0.148       - -       0.148 
 
         Expected Change for LAMBDA-Y     
 
             comself    goallevel   goalcomm     comper    
            --------   --------     --------   -------- 
 wordself      - -       -0.023       - -      -0.074 
 pptself       - -        - -        - -        - -  
 wordgoal      0.008       - -      -0.015     -0.023 
 pptgoal      -0.009       - -       0.025      0.037 
 wordper      -0.044     -0.101      0.103       - -  
 pptper        0.045      0.104     -0.105       - -  
 goalcomm       - -       0.010       - -       0.032 
 
         Standardized Expected Change for LAMBDA-Y        
 
             comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 wordself      - -       -0.023      - -       -0.073 
 pptself       - -        - -        - -        - -  
 wordgoal      0.013       - -      -0.015     -0.023 
 pptgoal      -0.014       - -       0.025      0.037 
 wordper      -0.069     -0.102      0.103       - -  
 pptper        0.070      0.105     -0.105       - -  
 goalcomm       - -       0.010       - -       0.032 
 
         
 
 

 Completely Standardized Expected Change for LAMBDA-Y     
 
             comself    goallevel   goalcomm     comper    
              --------   --------   --------   -------- 
 wordself      - -       -0.039       - -      -0.122 
 pptself       - -         - -        - -        - -  
 wordgoal      0.012       - -      -0.013     -0.021 
 pptgoal      -0.013       - -       0.023      0.034 
 wordper      -0.024     -0.035      0.035       - -  
 pptper        0.023      0.034     -0.034       - -  
 goalcomm       - -       0.021       - -       0.067 
 
         Modification Indices for LAMBDA-X        
 
               prevexp     trainper   learngoa    comanxi    
               --------   --------   --------   -------- 
  wordexp       5.702      5.702      5.702      5.702 
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  pptexp         - -        - -        - -        - -  
  selfest        - -        - -        - -        - -  
  neurotic       - -        - -        - -        - -  
  learngoa       - -        - -        - -        - -  
  comanxie       - -        - -        - -        - -  
 
         Expected Change for LAMBDA-X     
 
               prevexp     trainper   learngoa    comanxi    
               --------   --------   --------   -------- 
  wordexp      -1.193      0.103      0.219      0.140 
  pptexp         - -        - -        - -        - -  
  selfest        - -        - -        - -        - -  
  neurotic       - -        - -        - -        - -  
  learngoa       - -        - -        - -        - -  
  comanxie       - -        - -        - -        - -  
 
         Standardized Expected Change for LAMBDA-X        
 
                prevexp     trainper   learngoa    comanxi    
               --------   --------   --------   -------- 
  wordexp       -1.193      0.103      0.219      0.140 
  pptexp         - -        - -        - -        - -  
  selfest        - -        - -        - -        - -  
  neurotic       - -        - -        - -        - -  
  learngoa       - -        - -        - -        - -  
  comanxie       - -        - -        - -        - -  
 
         Completely Standardized Expected Change for LAMBDA-X     
 
                prevexp     trainper   learngoa   comanxi    
                --------   --------   --------   -------- 
  wordexp       -1.929      0.166      0.354      0.227 
  pptexp         - -        - -        - -        - -  
  selfest        - -        - -        - -        - -  
  neurotic       - -        - -        - -        - -  
  learngoa       - -        - -        - -        - -  
  comanxie       - -        - -        - -        - -  
 
          

Modification Indices for BETA            
 
               comself    goallevel   goalcomm   comper    
               --------   --------   --------   -------- 
 comself         - -        - -       0.148      0.148 
 goallevel       - -        - -       0.148      0.148 
 goalcomm        - -       0.148       - -       0.148 
 comper          - -        - -        - -        - -  
 
 

 Expected Change for BETA         
 
              comself    goallevel  goalcomm   comper    
             --------   --------   --------   -------- 
 comself       - -        - -       0.094      0.279 
 goallevel     - -        - -       0.025      0.075 
 goalcomm      - -       0.021       - -       0.068 
  comper       - -        - -        - -        - -  
 
         Standardized Expected Change for BETA            
 
             comself   goallevel goalcomm     comper    
            --------   --------   --------   -------- 
 comself      - -        - -       0.060      0.179 
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 goallevel    - -        - -       0.025      0.075 
 goalcomm     - -       0.021       - -       0.069 
 comper       - -        - -        - -        - -  
 
         Modification Indices for GAMMA           
 
              prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
  comself     - -        - -        - -        - -  
  goallevel   0.089      0.089      0.089      0.089 
  goalcomm    0.365      0.666      0.584      0.732 
  comper      0.089      0.089      0.089      0.089 
 
         Expected Change for GAMMA        
 
             prevexp     trainper   learngoa    comanxi    
             --------   --------   --------   -------- 
  comself       - -        - -        - -        - -  
  goallevel   0.277     -0.102      0.034     -0.099 
  goalcomm    0.151     -0.081      0.026     -0.082 
  comper      0.086     -0.032      0.011     -0.031 
 
         Standardized Expected Change for GAMMA           
 
              prevexp     trainper   learngoa    comanxi    
             --------   --------   --------   -------- 
  comself     - -        - -        - -        - -  
  goallevel   0.274     -0.101      0.034     -0.098 
  goalcomm    0.151     -0.081      0.026     -0.082 
  comper      0.087     -0.032      0.011     -0.031 
 
 No Non-Zero Modification Indices for PHI          
 
         Modification Indices for PSI             
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 comself     - -  
 goallevel   - -        - -  
 goalcomm    0.148      0.148       - -  
 comper       - -        - -        - -        - -  
 
         Expected Change for PSI          
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 comself      - -  
 goallevel    - -        - -  
 goalcomm    0.066      0.018       - -  
 comper       - -        - -        - -        - -  
 
 
         Standardized Expected Change for PSI             
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 comself      - -  
 goallevel    - -        - -  
 goalcomm     0.042      0.018      - -  
 comper       - -        - -        - -        - - 
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         Modification Indices for THETA-EPS       
 
            wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordself      - -  
 pptself       - -        - -  
 wordgoal     0.148       - -        - -  
 pptgoal       - -        - -        - -        - -  
 wordper       - -        - -       0.024      0.037       - -  
 pptper        - -        - -       0.000      0.140       - -        - -  
 goalcomm      - -        - -       0.178      0.488      0.495      0.495 
 
         Modification Indices for THETA-EPS       
 
             goalcomm    
            -------- 
  goalcomm       - -  
 
         Expected Change for THETA-EPS    
 
           wordself     pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordself      - -  
 pptself       - -        - -  
 wordgoal    -0.016       - -        - -  
 pptgoal       - -        - -        - -        - -  
 wordper       - -        - -      -0.011     -0.014       - -  
 pptper        - -        - -      -0.001      0.030       - -        - -  
 goalcomm      - -        - -      -0.005      0.010      0.043     -0.044 
 
         Expected Change for THETA-EPS    
 
             goalcomm    
            -------- 
  goalcomm       - -  
 
         Completely Standardized Expected Change for THETA-EPS    
 
           wordself       pptself   wordgoal   pptgoal    wordper    pptper    
           --------   --------   --------   --------   --------   -------- 
 wordself      - -  
 pptself       - -        - -  
 wordgoal    -0.025       - -        - -  
 pptgoal       - -        - -        - -        - -  
 wordper       - -        - -      -0.004     -0.005       - -  
 pptper        - -        - -       0.000      0.009       - -        - -  
 goalcomm      - -        - -      -0.011      0.018      0.031     -0.030 
 
         Completely Standardized Expected Change for THETA-EPS    
 
             goalcomm    
            -------- 
 goalcomm       - -  
 
         Modification Indices for THETA-DELTA-EPS 
 
            wordself       pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
  wordexp      - -        - -        - -        - -        - -        - -  
  pptexp       - -        - -        - -        - -        - -        - -  
  selfest     0.873       - -        - -        - -       0.042      0.227 
  neurotic     - -        - -       0.576      0.576       - -        - -  
  learngoa    0.571       - -        - -        - -       0.311      0.747 
  comanxie     - -        - -       0.069      0.069       - -        - - 
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         Modification Indices for THETA-DELTA-EPS 
 
             goalcomm    
            -------- 
 wordexp      5.702 
 pptexp       - -  
 selfest      0.640 
 neurotic      - -  
 learngoa     0.375 
 comanxie      - -  
 
         Expected Change for THETA-DELTA-EPS  
 
            wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordexp      - -        - -        - -        - -        - -        - -  
 pptexp       - -        - -        - -        - -        - -        - -  
 selfest     0.014       - -        - -        - -       0.006     -0.016 
 neurotic     - -        - -       0.016     -0.016       - -        - -  
 learngoa    -0.013      - -        - -        - -      -0.019      0.032 
 comanxie     - -        - -       0.008     -0.008       - -        - -  
 
         Expected Change for THETA-DELTA-EPS  
 
             goalcomm    
            -------- 
 wordexp      0.024 
 pptexp       - -  
 selfest     -0.005 
 neurotic     - -  
 learngoa     0.004 
 comanxie      - -  
 
         Completely Standardized Expected Change for THETA-DELTA-EPS  
 
           wordself       pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
 wordexp      - -        - -        - -        - -        - -        - -  
 pptexp       - -        - -        - -        - -        - -        - -  
 selfest     0.050       - -        - -        - -       0.005     -0.011 
 neurotic     - -        - -       0.020     -0.020       - -        - -  
 learngoa   -0.041       - -        - -        - -      -0.013      0.020 
 comanxie     - -        - -       0.007     -0.007       - -        - -  
 
         Completely Standardized Expected Change for THETA-DELTA-EPS  
 
             goalcomm    
            -------- 
 wordexp     0.082 
 pptexp       - -  
 selfest    -0.023 
 neurotic     - -  
 learngoa    0.018 
 comanxie     - -  
 
 
 TI        
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 Factor Scores Regressions 
 
         ETA  
 
            wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
comself      1.689      1.110     -0.053      0.145     -0.044     -0.085 
goallevel    0.333      0.099      0.417      0.559      0.017      0.000 
goalcomm     0.465      0.425     -0.050     -0.027      0.009     -0.021 
comper      -0.078      0.261      0.076      0.060      0.190      0.129 
 
         ETA  
 
            goalcomm    wordexp    pptexp    selfest    neurotic    learngoa    
            --------   --------   --------   --------   --------   -------- 
comself      0.664      0.095     -1.215     -0.269      0.262      0.009 
goallevel   -0.084     -0.245     -0.482     -0.365      0.004      0.115 
goalcomm     2.145     -0.025     -0.152     -0.239     -0.160     -0.222 
comper       0.343     -0.170     -0.121     -0.070     -0.116     -0.015 
 
         ETA  
 
            comanxie    
            -------- 
comself      0.519 
goallevel    0.042 
goalcomm    -0.053 
comper      -0.174 
 
         KSI  
 
            wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
prevexp      0.050     -0.716      0.445     -0.584     -0.026      0.030 
trainper     0.863      0.613     -0.013     -0.005     -0.051     -0.053 
learngoa     0.204      0.191      0.115     -0.007     -0.001     -0.009 
comanxi      0.414      0.393      0.053     -0.127     -0.067     -0.039 
 
         KSI  
 
            goalcomm    wordexp    pptexp    selfest    neurotic    learngoa    
            --------   --------   --------   --------   --------   -------- 
prevexp      0.232     -4.770      6.001     -0.185     -0.070      0.383 
trainper     0.242     -0.363     -0.232      0.681      0.040     -0.829 
learngoa     0.141     -0.701      0.561     -2.018      0.149      2.767 
comanxi     -0.016     -1.005      0.667      0.925     -0.086     -0.756 
 
         

 KSI  
 
            comanxie    
            -------- 
   prevexp      0.247 
   trainper     0.723 
  learngoa     -0.071 
   comanxi      1.013 
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 TI                                                                              
 
 Standardized Solution            
 
         LAMBDA-Y     
 
           comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
wordself     0.597       - -        - -        - -  
pptself      0.633       - -        - -        - -  
wordgoal      - -       0.847       - -        - -  
pptgoal       - -       0.885       - -        - -  
wordper       - -        - -        - -       2.244  
pptper        - -        - -        - -       2.301 
goalcomm      - -        - -       0.476       - -  
 
 
 
         LAMBDA-X     
 
            prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
wordexp        - -        - -        - -        - -  
pptexp        0.609       - -        - -        - -  
selfest        - -       0.229       - -        - -  
neurotic       - -       0.372       - -        - -  
learngoa       - -        - -       0.518       - -  
comanxie       - -        - -        - -       1.052 
 
         BETA         
 
             comself  goallevel   goalcomm    comper    
            --------   --------   --------   -------- 
comself      - -         - -        - -        - -  
goallevel    0.420       - -        - -        - -  
goalcomm     0.550       - -        - -        - -  
comper      -0.043      0.317      0.342       - -  
 
         GAMMA        
 
            prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
comself     -0.009      1.542      0.259     -0.757 
goallevel     - -        - -        - -        - -  
goalcomm      - -        - -        - -        - -  
comper        - -        - -        - -        - -  
 
         Correlation Matrix of ETA and KSI        
 
         comself    goallevel   goalcomm     comper    prevexp    trainper    
         --------   --------   --------   --------   --------   -------- 
comself      1.000 
goallevel    0.420      1.000 
goalcomm     0.550      0.231      1.000 
comper       0.279      0.378      0.392      1.000 
prevexp     -0.077     -0.033     -0.043     -0.022      1.000 
trainper     0.900      0.378      0.495      0.251      0.009      1.000 
learngoa     0.422      0.177      0.232      0.118      0.119      0.156 
comanxi      0.658      0.276      0.362      0.183      0.149      0.901 
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         Correlation Matrix of ETA and KSI        
 
            learngoa    comanxi    
            --------   -------- 
 learngoa      1.000 
  comanxi      0.100      1.000 
 
         PSI          
         Note: This matrix is diagonal. 
 
             comself    goallevel  goalcomm   comper    
            --------   --------   --------   -------- 
                - -       0.824      0.698      0.758 
 
         Regression Matrix ETA on KSI (Standardized)  
 
            prevexp    trainper   learngoa   comanxi    
            --------   --------   --------   -------- 
comself     -0.009      1.542      0.259     -0.757 
goallevel   -0.004      0.647      0.109     -0.318 
goalcomm    -0.005      0.848      0.142     -0.416 
comper      -0.002      0.430      0.072     -0.211 
 
 TI                                                                              
 
 Completely Standardized Solution 
 
         LAMBDA-Y     
 
             comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 wordself     0.973       - -        - -        - -  
 pptself      0.901       - -        - -        - -  
 wordgoal      - -       0.778       - -        - -  
 pptgoal       - -       0.809       - -        - -  
 wordper       - -        - -        - -       0.774 
 pptper        - -        - -        - -       0.735 
 goalcomm      - -        - -       1.000       - -  
 
         LAMBDA-X     
 
            prevexp    trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
 wordexp      0.980       - -        - -        - -  
 pptexp       1.000       - -        - -        - -  
 selfest       - -       0.494       - -        - -  
 neurotic      - -       0.508       - -        - -  
 learngoa      - -        - -       1.000       - -  
 comanxie      - -        - -        - -       1.000 
 
         BETA         
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
  comself     - -        - -        - -        - -  
  goallevel  0.420       - -        - -        - -  
  goalcomm   0.550       - -        - -        - -  
  comper     -0.043      0.317      0.342      - -  
 
         GAMMA       
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              prevexp   trainper   learngoa    comanxi    
             --------   --------   --------   -------- 
 comself     -0.009      1.542      0.259     -0.757 
 goallevel    - -        - -        - -        - -  
 goalcomm     - -        - -        - -        - -  
 comper       - -        - -        - -        - -  
 
          
 
 

Correlation Matrix of ETA and KSI        
 
         comself    goallevel   goalcomm   comper    prevexp    trainper    
         --------   --------   --------   --------   --------   -------- 
comself    1.000 
goallevel  0.420      1.000 
goalcomm   0.550      0.231      1.000 
comper     0.279      0.378      0.392      1.000 
prevexp   -0.077     -0.033     -0.043     -0.022      1.000 
trainper   0.900      0.378      0.495      0.251      0.009      1.000 
learngoa   0.422      0.177      0.232      0.118      0.119      0.156 
comanxi    0.658      0.276      0.362      0.183      0.149      0.901 
 
         Correlation Matrix of ETA and KSI        
 
            learngoa    comanxi    
            --------   -------- 
 learngoa      1.000 
  comanxi      0.100      1.000 
 
         PSI          
         Note: This matrix is diagonal. 
 
           comself    goallevel   goalcomm    comper    
            --------   --------   --------   -------- 
              - -       0.824      0.698      0.758 
 
         THETA-EPS    
 
           wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
wordself    -0.003 
pptself     -0.153      0.188 
wordgoal       - -     -0.012      0.395 
pptgoal     -0.055      0.038       - -       0.346 
wordper      0.022     -0.067       - -        - -       0.401 
pptper       0.061       - -        - -        - -        - -       0.460 
goalcomm    -0.305     -0.332       - -        - -        - -        - -  
 
         THETA-EPS    
 
             goalcomm    
            -------- 
  goalcomm       - -  
 
         THETA-DELTA-EPS  
 
            wordself    pptself   wordgoal   pptgoal    wordper    pptper    
            --------   --------   --------   --------   --------   -------- 
wordexp     0.269      0.278      0.326      0.280      0.138      0.113 
pptexp      0.331      0.399      0.273      0.358      0.121      0.092 
selfest      - -      -0.014      0.076      0.110       - -        - -  
neurotic   -0.294     -0.292       - -        - -       0.141      0.095 
learngoa     - -      -0.039       - -       0.022       - -        - -  
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comanxie   -0.324     -0.380       - -        - -       0.221      0.164 
 
         THETA-DELTA-EPS  
 
              goalcomm    
              -------- 
  wordexp        - -  
  pptexp         - -  
  selfest        - -  
  neurotic      0.103 
  learngoa       - -  
  comanxie      0.013 
 
         
 

 THETA-DELTA  
 
             wordexp    pptexp    selfest    neurotic   learngoa   comanxie    
            --------   --------   --------   --------   --------   -------- 
  wordexp     1.000 
  pptexp      0.832       - -  
  selfest     0.104      0.125      0.756 
  neurotic    0.012       - -      -0.061      0.742 
  learngoa    0.107       - -       0.518       - -        - -  
  comanxie    0.187       - -      -0.339       - -        - -        - -  
 
         Regression Matrix ETA on KSI (Standardized)  
 
              prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
  comself     -0.009      1.542      0.259     -0.757 
  goallevel   -0.004      0.647      0.109     -0.318 
  goalcomm    -0.005      0.848      0.142     -0.416 
   comper     -0.002      0.430      0.072     -0.211 
 
 
 TI                                                                              
 
 Total and Indirect Effects 
 
         Total Effects of KSI on ETA  
 
              prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
  comself     -0.014      0.877      0.408     -0.516 
             (0.336)    (0.541)    (0.240)    (0.354) 
              -0.041      1.341      1.703     -0.634 
  
  goallevel   -0.004      0.654      0.110     -0.321 
             (0.090)    (0.473)    (0.057)    (0.508) 
              -0.041      1.382      1.927     -0.633 
  
  goalcomm    -0.005      0.849      0.142     -0.417 
             (0.117)    (0.516)    (0.072)    (0.606) 
              -0.040      1.647      1.983     -0.688 
  
  comper     -0.002      0.424      0.071     -0.208 
             (0.059)    (0.288)    (0.040)    (0.312) 
             -0.040      1.472      1.766     -0.668 
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         Indirect Effects of KSI on ETA   
 
              prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
  comself       - -        - -        - -        - -  
  
  goallevel   -0.004      0.654      0.110     -0.321 
             (0.090)    (0.473)    (0.057)    (0.508) 
              -0.041      1.382      1.927     -0.633 
  
  goalcomm    -0.005      0.849      0.142     -0.417 
             (0.117)    (0.516)    (0.072)    (0.606) 
              -0.040      1.647      1.983     -0.688 
  
  comper     -0.002      0.424      0.071     -0.208 
             (0.059)    (0.288)    (0.040)    (0.312) 
             -0.040      1.472      1.766     -0.668 
  
 
         Total Effects of ETA on ETA  
 
            comself    goallevel   goalcomm     comper    
           --------   --------   --------   -------- 
  comself     - -        - -        - -        - -  
  
  goallevel   0.269       - -        - -        - -  
             (0.080) 
              3.364 
  
  goalcomm      0.349       - -        - -        - -  
             (0.126) 
               2.772 
  
  comper      0.174      0.309      0.338       - -  
             (0.097)    (0.060)    (0.071) 
              1.801      5.120      4.754 
  
    Largest Eigenvalue of B*B' (Stability Index) is   0.217 
 
         Indirect Effects of ETA on ETA   
 
          comself    goallevel   goalcomm     comper    
           --------   --------   --------   -------- 
 comself       - -       - -        - -        - -  
  
 goallevel     - -       - -        - -        - -  
  
 goalcomm      - -       - -        - -        - -  
  
 comper      0.201       - -        - -        - -  
            (0.051) 
             3.964 
  
         Total Effects of ETA on Y    
 
       comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
wordself     0.378       - -        - -        - -  
            (0.126) 
             3.007 
  
pptself      0.401       - -        - -        - -  
  
wordgoal     0.225      0.838       - -        - -  
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            (0.067) 
             3.364 
  
pptgoal      0.235      0.875       - -        - -  
            (0.071)    (0.087) 
             3.294     10.011 
  
wordper      0.396      0.703      0.768      2.273 
            (0.220)    (0.137)    (0.162) 
             1.801      5.120      4.754 
  
pptper       0.406      0.721      0.787      2.330 
            (0.227)    (0.143)    (0.167)    (0.214) 
             1.788      5.056      4.700     10.879 
  
goalcomm     0.166       - -       0.476       - -  
            (0.060) 
             2.772 
  
         Indirect Effects of ETA on Y     
 
             comself    goallevel   goalcomm     comper    
             --------   --------   --------   -------- 
 wordself      - -        - -        - -        - -  
  
 pptself       - -        - -        - -        - -  
  
 wordgoal     0.225       - -        - -        - -  
             (0.067) 
              3.364 
  
 pptgoal     0.235       - -        - -        - -  
            (0.071) 
              3.294 
  
 wordper     0.396      0.703      0.768       - -  
            (0.220)    (0.137)    (0.162) 
             1.801      5.120      4.754 
  
 pptper      0.406      0.721      0.787       - -  
            (0.227)    (0.143)    (0.167) 
             1.788      5.056      4.700 
  
 goalcomm    0.166       - -        - -        - -  
            (0.060) 
             2.772 
  
         Total Effects of KSI on Y    
 
              prevexp     trainper   learngoa    comanxi    
              --------   --------   --------   -------- 
 wordself     -0.005      0.920      0.154     -0.452 
              (0.127)    (0.567)    (0.077)    (0.662) 
              -0.040      1.623      1.995     -0.682 
  
  pptself     -0.005      0.976      0.164     -0.479 
             (0.135)    (0.728)    (0.096)    (0.755) 
              -0.041      1.341      1.703     -0.634 
  
  wordgoal     -0.003      0.548      0.092     -0.269 
             (0.076)    (0.397)    (0.048)    (0.425) 
              -0.041      1.382      1.927     -0.633 
  
  pptgoal     -0.003      0.573      0.096     -0.281 
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             (0.079)    (0.422)    (0.050)    (0.448) 
              -0.041      1.357      1.924     -0.628 
  
  wordper     -0.005      0.964      0.162     -0.473 
             (0.133)    (0.655)    (0.092)    (0.709) 
              -0.040      1.472      1.766     -0.668 
  
  pptper     -0.006      0.988      0.166     -0.485 
             (0.137)    (0.674)    (0.094)    (0.728) 
              -0.040      1.466      1.766     -0.667 
  
  goalcomm     -0.002      0.404      0.068     -0.198 
             (0.056)    (0.245)    (0.034)    (0.288) 
              -0.040      1.647      1.983     -0.688 
  
 TI                                                                              
 
 Standardized Total and Indirect Effects 
 
         Standardized Total Effects of KSI on ETA 
 
            prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
 comself     -0.009      1.542      0.259     -0.757 
 goallevel   -0.004      0.647      0.109     -0.318 
 goalcomm    -0.005      0.848      0.142     -0.416 
 comper      -0.002      0.430      0.072     -0.211 
 
         Standardized Indirect Effects of KSI on ETA  
 
            prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
 comself     - -        - -        - -        - -  
 goallevel  -0.004      0.647      0.109     -0.318 
 goalcomm   -0.005      0.848      0.142     -0.416 
 comper     -0.002      0.430      0.072     -0.211 
         Standardized Total Effects of ETA on ETA 
 
            comself    goallevel   goalcomm   comper    
            --------   --------   --------   -------- 
 comself      - -        - -        - -        - -  
 goallevel   0.420       - -        - -        - -  
 goalcomm    0.550       - -        - -        - -  
 comper      0.279      0.317      0.342       - -  
 
         Standardized Indirect Effects of ETA on ETA  
 
            comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
 comself      - -        - -        - -        - -  
 goallevel    - -        - -        - -        - -  
 goalcomm     - -        - -        - -        - -  
 comper      0.321       - -        - -        - -  
 
         Standardized Total Effects of ETA on Y   
 
             comself    goallevel   goalcomm     comper    
            --------   --------   --------   -------- 
wordself     0.597       - -        - -        - -  
pptself      0.633       - -        - -        - -  
wordgoal     0.356      0.847       - -        - -  
pptgoal      0.371      0.885       - -        - -  
wordper      0.625      0.711      0.769      2.244 
pptper       0.641      0.729      0.788      2.301 
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goalcomm     0.262       - -       0.476       - -  
 
         Completely Standardized Total Effects of ETA on Y    
 
            comself    goallevel   goalcomm   comper    
            --------   --------   --------   -------- 
wordself     1.001       - -        - -        - -  
pptself      0.901       - -        - -        - -  
wordgoal     0.326      0.778       - -        - -  
pptgoal      0.339      0.809       - -        - -  
wordper      0.216      0.245      0.265      0.774 
pptper       0.205      0.233      0.252      0.735 
goalcomm     0.550       - -       1.000       - -  
 
          

Standardized Indirect Effects of ETA on Y    
 
             comself    goallevel   goalcomm   comper    
              --------   --------   --------   -------- 
 wordself      - -        - -        - -        - -  
 pptself       - -        - -        - -        - -  
 wordgoal     0.356       - -        - -        - -  
 pptgoal      0.371       - -        - -        - -  
 wordper      0.625      0.711      0.769       - -  
 pptper       0.641      0.729      0.788       - -  
 goalcomm     0.262       - -        - -        - -  
 
         Completely Standardized Indirect Effects of ETA on Y     
 
             comself    goallevel   goalcomm   comper    
            --------   --------   --------   -------- 
 wordself     - -         - -        - -        - -  
 pptself      - -         - -        - -        - -  
 wordgoal     0.326       - -        - -        - -  
 pptgoal      0.339       - -        - -        - -  
 wordper      0.216      0.245      0.265       - -  
 pptper       0.205      0.233      0.252       - -  
 goalcomm     0.550       - -        - -        - -  
 
         Standardized Total Effects of KSI on Y   
 
             prevexp     trainper  learngoa   comanxi    
            --------   --------   --------   -------- 
 wordself    -0.005      0.920      0.154     -0.452 
 pptself     -0.005      0.976      0.164     -0.479 
 wordgoal    -0.003      0.548      0.092     -0.269 
 pptgoal     -0.003      0.573      0.096     -0.281 
 wordper     -0.005      0.964      0.162     -0.473 
 pptper      -0.006      0.988      0.166     -0.485 
 goalcomm    -0.002      0.404      0.068     -0.198 
 
         Completely Standardized Total Effects of KSI on Y    
 
            prevexp     trainper   learngoa    comanxi    
            --------   --------   --------   -------- 
 wordself    -0.009      1.544      0.259     -0.758 
 pptself     -0.008      1.390      0.233     -0.682 
 wordgoal    -0.003      0.503      0.084     -0.247 
 pptgoal     -0.003      0.523      0.088     -0.257 
 wordper     -0.002      0.332      0.056     -0.163 
 pptper      -0.002      0.316      0.053     -0.155 
 goalcomm    -0.005      0.848      0.142     -0.416 
 
                           Time used:    0.621 Seconds 
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ประวัติผูเขียนวิทยานิพนธ 
 
 นายชุติวัฒน สุวัตถิพงศ  เกิดเมื่อวันที่  5 พฤศจิกายน  พ .ศ .2525 สําเร็จการศึกษา                
ครุศาสตรบัณฑิต (เกียรตินิยมอันดับ 2) วิชาเอกคอมพิวเตอรเพื่อการศึกษา - วิทยาศาสตรทั่วไป 
ภาควิชาหลักสูตรการสอนและเทคโนโลยีการศึกษา คณะครุศาสตร จุฬาลงกรณมหาวิทยาลัย  
เมื่อปการศึกษา 2547 และเขาศึกษาตอในหลักสูตรครุศาสตรมหาบัณฑิต สาขาวิจัยการศึกษา 
ภาควิชาวิจัยและจิตวิทยาการศึกษา คณะครุศาสตร จุฬาลงกรณมหาวิทยาลัย ในปการศึกษา 
2550 ตําแหนงหนาที่ปจจุบัน ครูโรงเรียนมาแตรเดอีวิทยาลัย แขวงลุมพินี เขตปทุมวัน 
กรุงเทพมหานคร   
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